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Introduction

Important

To the maximum extent permitted by applicable laws, in no event will the manufacturer be liable for any
damages whatsoever arising out of failures of this product, losses of documents or data, or the use or
non-use of this product and operation manuals provided with it.

Make sure that you always copy or have backups of important documents or data. Documents or data
might be erased due to your operational errors or malfunctions of the software. Also, you are
responsible for taking protective measures against computer viruses, worms, and other harmful software.

In no event will the manufacturer be responsible for any documents created by you using this product or
any results from the data executed by you.

Cautions regarding this guide

• Some illustrations or explanations in this guide could differ from your product due to improvement or
change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified, or
quoted without prior consent of the supplier.

• Throughout this publication, references to directory paths indicate the default paths only. If you
install InfoPrint Manager or any of its components in a different location, including a different drive,
you must adjust the paths accordingly.
For example, if you install InfoPrint Manager on the D: drive of a computer running a Windows
operating system, replace C: with D: in the directory paths.

Guides for this application

This publication provides information about RICOH InfoPrint Manager™ for AIX, Linux, and Windows,
Version 4.13 (Program Number 5648-F40).

This publication includes an overview of InfoPrint Manager and installation and configuration
information about the product.

Instruction manuals

These instruction manuals are included:

For information about InfoPrint Manager, see these documents:

• RICOH InfoPrint Manager for Windows: Planning Guide , G550-1071

• RICOH InfoPrint Manager for Windows: Getting Started , G550-1072

• RICOH InfoPrint Manager for Windows: Procedures , G550-1073

• RICOH InfoPrint Manager for Linux: Planning Guide, G550-20262

• RICOH InfoPrint Manager for Linux: Getting Started, G550-20263

• RICOH InfoPrint Manager for Linux: Procedures , G550-20264

• RICOH InfoPrint Manager for AIX and Linux: Configuring and Tuning Guide, S550-1062



• RICOH InfoPrint Manager for AIX: Planning Guide, G550-1060

• RICOH InfoPrint Manager for AIX: Getting Started, G550-1061

• RICOH InfoPrint Manager for AIX: Procedures, G550-1066

• RICOH InfoPrint Manager: High Availability Guidelines, G550-20261

• RICOH InfoPrint Manager: Reference, S550-1052

• RICOH InfoPrint Manager: PSF, Server, and Transform Messages, G550-1053

• RICOH InfoPrint Manager: Secure Print: Installing and Configuring, G550-20129

• RICOH InfoPrint Manager: SAP R/3 Planning and Configuring Guide, S550-1051

• RICOH InfoPrint Manager: Dictionary of Keywords, S550-1188

• AFP Conversion and Indexing Facility: User’s Guide, G550-1342

• Page Printer Formatting Aid for Windows: User’s Guide and Reference, S550-0801

• RICOH InfoPrint Manager AFP2PDF Transform Feature: Installing and Using , G550-1057

• RICOH InfoPrint Manager: Installing InfoPrint Manager Transform Feature, G550-20160

Help

Property help is available on many screens to provide information for specific tasks and settings.

In addition, the Help menu provides access to the HTML version of the instruction manual directly from
the user interface.

• A PDF reader, such as Adobe Reader, must be installed to view the PDF documentation.

For more information about RICOH printing products, see:

RICOH Commercial and Industrial Printing website at https://www.ricoh-usa.com/en/products/
commercial-industrial-printing.

RICOH Software Information Center at https://help.ricohsoftware.com/swinfocenter.

How to read the documentation

Displaying the instruction manual

Use this procedure to view the instruction manuals.

Displaying the instruction manual in PDF format

• InfoPrint Manager includes publications in PDF format on the DVD-ROM supplied with the product.

Displaying the instruction manual in HTML format

• The HTML version of the instruction manual is available directly from the user interface. Start the

application, and then click button at the right of the banner and select Help.
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Displaying property help

Click the button next to a property on the user interface to display the property help for that item.

Symbols

The following symbols are used in this manual to help you to identify content quickly.

• This symbol indicates points to pay attention to when using the product. Be sure to read these
explanations.

• This symbol indicates helpful supplementary information that is not essential to completing a task.

Bold
Bold type indicates the names of dialogs, menus, menu items, settings, field labels, buttons, and
keys.

IIttaalliicc
Italic type indicates the titles of manuals and variables that you must replace with your own
information.

MMoonnoossppaaccee

Monospace type indicates computer input and output.

Abbreviations

AFP
Advanced Function Presentation

IP
Internet Protocol

PDF
Portable Document Format

PCL
Printer Command Language

GIF
Graphical Interchange Format

JPEG
Joint Photographic Experts Group

TIFF
Tagged Image File Format
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Trademarks

RICOH InfoPrint Manager™ and RICOH ProcessDirector™ are trademarks of Ricoh Company, Ltd. in
the United States, other countries, or both.

These terms are trademarks or registered trademarks of International Business Machines Corporation in
the United States, other countries, or both:

• AIX

• DFS

• IBM

• MVS

• OS/390

• POWER

• Print Services Facility

• pSeries

• S/390

• z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

CUPS and macOS are trademarks or registered trademarks of Apple, Inc. in the United States, other
countries, or both.

Fiery is the registered trademark of Fiery, LLC in the U.S. and/or certain other countries.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Microsoft, Microsoft Edge, Windows, the Windows logo, and Active Directory are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Okta is a registered trademark of Okta, Inc. in the U.S. and other countries.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Thales Group code: The license management portion of this Licensee Application is based upon one or
more of the following copyrights:

Sentinel RMS
Copyright 1989-2024 Thales Group
All rights reserved.

Sentinel EMS
Copyright 2008-2024 Thales Group
All rights reserved.

Sentinel is a registered trademark of Thales Group.

Other company, product, or service names may be trademarks or service marks of others.
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11.. Administrative Procedures: Configuring InfoPrint
Manager

•Using Multiple Network Adapter Cards
•Working with SNMP printers
•Managed IPDS Dialog support
•Configuring media
•InfoPrint Email support
•Configuring InfoPrint Manager to use the InfoPrint 5000 or RICOH Pro VC series models to

print PostScript and PDF
•Managing Access Control Lists security for InfoPrint Manager for Windows
•Managing LDAP security for InfoPrint Manager for Windows
•Managing Federated Authentication for InfoPrint Manager for Windows
•Managing Transport Layer Security encryption for InfoPrint Manager for Windows
•Managing Job Encryption for InfoPrint Manager for Windows
•Customizing error logs in the InfoPrint Manager Windows server
•Monitoring disk use
•Administering your InfoPrint Manager server using a Windows Terminal Server client
•Changing the server IP address
•Managing the password of the ipm1 default user
•Setting up your InfoPrint Manager server to use resources on a different Windows system
•Using InfoPrint Manager notifications
•Using PSF DSS user-exit programs
•Creating and managing auxiliary sheets and PSF DSS user-exit programs
•Gathering accounting and audit data about print jobs
•Creating and managing resource-context objects
•Using the InfoPrint Manager System Migration Utility (ISMU)
•Configuring InfoPrint systems for interoperability
•Using the InfoPrint Manager line printer daemon (LPD)
•Using the Internet Printing Protocol (IPP) with InfoPrint Manager

UUssiinngg MMuullttiippllee NNeettwwoorrkk AAddaapptteerr CCaarrddss
If you are concerned that your local area network (LAN) might not have enough bandwidth to handle
the additional traffic that installing additional printers can create, you can create a secondary network
that is essentially dedicated to driving printers. To set up this configuration, the system that your InfoPrint
Manager server is installed on will have to have two network adapter cards installed in it, one for each
network. Print data comes into the InfoPrint Manager server over the LAN and is transferred to the
secondary network to be printed.

When you set up the secondary network, keep these points in mind:

• In the system that your InfoPrint Manager server is installed on, the primary network adapter card
should be the one that connects to your existing network.

• In the system that your InfoPrint Manager server is installed on, the secondary network adapter card
connects to a network that contains only printers. This network is isolated; no IP forwarding is
recommended.

• The IP addresses for printers on the secondary network must not be resolvable on the primary
network.
It is recommended that you use private IP addresses for your secondary network card and your
printers, for example, addresses that follow either of these formats:

– Class A IP address: 10.xx.xxx.xxx
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– Class B IP address: 192.168.xxx.xxx

• In the properties for the secondary network adapter card, you should not set a Default Gateway,
DNS, or WINS. If these fields are filled in when you configure the card, clear the default values.

• On the printers that you connect to the secondary network, do not specify a Default Gateway. If you
must specify a Default Gateway, enter the IP address of the secondary network adapter card.

WWoorrkkiinngg wwiitthh SSNNMMPP pprriinntteerrss

SNMP support

To use SNMP, you must set the use-snmp actual destination attribute to true.

If the destination-tcpip-internet-address actual destination attribute is set, the use-snmp actual
destination attribute is set to true by default.

About SNMP communication

For network printers that work with Simple Network Management Protocol (SNMP) and the standard
printer management information block (MIB) described in RFC 1759, the InfoPrint Manager server can
use SNMP to automatically:

• Set the default of several InfoPrint Manager actual destination attributes in the printer to the values
returned in the standard printer MIB. The actual destination attributes pertain to trays, media, bins,
plexes, and sides. This process is called smart–defaulting the attributes.

• Detect, report, and recover from printer problems for several conditions, even if no jobs are
currently being printed.

• Assess device specific information directly.

• Execute device commands directly on the device.

InfoPrint Manager includes support for SNMP Version 3 (SNMPv3). This version enhances the security
of SNMP communications between InfoPrint Manager and printers, and it includes encrypted and
authenticated management traffic and protected remote configuration and device status messages.

SNMPv3 supports these levels of security:

• Minimum- Without authentication and privacy.

• Medium- With authentication, but without privacy.

• Maximum- With authentication and privacy.

To support these security levels, new SNMPv3 actual destination attributes are added. See Procedures,
p. 17 for more information.

1 Administrative Procedures: Configuring InfoPrint Manager
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Smart-defaulting actual destination attributes

The InfoPrint Manager server can automatically smart-default an actual destination attribute for an
SNMP printer only if an InfoPrint Manager user does one of these:

• Does not explicitly set the attribute when creating or modifying the actual destination

• Resets the attribute to the InfoPrint Manager default

Before you create the actual destination and let the server smart-default one or more actual destination
attributes for a printer, InfoPrint recommends that you:

1. Turn the printer on.

2. Make sure the printer is connected to the network.

The actual destination attributes that the server can smart-default are:

• destination-model

• input-trays-medium (also smart-defaults the attributes input-trays-supported and media-
ready)

• media-ready

• media-supported

• output-bin-numbers (also smart-defaults the attribute output-bins-supported)

• plexes-supported

• psf-tray-characteristics (also smart-defaults the attributes input-trays-supported and media-
ready)

• sides-supported

For media, smart-defaulting only detects the size of the medium. If you have different media that are the
same size (for example, three different letter-size preprinted forms) and you need to differentiate
between them in the attributes, you must explicitly set the attributes instead of using smart–defaulting.

Detecting, reporting, and recovering from printer problems

The InfoPrint Manager server can automatically detect, report, and recover from printer problems for
several needs key operator and needs attention conditions as it periodically queries an SNMP
printer, even if no jobs are currently being printed. (To turn off automatic recovery, a key operator can
manually disable the actual destination.)

For example, the server detects that a printer is out of toner, disables the actual destination, requeues
the jobs, and sets the actual destination state to needs attention or needs key operator. Then, when
a key operator replaces the toner, the server detects that the printer is running again, sets the actual
destination state to idle, and re-enables the actual destination.

Besides automatically managing the state of the actual destination, the InfoPrint Manager server also
updates its problem-message, warning-message, and snmp-device-conditions attributes and
sends out printer-needs-attention and printer-needs-key-operator notifications. The actual destination's
state, which message attribute is updated, and what type of notification is sent depends on the severity
of the condition reported by the printer, such as error, warning, or report.

Working with SNMP printers



1

14

This is the list of SNMP printer conditions that InfoPrint Manager reports:

• Cover open
• Input tray empty
• Interlock open
• Media empty
• Media missing
• Offline
• Paper jam
• Power off
• Service requested
• Fuser over temp
• Input tray missing
• Printer supply empty
• Printer supply missing
• Printer waste full
• Output bin full
• Output bin missing
• Fuser under temp
• Printer supply low
• Printer waste almost full
• Media low
• Moving offline
• Moving online
• Output bin near full
• Warmup

Not all printers report all these conditions. For example, most printers do not report the Warning
conditions.

The same condition can be reported with a different severity depending on the situation. For example, a
printer might report an input tray empty condition as an error or a warning. It could be a warning if the
printer had multiple input trays linked together with the same media and only one of them is empty. If a
condition is reported as an error, InfoPrint Manager reports these conditions as needs-key-operator as
opposed to needs-attention:

• fuser-over-temp
• fuser-under-temp
• marker-supply-empty
• marker-supply-low
• marker-supply-missing
• marker-waste-full
• marker-waste-almost-full
• media-missing

1 Administrative Procedures: Configuring InfoPrint Manager
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• output-bin-missing
• service-requested
• warmup
Regardless of the severity, InfoPrint Manager lists all conditions on the snmp-device-conditions
attribute.

Accessing device information

You can use the InfoPrint Manager Administration GUI or the pdls command to access information
about SNMP devices.

Besides providing information about the actual destination object, InfoPrint Manager lets you access
information directly from the printer. InfoPrint Manager uses device-specific attributes to provide this
function. While device-specific actual destination attributes are accessed through an actual destination,
the information comes from the physical printer. The device-specific attributes are not returned when you
ask for all the actual destination's attributes. You have to request the device-specific attributes
specifically or you can use -r all-device to query all the device-specific attributes.

This is the list of non-settable device-specific actual destination attributes:

• device-description
• device-input-trays
• device-ip-address
• device-manufacturer
• device-printer-supplies
• device-media-supported
• device-model
• device-op-panel-locked
• device-output-bins
• device-printer-name
• device-ready-media
• device-serial-number
• device-state
• device-version

This is the list of settable device-specific actual destination attributes:

• device-contact
• device-location

1. Not all printers report all these attributes.

2. The information returned is not translated.

The InfoPrint Manager Administration Interface can launch a Status window that displays information
returned from SNMP. The window lets you see a detailed view of the status of an SNMP printer. It
includes a graphic representation of the printer and its current status, such as whether it has a paper jam
or a door open.

Working with SNMP printers



1

16

To see the Status window from the InfoPrint Manager Administration Interface:

1. Select an SNMP printer.

2. Click Check Status.

3. ClickMore Information.

You can use the pdls command to access SNMP device information with the -r flag, such as output-
bins, like this:

pdls -c destination -r device-output-bins prt5-ad

You can filter for specific device information with the -f flag.

You can also use the pdls command to access all the information for an SNMP device by specifying the
-r flag with the all-device value.

For more information about the pdls command, see the “InfoPrint Manager Tools” chapter in the RICOH
InfoPrint Manager: Reference.

Changing device information

You can use the InfoPrint Manager Administration GUI, the pddeviceop command, and the pdset
command to change information for SNMP devices.

The value of the snmp-active actual destination attribute must be true, and the printer device
associated with the actual destination must support the operation. You must have write permission to the
actual destination, and depending on the SNMP version that you use, the snmp-write-community-
name (V1) or the snmpv3-username (V3) actual destionation attributes must be set properly for the
pddeviceop command or GUI commands to work.

From the Device Information window in the InfoPrint Manager Administration GUI, you can reset the
specific device, take it offline, or put it online. You can also change the contact or location information.

You use the pddeviceop command to reset a specific device, take it offline, put it online, as well as lock
and unlock the operation panel for the specific device.

You can use the pdset command or the InfoPrint Manager Administration GUI to change the contact or
location information for SNMP devices.

You cannot combine setting device-specific and actual destination attrributes in the same pdset
command.

For more information about the pddeviceop and pdset commands, see the “InfoPrint Manager Tools”
in the RICOH InfoPrint Manager: Reference.

Setting up and using SNMP

To set up and use SNMP with InfoPrint Manager, you must check and set the appropriate InfoPrint
Manager attributes when you create or modify the physical printer in InfoPrint Manager.
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This section explains:

• Determining if a printer works with SNMP

• Using the InfoPrint Manager Administration Interface

• Procedures

Determining if a printer works with SNMP

Not all printers work with SNMP and the standard MIB. In addition, only printers that are attached to a
network can work with SNMP. Printers that are parallel-attached or channel-attached cannot use
SNMP.

To determine if a printer works with SNMP:

1. Set the actual destination attribute destination-tcpip-internet-address to the IP address of the
printer to indicate that InfoPrint Manager should try to communicate with the printer using SNMP.
The server sets the actual destination attribute use-snmp to “true”.

For PSF TCP-IP attached printers, a destination TCP-IP port number of 5002 must be used when
driving the second engine in an InfoPrint 4000 or InfoPrint 4100 dual simplex configuration for
SNMP support to work. If 5002 is used for a printer other than one using SNMP, the actual
destination for that printer will not work. The server will set the actual destination attribute use-
snmp to "false".

2. If the server cannot communicate with the printer using SNMP, it pings the printer. If the ping
command:

• Works, the server concludes that the printer is not an SNMP printer. It sets use-snmp to
“false”.

• Does not work, the server concludes that the printer is turned off or is not currently
connected to the network. It leaves use-snmp set to “true” and continues trying to establish
an SNMP connection with the printer.

3. Check the actual destination attribute snmp-active. If it is “true”, the printer works with SNMP.

Using the InfoPrint Manager Administration Interface

To use the InfoPrint Manager Administration Interface to check and set the attributes:

1. From the menu bar, select Printer or Server, as appropriate.

2. Select Properties. You see the printer properties or server properties notebook.

3. Select the SNMP tab.

4. Check and set the appropriate attributes on the SNMP tab as explained in Procedures, p. 17.

Procedures

Do these steps to check and set the attributes:

Working with SNMP printers



1

18

1. Check these actual destination attributes:

1. For SNMPv1:
snmp-community-name

snmp-write-community-name

InfoPrint Manager keeps both attributes and uses them as follows:

• If snmp-write-community-name attribute is set, it is used for both reading and setting
SNMP data. In this case, snmp-community-name attribute is ignored.

• If snmp-write-community-name attribute is not set, snmp-community-name attribute
is used. In this case, any attempts to set other SNMP data on the device should fail.

2. For SNMPv3:
snmpv3-username

snmpv3-authentication-type

snmpv3-authentication-password

snmpv3-privacy-type

snmpv3-privacy-password

snmpv3-security-level

snmpv3-context-name

3. For SNMPv1 and SNMPv3:
snmp-retry-count

snmp-timeout

snmp-active-version

The snmp-active-version attribute is read only.

snmp-version

snmp-version-fallback

use-snmp

2. If the defaults in Step 1 in this section are correct, set this actual destination attribute:

destination-tcpip-internet-address

Indicates the IP address of the SNMP printer. The field on the tab is “TCP/IP address”.

3. Check this actual destination attribute:

snmp-active

Indicates whether the server has been able to establish an SNMP session with the printer.
The field on the SNMP tab is “SNMP is active”.

4. Set these server attributes:

• snmp-discovery-during-startup
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Indicates whether the server queries the printer MIB when InfoPrint Manager starts or whether
the server gets the printer status when it periodically polls the printer. The default is “true”, but
you might want to set it to “false” if you have several SNMP printers and you want to make
the server start faster. The field on the SNMP tab is “Discover printers at startup”.

• snmp-normal-poll-interval
Indicates the number of seconds that the server should wait after sequentially polling all the
SNMP printers without known problems. Increasing the polling interval causes the server to
use less CPU and network resources for SNMP polling, but it makes the currently shown
printer status (for printers that are not currently printing) less accurate. The field on the SNMP
tab is “Normal poll interval”.

• snmp-problem-poll-interval
Indicates the number of seconds that the server should wait after sequentially polling all the
SNMP printers with known problems. Increasing the polling interval causes the server to use
less CPU and network resources for SNMP polling, but it makes the currently shown printer
status (for printers that are not currently printing) less accurate. The field on the SNMP tab is
“Problem poll interval”.

For more information about the SNMP actual destination attributes, see the “InfoPrint Object attributes”
chapter in the RICOH InfoPrint Manager: Reference.

Effects on performance with SNMP

The performance areas that SNMP can influence are:

• Server start-up

• Actual destination queries

• SNMP polling

• Number of SNMP printers on a server

Server start-up

If you set snmp-discovery-during-startup to “true”, the server start-up might be slow because the
server queries the printer MIB for each SNMP enabled actual destination for the most current
information. Setting this attribute to “false” can improve startup performance. However, the initial actual
destination status is not current and won't be until because the server polls the printer next.

Actual destination queries

On an SNMP printer, when you query an actual destination attribute that might be affected by the
printer MIB (for example, destination-state), the default is that the server uses SNMP at the same time
to get the relevant information from the printer. If the printer is turned off or not connected to the
network, it might take a long time before the printer times out, which delays the response to your query.

If this is a problem, you can use the pdls command with the when=now attribute to return the current
information instead of querying the printer MIB. Using this attribute can improve performance.
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SNMP polling

The server periodically polls the SNMP printers to get their latest status. If a printer condition changes
while the server is polling a printer (for example, a user closes an open cover), the server might
temporarily miss one of the changes. However, during the next polling cycle, the server automatically
picks up any changes that it missed.

If the server cannot discover an SNMP printer when InfoPrint Manager starts, it shows the printer status
from the last time the server was shut down.

Increasing the polling interval causes the server to use less CPU and network resources for SNMP
polling, but it makes the currently shown printer status (for printers that are not currently printing) less
accurate.

MMaannaaggeedd IIPPDDSS DDiiaalloogg ssuuppppoorrtt
The Managed IPDS Dialog (MID) support enables additional sharing capabilities for specific printers.
Current sharing of a print device is based on the setting of an inactivity timer. MID support overcomes
these current limitations:

• Release for sharing requires physical intervention to disconnect the print device, and the PSF host
must re-acquire the TCP/IP connection to process additional print requests. When the original
connection is released, all downloaded resources are generally lost. Furthermore, there is a
possibility that another host might acquire the TCP/IP connection and prevent the current host from
processing additional print requests.

• Release of the print device is controlled by a specific time value. This causes the release of the
printer even when there are no additional print requests pending.

With MID support, the printer can request that the PSF host release its control of the print device (but not
drop the TCP/IP connection), thus allowing the print engine to print non-IPDS data streams when IPDS
activity is minimal. MID support also enables the sharing of the print mechanism with other non-IPDS
data streams.

This chapter includes the following sections:

• Enabling MID support, p. 20

• Considerations to activate MID support, p. 21

Enabling MID support

Set these parameters to enable MID support:

mid-support-enabled

1. Right-click the actual destination in the InfoPrint Manager GUI and click Properties.

2. Click Tuning.

3. Enter Yes in the Enable MID Support field to activate MID. The default value is No.

mid-release-timer
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1. Right-click the actual destination in the InfoPrint Manager GUI and click Properties.

2. Click Tuning.

3. Specify a numeric value forMID Release Timer from 1 to 9999. The default value is 15.

The value for theMID-release-timer must be less than the value for the destination-release-
timer-setting. The MID will never be enabled if the destination-release-timer-setting value is
less than theMID-release-timer value.

Considerations to activate MID support

Consider these before you activate MID support for your print device:

• Your print device must be capable of supporting MID. Contact your InfoPrint representative if you
are not sure of your print device capability.

• If you want incoming non-IPDS print requests to be intermingled with IPDS print requests, it is
suggested that you maintain control over the print mechanism rather than activate MID.

• Jobs must be “stacked" before the print mechanism is released. This might lead to paper loss for the
print device.

• Releasing the print mechanism might prevent the IPDS host from processing subsequent print
requests until the control is returned to the host (the time depends on the capacity of each print
device).

• The MID support does not allow for sharing of the print mechanism between two IPDS hosts for
InfoPrint printers.

CCoonnffiigguurriinngg mmeeddiiaa
This section describes how to create, configure, and manage media. Use the InfoPrint Manager
Administration Interface to complete these tasks.

Determining the media that are in the servers

You can use the InfoPrint Manager Administration Interface to show the media in the servers being
monitored.

Using the InfoPrint Manager Administration Interface

Start the InfoPrint Manager Administration Interface by double-clicking the icon or by entering
ipguiadvadm at the AIX command line. From the Server menu on the Main window, selectMedia→
Show Media. The dialog displays the media that is located on all servers currently being monitored.
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Creating a media object

You can use the InfoPrint Manager Administration Interface to create a media object.

Using the InfoPrint Manager Administration Interface

From the Server menu, selectMedia→ Create or Copy (and select a media in the Select Media to
Copy dialog) to open the Create Media dialog. You use this dialog to create a media in the specified
server.

The InfoPrint Manager Administration Interface creates a new media with property settings based on
whether you choose to create a new media or copy an existing media:

• Use the Create option when you want to create a unique media (with default settings) without
copying properties from an existing media.

• Use the Copy option when you want to create a new media using properties from an existing
media.

Enter values in these fields:

Name
Media names can contain up to 255 characters and are case-sensitive.

Server
Displays the names of all servers being monitored. Select a server from the list; this is the server that
will contain the media. When you are copying a media, the server containing the media being
copied is initially selected.

Type
Displays a list of predefined media types. Select a media type from the list. When you are copying
a media, the type of the media being copied is initially selected.

Untrimmed width and length
Specifies the physical size of the media. The width is usually the shorter dimension with respect to
how the medium is loaded into the printer device. The length or height is usually the longer
dimension with respect to how the media is loaded into the printer. Enter a positive real number for
the width and the length fields. When you are copying a media, the untrimmed width and length (in
inches or mm) of the media being copied is displayed.

Weight
Identifies the media weight. Enter a positive integer. When you are copying a media, the weight of
the media being copied is displayed.

Color
Displays a list of predefined media colors. Select a color from the list. When you are copying a
media, the color of the media being copied is initially selected.

Details
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Provides a text entry area for a message to be associated with the media object. Enter description
information about the media. When you are copying a media, the message for the media being
copied is displayed.

Select OK and you have created a new media.

Viewing or changing attributes of a medium

You can use the InfoPrint Manager Administration Interface to view or change attributes of a medium.

Using the InfoPrint Manager Administration Interface

1. From the Server menu, selectMedia→ Properties to open the Select Media dialog.

2. Select the medium whose properties you want to view or change.

3. Click OK. The Media Properties notebook for that medium opens and you can view all its attributes.

4. Make any changes and click OK to save those changes.

Associating a medium with an actual destination

You can use the InfoPrint Manager Administration Interface to associate a medium with an actual
destination.

Using the InfoPrint Manager Administration Interface

Depending on the input trays and paper feed mechanisms, a printer device might have a wide variety
of paper sources loaded. You can use the Change Media dialog (Printer→ Change Media) for an
actual destination to define the different paper types that operators can load in the printer on theMedia
Allowed tab.

To specify the media supported by the actual destination:

1. From the Printer menu, select Change Media to open the Change Media dialog.

2. On theMedia Ready tab, specify the bin and then select the media loaded into each bin for the
printer. You can also specify an input tray name to associate with the bin.

3. Click OK. InfoPrint updates the actual destination properties notebook with the values you specified.

IInnffooPPrriinntt EEmmaaiill ssuuppppoorrtt
InfoPrint Email can be used for interoffice communication or to send e-mail to other addresses around
the world. You can take advantage of the Email option to format documents that are both viewable and
printable at company workstations. Send and receive data from a wide variety of sources, whether the
data is PCL, PDF, PostScript, GIF, JPEG, TIFF, or a native SAP R/3 data stream (ABAP or OTF).
Incoming data can be all these types; the Email DSS converts the data to PDF for viewing. To view
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output, you can use Adobe Acrobat Reader. For more information and available downloads, go to the
Adobe Systems website.

1. Color PDF and PostScript jobs are converted to black and white PDF e-mails if not handled
appropriately.

2. To maintain the original document file name in the PDF attachment name from a job sent to the Email
DSS, see Maintaining original document file names in the PDF attachment name, p. 25.

Configuring InfoPrint Email

Before you can send e-mail through InfoPrint Manager for Windows, you must make sure your SMTP
email server is correctly configured and defined to InfoPrint and create an InfoPrint e-mail destination.

Defining the SMTP Email server to InfoPrint

The InfoPrint Manager for Windows Email DSS uses a Simple Mail Transfer Protocol (SMTP) server to
send e-mail. The SMTP server must have MIME support. The SMTP server used is defined by the
InfoPrint Manager server attributes smtp-server-host and smtp-server-port. These attributes default to
the local Windows SMTP server. If you want to use a different SMTP server, you can modify these
server attributes.

Your SMTP server must be correctly configured to get outside the firewall if you plan to send e-mail
outside your firewall.

To change the SMTP server for the InfoPrint Manager Windows server:

1. To set the mail server at installation, start the InfoPrint Manager Administration Interface.

2. From the InfoPrint Manager Administration Servers main window, click Server→ Properties.

3. From the Server Properties dialog, specify your installation's mail server in the SMTP server field
and the port in the SMTP port field.

The SMTP server port field defaults to 25, which is the default port for the SMTP server on most
Windows servers.

If you plan to use e-mail to send large PDF files consisting of 50 pages or more, you will need to
expand the size of the /var/psf/segments file system to 500 MB.

Creating an InfoPrint e-mail destination

Before you can send e-mail output through InfoPrint Manager, you must create an e-mail destination on
your InfoPrint Windows server. Use the Advanced InfoPrint Manager Administration Interface to
do this task.

1 Administrative Procedures: Configuring InfoPrint Manager
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1. Start the Advanced InfoPrint Manager Administration Interface.

2. From the main window, click Other→ Create→ Email Destination.

If the Email Destination option is not available under the Other→ Create path, click the Options
→ Add/Remove Menu Items path and check the Create Email Destination from the Customize
dialog. You can specify any actions (such as delete, enable, disable) from this dialog.

3. In the first panel of the Create Email Destination Wizard:

1) Specify a Name for the e-mail destination, such as email1.

2) Specify the InfoPrint Manager Windows Server where you are creating the e-mail destination,
such as server1.

4. In the second panel of the Create Email Destination Wizard, select a logical destination to feed this
e-mail actual destination.
We recommend that you create a separate logical destination object (email-ld), so that the same
logical destination does not feed jobs to both a printer and an e-mail destination. This step will make
it easier for operators to monitor the progress of the jobs through the system and make it easier to
diagnose problems.

5. In the third panel (if you have decided to create a separate logical destination object in the
preceding step), you can select where to put the new logical destination object.

6. In the fourth panel of the Create Email Destination Wizard, you can decide to take the default
configuration or to further customize this destination by:

• Changing the InfoPrint logical destination to which jobs are routed (if different from the logical
destination defined in the preceding step).

• Specifying particular job batch values.

• Modifying actual destination properties.

For purposes of this example, we take the default and apply the standard configuration.

7. In the fourth panel of the Create Email Destination Wizard, accept the default to enable the
destination, so that you have an e-mail destination with a status of ready.

Maintaining original document file names in the PDF attachment name

To preserve the original file name from the job-name attribute sent to the Email DSS as the file name of
the email attachment, you must configure the email DSS actual destination attribute maintain-original-
filename to true. If you used document-formats-ripped-at-destination or job-ripped-by-server=
false, this attribute is ignored.

Configuring PDF settings for email jobs

Configuring PDF settings for email jobs are in the file <Install_Path>\afp2pdf\email.cfg.

The PDF settings parameters for email jobs are:

AFM_PATH=<path>
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This parameter specifies the path location of the Adobe Font Metrics (AFM) files that the transform
uses. An AFM stores font metric data for a Type 1 PostScript font. It contains the master design of a
specific font, which defines the way each character of the font looks. If a path is not specified, the
default path is:

For Windows:
<install_path>\afp2pdf\font\AFM

There is no command line flag associated with the AFM_PATH parameter.

CNV_PATH=<path>
This parameter specifies the path location of the CNV files that the ICU library uses to convert text
from one code page to Unicode and vice versa. If a path is not specified, the default path is:

For Windows:
<install_path>\afp2pdf\cnv

There is no command line flag associated with the CNV_PATH parameter.

DEFAULT_CPID=<>intValue
This parameter specifies a default Code Page Identifier (CPID) to be used when transforming AFP or
SCS files.

If a DEFAULT_CPID is not specified when transforming AFP files, a default value based on the
cpdef file will be used.

If a DEFAULT_CPID is not specified when transforming SCS files, CPID 500 will be used as the
default.

There is no command line flag associated with the DEFAULT_CPID parameter.

DEFAULT_FGID=<>intValue
This parameter specifies a default Font Global Identifier (FGID) to be used when transforming AFP
or SCS files.

If a DEFAULT_FGID is not specified when transforming AFP files, a default value based on the
csdef file will be used.

If a DEFAULT_FGID is not specified when transforming SCS files, FGID 11 (Courier) will be used
as the default.

There is no command line flag associated with the DEFAULT_FGID parameter.

ENABLE_AUTO_FONT_IMAGE=(TRUE|FALSE)
When this parameter is set to TRUE, it specifies that the output PDF document will contain an image
for each character that was written with a raster font in the AFP document. By default, the raster
fonts will be replaced with another font, and all characters will be written as text in the PDF
document. However, some of the characters might look different from their raster form.

There is no command line flag associated with the ENABLE_AUTO_FONT_IMAGE parameter.

FOCA_FONT_PATH=<path>
This parameter specifies the path where the AFP FOCA fonts are installed. The default path is:

For Windows:
<install_path>\afp2pdf\fontlib
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There is no command line flag associated with the FOCA_FONT_PATH parameter.

FONT_PATH=<path>
This parameter specifies the path location of the font files that the transform uses when writing the
PDF document. If a path is not specified, the default path is:

For Windows:
<install_path>\afp2pdf\fontlib

There is no command line flag associated with the FONT_PATH parameter.

GOCA_PASS1=<number>
The<number> for this parameter can be 0,1, or 2.
When processing an afp file, there are 2 passes, an image pass and a text pass.

Setting this attribute will tell when to process the GOCA objects.

• GOCA_PASS1=0, goca objects processing are disabled.

• GOCA_PASS1=1, goca objects are processed in the image pass.

• GOCA_PASS1=2, goca objects are processed in the text pass.

The default value is 2.

OVERLAYEXT=<ListOfExtenstions>PAGESEGEXT=<ListOfExtenstions>FORMDEFEXT=
<ListOfExtenstions>JFIFext=<ListOfExtenstions>GIFEXT=<ListOfExtenstions>TIFFEXT=
<ListOfExtenstions>CHARSETEXT=<ListOfExtensions>CODEPAGEEXT=
<ListOfExtensions>CODEDFONTEXT=<ListOfExtensions>

These parameters specify the accepted extension for a resource type. The possible extension are
separated by a comma (,). For each extension, a * (asterisk) will be replaced with the name of the
searched resource. Therefore, specifying an * (asterisk) means no extension.

When searching by name in the RESOURCE_DATA_PATH, the transform first tries the name with
no extension. If it does not succeed, it tries with every extension from the list until the resource is
found.

By default, the extension list is an * (asterisk).

There is no command line flag associated with these parameters.

PDF_FONT_MAP_FILE = <path>
This parameter specifies the path location of the fontmap.lst file that maps the Type 1 Fonts.
When specified, it means that the user wants to embed Type 1 Fonts into the PDF document. If a
path is not specified, the default path is:

For Windows:
<<iinnssttaallll__ppaatthh>>\\aaffpp22ppddff\\ffoonntt\\ffoonnttmmaapp..llsstt

There is no command line flag associated with the PDF_FONT_MAP_FILE parameter.

PFMPFB_DIRECTORY=<path>
This parameter specifies the path location of the Adobe Type 1 outline font files that the transform
uses when embedding fonts inside of the PDF document. When simple font substitution is not
acceptable in the PDF output, it is possible to embed a custom Type 1 font inside the PDF for better
results. If a path is not specified, the default path is
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For Windows:
<<iinnssttaallll__ppaatthh>>\\aaffpp22ppddff\\ffoonntt\\ttyyppee11

Placing Type 1 font files in this directory does not mean that they are automatically placed inside of
the PDF file. For a font to be embedded, it must be mapped using the transform font definition files.
See Embedding Type 1 Fonts in RICOH InfoPrint Manager AFP2PDF Transform Feature: Installing and Using
for more information.

There is no command line flag associated with the PFMPFB_DIRECTORY parameter.

PRAGMA_FDEF= <filename>
This parameter specifies the file name of the form definition (FORMDEF) resource to be used when
transforming the AFP file. If an inline form definition is associated with the AFP document, then both
the FDEF from the configuration file and the command line are ignored. If FDEF is not included in
the configuration file or specified on the command line, the F1A10110 default form definition is
used.

Command line flag:
-pragma fdef <filename>

Command line example:
-pragma fdef=myformdef.fde

PRAGMA_ALIGNTEXT=<angle>
This parameter specifies the rotation value to use when transforming the file. Valid values are 0, 90,
180, or 270 (clockwise). Some AFP files might have already been formatted with a rotated
orientation. If this occurs, text is aligned with the vertical axis of the paper rather than the horizontal
axis. To correct this, you must use this parameter to align the text as desired.

Command line flag:
-pragma aligntext <angle>

Command line example:
-pragma aligntext=90

VERBOSE
This parameter specifies verbose information will be generated to ssttddeerrrr.

Command line flag:
-v

OUTPUTFILE=<path+filename>
This parameter specifies the path and filename of the output PDF file. By default, the output PDF file is
placed in the same directory as the input file, and it has the same file name as the input file with the
extension changed from aaffpp to ppddff. For example, when the PDF is generated from an AFP file
named aaffppddoocc..aaffpp, an output file named aaffppddoocc..ppddff is created.

If AFP is not used as the extension, a ppddff extension is still added to the output PDF file.

Command line flag:
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-o <path+filename>

Command line example:
-o c:\mydirectory\mystream.pdf

RESOURCE_DATA_PATH =<path>
This parameter specifies the path location of the resource library. For all the external resources used
by the AFP document (formdef, overlay, page segment, jfif, gif, IOCA image), the transform looks
for them in this specified path. If a path is not specified, the default path is:

For Windows:
<install_path>\afp2pdf\reslib;<install_path>\reslib

There is no command line flag associated with the RESOURCE_DATA_PATH parameter.

TT_FONT_PATH=<path>
This parameter specifies the location of the TrueType font or the TrueType Collection used. If a path
is not specified, the default path is:

For Windows:
<install_path>\afp2pdf\font\truetype

Submitting e-mail jobs

After you have installed and configured the Email option, you can submit jobs to a particular output
destination by using the command line anywhere that you have the pdpr command installed. This topic
shows the command syntax and provides three examples for submitting e-mail jobs:

• Submitting attributes through a file with the -Z option, p. 30

• Using the InfoPrint Select client, p. 31

Submitting a basic e-mail job

For information about the pdpr command and its attributes, see the RICOH InfoPrint Manager: Reference on
the Web, or the pdpr man page.

To submit a basic e-mail job, you can use this syntax:

pdpr -p email-ld -Z emailfilename

For an explanation of each variable on the command line, see this table:
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Variable Definition
logical_destination

Example:

-p email-ld

Specifies the logical destination that you defined when
configuring the Email option through the Advanced InfoPrint
Manager Administration Interface.

For more information about configuring both logical and actual
destinations and using the pdpr command, see the RICOH
InfoPrint Manager: Reference.

emailfilename

Example:

-Z

emailfilename

Specifies a file that contains the job attributes, the name of the
file you are sending, and the e-mail destination that you are
sending the e-mail to.

E-mail attributes include cover sheet information, billing code
information, and other options.

subject-text, email-body, email-from-adress, email-to-
adress, and email-signature are the only required attributes.

We recommend that you create sample attribute scripts that you can customize for your particular site.
While you can specify e-mail attributes on the command line, we recommend using an attribute file.

Submitting attributes through a file with the -Z option

You can create a sample attribute file using an input date type of AFP, PostScript, or Portable Document
Format and submit it as the emailfilename for the syntax listed above:

-x email-from-address=root@serv.us.name.com
-x email-to-address=johndoe@us.name.com
-x subject-text="Test Script"
-x document-type=printable

/usr/lpp/ps/sample.pdf
-x document-type=email-body

/email_script/body.txt
-x document-type=email-signature

/email_script/sig.txt

On the command line, use this syntax to use this attribute file:

pdpr -p logical_destination -Z emailfilename

where logical_destination is email1-ld and emailfilename could be named emailfilename and stored on
your local system. You must define a body.txt file and a sig.txt file for this script to work correctly.

This attribute file sends a report to a 'johndoe' Internet ID, using a logical destination (printer) named
email1-ld that you specify from the command line. The convention us.name.com indicates a company-
wide addressing system. It indicates the country (us), the company name (name), and the
communications name (com) for all fully qualified addresses in the company.

You cannot put comments in an attributes file using the -Z option.
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Using the InfoPrint Select client

After you have successfully installed InfoPrint Select and defined an e-mail destination (see the "Using
InfoPrint Select to submit a job" chapter in InfoPrint Manager for Windows: Getting Started for more
information), you can use this procedure to send e-mail.

To configure the port for the InfoPrint server e-mail destination on your client workstation, the e-mail
logical destination (in our example, email-ld) on the InfoPrint Windows server must have a value filled
in for the client-driver-names logical destination attribute. If this value is not filled in, you will not be
able to display printers from the InfoPrint Windows server when you click Refresh Printers Selection
List.

You must also set the destination-support-system logical destination attribute to email for InfoPrint
Select to send e-mail.

1. Specify Print from the screen menu.

2. From the Print window, make sure that the Name field contains the name of the logical destination
that you defined to the InfoPrint Windows server, then click OK.

3. From the InfoPrint Email pop-up window, specify the attribute information in the fields as indicated.

Color Email

Sending documents as email attachments
If you have color Portable Document Format (PDF) or PostScript files, you can send these files to target
e-mail address through InfoPrint Manager and receive color output.

If you want to submit color emails, you should set color-bits-per-plane attribute to 8.

Make sure that your color PDF files pass through the Email DSS without being transformed no matter
what method you use to submit the job to the InfoPrint Manager Windows server. To do this, specify job
attribute job-ripped-by-server = false. Or, you can set the actual destination to not rip PDF
document formats. However, that would apply to all PDF jobs submitted.

Any job or document attributes that require the Email DSS to transform the data are not supported. For a
list of these attributes and for more information about the job-ripped-by-server attribute, see RICOH
InfoPrint Manager: Reference.

Color Email is not supported if your e-mail job sent to an Actual Destination contains any of the
attributes specified in the lists that follow. If these attributes or conditions are sent to an Actual
Destination, the file will print as black-and-white (MO:DCA-P) output.

Submitting color e-mail attributes through a file

You can print a color e-mail job with a batch file that contains these:

• Job name
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• E-mail body text

• E-mail to address

• E-mail from address

Here is the sample file:

-x job-name="Titleist"
-x job-ripped-by-server=false
-x email-from-address=gopher1@gopher.com
-x email-to-address=gopher@gopher.com
-x subject-text="testing"
-x document-type=email-body
-f d:\bsi\data\body.txt
-x document-format=pdf
-x document-type=printable

To submit this job to the InfoPrint Windows server, specify this on an Windows command line:

c:\Infoprint\pdpr -p email -Z d:\bsi\options\em_rip.txt \
d:\bsi\data\LogoOnly.pdf

where em_rip.txt is the -Z file above.

Sending fax documents as email attachments via email DSS

Email DSS accepts fax jobs. If job attribute fax-number is set at job submission, InfoPrint Manager
forwards the fax document as an email attachment to a recipient with the email-to-address composed
by as fax-number@fax-to-email-domain from the fax-number and fax-to-email attribute values.
For more information about sending fax documents as email attachments, see RICOH InfoPrint Manager:
Reference.

CCoonnffiigguurriinngg IInnffooPPrriinntt MMaannaaggeerr ttoo uussee tthhee IInnffooPPrriinntt 55000000 oorr
RRIICCOOHH PPrroo VVCC sseerriieess mmooddeellss ttoo pprriinntt PPoossttSSccrriipptt aanndd PPDDFF
You can use hot folders to print PDF and PostScript files on the InfoPrint 5000 printer models (AD1/
AD2, AD3/AD4, AD3/AD4-XR3, AS1, AS3, KM3, KM3/MD4, MD3/MD4) or RICOH Pro VC
series models (RICOH Pro VC40000, RICOH Pro VC60000, RICOH Pro VC70000, and RICOH Pro
VC80000) with InfoPrint Manager.

When you use hot folders, you must complete minor configuration tasks.

To connect to an InfoPrint 5000 or RICOH Pro VC printer hot folder from InfoPrint Manager for
Windows, you need to map the printer network shared hot folder using Windows Explorer.

Running scripts before printing PDF and PostScript files

All hot folders must be created from the InfoPrint 5000 printer operator panel. The hot folders can have
different job attributes, such as the actual destination to print the job (actual-destination-requested
job/default job attribute) or the combination of start, end, or separator sheets to use with a job
(auxiliary-sheet-selection job/default job attribute).

To enable InfoPrint 5000 hot folder support, run scripts on the InfoPrint Manager server to create a new
BSD DSS printer (together with a new logical destination and a new or existing queue), to create the
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custom transforms that allows InfoPrint Manager to convert the input data to the corresponding output
data format, and to assemble the list of transform objects previously created on the BSD DSS printer.

To configure the InfoPrint Manager server to enable hot folder support on the InfoPrint 5000 printer:

1. Log on to your InfoPrint Manager server.

2. Locate the scripts provided by InfoPrint Manager: install_path\bin

3. Type one of these commands:

• For models AS1 and AS3:

run_customization_1.cmd nameOfServer nameOfAD nameOfQueue
nameOfLD \\printerIPAddress\Simplex\yourhotfolder

• For models AD1/AD2, AD3/AD4, AD3/AD4-XR3, KM3, KM3/MD4, MD3/MD4,
RICOH Pro VC40000, RICOH Pro VC60000, RICOH Pro VC70000, and RICOH Pro
VC80000:

run_customization_1.cmd nameOfServer nameOfAD nameOfQueue
nameOfLD \\printerIPAddress\Duplex\yourhotfolder

nameOfServer

Specify the name of the InfoPrint Manager server on which to create the destination.

nameOfAD

Specify the name of the new actual destination that will be created.

nameOfQueue

Specify the name of the existing queue or a new queue.

nameOfLD

Specify the name of the new logical destination that will be created.

PrinterIPAddress

Specify the IP address for the InfoPrint 5000.

Simplex or Duplex
Specify the parent directory for your hot folder. With models AS1 and AS3, specify Simplex.
With models AD1/AD2, AD3/AD4, AD3/AD4-XR3, KM3, KM3/MD4, MD3/MD4,
RICOH Pro VC40000, RICOH Pro VC60000, RICOH Pro VC70000, and RICOH Pro
VC80000, specify Duplex.

yourhotfolder

Specify the name of the hot folder created at the InfoPrint 5000 printer console.

4. Verify that a new actual destination and logical destination were created by checking the
InfoPrint Manager Administration GUI.

5. Submit a PDF or PostScript test job to the InfoPrint 5000.

Example scripts

• For Model AS1:

run_customization_1.cmd ipwin 5k-short color-q 5k-short-ld
\\9.16.72.105\Simplex\shortcolorjobs
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• For Models AD1/AD2, AD3/AD4, AD3/AD4-XR3, KM3, KM3/MD4, MD3/MD4, RICOH Pro
VC40000, RICOH Pro VC60000, RICOH Pro VC70000, and RICOH Pro VC80000:

run_customization_1.cmd ipwin 5k-long color-q 5k-long-ld
\\9.27.83.207\Duplex\longcolorjobs

MMaannaaggiinngg AAcccceessss CCoonnttrrooll LLiissttss sseeccuurriittyy ffoorr IInnffooPPrriinntt MMaannaaggeerr ffoorr
WWiinnddoowwss
InfoPrint Manager security is a feature that you administer through the InfoPrint Manager Management
Console. It lets you protect your printing system by associating an Access Control List (ACL) with an
InfoPrint object or operation. An ACL is the list of users and groups who have specific types of
permission to do something to or with an object.

InfoPrint Manager Security references the login ID of the current user to determine who is attempting to
perform an action. Otherwise, the InfoPrint Manager security system is entirely separate from any
Windows security you have set. For example, you cannot use groups that you create with the Windows
User Manager in InfoPrint Manager Security- you must create security groups using the InfoPrint
Manager Management Console.

If you do not want to use InfoPrint Manager Security, you can turn it off using the server properties
notebook in the InfoPrint Manager Administration GUI by setting the Security level for your server to
none.

Types of permission

In InfoPrint Manager, users can have three levels of permission: read, write, and delete. The levels
provide these types of access.

• Read - For operations, the user can perform the operation. For servers and queues, the user can
view the attributes of the object. If you restrict access to a server or queue, access to all objects
contained by that server or queue is automatically restricted, even if the objects are not explicitly
protected. For destinations, the user can view attributes and submit jobs to that destination.

To access an object contained by a server or a queue, you must have at least read permission for
the higher-level object.

• Write - For all objects, the user can modify attributes.

• Delete - For all objects, the user can delete the object.

The levels of permission are not cumulative. If you give a user delete permission only, he will not
automatically have read and write permissions. Be sure to mark all of the levels of permission that
the user needs.

If you place user A on the ACL for the logical destination "print2ld" and give this user read permission,
user A can send the print jobs to it and can open the “print2ld” object to see its properties. However,
user A cannot make changes to those properties. If user A tried to change any of them or tried to delete
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the destination, user A would receive an error message. If you decide that user A needs to be able to
do more and give them write permission as well, user A will be able to change the properties of
“print2ld,” but still will not be able to delete it.

• If you protect a destination (logical or actual) so that only certain users can modify or delete its
properties, you might inadvertently prevent other users from submitting print jobs to it. To be sure that
all of your users can still print to the destination, add the wildcard character (*) to the ACL as a user
with read permission.

You can also attach ACLs to the operations that you can perform on InfoPrint objects. Allowing you to
protect both operations and objects means that InfoPrint Manager Security provides different levels of
security: you can protect all objects by using ACLs at the operation level or you can protect individual
objects with ACLs applied only to them. Or you can do both: protect all objects by using operation-level
ACLs for some operations, and limit access to subsets of objects by using object-level ACLs.

For operations, there is only one level of permission: read. If a user has read permission, they can
perform that action; if the user does not, they cannot perform the action. For example, user B is a printer
operator and must be able to move jobs to different positions in the print queue because some jobs
need to be printed before others. You can give user B read permission for the operation Reorder Job
to allow the user to do their job. On the other hand, user C submits print jobs from their office
workstation and does not like to wait for the jobs ahead of theirs in the queue to print. To prevent user C
from moving jobs, do not put user C on the ACL for the Reorder Job operation. When user C tries to
move their job to the top of the queue, the action will be denied.

When you install InfoPrint Manager, many operations are already protected so that only members of
the admin and oper groups, p. 36 can perform them. You can see the ACLs for operations in the
Management Console by selecting the Security-ACL-Operations item in the left pane. If you want
users to be able to perform those operations, you must either add those users to the individual ACLs or
to a group that has permission (either the existing admin and oper groups or a new group that you
create).

If an object is protected, a user can only perform an operation on that object if he has both read
permission for the operation and the appropriate level of permission for the object (for example, a job
or a printer).

• If the object is not protected, any user with read permission on an operation can perform that
operation.

• If the object is protected, the permission needed depends on the operation. For example: List
requires read permission on the object, Set requires write permission, and Delete requires delete
permission.

By default, InfoPrint objects (destinations, queues, servers) are not protected, members of the admin
group have read permission on all operations, members of the oper group have read permission on
most operations, and all users have read permission on five operations. Those five operations are:

• List/Query (all objects)

• Print

• Modify job

• Query job
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• Remove job (delete job)

However, users who are not members of the admin and oper groups can only modify and remove jobs
that they submitted. In addition, if the ACL for the Reorder job action is changed so that everyone can
use it, users who are not members of the admin and oper groups will only be able to reorder jobs that
they submitted. By default, members of the admin and oper groups can do all six of those operations
on all jobs.

If you decide to protect your queues, all users will still be able to perform the tasks listed above on their
own jobs. Users who are on the ACL for a queue will be able to perform those tasks on all jobs in that
queue.

Security groups

No matter what size organization you work in, manually adding every user to every ACL can be a time-
consuming process. To reduce some of the work, you can create security groups, groups of users who
need to have the same levels of permission for the same objects. You use the name of the security group
like a user ID; instead of adding each user ID to an ACL, you add the group name. For example, if you
want all of your help desk operators to be able to perform the same operations, create a group and
name it helpdesk. Then, add helpdesk to the appropriate ACLs.

All fields, such as User IDs, group names, hostnames, and DNS suffixes, are case sensitive.

When you install InfoPrint Manager, three security groups are created by default:

• acl_admin- Users who have authority to manage security by changing access control lists and
groups. The default members are Administrator@* and the user who was logged on when
InfoPrint Manager was installed (for example, myuserid@*).

• admin- Users who have administrator authority. The default members are Administrator@* and
the user who was logged on when InfoPrint Manager was installed (for example, myuserid@*).

• oper- Users who have operator authority. The default member is Administrator@*.

1. You can modify these groups as needed. In the example above, you could have simply added the
help desk operators to the default oper group and modified any permissions that weren't set to the
level that you wanted them.

2. The default group members contain the wildcard character (*) for greater flexibility. See below for
more information about wildcarding. If you do not want the Administrator user on other systems to
be able to administer InfoPrint Manager, replace the * with the explicit address of the system that
the InfoPrint Manager server is installed on, for example Administrator@serversystem.company.
com.

You can add users to multiple groups, but you cannot make one group a member of another group. For
example, if you hire five new print operators, you might create a group for them called trainees, since
you only want them to have limited permissions until they are finished with their training. When they
finish their training, you cannot add trainees as a member of the operators group. You will have to
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add their user IDs to the operators group one at a time. In addition, you will have to either delete the
trainees group or delete the members from it— otherwise those users will have conflicting levels of
permission.

When users are members of more than one group and each group has a different level of permission
for a particular object, the most restrictive permission applies. In the example above, if you forgot to
remove the new employees from the trainees group at the end of their training, they wouldn't be able
to perform the tasks their job required- they would still be restricted.

Identifying FST users and groups: wildcarding

When you add FST users to ACLs or Security groups, you identify them by their user ID and the
computer that they work on in this format: username@computername. The permissions you assign will only
apply when that person accesses InfoPrint Manager from that workstation.

If, however, you or any of your users want to be able to work with InfoPrint Manager objects from
various workstations, you might not want to add multiple user ID/computer name combinations for the
same person—you can use wildcarding instead. When you use wildcarding, you replace the computer
name or user ID with the wildcard character (*) when you add a member to an ACL or Security Group.
The wildcard character stands for “any computer” or “any user ID.” So, if you create an ACL member
called administrator@*, no matter what computer you log on to as administrator, you have the same
permissions. If you use the wildcard character before the computer name, for example *@computer,
any user who logs on to computer1 can do the actions that the ACL member has permission for.

Identifying Federated Authentication groups

If there is no matching FST group, when you add federated authentication groups to ACLs or Security
groups, you must create an FST group with the same name as the federated authentication group you
need to identify. These groups must be added to the corresponding ACLs for the InfoPrint Manager
objects and operations.

• When you log in using federated authentication, InfoPrint Manager validates the user roles to
control access to different resources and functionalities based on the roles specified in the user
identification token or in the User information endpoint response. To access the Web
Management Interface, the system verifies whether the user ID belongs to the acl_admin group. To
grant permissions to desired users, they must be members of the acl_admin group defined on the
website of your chosen IdP.

Identifying LDAP/ Active Directory users and groups

When you add LDAP/Active Directory users to ACLs or Security groups, you identify them by their
Login in the LDAP/Active Directory system. If these users use the same Login across workstations, they
are able to work with InfoPrint Manager objects from other workstations.
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Identifying users and groups: wildcarding

When you add users to ACLs or Security groups, you identify them by their user ID and the computer
that they work on in this format: username@computername. The permissions you assign will only apply
when that person accesses InfoPrint Manager from that workstation.

If, however, you or any of your users want to be able to work with InfoPrint Manager objects from
various workstations, you might not want to add multiple user ID/computer name combinations for the
same person—you can use wildcarding instead. When you use wildcarding, you replace the computer
name or user ID with the wildcard character (*) when you add a member to an ACL or Security Group.
The wildcard character stands for “any computer” or “any user ID.” So, if you create an ACL member
called administrator@*, no matter what computer you log on to as administrator, you have the same
permissions. If you use the wildcard character before the computer name, for example *@computer,
any user who logs on to computer1 can do the actions that the ACL member has permission for.

Working with ACLs and groups

Use the InfoPrint Manager Management Console to manage the security of your print system. Open the
Security folder in the left pane of the Management Console to display the Access Control Lists folder
and Groups object. Open the Access Control Lists folder to see the types of ACLs that exist. Click the
type of ACL (Operations, Destinations, Servers, or Queues) to display the ACLs that exist. Click
Groups to see the groups that currently exist and their members.

For more detailed information about using the Management Console to work with groups and ACLs,
see the online help (in the Management Console, click Help -> Contents, and look on the Contents
tab underManaging Security).

MMaannaaggiinngg LLDDAAPP sseeccuurriittyy ffoorr IInnffooPPrriinntt MMaannaaggeerr ffoorr WWiinnddoowwss
InfoPrint Manager provides an extension to the FST security that lets you use a LDAP/Active Directory
server for user authentication and access rights. When enabling LDAP security, the FST security
continues to work as before. Use the Management Console for InfoPrint Manager Server utility to
configure, enable, or disable the LDAP security of your print system. Open the MMC interface, and go
to InfoPrint Printing System→ Security→ LDAP Security

Enable/Disable LDAP Security
Use the Management Console interface to enable or disable the LDAP security of your InfoPrint
system.

To enable the LDAP security:

1. Click the Security folder.

2. Right-click the LDAP object and choose the Enable LDAP Security option.

To disable the LDAP security:

1. Click the Security folder.

2. Right-click the LDAP object and choose the Disable LDAP Security option.
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You must have at least one LDAP connection with valid authentication settings and search
options to enable the LDAP security.

Create/Change LDAP Connection
To create an LDAP connection:

1. Click the Security folder.

2. Right-click the LDAP option and choose the New… option.

To change an LDAP connection:

1. Click the Security folder.

2. Go to the LDAP object.

3. Select an available connection in the right pane of the Management Console.

4. Right-click the LDAP connection and choose the Open... option.

You can see and change these options:

Connection Name
Enter the connection name of the LDAP server.

IP Address or Host Name
Enter the host name or IP address of the LDAP server.

Port
Enter the port number that is used for communication.

Encryption Method
Enter an encryption method for the LDAP Server. Select the Use Start TLS Extension or the Use
SSL Encryption option if you want to use the Start TLS or the SSL protocols.

Description
Enter an optional description.

Test Connection
If the information you enter is valid, you receive a confirmation message. If you enter incorrect
settings, you receive an error message.

LDAP Authentication
Specify how InfoPrint Manager authenticates to the Lightweight Directory Access Protocol Server
(LDAP). This information is used as authentication data for all existing LDAP connections. InfoPrint
Manager uses the information to authenticate to the LDAP Server to retrieve specific data (for
example, group membership and login attributes) about the entries.

To change the LDAP authentication:

1. Click the Security folder.

2. Go to the LDAP object.

3. Select an available connection in the right pane of the Management Console.
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4. Right-click the LDAP connection and choose the Authentication… option.

You can see and change these options:

Bind DN or user
Enter the distinguished name (DN) of the account.

Bind Password
Enter your password.

When you use the Anonymous login, it is not necessary to specify a value for: Bind DN/user or
Bind Password.

Method
Select the method of authentication: Simple or Digest.

SASL Realm
Enter the name of the SASL Realm. This option is available when you use the Digest method.

Anonymous login
Select to authenticate as an anonymous user when no access permission is required.

Test Authentication
Validates settings. If the information you enter is valid, you receive a confirmation message. If
you enter incorrect settings, you receive an error message.

If you have multiple LDAP servers defined, the authentication information is common for all.

LDAP Search options

1. Click the Security folder.

2. Go to the LDAP object.

3. Select an available connection in the right pane of the Management Console.

4. Right-click the LDAP connection and choose the Search option… option.

You can see and change these options:

Users:

Search Base
Specifies the distinguished name (DN) of the branch in the LDAP directory tree where the
users are located.

Login Attributes
Specifies the user attributes for the login in the LDAP server.

Object Class Filter
Specifies one or more optional object classes to filter when InfoPrint Manager searches for
users.
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Custom Filter
Specifies an optional custom filter that InfoPrint Manager uses when it searches users.

Groups:

Search Base
Specifies the distinguished name (DN) of the branch in the LDAP directory tree where the
groups are located.

Group Name Attributes
Specifies an attribute that identifies the group name (for example, cn).

Group Member Attribute
Specifies the attribute of a user group (for example, member).

Object Class Filter
Specifies one or more optional object classes to filter when InfoPrint Manager searches for
groups.

Custom Filter
Specifies an optional custom filter that InfoPrint Manager uses when searching for groups.

Performance Search Option

Use “memberOf” capability
Informs InfoPrint Manger that the group membership can be determined directly from the
memberOf field.

Make sure that this property is supported on your LDAP server.

Traverse Nested Groups
Applies only to the Microsoft Active Directory and it is used to check if a user is an indirect
member of a group.

Use “ibm-allGroups” Capability
Applies only to IBM Tivoli Directory Server and it is used to determine the group
membership directly from the attribute ibm-allgroups.

Make sure that this option is supported on your LDAP server.

Use case-sensitive search
This option is used for case-sensitive matching in LDAP/AD queries. For instance, when this
option is enabled, UUSSEERR does not match uusseerr in the LDAP/AD query. This option must be
consistent with the LDAP/AD server case-sensitive settings.
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MMaannaaggiinngg FFeeddeerraatteedd AAuutthheennttiiccaattiioonn ffoorr IInnffooPPrriinntt MMaannaaggeerr ffoorr
WWiinnddoowwss
InfoPrint Manager allows you to use federated authentication as an alternative to the existing FST or
LDAP/AD security.

Federated authentication is a method of granting users secure access to InfoPrint Manager Web
Management Interface and InfoPrint Manager Web Administration Interface by relying on external
identity providers (IdPs). Instead of managing separate user credentials within our system, federated
authentication allows users to log in using their existing accounts from trusted third-party services.

Configuring Federated Authentication
Before enabling federated authentication, the InfoPrint Manager administrator must configure the
connection settings between InfoPrint Manager and the federated authentication server.

To configure federated authentication:

1. Start the InfoPrint Manager Web Management Interface.

2. Click the Security tab in the left pane.

3. Select the Federated Authentication option.

4. In the Federated Authentication dialog, specify the required values.

• Make sure that the information that you enter in each field is correct. InfoPrint Manager does
not validate the data you enter in the Federated Authentication dialog.

• For more information about a field property, click the ? button next to it.

5. Select the name of the identity provider (IdP) you want to use to authenticate from the Identity
provider list.

6. In the Authorization endpoint field, enter the uniform resource identifier (URI) of the identity
provider where client applications send the user to get authenticated.

7. In the Client ID field, enter the unique string representing the client identifier issued by the
identity provider for InfoPrint Manager during the registration process.

8. In the Client secret field, enter the string representing the client passkey generated by the
identity provider allowing the client to authenticate to the authorization server.

• The Client secret field is not available when the Use PKCE option is checked.

9. In the Token endpoint field, enter the uniform resource identifier (URI) of the identity provider
where the access token and the ID token are requested.

10. In the User information endpoint field, enter the uniform resource identifier (URI) of the
identity provider where the user information is requested.

• The User information endpoint field is displayed only for the Common Approach to
Identity Assurance (CAIA) identity provider.
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11. In the Logout endpoint field, enter the uniform resource identifier (URI) where the user is
redirected to end the authentication session.

12. In the Redirect hostname and port field, enter the external host name and port for the InfoPrint
Manager web server. The host name and port are used to generate the uniform resource
identifier (URI) of the application, the location where the authorization server redirects the user
once the application has been successfully authorized and granted an authorization code or
access token.

• A colon (:) must separate the host name/IP address and the port number. For example,
prod.yourcompany.com:14443 or 123.123.123.123:14443.

13.Check the Allow insecure context box if you want to enable the possibility to communicate
with identity providers using self-signed certificates.

14.Check the Enforce federated authentication box to make federated authentication
compulsory and to bypass the standard login dialog of the application.

• If you entered any incorrect values in the Federated Authentication dialog, after checking
the Enforce federated authentication box you no longer have access to the standard
login dialog, making you unable to update the configuration values.

15.Check the Use PKCE box if you want to use a Proof Key for Code Exchange (PKCE).

• The Use PKCE field is displayed only for the Okta® identity provider.

16. In the User roles paramater field, enter the parameter name sent by the identity provider, that
contains the user roles or group membership information relevant to InfoPrint Manager. You
have to configure beforehand the identity provider to include the user roles or group
membership information as a claim either in the user identification token for Active Directory
Federation Services™ (AD FS) and Okta, or in the User information endpoint response for
CAIA.

• Keep in mind that the actual steps and terminology can vary depending on the identity
provider being used. The group claim name might be role for CAIA, groups for Okta, and
memberof for AD FS. Any other value you currently use is accepted.

• Consult the documentation of your identity provider for detailed instructions on how to do
this customization.

• InfoPrint Manager validates the user roles to control access to different resources and
functionalities based on the roles specified in the user identification token or in the User
information endpoint response. To access the Web Management Interface, the system
verifies whether the user ID belongs to the acl_admin group. To grant permissions to
desired users, they must be members of the acl_admin group defined on the website of
your chosen IdP.
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17. If your company uses proxy servers, ask your IT department for the correct IP address or host
name and port number to use. In the Proxy host and port field, enter the host name and port
of the proxy server used to communicate through.

• A colon (:) must separate the host name/IP address and the port number. For example,
proxy.example.com:3128 or 123.123.123.123:3128.

18.Click Save.

• If you click the Save button while the Federated Authentication switch is set to ON, the
web server restarts automatically to apply the changes.

Enable/Disable Federated Authentication
The InfoPrint Manager Web Management Interface allows you to enable or disable federated
authentication.

To enable or disable federated authentication:

1. Go to the InfoPrint Manager Web Management Interface.

2. Click the Security tab in the left pane.

3. Select the Federated Authentication option.

4. Use the switch at the top of the Federated Authentication dialog to enable or disable
federated authentication.

• When you enable federated authentication, the FST or LDAP/AD security continues to work
as before.

• When you enable or disable federated authentication, the web server restarts automatically.

MMaannaaggiinngg TTrraannssppoorrtt LLaayyeerr SSeeccuurriittyy eennccrryyppttiioonn ffoorr IInnffooPPrriinntt
MMaannaaggeerr ffoorr WWiinnddoowwss
The Transport Layer Security (TLS) protocol encrypts internet traffic of all types, making secure
communication possible across a network in a way designed to prevent eavesdropping and tampering.

InfoPrint Manager uses OpenSSL (https://www.openssl.org) to enable TLS encryption so that the
communication between servers and clients is secure. InfoPrint Manager provides the OpenSSL libraries
on all supported OS-es. By default, the latest version of TLS available with InfoPrint Manager is used.

Not all communication channels can be encrypted. Exception are: LPD protocol, InfoPrint TCP/IP Port
Monitor, pioinfo, pioinfoprt, piorpdm, piorpdf, PSF, transform clients, Transform Feature for InfoPrint
Manager, Select notifications.

For the Java components, InfoPrint Manager uses the Java native SSL/TLS implementation. By default,
the latest version of TLS available with Java is used.

The identity of the communicating parties is authenticated using public-key cryptography (i.e.: similar to
HTTPS protocol).
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Server and Client certificates

To encrypt the traffic between the InfoPrint Manager server and an InfoPrint Manager client, you need
a digital certificate. Each digital certificate has two parts: a key (the private part) and the certificate (the
public part). The key should always be kept private, otherwise the communication is not secure
anymore.

InfoPrint Manager only supports unencrypted certificate keys in PEM format.

You can:

1. Personally generate the certificate

2. Buy a certificate from a globally known third-party Certificate Authority (CA).

In the first case, you need to generate a CA authority certificate. The CA key file will sign the certificates
you generate (for servers and clients). The CA certificate will authenticate the certificates you generate.
The CA certificate (public part) must be available for InfoPrint Manager servers and clients in order to
validate the certificates it receives.

In the second case, the certificates are verified using the Mozilla CA Certificate Store, a collection of
CAs maintained by Mozilla organization. The raw file can be found at https://hg.mozilla.org/mozilla-
central/raw-file/tip/security/nss/lib/ckfw/builtins/certdata.txt.

certdata.txt file is distributed with InfoPrint Manager in a form that is suitable to be used with
OpenSSL.

The certificate included in certdata.txt usually expires in 398 days. To update the collection of CAs
maintained by Mozilla organization, follow these steps:

1. On a computer with perl and curl installed and internet access, copy mk-ca-bundle.pl from a
computer running InfoPrint Manager or from an InfoPrint Manager client computer. The mk-ca-
bundle.pl script is located in the <install path>\bin directory.

• You can also download the mk-ca-bundle.pl script from https://raw.githubusercontent.com/
curl/curl/master/scripts/mk-ca-bundle.pl.

• curl can be downloaded from https://curl.se/download.html.

• Make sure that perl and curl are used in PATH.

2. Open a console and change the directory to the location of the mk-ca-bundle.pl script.

3. Execute the following command:

perl mk-ca-bundle.pl -s SHA256 -t -p SERVER_AUTH,CLIENT_AUTH,CRL_SIGN:TRUSTED_DELEGATOR

4. Rename certdata.txt to ca-cert.pem.

5. Copy ca-cert.pem to all computers running InfoPrint Manager and also to all InfoPrint Manager
client computers. On Windows the location is: C:\Windows\ipm . On AIX, Linux, and MacOS the
location is: /etc/ipm.
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6. Restart each computer where the ca-cert.pem file has been copied.

A server certificate must have X509v3 Extended Key Usage (EKU) set to Server Authentication (TLS
Web Server Authentication). X509v3 Key Usage must be Digital Signature and Key Encipherment.

To use Mutual Authentication (the client validates the server certificate and the server also validates the
client certificate), you need a client certificate.

A client certificate must have X509v3 Extended Key Usage (EKU) set to Client Authentication (TLS Web
Client Authentication). X509v3 Key Usage must be Digital Signature.

If Mutual Authentication is required, the server certificate must have X509v3 Extended Key Usage
(EKU) set to Server Authentication (TLS Web Server Authentication) and Client Authentication (TLS Web
Client Authentication).

You should not use a globally known third-party CA when Mutual Authentication is enabled. For
example, using a Verisign certificate as a "known CA" means that ANYONE who has a certificate
signed by them is authenticated. This is most likely not what you want. Generate your own CA
certificate, server certificate, client certificates, etc.

The Subject field in the digital certificate must be set to the full computer name from DNS (example:
ipmsrv.example.com) or set to a wildcard for your DNS domain (example: *.example.com).

Partial wildcards are not allowed.

The X509v3 Subject Alternative Name (SAN) must contain any other names or aliases for that
computer (if available) and the IP addresses associated with the computer name. The field in the
certificate must look like this: DNS:alt1.example.com, DNS:alt2.example.com, IP:10.0.0.1, IP:
fc00::1, where host names are prefixed with "DNS:" and IP addresses with "IP:".

InfoPrint Manager warns you when your SSL/TLS certificate has less than 31 days left until it expires.
The message is issued to error log and it looks like this: "5010-907 The SSL/TLS certificate for InfoPrint
Manager expires on May 21 10:33:41 2029 GMT". To avoid interruptions you should consider
renewing your certificate.

In order to identify if your InfoPrint Manager server is SSL/TLS enabled, check the error log file for the
following message: "5010-908 InfoPrint Manager started with SSL/TLS enabled." after the InfoPrint
Manager server start.

When encryption is disabled, InfoPrint Manager server accepts connections from previous versions of
clients and servers (which do not understand TLS encryption). Once the encryption is enabled for an
InfoPrint Manager server, such clients or servers are no longer able to communicate with the system.
Only InfoPrint Manager servers that have encryption enabled or InfoPrint Manager clients that know to
use TLS encryption will successfully communicate with the system.

Enabling Transport Layer Security encryption for InfoPrint Manager servers for
Windows

To enable TLS encryption for InfoPrint Manager servers, follow these steps:
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1. Copy the provided sample configuration file, ipmssl.cfg, from the Instalation Directory
\cfg-samples\ssl\server directory to the %ProgramData%\RICOH\InfoPrint Manager\var
\pddir\ssl directory.

2. If you are using a custom CA, copy the CA certificate file (public part) to the InfoPrint Manager
server.

3. Copy the server certificate and key to the InfoPrint Manager server. Make sure that the certificate
key is stored in a secure location and only available for reading to the user that runs the InfoPrint
Manager server.

4. If you have Certificate Revocation List (CRL), copy the CRL file to the InfoPrint Manager server.

5. Edit the ipmssl.cfg file using a text editor. These keywords must be configured: EnableTLS,
CertFile, and KeyFile. If the server certificate key file and the server certificate are combined in one
file, only the CertFile keyword must be configured and KeyFile must be left commented. If the
certificate files and keys are found in the same directory as the configuration file, the full path is
optional. Otherwise, the full path should be specified.
Uncomment and change the following keyword values (where available):

1) Uncomment and set EnableTLS to 1.

2) Uncomment the CertFile keyword and specify the file name for the server certificate file.

3) Uncomment the KeyFile keyword and specify the file name for the server certificate key.

4) Optional: uncomment the CAFile keyword and specify the file name for the CA certificate if you
are using a custom CA.

5) Optional: uncomment the CrlFile keyword and specify the file name for the CRL certificate if
you have one available.

6) ) Optional: uncomment and set MutualAuthenticationRequired to 1 if you are planning to
use Mutual Authentication.
The last two optional keywords are commonly used if errors occur during the TLS handshake:

• CertValidationIgnoreHostName can help if the client host name from the DNS is
different from the value set in the certificate presented by the client during the TLS handshake
(Subject field and X509v3 Subject Alternative Name (SAN) field). Setting this keyword to 1
prevents the validation of the host name.
This table shows how validation is made if the Subject field from the certificate contains a
wildcard:

Host name Certificate Subject or
Certificate Subject
Alternative Name

Validation

host.example.com host.example.com OK

host.example.com *.example.com OK

host.subdomain.example.
com

*.subdomain.example.com OK

host.example.com host.another-example.com FAIL

host.subdomain.example.
com

host.another-subdomain.
example.com

FAIL
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host.example.com host*.example.com FAIL

host.example.com *host.example.com FAIL

host.subdomain.example.
com

host*.subdomain.example.
com

FAIL

host.subdomain.example.
com

*host.subdomain.example.
com

FAIL

To be valid, a host name in certificate must have at least 2 (two) dots.

• IgnoreCertificateErrors ignores any errors related to the client certificate (invalid
value presented in the certificate Subject or SAN fields, certificate expired, client not
sending a certificate, and so on.)

6. Reboot the computer or restart all InfoPrint Manager components that run (Notification, SAP, LPD,
DPF, IPP, LDAP, MVSD Download, Web Server) and all InfoPrint Manager servers.
Sample ipmssl.cfg configuration file:

#
# IPM SSL/TLS configuration file (server)
#

#############################################################################
#
# Empty lines and whitespace-only lines are ignored, as are lines whose
# first non-whitespace character is a semicolon (;) or a hash (#).
# This file use hashes to denote commentary and semicolons for options
# you may wish to configure.
# Every comment applies to the following section or option. The defaults
# refer to IPM's built-in values, not anything set in this file.
#
# Uncomment the lines where you want to do a change and enter the
# desired value. Option names are case-sensitive.
#
# If a full path is required but only a file name is provided
# (i.e., no '/' or '\' in file name), the lookup for the file is
# done only in the directory where this configuration file
# is located. Apply to: CAFile, CrlFile, CertFile, KeyFile.
#
# IMPORTANT: If you make changes to this file, make sure that
# you restart all the InfoPrint Manager processes.
# On Windows operating system, make sure that you
# also restart Print Spooler service.
#
#############################################################################

#
# Enable/disable encryption (0 = disabled, 1 = enabled).
# Default: 0
#
;EnableTLS = 0
#
# Path to a file containing one or more Certificate Authority (CA).
# Required if mutual authentication is enabled and _client_ certificate is
# not signed by a globally known CA. See also MutualAuthenticationRequired.
# Default: <empty>
#
;CAFile =
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#
# Path to a file containing one or more Certificate Revocation List (CRL).
# Default: <empty>
#
;CertFile =
#
# If the key is not combined with the certificate this directive will
# specify the path to Certificate Private Key (KEY) file.
# Default: <not set>, required.
#
;KeyFile =
#
# Enable/Disable mutual authentication (0 = disabled, 1 = enabled).
# Default: 0
#
# Note that you should NOT use a globally known CA when mutual authentication
# is enabled. i.e., using a Verisign certificate as a "known CA" means that
# ANYONE who has a certificate signed by them will be authenticated.
# This is most likely not what you want. Generate your own CA certificate,
# client keys and certificates, etc.
#
;MutualAuthenticationRequired = 0

#
# When enabled will prevent comparing client name with the name in
# certificate subject. Also apply to Subject Alternative Name (SAN).
# Ignored if MutualAuthenticationRequired is not enabled.
# Ignored if IgnoreCertificateErrors is enabled.
# (0 = disabled, 1 = enabled).
# Default: 0
#
;CertValidationIgnoreHostName = 0

#
# Ignore any errors related to certificate validation (0 = disabled,
# 1 = enabled).
# Default: 0
#
;IgnoreCertificateErrors = 0

Enabling Transport Layer Security encryption for InfoPrint Manager clients for
Windows

Normally, there is no need to configure anything on the client side if you use a server certificate from a
globally known third-party CA.

If you are using a custom CA certificate, or if you use Mutual Authentication, you must configure the
InfoPrint Manager clients to be able to communicate with the server. There are two places where the
client configuration file can reside:

• The user configuration directory:
For AIX/ Linux/ MacOS: ~/.ipm

For Windows: %APPDATA%\Ricoh\InfoPrint Manager\ssl

• The administrator-enforced configuration directory:
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For AIX / Linux / MacOS : /etc/ipm

For Windows: %windir%\ipm

A configuration file enforced by an administrator must be readable for everyone, but not writable. Any
directive present in the administrator version of the configuration file overwrites the same directive in the
user version of the configuration file, regardless of its configuration in the latter file. At least one of the
two client configuration files must exist in order to modify the default SSL encryption behavior. If the
certificate files and keys are found in the same directory as the configuration file, the full path is
optional. Otherwise, the full path should be specified.

To enable TLS encryption for InfoPrint Manager clients, follow these steps:

1. Copy the provided sample configuration file ipmssl.cfg from Instalation Directory\cfg-
samples\ssl\client directory to the desired location of the client configuration file (user or
administrator).

2. If you are using a custom CA, copy the CA certificate file (the public part) to the InfoPrint Manager
client.

3. If the server uses Mutual Authentication, copy the client certificate and key to the machine running
the InfoPrint Manager client. Ensure that the certificate key is secured and only available for reading
to the user running the InfoPrint Manager client.

4. If you have Certificate Revocation List (CRL), copy the CRL file to the InfoPrint Manager client.

5. Edit the ipmssl.cfg file using a text editor.
If the client certificate key file and the server certificate are combined in one file, only the CertFile
keyword must be configured and KeyFile must be commented. If the certificate files and keys are
found in the same directory as the configuration file, the full path is optional. Otherwise, the full path
should be specified.

Uncomment and change the following keywords values (where available):

1) Optional: uncomment the CertFile keyword and specify the file name for the client certificate
file if the InfoPrint Manager server is using Mutual Authentication.

2) Optional: uncomment the KeyFile keyword and specify the file name for the client certificate
key if the InfoPrint Manager server is using Mutual Authentication.

3) Optional: uncomment the CAFile keyword and specify the file name for the CA certificate if you
are using a custom CA.

4) Optional: uncomment the CrlFile keyword and specify the file name for the CRL certificate if
you have one available.

The last two optional keywords are commonly used if errors occur during TLS handshake:

• CertValidationIgnoreHostName can help if the server host name from the DNS is different
from the value set in the certificate presented by the server during TLS handshake (Subject field
and X509v3 Subject Alternative Name (SAN) field). Setting this keyword to 1 prevents the
validation of the host name. This table shows how the validation is made in case the Subject
field from the certificate contains a wildcard:

Host name Certificate Subject or
Certificate Subject
Alternative Name

Validation

host.example.com host.example.com OK
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host.example.com *.example.com OK

host.subdomain.example.com *.subdomain.example.com OK

host.example.com host.another-example.com FAIL

host.subdomain.example.com host.another-subdomain.
example.com

FAIL

host.example.com host*.example.com FAIL

host.example.com *host.example.com FAIL

host.subdomain.example.com host*.subdomain.example.
com

FAIL

host.subdomain.example.com *host.subdomain.example.
com

FAIL

To be valid, a host name in the certificate must have at least 2 (two) dots.

• IgnoreCertificateErrors ignores any errors related to the server certificate (invalid value
presented in the certificate Subject or SAN fields, certificate expired, and so on.)

6. Reboot the computer.

Sample iippmmssssll..ccffgg configuration file:

#
# IPM SSL/TLS configuration file (client)
#

#############################################################################
#
# Empty lines and whitespace-only lines are ignored, as are lines whose
# first non-whitespace character is a semicolon (;) or a hash (#). This
# file uses hashes to denote commentary and semicolons for options you
# might want to configure.
# Every comment applies to the following section or option. The defaults
# refer to IPM's built-in values, not anything set in this file.
#
# Uncomment the lines where you want to do a change and enter the desired
# value. Option names are case-sensitive.
#
# Any directive found in administrator version of the configuration file
# overwrites the same directive in user version of the configuration file
# regardless of what is configured in the later file or not.
#
# If a full path is required but only a file name is provided
# (i.e., no '/' or '\' in file name), the lookup for the file is
# done only in the directory where this configuration file
# is located. Apply to: CAFile, CrlFile, CertFile, KeyFile.
#
# IMPORTANT: If you make changes to this file, make sure that
# you restart all the InfoPrint Manager processes.
# On Windows operating system, make sure that you
# also restart Print Spooler service.
#
#############################################################################

#
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# Path to a file containing one or more Certificate Authority (CA).
# Required if _server_ certificate is not signed by a globally known CA.
# Default: <empty>
#
;CAFile =

#
# Path to a file containing one or more Certificate Revocation List (CRL).
# Default: <empty>
#
;CrlFile =

#
# Path to unencrypted PEM Certificate (CRT) file.
# Default: <not set>, required only if the remote server require mutual
# authentication.
#
;CertFile =

#
# If the key is not combined with the certificate, this directive
# specifies the path to Certificate Private Key (KEY) file.
# Default: <not set>, required only if the remote server requires mutual
# authentication.
#
;KeyFile =

#
# When enabled, it prevents comparing _server_ name with the name in
# certificate subject. It also applies to Subject Alternative Name (SAN).
# Ignored if IgnoreCertificateErrors is enabled.
# (0 = disabled, 1 = enabled).
# Default: 0
#
;CertValidationIgnoreHostName = 0

#
# Ignore any errors related to certificate validation (0 = disabled, 1 =
# enabled).
# Default: 0
#
;IgnoreCertificateErrors = 0

Enabling Transport Layer Security encryption for sendmemo

The sendmemo component is responsible with submitting emails from the InfoPrint Manager server, either
as Email Notifications or through an Email actual destination. If you want to enable encrypted
communication between the InfoPrint Manager server and your email server, you must configure the
sendmemo SSL/TLS configuration file. The configuration file, like smtp-server-port and smtp-
server-host server attributes, is configured per server. Therefore, the location of the configuration file
is the server working directory: %ProgramData%\Ricoh\InfoPrint Manager\var\pd\<your-
server-name>, where <your-server-name> is the name of the server that you want to have an
encrypted communication with your email server.
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• Your email server must also have SSL/TLS configured and functional. You can choose between
STARTTLS or SMTPS. By default, STARTTLS can be used with port 25/tcp (smtp) and 587/tcp
(submission). By default, SMTPS can be used with port 465/tcp (smtps). However, you can use any
other TCP port as long as your email server is configured as such.

• Authentication over STARTTLS or SMTPS is not supported.

By default, sendmemo uses TLS to encrypt the connection to the email server. It negotiates the highest
available cipher shared with the email server. By default, SSLv3 encryption is disabled. If your server is
very old and needs Secure Sockets Layer (SSL) version 3 for encrypted connections to it, you can set
the environment variable IPM_ENABLE_SSL_V3 to a non-empty value.

SSLv2 is disabled and cannot be enabled.

If the certificate files and keys are found in the same directory as the configuration file, the full path is
optional. Otherwise, the full path should be specified.

To enable TLS encryption for sendmemo, you must follow these steps:

1. Copy the provided sample configuration file sendmemo-ssl.cfg from Instalation Directory
\cfg-samples\ssl\ sendmemo directory into the working directory of the server.

2. If you are using your own CA, copy the CA certificate file (the public part) to the InfoPrint Manager
server.

3. If you have Certificate Revocation List (CRL), copy the CRL file to the InfoPrint Manager server.

4. Edit the sendmemo-ssl.cfg file using a text editor. Uncomment and change the following
keywords values (where available):

1) Uncomment the EnableTLS keyword and the desired value as follows:

• 0: SMTP session encryption disabled

• 1: use STARTTLS

• 2: use SMTPS

The correct SMTP port number must be set using the specific InfoPrint Manager server
attribute smtp-server-port.

2) Optional: uncomment the CAFile keyword and specify the file name for the CA certificate if you
are using a custom CA.

3) Optional: uncomment CrlFile keyword and specify the file name for the CRL certificate if you
have one available.

4) Optional: uncomment the Hostname keyword and specify the host name that sendmemo uses to
identify itself (EHLO) to the email server. This is useful when you are behind NAT and sendmemo
needs to send email to the SMTP servers that are outside of your LAN or when autodetect fails.
Some email servers might ignore an invalid host name passed to EHLO, others might not.
The format must be one of the following (RFC 2821):

FQDN host name:
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example: host.example.com

Brackets enclosed IPv4 address:
example: [1.2.3.4]

Brackets enclosed IPv6 address:
example: [IPv6:fc00::1]

The last two optional keywords are commonly used if errors occur during TLS handshake:

• CertValidationIgnoreHostName can help if the server host name from the DNS is different from
the value set in the certificate presented by the server during TLS handshake (Subject field and
X509v3 Subject Alternative Name (SAN) field). Setting this keyword to 1 prevents validation of the
host name. This table shows how validation is made in case the Subject field from the certificate
contains a wildcard:

Host name Certificate Subject or
Certificate Subject
Alternative Name

Validation

host.example.com host.example.com OK

host.example.com *.example.com OK

host.subdomain.example.com *.subdomain.example.com OK

host.example.com host.another-example.com FAIL

host.subdomain.example.com host.another-subdomain.
example.com

FAIL

host.example.com host*.example.com FAIL

host.example.com *host.example.com FAIL

host.subdomain.example.com host*.subdomain.example.com FAIL

host.subdomain.example.com *host.subdomain.example.com FAIL

To be valid, a host name in the certificate must have at least 2 (two) dots.

• IgnoreCertificateErrors ignores any errors related to the server certificate (invalid value
presented in the certificate Subject or SAN fields, certificate expired, and so on.)

Sample sseennddmmeemmoo--ssssll..ccffgg configuration file:

#
# sendmemo SSL/TLS configuration file
#

#############################################################################
#
# Empty lines and whitespace-only lines are ignored, as are lines whose
# first non-whitespace character is a semicolon (;) or a hash (#). This
# file uses hashes to denote commentary and semicolons for options you
# might want to configure.
# Every comment applies to the following section or option. The defaults
# refer to IPM's built-in values, not anything set in this file.
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#
# Uncomment the lines where you want to do a change and enter the desired
# value. Option names are case-sensitive.
#
# If a full path is required, but only a file name is provided (i.e., no
# '/' or '\' in file name), the lookup for the file is done only in the
# directory where this configuration file is located. Apply to: CAFile,
# CrlFile, CertFile, KeyFile.
#
#############################################################################

#
# Enable/disable SMTP session encryption. Available options:
# 0: SMTP session encryption disabled
# 1: use STARTTLS
# 2: use smtps
# Note that the correct SMTP port number must be set using the specific
# IPM server attribute (smtp-server-port).
#
# Default: 0
#
;EnableTLS = 0

#
# Path to a file containing one or more Certificate Authority (CA).
# Required if _server_ certificate is not signed by a globally known CA.
# Default: <empty>
#
;CAFile =

#
# Path to a file containing one or more Certificate Revocation List (CRL).
# Default: <empty>
#
;CrlFile =

#
# When enabled, it prevents comparing _server_ name with the name in
# certificate subject. It also applies to Subject Alternative Name (SAN).
# Ignored if IgnoreCertificateErrors is enabled.
# (0 = disabled, 1 = enabled).
# Default: 0
#
;CertValidationIgnoreHostName = 0
#

# Ignore any errors related to certificate validation (0 = disabled, 1 =
# enabled).
# Default: 0
#
;IgnoreCertificateErrors = 0

# Specify the hostname that sendmemo uses to identify itself (EHLO).
# The format must be one of the following (RFC 2821):
# * FQDN hostname:
# host.example.com
# * Brackets enclosed IPv4 address:
# [1.2.3.4]
# * Brackets enclosed IPv6 address:
# [IPv6:fc00::1]
# Anything else is invalid. Some email servers might ignore an invalid
# hostname passed to EHLO, other will not.
#
# Useful when you are behind NAT and sendmemo needs to send email to SMTP

Managing Transport Layer Security encryption for InfoPrint Manager for Windows



1

56

# servers that are outside of your LAN or when autodetect fails.
# Default: sendmemo will autodetect hostname.
;Hostname =

MMaannaaggiinngg JJoobb EEnnccrryyppttiioonn ffoorr IInnffooPPrriinntt MMaannaaggeerr ffoorr WWiinnddoowwss
To prevent data from being accessed, modified, or stolen, InfoPrint Manager can encrypt the files for
jobs in pending, held, ripped, or retained state.

InfoPrint Manager Uses OpenSSL (https://www.openssl.org) to enable Job Encryption. To encrypt and
decrypt large amounts of data, InfoPrint Manager uses symmetric encryption. Only printable job files,
RIP files, submission files, and email-body files for Email DSS are encrypted.

• On AIX and Linux, ppddpprr --ll copies the file instead of creating a symbolic link.

• To have all InfoPrint Manager files encrypted, including temporary files, instead of using Job
Encryption, we recommend encrypting all the partitions where InfoPrint Manager stores files: the
partitions that store %ProgramData%\RICOH\InfoPrint Manager\var\pd, %ProgramData%
\RICOH\InfoPrint Manager\var\psf, %ProgramData%\RICOH\InfoPrint Manager\var\psf
\segments, the partitions that store the %TEMP% directory and the Windows swap file.

When a job enters the system, it is initially saved as plain data. It is encrypted after document format
sniffer and page count have been completed.

An InfoPrint Manager server encrypts a file when a job submission (pdpr) is made or a control (from
Anyplace Print across namespace) is executed.

An InfoPrint Manager server decrypts a file when a job starts processing. The encrypted and the
decrypted files are deleted when a job completes. If a job moves back to a pending or held state, the
decrypted file is deleted.

At server startup, all decrypted files are deleted.

• Job Viewer also decrypts job files and deletes the decrypted files, when appropriate.

For Anyplace Print across namespaces, a move job is made. The job files are decrypted and a job is
submitted. Files are encrypted again on the destination server.

To identify if Job Encryption is enabled on your InfoPrint Manager server, check the error log file for the
following message:"5010-909 InfoPrint Manager started with Job Encryption enabled.", after
the InfoPrint Manager server has started.

Enabling Job Encryption for InfoPrint Manager for Windows

To enable Job Encryption for InfoPrint Manager servers:

1. Stop all running instances of InfoPrint Manager. In interoperated environments, stop all running
instances of InfoPrint Manager on all interoperated machines.
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2. Copy the sample configuration file, iippmm--ffiillee--eennccrryyppttiioonn..ccffgg, from Instalation
Directory\cfg-samples\file-encryption directory to %ProgramData%\RICOH
\InfoPrint Manager\var\pddir\crypto directory.

3. Uncomment and set EEnnaabblleeFFiilleeEEnnccrryyppttiioonn to 1.

4. Uncomment and set CCiipphheerr to the desired cipher to use for encryption.

• The list of available ciphers can be obtained by running the following command:

openssl-ipm enc -ciphers

Do not include the first character ('-') from the cipher name.

• If you use an AES cipher, having a processor that supports hardware encryption, AES instruction
set, speeds up the encryption/decryption time. For the AES instruction set, see https://software.
intel.com/content/www/us/en/develop/articles/intel-advanced-encryption-standard-instructions-
aes-ni.html.

5. Run ppddeenncc__jjoobbss. In interoperated environments, run ppddeenncc__jjoobbss sequentially on all
interoperated machines.

6. Start all instances of InfoPrint Manager or reboot.

• Do not change the cipher in the iippmm--ffiillee--eennccrryyppttiioonn..ccffgg configuration file once encryption
has been enabled. To change the cipher, follow the procedure in Disabling Job Encryption for
InfoPrint Manager for Windows, p. 57, change the cipher in the iippmm--ffiillee--eennccrryyppttiioonn..ccffgg
configuration file, and then follow the procedure to enable Job Encryption for InfoPrint Manager.

• Do not remove the iippmm--ffiillee--eennccrryyppttiioonn..ddaatt file once encryption has been enabled. This file
is stored in the same directory as the iippmm--ffiillee--eennccrryyppttiioonn..ccffgg configuration file.

• Before running ppddeenncc__jjoobbss, make sure that there is at least 1.5* (size of jobs + rip files)
free space available on the partition where jobs are stored.

Disabling Job Encryption for InfoPrint Manager for Windows

To disable Job Encryption for InfoPrint Manager servers:

1. Stop all running instances of InfoPrint Manager. In interoperated environments, stop all running
instances of InfoPrint Manager on all interoperated machines.

2. Run ppddddeecc__jjoobbss. In interoperated environments, run ppddddeecc__jjoobbss sequentially on all
interoperated machines.

3. Uncomment and set EEnnaabblleeFFiilleeEEnnccrryyppttiioonn to 0 or remove the iippmm--ffiillee--eennccrryyppttiioonn..
ccffgg file.

4. Start all instances of InfoPrint Manager or reboot.

• Before running ppddddeecc__jjoobbss, make sure that there is at least 1.5* (size of jobs + rip files)
free space available on the partition where jobs are stored.

Managing Job Encryption for InfoPrint Manager for Windows
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Sample iippmm--ffiillee--eennccrryyppttiioonn..ccffgg file:

#
# IPM File Encryption configuration file
#

###############################################################################
#
# Empty lines and whitespace-only lines are ignored, as are lines whose
# first non-whitespace character is a semicolon (;) or a hash (#).
# This file uses hashes to denote commentary and semicolons for options
# you may wish to configure.
# Every comment applies to the following section or option. The defaults
# refer to IPM's built-in values, not to anything set in this file.
#
# Uncomment the lines where you want to make a change and enter the
# desired value. Option names are case-sensitive.
#
###############################################################################

#
# Enable/disable encryption (0 = disabled, 1 = enabled).
# Default: 0
#
;EnableFileEncryption = 0

#
# Specifies the cipher to be used when encrypting/decrypting files.
# To obtain the supported list of ciphers run:
#
# openssl-ipm enc -ciphers
#
# Do not include the first character ('-') from the cipher name.
# Default: <not set>, required.
#
# DO NOT change the cipher in this file after encryption has been enabled!
#
# To change the cipher, stop all pdservers, run the decryption tool, change the
# cipher in this file, run the encryption tool and then start all pdservers.
#
;Cipher =

CCuussttoommiizziinngg eerrrroorr llooggss iinn tthhee IInnffooPPrriinntt MMaannaaggeerr WWiinnddoowwss sseerrvveerr
InfoPrint Manager provides three configuration files for various InfoPrint Manager servers and
processes:

1. spl_error.cfg for the InfoPrint Manager server error log.

2. notifyd_error.cfg for the Notification server error log.

3. sap_error.cfg for all the SAP Callback processes.

To customize error logs for one of these servers or processes to control their size, whether they wrap,
the severity level of messages written to the logs, and the number of back-up logs that InfoPrint
Manager saves, you must perform one of the procedures in the next section.

1 Administrative Procedures: Configuring InfoPrint Manager
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Customizing an InfoPrint Manager server error log

By default, the InfoPrint Manager server error log starts when the InfoPrint Manager server starts. Use
this procedure to customize the InfoPrint Manager server error log.

1. Find the spl_error.cfg file in the bin directory that is under the directory where InfoPrint Manager
is installed (the default is C:\Program Files\RICOH\Infoprint Manager).

2. Copy the spl_error.cfg file into the workspace_path\servername directory if you want to customize
the error log only for servername or into the workspace_path directory if you want to customize the
error log for all InfoPrint Manager servers.

The workspace_path is specified on theWorkspace path field. From the InfoPrint Manager
Management Console, click Edit→ Service Configuration path to verify the setting of the
Workspace path field. For these examples, workspace_path signifies the fully qualified path
where the error log is in, such as C:\ProgramData\RICOH\Infoprint Manager\var\pd.

If you already customized your server error logs, remember to change the name or move the
current spl_error.cfg file in workspace_path\servername or workspace_path so that your
customization values can be copied over into the newer version of the file.

3. Open a copy of the spl_error.cfg file in the workspace_path\servername or workspace_path
directory and edit it to specify the settings for the log attributes that you want (as shown in Sample
spl_error.cfg file provided by InfoPrint Manager, p. 59).

For example, you can modify the log-backup-number attribute, which lets you specify the
number of backup logs that InfoPrint saves, including the initial error.log.BAK file. Before this
attribute was added to the product, an unlimited number of logs were saved.

Sample spl_error.cfg file provided by InfoPrint Manager

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

When you start the InfoPrint Manager server after a shut down, it backs up the first error log by
creating an error.log.BAK file. With each successive restart, it creates an additional .BAK file,
adding a timestamp as a fourth qualifier. By default, the log-backup-number attribute specifies
a value of 10, meaning that you can have nine back up files with timestamps and the initial .BAK
file. You can reduce this number as low as 1 or increase it as high as 999.

For a complete list of the error log attributes that you can customize, see the RICOH InfoPrint
Manager: Reference "Attributes for logs" topic in "Chapter 3. InfoPrint object attributes."

4. Once you have finished defining your options, save and close the file.

Customizing error logs in the InfoPrint Manager Windows server
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If you do not need the customization change to take effect immediately, you can skip the final two
steps and just wait until the next time the InfoPrint Manager server is restarted.

5. To shut down the server from the Management Console, specify File→ Stop server.

To start and stop the server, run the InfoPrint Manager Management Console interface using the
"Run as Administrator" command.

6. To restart the server from the Management Console, specify File→ Start server.

Customizing a Notification server error log

By default, the Notification server error log starts when the Notification server starts. Use this procedure
to customize the InfoPrint Notification server error log.

1. Find the notifyd_error.cfg file in the bin directory that is under the directory where the file is
installed.

2. Copy it to the workspace_path directory.

The workspace_path is specified on theWorkspace path field. From the InfoPrint Manager
Management Console, click Edit→ Service Configuration path to verify the setting of the
Workspace path field. For these examples, workspace_path signifies the fully qualified path
where the error log is in, such as C:\ProgramData\RICOH\Infoprint Manager\var\pd.

If you already customize your Notification server error log, remember to change the name or
move the current notifyd_error.cfg file in workspace_path so that your customization values can
be copied over into the newer version of the file.

3. From the workspace_path directory, edit the notifyd_error.cfg file to specify the settings for the
log attributes that you want (as shown in Sample notifyd_error.cfg file provided by InfoPrint
Manager, p. 60).

For example, you can modify the log-backup-number attribute, which lets you specify the
number of backup logs that InfoPrint saves, including the initial error.log.BAK file. Before the
log-backup-number attribute was added, InfoPrint Manager for Windows only saved one
backup error log.

Sample notifyd_error.cfg file provided by InfoPrint Manager

#
# Error Log Configuration File
#
log-size = 1024
log-wrap = true
log-severity = debug
log-backup-number = 10

When you start the InfoPrint Manager server after a shut down, it backs up the first error log by
creating an error.log.BAK file. With each successive restart, it creates an additional .BAK file,

1 Administrative Procedures: Configuring InfoPrint Manager
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adding a timestamp as a fourth qualifier. By default, the log-backup-number attribute specifies
a value of 10, meaning that you can have nine back up files with timestamps and the initial .BAK
file. You can reduce this number as low as 1 or increase it as high as 999.

For a complete list of the error log attributes that you can customize, see the RICOH InfoPrint
Manager: Reference "Attributes for logs" topic in "Chapter 3. InfoPrint object attributes."

4. Once you have finished defining your options, save and close the file.

If you do not need the customization change to take effect immediately, you can skip the final two
steps and just wait until the next time the InfoPrint Manager server is restarted.

5. To stop the Notification server on an InfoPrint Windows server:

1. Click Start→ Settings→ Control Panel→ Services.

2. Highlight InfoPrint Manager Notification and click Stop.

6. To restart the Notification server on an InfoPrint Windows server:

1. Click Start→ Settings→ Control Panel→ Services.

2. Highlight InfoPrint Manager Notification and click Start.

MMoonniittoorriinngg ddiisskk uussee
InfoPrint Manager includes support to help you monitor disk usage. The InfoPrint Manager server polls
critical disks at regularly scheduled intervals, and it increases the polling as the usage increases.
Initially, the disk is polled for usage every 16 minutes.

Here is the polling schedule:

80%
Every 8 minutes

90%
Every 4 minutes

95%
Every 2 minutes

97.5%
Every minute

If the usage for a disk goes above the InfoPrint Manager pre-defined threshold of 80%, InfoPrint
Manager logs a message and generates a disk-space-low event. As usage increases above the 80%
threshold, more messages and disk-space-low events are logged and generated.

Each time usages goes above the 80, 90, 95, and 97.5 percent usage levels, the disk-space-low
event is generated and logged. However, InfoPrint Manager only issues one event for each usage level.
Disk usage algorithm, p. 62 illustrates the algorithm used to monitor disk usage.

Monitoring disk use
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Disk usage algorithm

The threshold is reset if the disk usage drops below the previous threshold; for example, when the disk
usage drops to 70% after an 80% disk-space-low event, it is reset.

Adjusting your server notification profile for disk usage

The InfoPrint Manager server notification profile uses the out-of-disk-space event as the default, so
that when your disk usage reaches 100%, this event is generated. You can modify the server notification
profile to add the disk-space-low event. However, the messages from the disk usage monitoring are
always logged; regardless of the events in the server notification profile. It is recommended that you
include both the disk-space-low and out-of-disk-space events in your notification profiles.

Disks monitored by InfoPrint Manager

InfoPrint Manager for Windows monitors these paths (as shown in theManagement Console→
Service Configuration) that point to subdirectories where InfoPrint Manager is installed:

• Install path

• Base namespace path

• Workspace path

• AFP support workspace path

1 Administrative Procedures: Configuring InfoPrint Manager



1

63

AAddmmiinniisstteerriinngg yyoouurr IInnffooPPrriinntt MMaannaaggeerr sseerrvveerr uussiinngg aa WWiinnddoowwss
TTeerrmmiinnaall SSeerrvveerr cclliieenntt
While you can do most administrative tasks using the InfoPrint Manager Administration GUI, there are a
few that you must do using the Management Console. However, since the Management Console must
reside on the system that your InfoPrint Manager server is installed on, performing those tasks can be
inconvenient. The only way to perform administrative tasks on the Management Console on a different
system is to use a Windows Terminal Server. On Windows, Terminal Server capabilities are included in
Windows Server editions. Therefore, you must install your InfoPrint Manager server on a supported
Windows Server edition, not on a Windows non-Server edition.

Once you have InfoPrint Manager installed on the correct version of Windows, you need to install the
Terminal Server Client on any other systems that you want to be able to access the Management
Console from. You can install the client on one of these systems:

• Windows Server 2016

• Windows Server 2019

• Windows Server 2022

Use the Installing the Windows Terminal Server client, p. 63 procedure to create installation disks and
install the client.

Installing the Windows Terminal Server client

To complete this procedure, you need two blank floppy disks.

For Windows Server:

1. Log on to the system that your InfoPrint Manager server is installed on.

2. On Windows Server, click Start→ Programs→ Administrative Tools→ Terminal Services
Client Creator.

3. Select Terminal Services for Windows and check the Format disk(s) check box. Click OK.

4. Follow the instructions in the pop-up dialogs to create your Terminal Services Client installation
disks.

Save these disks. You will need them if you ever need to uninstall the client.

5. Close the dialog once the disks are created.

6. Log on to the machine that you want to install the Terminal Services Client on.

7. Insert the first Terminal Services Client installation disk in the drive.

8. Navigate to that disk drive and double click Setup.exe to start the Terminal Server/Services
Client Setup wizard.

9. Follow the instructions in the wizard to install the client.
When you finish the wizard, Terminal Server/Services Client will be added to your Start menu.

10. Start the client by selecting Start→ Programs→ Terminal Services Client→ Terminal Services
Client.

Administering your InfoPrint Manager server using a Windows Terminal Server client
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11. Find the name of the server that your InfoPrint Manager server is installed on and connect to it.
Once you are connected, you can open the Management Console and use it just as you would on
the server system itself.

CChhaannggiinngg tthhee sseerrvveerr IIPP aaddddrreessss
If you are changing the IP address and you have updated your system name resolution so that the old
name resolves to the new IP address, InfoPrint Manager will be reset to use the new IP address with the
old hostname when you restart the system. If any of your InfoPrint clients refer to InfoPrint Manager
using the IP address, you must update them so they use the new IP address.

MMaannaaggiinngg tthhee ppaasssswwoorrdd ooff tthhee iippmm11 ddeeffaauulltt uusseerr

• The default password for the iippmm11 user account is IInnff00PPrriinnttMMaannaaggeerr. If you do not use this
password for the iippmm11 user, the InfoPrint Manager services will not start. You can change the
default password after the InfoPrint Manager installation.

To change the iippmm11 password:

1. In the Windows Computer Management console, select System Tools→ Local Users and
Groups→ Users.

2. Right-click iippmm11 and select Set Password....

• You can also change the iippmm11 password by logging on as iippmm11, pressing Ctrl + Alt + Delete,
and selecting Change a password.

• After you change the iippmm11 password, you must use the new password for each InfoPrint Manager
service. You can change the password for InfoPrint Manager services either from the Windows
Services console or from the InfoPrint Manager Management Console.

To change the password for each InfoPrint Manager service from the Windows Services console:

1. In the Windows Services console, right-click each InfoPrint Manager service, and select Stop.

2. Right-click each InfoPrint Manager service and select Properties.

3. Click Log On, select the This account checkbox, set the new iippmm11 password, and click Apply.

4. Right-click each InfoPrint Manager service and select Start.

• Make sure that the first service whose password you change is InfoPrint Manager Licensing
Service.

To change the password for the InfoPrint Manager services from the InfoPrint Manager Management
Console:

1. In the InfoPrint Manager Management Console, click File→ Stop Server to stop each running
server from the list.
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2. Click Edit→ Service Account/Domain to open the Service Account/Domain dialog.

3. Enter the iippmm11 password you just created in the Password field and click OK.

4. Click File→ Start Server.

SSeettttiinngg uupp yyoouurr IInnffooPPrriinntt MMaannaaggeerr sseerrvveerr ttoo uussee rreessoouurrcceess oonn aa
ddiiffffeerreenntt WWiinnddoowwss ssyysstteemm
Sometimes, users choose to store printing resources (such as pagedefs, formdefs, and fonts) on systems
other than the one that their InfoPrint Manager server runs on. If you choose that setup, you must first
make sure that InfoPrint Manager has access to the resources, then tell InfoPrint Manager where the
resources are located. Use these procedures to complete these tasks.

1. Giving InfoPrint Manager access to remote resources, p. 65

2. Telling InfoPrint Manager where your remote resources are located, p. 67

Giving InfoPrint Manager access to remote resources

Follow Using Windows Server, p. 65 to set up access to remote resources.

Both of your systems must be running on the same operating system. You cannot mix Windows
operating systems in this environment. The systems should also operate in the same domain.

Using Windows Server

1. Set up a domain user account that your InfoPrint Manager server will run under.

1. Log on to the domain that your InfoPrint Manager servers operate in as a domain
administrator.

2. Click the Windows Start button and select Programs→ Administrative Tools→ Active
Directory Users and Computers.

3. In the left pane of the Active Directory Users and Computers window, find the Users directory.

4. Right-click the Users directory and select New→ User from the pop-up menu.

5. In the first dialog of the New Object – User wizard, type a name for this user in the Full
name and the User logon name fields.

You do not have to fill in the other name fields.

6. Click Next.

7. In the second dialog of the New Object – User wizard, enter a password for this user. Clear
all of the check boxes, then select Password never expires (so you do not have to change
the password and update all of your servers on a regular basis).

8. Click Next to verify the settings for the user and complete the wizard.

Setting up your InfoPrint Manager server to use resources on a different Windows system
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9. Once you have created the user, right-click the user in the right pane of the Active Directory
Users and Computers window and select Add members to a group from the pop-up
menu.

10. In the Select Group dialog, find and select the Domain Administrators (or Domain
Admins) group. Click OK to add your user to the group.

You can leave the Name field blank.

2. Grant the appropriate user rights to the new domain user on the system that your InfoPrint
Manager server runs on.

1. Log on to the system as a user who is a member of the Domain Administrators group.

2. Click the Windows Start button and select Settings→ Control Panel.

3. In the Control Panel window, double-click Administrative Tools.

4. In the Administrative Tools window, double-click Local Security Policy.

5. In the right pane of the Local Security Settings window, double-click Local policies.

6. Double-click User Rights Assignment in the right pane.

7. In the list of user rights, select Act as part of the operating system and double-click it.

8. In the Local Security Policy Setting dialog, click Add.

9. In the Select Users or Groups dialog, click the arrow on the drop-down list box and select
the domain that your InfoPrint Manager servers exist in.

10. Find and select the domain user you created and click Add.

11.Click OK in the Select Users or Groups dialog.

12.Click OK in the Local Security Policy Setting dialog.

13. Repeat from step 2.7 for two other user rights: Create permanent shared objects and Log
on as a service.

3. Set up the InfoPrint Manager server to use the new user account.

1. Click the Windows Start button and select Programs→ InfoPrint Manager→
Management Console.

2. Stop the InfoPrint Manager server by selecting File→ Stop Server.

If you are not able to stop the server because you are not authorized for that action, check
the InfoPrint Manager Access Control List (ACL) for the Shutdown operation. Log off and log
back on as a user who is on the access control list.

3. Select Edit→ Service Account/Domain.

4. Enter the name of the domain that the InfoPrint Manager server is installed in and the user
name and password from step 1.

5. Click OK.

4. On the machine where the AFP resources reside, share the directory that the resources reside in
so the domain user has access to it.
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1. Log on to the system that your resources reside on as a user who is a member of the
Administrators group.

2. OpenWindows Explorer and navigate to the directory that your resources are stored in.

3. Right-click the folder and select Properties from the pop-up menu.

4. In the Properties dialog, click Security.

5. If Domain Admins is not in the Name list, click Add.

6. In the Select Users, Computers, or Groups dialog, select the correct domain from the
Look in drop-down list.

7. Select Domain Admins in the Name list and click Add. You might also want to add the
local administrators group as well.

8. Click OK.

9. In the Properties dialog, make sure that Full Control is allowed for Domain Admins in the
Permissions box.

You might want change the access level for the Everyone group as well.

10.Click Sharing.

11. Select Share this folder. Verify the name of the folder in the Share name field and type a
descriptive comment in the Comment field.

12.Click OK.

13. Return to the Management Console on the system that InfoPrint Manager is installed on and
click File→ Start Server to restart the InfoPrint Manager server.

Preparing for shared resources with MVS Download

If you are running InfoPrint Manager on a Windows system and will be using MVS Download multiple
data set support, you must perform an additional task to share resources on a network drive:

1. Click the Windows Start button and select Settings→ Control Panel→ Administrative Tools→
Services.

2. Select InfoPrint Manager MVS Download.

3. On the InfoPrint Manager MVS Download Properties (Local Computer) dialog, click Log On,
and click This account.

4. Enter the account information for the same user you authorized in step 1 in Using Windows Server,
p. 65.

5. Click OK.

Telling InfoPrint Manager where your remote resources are located

Once you have made the resources available, you have to make sure the InfoPrint Manager
destinations that will be using them know where they are. To complete this configuration:

Setting up your InfoPrint Manager server to use resources on a different Windows system
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1. On the system that InfoPrint Manager runs on, map a network drive to the directory that your
resources reside in.

1) Open Windows Explorer.

2) Click Tools→Map Network Drive.

3) Specify the user and password to use.
Windows

1. In theMap Network Drive dialog, select a drive letter that you are not currently using from
the drop-down menu in the Drive field.

2. In the Folder field, type the Universal Naming Convention (UNC) name of the directory you
shared on the system that your resources are stored on server in this format: \
\resourcesystem\sharename.

3. Select Reconnect at logon.

4. Click Connect using a different user name.

5. In the Connect As dialog, type the user name and password that you created in the step 1
in Using Windows Server, p. 65.

6. Click OK in the Connect As dialog.

7. Click Finish in theMap Network Drive dialog.

2. Start the InfoPrint Administration GUI.

3. Select one of the printers that needs to access these resources and right-click it.

4. Select Properties from the pop-up menu.

5. In the Properties notebook for this printer, click AFP Resources.

6. Find the correct field for your situation. For example, if your directory only holds fonts, find the
Location of fonts field; if it holds only overlays, find the Location of overlays field. However, if
the directory holds a variety of resources, find the Location of resources field.

7. In the correct field, type the letter of the drive you mapped in step 1.3 and the share name of the
directory that contains the resources. For example: x:\afpresources.

8. Click OK to close the properties notebook and make the settings take effect.

UUssiinngg IInnffooPPrriinntt MMaannaaggeerr nnoottiiffiiccaattiioonnss
InfoPrint Manager can detect events (such as job completed or destination needs attention) as they
occur, generate messages about those events, and deliver the messages to users who need the
information. For example, users can receive messages about jobs they submit, operators can be notified
about InfoPrint objects that require their attention, and administrators can be notified if someone makes
a configuration change. With notifications, you do not have to query for status of the objects in your
system—you just receive messages when specific events occur so that you can take care of them.

You can tailor who receives these messages and how they are delivered based on the notification
profile that is set for a particular InfoPrint object.
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Understanding notification profiles

Most InfoPrint objects (the server, actual destinations, logical destinations, queues, jobs, and default
jobs) have notification profiles associated with them. A notification profile is composed of one or more
notification profile entries. Each notification profile entry has three main components:

Event Identifiers
Which events cause messages to be sent. See Event identifiers, p. 69 for more information.

Delivery method
How the messages are delivered. See Delivery method and delivery address, p. 70 for more
information.

Delivery address
Where the messages are sent. See Delivery method and delivery address, p. 70 for more
information.

In addition, a notification profile entry can include a comment (text that InfoPrint will add to the general
message text) and a locale (to set the language that the message will be sent in). Comments are
optional. If you do not specify a locale, InfoPrint delivers messages using the locale (language) that the
user is running.

Some objects need only one entry in their notification profiles. For example, when a person submits a
job, he is probably the only one who needs to receive information about it, and he will probably be
content to have all of the messages about that job delivered the same way.

For other objects, there are very good reasons to have multiple entries. For example:

• If operators manage printers from more than one workstation, you can create an entry for each
workstation. That way, all of the messages go to all of the machines.

• If operators can address some messages (like destination-needs-attention), but an administrator
needs to address others (like object-deleted), you can create an entry for each operator and one
for the administrator. Messages are delivered to the person who can handle them.

• If an administrator likes to use InfoPrint Manager Notifications while he's at work, and wants to keep
a more permanent record of how often some events occur, he can set up two entries. One delivers
messages to the InfoPrint Manager Notifications client and one writes certain messages into a file
that he can check periodically.

Event identifiers

The event identifiers component lists the InfoPrint events that trigger notifications. You can find a full list
of InfoPrint notification events and their descriptions in RICOH InfoPrint Manager: Reference. In the
descriptions, you will see what objects each event supports. If you add an event to an object that it does
not support, no messages will ever be generated for that event. For example, you can add the queue-
backlogged event to a notification profile entry for an actual destination, but queue-backlogged only
supports the queue, job, and server objects. As a result, the actual destination notification profile will not
generate any messages about that event.

Using InfoPrint Manager notifications
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That chapter also lists the InfoPrint Manager event classes, or groups of related notification events.
When you add event identifiers to a notification profile, you can add individual events, event classes, or
a combination of the two.

Each type of InfoPrint object has a default set of event identifiers. See Default notification profiles, p. 72
for a list of defaults for each object.

Delivery method and delivery address

The delivery method component shows how you want notification messages to be delivered. The
delivery method and delivery address components are strongly related; the delivery method you
choose determines the type of value you use for the delivery address.

In addition, delivery method and delivery address are the keyed components in notification profile
entries; they are the two values that InfoPrint Manager checks when you modify a notification profile. If
the delivery method and delivery address that you specify match the delivery method and delivery
address of an existing entry, InfoPrint Manager updates that entry. If both values do not match any of
the existing entries, InfoPrint Manager adds a new entry to the profile.

There are various delivery methods defined for InfoPrint objects. All methods are valid for all objects
except for job-log; job-log is only valid for jobs. InfoPrint notification delivery method characteristics,
p. 70 lists the delivery methods, along with descriptions and how to set the delivery address for each
type.

Two other delivery methods, sapcb and sapconnect exist, but they are only used internally with the
InfoPrint Manager SAP Print Feature. You should never use either of those values in a notification profile
entry.

IInnffooPPrriinntt nnoottiiffiiccaattiioonn ddeelliivveerryy mmeetthhoodd cchhaarraacctteerriissttiiccss

Delivery Method Description Delivery address
message

Message is the default
delivery method for all
objects.

Sends a message to the InfoPrint
Manager notification server, where
it waits for an InfoPrint Manager
Notifications client to pick it up.
Once a message is picked up, it is
deleted from the notification server;
there are no further records of that
message.

The delivery address listed in the
notification profile can be
whatever you want it to be– a user
id, office number, IP address,
driver's license number– as long
as it is unique. To receive
messages sent to that address, you
must set the delivery address listed
in the Settings dialog in the
InfoPrint Manager Notification
client to the same value. The
InfoPrint Manager Notifications
client will only pick up messages
that specify an identical delivery
address.

electronic-mail
(synonyms: e-mail,
email)

Sends an e-mail to the address listed
in the delivery address.

The e-mail address that you want
notification messages to be sent to.
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Delivery Method Description Delivery address

To use the e-mail delivery method,
you must also set the smtp-server-
host atttribute on your InfoPrint
Manager server to the IP address or
DNS hostname of the system that
your SMTP mail server runs on.

For example, kjones@printerco.
com.

exit Does not actually send a message.
Instead, when the event specified in
the event identifier occurs, InfoPrint
Manager runs an exit program or
script. See Using the 'exit' delivery
method, p. 72 for more information.

The full path to the notification exit
program or script (with hard-
coded arguments, if any).

wireless Sends notifications to wireless
devices, such as pagers, cellular
phones, palm pilots, and laptop
computers.

Because wireless notifications are
delivered as e-mails, you must set
both the smtp-server-host and
the smtp-server-port server
attributes on this InfoPrint server.

If your InfoPrint server is behind a
firewall, you might have to
configure your SMTP server.

file Writes the message in the file you
specify in the delivery address. If the
file does not exist, InfoPrint
Manager will create it. If the file
does exist, InfoPrint Manager will
overwrite it the first time it writes a
message. After that, messages are
added to the end of the file.

The directory path and name of
the file that you want to write your
notification messages in. This file
must be on the same system as
your InfoPrint Manager server.

file-add-to Adds the message to the end of the
file you specify in the delivery
address. If the file does not exist,
InfoPrint Manager will create it.

The directory path and name of
the file that you want to write your
notification messages in. This file
must be on the same system as
your InfoPrint Manager server.

job-log

Valid only for jobs.

Writes messages into the job-log
attribute of the job. If the job is
deleted, the job log is also deleted.
To see the messages, enter the pdls
command for the job-log attribute
on the job you want to know about;
or, on the InfoPrint Manager
Administration Interface, go to Job
→ View Log.

No value needed.

none Does not send any notifications;
turns notification off.

No value needed.
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Using the 'exit' delivery method

The exit delivery method lets you set up automatic responses to system events beyond just sending a
message. When you set the delivery method for a given event to exit, you use the delivery address to
specify the explicit path to a script or program on your system. Whenever that event occurs, InfoPrint
Manager runs the script or program you specify.

For example, if the InfoPrint Manager server runs low on disk space, the disk-space-low event
generates a message for the system administrator. The administrator then has to do something to clean
up the disk so InfoPrint Manager can continue to run effectively. However, using the exit delivery
method can automate that process by launching a "disk clean up" script. The administrator can still
receive the message, but will know that the script is already working on the problem.

If you are using the Print Optimizer DSS, InfoPrint Manager provides a sample script called
poexitcleanup that you can use with the exit delivery method. The script demonstrates one way that
you can automate cleaning up disk space in the Print Optimizer resource filesystem after the disk-
space-low event occurs.

By default, when you use the exit delivery method, InfoPrint Manager only passes two values along to
the script or program: the message number of the event that occurred and the text of the message. As a
result, the command line that the exit delivery method executes is composed of the path that you
specified in the delivery address, the last three digits of the message number, and the text of the
message.

Therefore, if you create a notification profile entry for the job-completed event, setting the delivery
method to exit and the delivery address to c:\Infoprint\exits\myscript, when a job finishes
printing, InfoPrint Manager will generate and execute a command line similar to this one:

c:\Infoprint\exits\myscript 280 "5010-280 Finished processing job ofc,
Job 20 (3520800004)."

The scripts or programs you write might require other information, such as the destination name or the
printer model. To pass those values, you can include them in the delivery address of the notification
profile entry; they will be added to the end of the command line when InfoPrint Manager creates it.

The program run by a notification profile with the "exit" delivery method runs under InfoPrint Manager,
which is running as a Windows service and does not have access to the desktop. Because of this, the
notification method of "exit" does not allow a delivery address that requires a windowed program to be
used, such as notepad.exe.

Default notification profiles

By default, the person who creates an object (server, destination, queue, job) receives the notification
messages about that object. The default notification profile settings provide information such as object
status, error conditions, or configuration changes. Some of these events require the person managing
the object to intervene; for example, someone might need to clear a paper jam.

By default, the events listed in this table generate messages for the corresponding objects. These
messages are delivered to the user who created the object: job submitters receive messages about their
print jobs; the administrator receives messages about destinations and servers that he or she created.
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The default delivery method is message, so the notifications are sent to the InfoPrint Manager
Notification client on the system that the person used to create the object.

DDeeffaauulltt nnoottiiffiiccaattiioonn pprrooffiillee sseettttiinnggss

Object Events

Actual destination destination-needs-administrator

destination-needs-attention

destination-needs-operator

destination-timed-out

object-cleaned

object-deleted

Default Job No defaults set. See Using notification profiles
with default jobs, p. 74 for more information.

Job destination-needs-attention

destination-needs-operator

destinations-not-ready-for-job

document-aborted-by-destination

document-aborted-by-server

document-cancelled-at-destination

job-aborted-by-server

job-cancelled-by-operator

job-cannot-be-scheduled

job-completed

past-discard-time

Logical destination object-cleaned

object-deleted

Queue object-cleaned

object-deleted

queue-backlogged

Server internal-server-error

low-on-memory

memory-exhausted

object-cleaned

object-deleted
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out-of-disk-space

out-of-dpf-haids

out-of-dpf-job-numbers

out-of-dpf-raids

sapcbd-down

sapconnectd-down

server-shutdown-complete

Determining how much notification administrators, operators, and job submitters require takes some
planning and, as you familiarize yourself with InfoPrint, you should discover when you require more or
less notification. You can start by using the defaults and see how many and what kind of messages you
receive. To send more or less notification, to modify which users receive notifications, or to send
messages using a different delivery method, you can change the notification profiles.

Using notification profiles with default jobs

When someone submits a print job, InfoPrint Manager sends messages about that job based on a
default notification profile. As a result, the delivery method is message, the delivery address is "the user
ID of the person who submitted the job @ the address of the system the job was submitted from," and the
event identifiers are those listed in Default notification profile settings, p. 73. (If you submit jobs using
InfoPrint Select, the default notification profile is different. See the “Working with InfoPrint Select
Notifications” section in RICOH InfoPrint Manager for Windows: Getting Started for additional information.)

To change the settings in the default notification profile, you can create a notification profile on a default
job. There are several things to keep in mind when you set up a notification profile on a default job:

• You can only set one default job on each logical destination. As a result, all of the jobs will use the
same notification profile.

• If you set a delivery address in the notification profile for the default job, all messages will go to that
address. However, if you leave the delivery address blank, InfoPrint Manager will fill it in with the
address that the job was submitted from (you can't specify this address; it is sent with the job). This
option only works with the message and e-mail delivery methods and is the only time that the
notification profiles are merged.

• If you submit a job with an explicit notification profile (for example, by including the notification-
profile attribute when you submit a job using pdpr), that profile overrides the one set in the default
job.

If you submit jobs using InfoPrint Select, an explicit notification profile is sent with every job. To use a
notification profile on a default job with InfoPrint Select, see the “Working with InfoPrint Select
Notifications” section in RICOH InfoPrint Manager for Windows: Getting Started for information about
overriding Select notifications.
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Changing notification profiles

For jobs, default jobs, servers, queues, and actual destinations

You can use the properties notebooks in the InfoPrint Manager Administration GUI to change
notification profiles for jobs, default jobs, servers, queues, and actual destinations. Open the properties
notebook and click Notification for an actual destination, a job, or a default job. For a server, click
Other. On the page that opens, you can see the notification profile entries that already exist, including:

• How messages about that object are delivered

• Who they are sent to

• What events generate messages

• Any comments that are included with the messages

Use the Add,Modify, and Delete buttons to make changes to the notification profile. See the online
help for the InfoPrint Manager Administration GUI for additional information. You can also change
notification for jobs in the InfoPrint Manager Operations GUI.

If you change the delivery method, make sure you change the delivery address appropriately.

For logical destinations

The only way to change a notification profile for a logical destination is to use the pdset command. The
procedures below provide examples of some common modifications you might want to make. You can
use these procedures to change the notification profiles for other InfoPrint objects as well, but you might
find it easier to use the properties notebooks in the InfoPrint Manager Administration GUI.

This procedure describes how to modify notification profiles by:

• Adding or modifying events or users in a notification profile , p. 76

• Removing users from a notification profile , p. 78

• Changing the delivery method, p. 79

If you need to change other parts of a notification profile, see the RICOH InfoPrint Manager: Reference for
information on the pdset command and the notification-profile attribute.

Using InfoPrint Manager notifications



1

76

When you modify a notification profile, InfoPrint Manager compares the new delivery method and
delivery address to the delivery methods and delivery addresses in the existing entries and behaves
accordingly:

• If you specify both of the values and both match the values in an existing entry, the modification
replaces that entry.

• If you only specify one of the values, InfoPrint Manager fills in the other value with the default
values. Then, it checks to see if any of the existing entries match that combination. If they match,
InfoPrint Manager replaces that entry. If they do not match, InfoPrint Manager creates a new entry.

• If you specify both values but only one matches, InfoPrint Manager creates a new entry.

• If you specify both values and neither one matches, InfoPrint Manager creates a new entry.

When you delete a notification profile entry, the delivery method and delivery address in your
command must match those in an existing entry exactly.

Viewing an existing notification profile

To see what values are set for a notification profile, follow these steps.

1. Open a DOS window on the computer that your InfoPrint Manager server is installed on. On
Windows systems, click the Windows Start button and select Programs→ Accessories→
Command Prompt.

2. Type this command. Fill in the values for the italicized items as defined below.

pdls -c Type of InfoPrint object -r notification-profile Objectname

Type of InfoPrint object
What type of object you want to perform this command on, not the specific object. For
example, type destination not printer1-ld.

Objectname
The name of the destination or queue that this notification profile refers to.

3. Press Enter.

The notification profile will be displayed.

If you have messages about a particular object sent to more than one person, the notification profile will
display multiple entries, one for each person.

Adding or modifying events or users in a notification profile

To add or remove events in the notification profile for a particular delivery address, or to add another
entry to the notification profile so that messages will be sent to another address as well, do this
procedure:
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1. Open a DOS window on the computer that your InfoPrint Manager server is installed on. On
Windows systems, click the Windows Start button and select Program —> Accessories —>
Command Prompt.

2. Type the this command. Fill in the values for the italicized items as defined below.

pdset -c Type of InfoPrint object-x “notification-profile+={event-
identifiers= event(s) delivery-method= method
delivery-address=”address“}” Objectname

Type of InfoPrint object
What type of object you want to perform this command on, not the specific object. Type
destination, queue, job, or server.

event-identifiers
The events that cause InfoPrint Manager to send a message. You can have messages sent for
any of the events that are listed in the events-supported attribute for the server. See the RICOH
InfoPrint Manager: Reference, InfoPrint object attributes chapter, section Attributes for Servers:
events-supported, for a list of these values. Not all events support all objects. See the
Notification events and event classes chapter in the RICOH InfoPrint Manager: Reference for lists of
what objects each event supports.

You must type all of the events for this object that you want the user specified in the delivery
address to receive, even if they already appear in the notification profile. Any events that you
do not type will not be listed in the notification profile.

delivery-method
How you want messages to be sent. See InfoPrint notification delivery method characteristics,
p. 70 for information about the various delivery methods.

delivery-address
Where you want to have messages sent. See InfoPrint notification delivery method
characteristics, p. 70 for information about what kinds of delivery address value to use with
each delivery method. Enclose the value in double quotes.

You cannot specify more than one delivery address here. If you want another user to receive
messages about the same (or different) events, finish this procedure, then enter the command
again with that user's delivery address.

Objectname
The name of the destination or queue that this notification profile refers to.

3. Press Enter.

4. Repeat the process for other users and objects.

Example

The default notification profile for queues is set to send you messages when the queue-backlogged,
object-cleaned, and object-deleted events occur. You need to change the notification profile for the
print queue printer1-q so that you receive messages when the queue-no-longer-backlogged and
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queue-state-changed events occur as well. Your backup person does not currently receive any
messages about queues, but needs to receive all of the same messages you do.

Issue this command to change your notification profile. Remember to list the event-identifiers for all of
the events that you want this user to receive notifications about. This list of event-identifiers replaces the
existing list entirely.

pdset -c queue -x “notification-profile+={event-identifiers=
object-cleaned object-deleted queue-backlogged
queue-no-longer-backlogged queue-state-changed
delivery-address=”administrator@mydesk.office.com“}”
printer1-q

Then, enter this command to have the same queue messages sent to your backup person.

pdset -c queue -x “notification-profile+={event-identifiers=
object-cleaned object-deleted queue-backlogged
queue-no-longer-backlogged queue-state-changed
delivery-address=”backup@hisdesk.office.com“}” printer1-q

Use the Viewing an existing notification profile, p. 76 procedure to make sure the changes took effect.

Removing users from a notification profile

To remove an entire entry from a notification profile, follow this procedure:

1. Open a DOS window on the computer that your InfoPrint Manager server is installed on. On
Windows systems, click the Windows Start button and select Program —> Accessories —>
Command Prompt.

2. Use the Viewing an existing notification profile, p. 76 procedure to find the entry you want to
remove.

3. Type the following command. Type the correct delivery-method and the delivery-address
exactly as it is displayed for the entry that you want to remove.

pdset -c Type of InfoPrint object -x "notification-profile-={delivery-method=
electronic-mail or message delivery-address=“address”}"Objectname

4. Press Enter.

5. Use the Viewing an existing notification profile, p. 76 procedure to verify that the entry has been
removed.

6. Repeat the process for other entries.

Example

You and two other people currently receive messages about the logical destination printer1-ld. You do
not want to receive them any longer. You view the notification profile, and see these three entries:

printer1-ld: notification-profile=

{event-identifiers = object-cleaned object-deleted delivery-method =
message delivery-address = “admin@desk1.office.com” locale = en_US}

{event-identifiers = object-cleaned object-deleted delivery-method =
message delivery-address = “helpdesk@desk2.office.com” locale = en_US}
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{event-identifiers = object-cleaned object-deleted delivery-method =
message delivery-address = “backup@desk3.office.com” locale = en_US}

Enter this command to remove your entry from the notification profile.

pdset -c destination -x "notification-profile-={delivery-method=
message delivery-address = “admin@desk1.office.com”}" printer1-ld

If you display the notification profile to verify that the entry has been removed and find that it has not
been removed, enter the command again, but this time instead of only specifying the delivery-
address, type the entire notification profile exactly as it appears.

Changing the delivery method

You can choose to receive your notification messages in a variety of ways, as listed in InfoPrint
notification delivery method characteristics, p. 70. To change the delivery method from the default to
another value, follow this procedure:

1. Open a DOS window on the computer that your InfoPrint Manager server is installed on. On
Windows systems, click the Windows Start button and select Program —> Accessories —>
Command Prompt.

2. Use the Viewing an existing notification profile, p. 76 procedure to find the entry you want to
change.

3. Type the following command. Fill in the values for the italicized items exactly as they appear in
the entry you want to change. Replace the delivery-method and delivery-address values as
specified in InfoPrint notification delivery method characteristics, p. 70.

pdset -c Type of InfoPrint object -x “notification-profile+=
{event-identifiers=event(s) delivery-method=method
delivery-address=”address“ locale=yourlocale}”Objectname

4. Press Enter.

5. Use the Viewing an existing notification profile, p. 76 procedure to verify that the entry was
added.

6. Follow the procedure for Removing users from a notification profile , p. 78 to remove the old
entry.

Example

You want to receive your messages about printer1-q in your E-mail instead of through InfoPrint
Manager Notifications. You view the notification profile, and see this entry:

printer1-q: notification-profile={event-identifiers =
object-cleaned object-deleted queue-backlogged delivery-method =
message delivery-address = “admin@desk1.office.com” locale = en_US}

Enter this command to add another entry to the notification profile with a different delivery method and
delivery address.

pdset -c queue -x “notification-profile+={event-identifiers=
object-cleaned object-deleted queue-backlogged delivery-method=
electronic-mail delivery-address=”admin@mycompany.com“
locale=en_US}” printer1-q
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Then view the notification profile, p. 76 again and see two entries:

printer1-q: notification-profile= {event-identifiers = object-cleaned
object-deleted queue-backlogged delivery-method = message delivery-address
= “admin@desk1.office.com” locale = en_US} {event-identifiers =
object-cleaned object-deleted queue-backlogged delivery-method =
electronic-mail delivery-address = “admin@mycompany.com” locale = en_US}

Follow the procedure for removing a user, p. 78 to delete the entry that would send messages to
InfoPrint Manager Notifications.

Getting help for notification messages

If you receive a notification message that you do not understand, InfoPrint Manager provides a way to
get more information about the situation. In some cases, the explanation even suggests some things you
can do to resolve the problem.

To see the full text of an error message, open the Management Console and select Help→Message
Help. Type the message code in the fields at the top of the Message Help dialog, and click OK.

Other notification methods

Notify-operator attribute

The notify-operator attribute is a scaled-down version of a notification profile. It can only be set on
InfoPrint Manager queues and actual destinations and can only use the e-mail, message, exit and
wireless delivery methods. In addition, it only sends messages when one of these events occur.

1. A job is added to a queue.

2. An actual destination starts processing a job.

3. An actual destination finishes processing a job.

The syntax of the notify-operator attribute is:

delivery-method:delivery-address

See InfoPrint notification delivery method characteristics, p. 70 for descriptions of the e-mail and
message delivery methods and their corresponding delivery addresses. By default, the notify-operator
attribute is set to message:your user ID@your node when you create an actual destination or a queue.
To change the value for an actual destination, you can use the Notification tab of the properties
notebook. To change the value for a queue, use the pdset command.

The messages that the notify-operator attribute delivers are not standard error messages like the ones
you receive when you use a full notification profile. Instead, you write the messages that you want to
send and specify them as attributes of jobs when you submit them.

You must either specify those attributes in the command when you submit the job or set the text in the job
and document defaults for the appropriate logical destination.
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The job attributes that you use to specify these messages are the following.

• job-message-to-operator
The message that InfoPrint Manager sends when it adds a job to the queue.

• job-start-message
The message that InfoPrint Manager sends when the job starts processing.

• job-end-message
The message that InfoPrint Manager sends when the job finishes processing.

You can type the text for all three of these messages in the appropriate field on the Job Notification
tab of the properties notebook for a job or a default job.

In addition, you can use the job-start-message attribute in conjunction with the job-start-wait
attribute. If you set the job-start-wait attribute on a job (or in a default job) to true, the actual
destination receives the job and sends the job-start message. Then, it pauses the actual destination
(whether or not a job is currently being printed) until the operator intervenes. This function is useful when
different jobs need to be printed on different types of paper. Operators do not need to manually pause
the actual destination to change paper between jobs; InfoPrint Manager does it automatically. Once the
printer is ready, the operator must resume the actual destination and the job prints. This function should
be set for the first in a series of jobs, once you are certain that there are no jobs printing on the printer.
Because it compels InfoPrint Manager to pause the printer for every job with job-start-wait=true,
you should not specify this value on the default job.

To use the job-start-wait attribute, you must set it to yes on the job or default job. You can specify the
attribute in the command when you submit a print job or set it on the Job Notification tab of the
properties notebook for default jobs.

UUssiinngg PPSSFF DDSSSS uusseerr--eexxiitt pprrooggrraammss
This section describes the sample PSF DSS user-exit programs supplied with InfoPrint Manager and
shows how you can create your own PSF DSS user-exit programs. These user-exit programs apply to
printers connected to InfoPrint Manager through the PSF device support subsystem (DSS).

This chapter contains these topics:

• Supported types of PSF DSS user-exits, p. 82

• Sample PSF DSS user-exit programs, p. 82

• Creating and using your own PSF DSS user-exit programs, p. 84

• Compiling and installing the user-exit program, p. 84

• The header page and trailer page user-exit programs, p. 90

• Accounting, post-print accounting, and audit user-exit program inputs and outputs , p. 92

• Input data user-exit program inputs and outputs, p. 95

• Ouput data user-exit program inputs and outputs, p. 98

• Structure of a user-exit program, p. 98

• User-exit programs for the line data transform, p. 99

• Attributes of the line data input file, p. 107

• Using the uconv command to convert coded character sets, p. 108
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Supported types of PSF DSS user-exits

InfoPrint Manager supports dynamically loaded user-exit programs. These programs are loaded with
InfoPrint Manager during initialization and are called at various points during job processing.

InfoPrint Manager allows eight different types of PSF DSS user exits. InfoPrint Manager calls the exits in
this order:

• Header (Start) page user exit

• Separator page user exit

• Input data user exit

• Output data user exit

• Accounting user exit

• Audit user exit

• Trailer (End) page user exit

• Post-print accounting user exit

InfoPrint Manager user-exit program order at the printer

Sample PSF DSS user-exit programs

InfoPrint Manager supplies sample PSF DSS user-exit programs for the header, separator, and trailer
pages, for accounting and audit data, and for post-print accounting data. The sample header,
separator, and trailer page user-exit programs generate Advanced Function Presentation (AFP) data
stream pages. The sample accounting and audit user-exit programs generate ASCII data in a report file
format or write to a log file. The sample post-print accounting user-exit program only writes to a log file.
InfoPrint Manager also supplies sample user-exit programs for input data and output data; however,
these user-exit programs do not perform any function. You can use all of these sample programs as they
are or you can modify them.

If you choose to modify the existing user-exit programs, the source code for each one is located in the
install_path\exits\psf directory. The install_path is the directory that InfoPrint Manager is installed in. If
you do not know the install path, you can find it in theManagement Console. Open the Management
Console, click Edit→ Change Service Configuration and find the Install path field.

The next table lists the sample user exit programs supplied with InfoPrint Manager.
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SSaammppllee uusseerr--eexxiitt pprrooggrraammss

Type of user exit File Name Description

Header Page ainuxhdr.c Generates brief style start sheet.

ainuxhdr2.c Generates full style start sheet.

ainuxhdrp.c Generates start sheet with job
ticket information.

ainuxhdrx.c Generates start sheet without
vertical lines.

pduxblkh.c Generates a blank start sheet.

Separator Page ainuxsep.c Generates brief style separator
sheet

ainuxsep2.c Generates full style separator
sheet.

ainuxsepp.c Generates separator sheet with
job ticket information.

ainuxsepx.c Generates separator sheet
without vertical lines.

pduxblks.c Generates a blank separator
sheet.

Trailer Page ainuxtlr.c Generates brief style end sheet.

ainuxtlr2.c Generates full style end sheet.

ainuxtlrp.c Generates start sheet with job
ticket information.

ainuxtlrx.c Generates end sheet without
vertical lines.

pduxblkt.c Generates a blank end sheet.

Accounting ainuxacc.c Generates brief style accounting
sheet.

ainuxacc2.c Generates full style accounting
sheet.

ainacclog.c Generates accounting log
information.

ainuxaccp.c Generates accounting sheet log
with job ticket information.

Post-print Accounting ainuxjobcompletion.c Generates accounting log
information about printed
("stacked") sheets

Audit ainuxaud.c Generates brief style audit
sheet.
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Type of user exit File Name Description

ainuxaud2.c Generates full style audit sheet.

ainuxaudp.c Generates audit sheet with job
ticket information.

ainaudlog.c Generates audit log information.

Input Data ainuxind.c Provides template for writing
your own user-exit program.

Output Data ainuxout.c Provides template for writing
your own user-exit program.

For sample user-exit programs used with the line data transform, see User-exit programs for the line
data transform, p. 99.

Creating and using your own PSF DSS user-exit programs

You can create your own PSF DSS user-exit program at any time; however, you must perform
additional tasks to produce a PSF DSS user-exit executable program. You must have the Microsoft
Visual Studio 2017 Program installed on your InfoPrint Windows server to compile and build user-exit
programs. Be sure to apply the latest service available.

You can create your own user-exit program in one of these ways:

• Copy one of the sample user-exit programs, rename it, and modify it using the Microsoft Visual
Studio 2017 Program.

• Write your own user-exit program. You can include the variable data shown in these sections, for
example, USERID; but InfoPrint cannot process variable data that is not shown in this section.

If you have written any user-exit programs that use ICONV, you must alter them to use UCONV instead.
For more information, see RICOH InfoPrint Manager: Reference.

Compiling and installing the user-exit program

You can only specify one user-exit program for each function name provided by InfoPrint per actual
destination.

The function name of the user exit must be one of these (in uppercase), because that is the entry point in
the module:

• ACCOUNTING

• AUDIT

• JOBCOMPLETION

• HEADER
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• SEPARATOR

• TRAILER

• INDATA

• OUTDATA

Activating the user-exit program

Before you can use the new user-exit program, you must activate the program.

To perform this task from the command line, click the Windows Start button and select Programs→
Command Prompt and complete these steps:

1. Enter this command: ppddllss --cc aauuxx --rr aallll sseerrvveerrnnaammee::, where servername refers to the name of
the server you are using.
This command displays the attributes for all current auxiliary sheet objects available on the server.
You can also view attributes for a specific auxiliary sheet object. For example, to view attributes for
the accounting log, enter this command: ppddllss --cc aauuxx --rr aallll sseerrvveerrnnaammee::aaccccoouunnttiinngg--lloogg

2. Use the pdset command to change the values of any of the auxiliary sheet objects, as necessary.

From the InfoPrint Manager Administration GUI, you must select the printer that you want to
associate with an auxiliary sheet (in this case, prt1) and then use the Printer→ Properties menu to
access the Printer Properties notebook. To complete this task, see the online help topic Using auxiliary-
sheet objects in the InfoPrint Manager Administration GUI.

To do this task from the command line, complete these steps.

1. To create a new auxiliary-sheet object, type:

pdcreate -c aux-sh -x psf-exit-prog-name=
fullpath\exit_name server1:auxiliary_sheet_name

2. Shut down the actual destination (in this case, prt1).

pdshutdown -cp prt1

3. Associate this new auxiliary-sheet object (in this case, an audit exit) with the actual destination.

pdset -cp -x dest -x audit-exit=auxiliary_sheet_name prt1
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For the post-print accounting exit, instead of this step you will set the attribute in the accounting
auxiliary sheet object for the actual destination, using this command:

pdset —c auxiliary-sheet —x psf-post-print-accounting-program-name=
fullpath\exit_name servername: accounting-log

By default, the accounting-log auxiliary sheet object is available for all destinations. This object
can point to any combination of the accounting and post-print accounting exits. For example, you
can set either one, both, or neither of these attributes at the same time:

psf-exit-program-name=name of accounting exit
psf-post-print-accounting-program-name=name of post-print
accounting exit

If you want some printers to have different accounting configurations than others, you must create
a new auxiliary sheet object for each configuration.

4. Enable the actual destination (in this case, prt1).

pdenable prt1

User-exit program structures

All input and output variables used in InfoPrint Manager user-exits are defined through either of these
two files:

• The install_path\psf\exits\ainuexit.h file

• The install_path\psf\exits\ainurpt.h file

The ainuexit.h file contains definitions for the header, trailer, separator, accounting, audit, and post-
print accounting exits, while the ainuprt.h file formats data for these executable reporting utilities that
apply to the accounting, audit, and post-print accounting exits:

• Accounting Log

– ainurpt1

– ainurpt2

– ainurpt3

• Audit Log

– ainurpt4

– ainurpt5

– ainurpt6

• Post-print Accounting Log

– ainurpt7

– ainurpt8

– ainurpt9
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These user-exit program structure files are written in the C programming language. The declarations and
statements in these files show the structure of the InfoPrint Manager user-exit programs, which are
imbedded as part of the user-exit program.

Common input and output fields

These fields can be found in the user-exit programs. For a detailed list of input and output fields
according to user-exit, see the install_path\psf\exits\ainuexit.h file. This information can be specified
from:

• Migrated jobs

• MVS Download jobs

• Fields set in the InfoPrint Manager Administration Interface Job and Document Defaults notebook

UserID
Identifies the system user ID of the person who submitted the job.

The Userid field value can be any null-terminated (X'00') character string. You should limit the string
to 10 or less characters.

NodeID
Identifies the name of the system (host). The backend program sets the NodeID.

The Nodeid field value can be any null-terminated (X'00') character string. You should limit the
string to 10 or less characters.

Jobname or Name
Identifies the name of the job. This is the same as the file name in the job.

Job submitters can also specify the job name with the InfoPrint Manager job attribute job-name=
nnaammee or name=nnaammee when they submit a job. If the job name is not specified for files defined as
PCL, PostScript, line data, unformatted ASCII, double-byte character set (DBCS) ASCII, or PDF,
when the job is submitted, InfoPrint creates a temporary file for the transform output. InfoPrint uses
the temporary file name for the job name.

This field value can be any null-terminated (X'00') character string. You should limit the string to 24
or less characters.

SpoolID
Identifies the PSF job ID, which is an integer. InfoPrint Manager sets the SpoolID.

PrinterName
Identifies the first 64 characters of the InfoPrint Manager destination name.

hab
This function is not used.

Date
Identifies the date the job is printed in MM/DD/YY format.

Time
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Identifies the time the job is printed in HH:MM:SS format.

Distribution
Identifies the distribution information provided when the job is submitted.

PagePointer
Points to a buffer containing the header page or trailer page data produced by the exit.

PageSize
Indicates the size of the header page or trailer page data returned by the exit. This field is initially
set to 0 before the exit is called. If no data is generated by the exit, this field remains set at 0.

PageType
Indicates the type of header or trailer page data (if any) that the exit generates. The field is initially
set to 0 (AFP data stream) before the exit is called. Valid values are:

0
AFP data stream

1
ASCII data

Job Completion
Indicates the status returned by the exit. This field is initially set to 0 before the exit is called. Valid
return codes are:

0
Good completion, all done, accept resultant page.

-1
Bad completion, non-fatal error, no page generated.

-5
Bad completion, fatal error. The exit is disabled until you shut down the actual destination.

-8
Bad completion, terminate the current job.

-12
Bad completion: terminate the job and put it in pending state. In addition, InfoPrint disables
the actual destination.

Account
Identifies the account information provided when the job is submitted. The Account field value can
be any null-terminated (X'00') character string. You should limit the string to 20 characters or less.
Job submitters can specify this same information through the account-text document attribute.

Address1
Identifies the first line of address information provided when the job is submitted.
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The Address1 field value can be any null-terminated (X'00') character string. You should limit the
string to 57 or less characters.

Address2
Identifies the second line of address information provided when the job is submitted.

The Address2 field value can be any null-terminated (X'00') character string. You should limit the
string to 57 or less characters.

Address3
Identifies the third line of address information provided when the job is submitted.

The Address3 field value can be any null-terminated (X'00') character string. You should limit the
string to 57 or less characters.

Address4
Identifies the fourth line of address information provided when the job is submitted.

The Address4 field value can be any null-terminated (X'00') character string. You should limit the
string to 57 or less characters.

Account
Identifies the account information provided when the job is submitted.

The Account field value can be any null-terminated (X'00') character string. You should limit the
string to 20 or less characters.

Building
Identifies the building information provided when the job is submitted.

The Building field value can be any null-terminated (X'00') character string. You should limit the
string to 24 or less characters. You can specify this same information through the building-text
document attribute.

Department
Identifies the department information provided when the job is submitted.

The Department field value can be any null-terminated (X'00') character string. You should limit the
string to 24 or less characters. You can specify this same information through the department-text
document attribute.

Passthru
Identifies any other information provided when the job is submitted that will be passed through the
user-exit to the backend program.

These Passthru flags are supported:

class
Identifies the one-character class attribute.

destination
Identifies the one-to 64-character destination attribute.

forms
Identifies the one-to 64-character forms attribute.
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segmentid
Identifies the one-to ten-character segmentation identifier.

ServerJobID
Identifies the job identifier.

The Passthru field value can be any null-terminated (X'00') character string no greater than 1,024
characters.

Programmer
Identifies the programmer information provided when the job is submitted.

The Programmer field value can be any null-terminated (X'00') character string. You should limit
the string to 24 or less characters. You can specify this same information through the programmer-
text document attribute.

Room
Identifies the room information provided when the job is submitted.

The Room field value can be any null-terminated (X'00') character string. You should limit the string
to 24 or less characters. You can specify this same information through the room-text InfoPrint
document attribute.

Title
Identifies the title information provided when the job is submitted.

The Title field value can be any null-terminated (X'00') character string. You should limit the string to
24 or less characters. You can specify this same information through the title-text document
attribute.

LongPrinterName
The full name of the InfoPrint destination.

Because InfoPrint Manager only allows 64 character names, PrinterName and LongPrinterName
are the same.

The header page and trailer page user-exit programs

Because the InfoPrint Manager start page and trailer page user-exit programs require the same inputs
and produce the same outputs, the program descriptions are similar.

The source code (in the C programming language) for the sample header page user-exit programs and
trailer page user-exit programs listed in Sample PSF DSS user-exit programs, p. 82 are located in the
install_path\exits\psf directory. These sample programs generate an AFP data stream page.

The data structures for the header and trailer page user-exit programs are included with the source
code in the install_path\exits\psf\ainuexit.h file. The code for these structures is shown in User-exit
program structures, p. 86.

The declaration of these exits is:
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void HEADER (HEADER_EXITDATA *exitdata)
void TRAILER (TRAILER_EXITDATA *exitdata)

The HHEEAADDEERR__EEXXIITTDDAATTAA and the TTRRAAIILLEERR__EEXXIITTDDAATTAA input/output parameters contain all of the input
and output data needed to communicate between InfoPrint Manager and the user-exit programs.

See Common input and output fields, p. 87 and the ainuexit.h file for explanations of the function and
structure of the various components of this user-exit.

After you create your header page or trailer page user-exit program, you must use the AIX make
command to compile the code (see Compiling and installing the user-exit program, p. 84).

The separator page user-exit program

The InfoPrint Manager separator page user-exit program is called before copies of a job (including the
very first copy) print. This exit is also called before the error messages and the trailer page ( Supported
types of PSF DSS user-exits, p. 82).

The source code (in the C programming language) for the sample separator page user-exit programs
listed on page Sample PSF DSS user-exit programs, p. 82 are located in the install_path\exits\psf
directory. These sample programs generate an AFP data stream page.

The data structures for the separator page user-exit program are included with the source code in the
install_path\exits\psf\ainuexit.h file. The code for these structures is shown in User-exit program
structures, p. 86.

The declaration of this exit is:

void SEPARATOR (SEPARATOR_EXITDATA *exitdata)

The SSEEPPAARRAATTOORR__EEXXIITTDDAATTAA input/output parameter contains all the input and output data needed to
communicate between InfoPrint Manager and the user-exit program.

SeeCommon input and output fields, p. 87 and the ainuexit.h file for explanations of the function and
structure of the various components of this user-exit.

This field is also found in the separator page user-exit program and provides output information:

Copy
Indicates which copy is associated with this call to the exit. Initially set to 1, it increments by one
each time the exit is called. The sample separator page user-exit program generates one separator
page for the first copy and all subsequent copies of the job.

After you create your separator page user-exit program, you must use the AIX make command to
compile the code (see Compiling and installing the user-exit program, p. 84).
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Accounting, post-print accounting, and audit user-exit program inputs and
outputs

The InfoPrint Manager accounting and audit user-exit programs require the same inputs and produce
the same outputs so the program descriptions are the same. The post-print accounting user-exit program
requires more inputs and produces more outputs.

The source code (in the C programming language) for the sample separator page user-exit programs
listed in Supported types of PSF DSS user-exits, p. 82 are located in the install_path\exits
directory.

The sample programs store the data into a file you can access with these executable reporting utilities:

ainurpt1
Provides accounting data for the actual destinations defined, based upon the destination ID.

ainurpt2
Provides accounting data for the actual destinations defined, based upon the userid.

ainurpt3
Provides detailed accounting data for the destinations defined, based upon the particular userid
supplied.

ainurpt4
Provides audit data for the actual destinations defined, based upon the destination ID.

ainurpt5
Provides audit data for the actual destinations defined, based upon the userid.

ainurpt6
Provides detailed audit data for the actual destinations defined, based upon the particular userid
supplied.

ainurpt7
Provides post-print accounting data stored in jobcompletion.log, sorted by actual destination.

ainurpt8
Provides summary post-print accounting data stored in jobcompletion.log, sorted by job submitter.

ainurpt9
Provides detailed entries of times and pages printed for a specific job submitter in jobcompletion.
log.

The source code for these reporting utilities is also located in the install_path\exits\psf directory.

These executable reporting utilities are located in the install_path\bin folder. By specifying these
executable reporting utilities at the DOS command line, you can display data by either destination ID or
userid. For example, to report on print requests submitted by a specific user to a actual destination for
which the accounting user exit has been activated, you can specify ainurpt3 and then provide the
userid to the program.
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You must activate these exits to generate the log files used by these report programs. For more
information about activating these exits, see Activating the user-exit program, p. 85.

The data structures for the accounting, audit, and post-print accounting user-exit programs are included
with the source code in the install_path\exits\psf\ainuexit.h and install_path\exits\paf
\ainurpt.h files. The code for these structures is shown in Structure of a user-exit program, p. 98.

The declarations of these exits are:

void ACCOUNTING (ACCOUNTING_EXITDATA *exitdata)
void AUDIT (AUDIT_EXITDATA *exitdata)
void JOBCOMPLETION (JOBCOMPLETION_EXITDATA *exitdata)

The ACCOUNTING_EXITDATA, AUDIT_EXITDATA, and JOBCOMPLETION_EXITDATA input and
output parameters contain all the input and output data needed to communicate between InfoPrint and
the user-exit programs.

The ACCOUNTING_EXITDATA, AUDIT_EXITDATA, and JOBCOMPLETION_EXITDATA structures
include these fields.

To build the executable program, you must use the Microsoft Visual Studio 2017 Program, pull-down
menu.

Fields that provide information for accounting, audit, and post-print accounting
user-exit programs

These fields are also found in the accounting, audit, and post-print accounting user-exit programs.

Pages Printed (accounting and audit user-exit only)
Shows the total number of impressions processed for this job.

Bin One Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from the primary bin.

Bin Two Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from bins other than the primary bin.

User Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked pages in the user print file. It does not include system pages, such
as the header page, in the count.

User Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked sheets in the user print file. It does not include system pages, such
as the header page, in the count.

Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of pages stacked for this job by bin.

Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of sheets stacked for this job by bin.
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Data Object Resources
Shows the total number of Data Object Resources, which can consist of PDF pages, IOCA images,
and Encapsulated PostScript (EPS) files, used in this job. Data Object Resources are also known as
presentation-object containers (for more information, see the presentation-object-container
attributes in RICOH InfoPrint Manager: Reference).

The counters do not include resources contained in the input file. The counters only include resources
used before the accounting or audit user-exit is called. Therefore, the resources required for printing
error messages and the trailer page do not appear in the resource totals.

Job Copies Requested (post-print accounting user-exit only)
Shows the total number of results-profile job copies requested in the job.

Fonts used
Shows the total number of fonts used in this job.

The counters do not include resources contained in the input file. The counters only include resources
used before the accounting or audit user-exit is called. Therefore, the resources required for printing
error messages and the trailer page do not appear in the resource totals.

Overlays used
Shows the total number of overlays used in this job.

The counters do not include resources contained in the input file. The counters only include resources
used before the accounting or audit user-exit is called. Therefore, the resources required for printing
error messages and the trailer page are not included in the resource totals.

Segments used
Shows the total number of page segments used in this job.

The counters do not include resources contained in the input file. The counters only include resources
used before the accounting or audit user-exit is called. Therefore, the resources required for printing
error messages and the trailer page are not included in the resource totals.

ExtStart Date
Identifies the date the job started processing.

Start Date
The date the job started processing.

Start Time
The time the job started processing.

ExtStop Date
The date the job finished processing.
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Stop Date
The date the job finished processing.

Stop Time
The time the job finished processing.

Completion Date (post-print accounting user-exit only)
The date all pages in the job printed and stacked.

If errors or operator commands affect the job so that all pages are not sent to the printer, this field
indicates the time when all pages sent are printed and stacked.

Completion Time (post-print accounting user-exit only)
The time all pages in the job printed and stacked.

If errors or operator commands affect the job so that all pages are not sent to the printer, this field
indicates the time when all pages sent are printed and stacked.

DORU
The data object resources used (DORU) by the exit.

DOFU
The data object fonts used (DOFU) by the exit.

Input data user-exit program inputs and outputs

The InfoPrint Manager input data user-exit program can be used to:

• Monitor the incoming print data stream to InfoPrint Manager

• Discard an input record before it is processed

• Replace an existing input record with one or more records (which might include the original record
or a modified version of the original record)

• Continue processing with the input record unchanged

This exit can be called for all parts of the job (see InfoPrint Manager user-exit program order at the
printer, p. 82).

The input data user-exit program only processes MO:DCA data.

If you are using the exit to insert extra input records, the original input record that is passed to the exit
can be processed before or after the extra input records. This means that the extra input records can be
inserted before or after the current structured field depending on where the current structured field is
placed in the list of structured fields to insert.
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Important considerations

• Code processing becomes an integral part of PSF and can affect performance and reliability.

• User exits should be coded by experienced programmers who are aware of overall system
implications.

• Any delays caused by this exit will translate into a PSF processing delay and could affect printer
performance.

• This exit is not passed any structured fields that are contained in resources that are processed. This
includes: form definitions, overlays, page segments, fonts, data object resources, internal medium
maps, and data object fonts.

• Code processing must be able to handle PSF repositioning.

Repositioning might occur as a result of errors or operator commands. PSF might reposition items
forward into the print job, skip structured fields, or reposition items back into previously processed data.
If PSF repositions back into the print file, it is the responsibility of the exit to return the same data in the
same sequence to PSF, just as it did when the structured field was originally passed to the exit.

Because of the constraints outlined above, you should first consider using the transform subsystem to
process data, because the transform subsystem does not have these limitations. For example, a
transform object would have access to all of the input data (no restrictions) and could add, delete, and
modify both resources and pages. In addition, the transform subsystem processing is performed before
printing begins, so it would have no impact on printer performance or behavior.

The Input Data User Exit is not capable of identifying individual document boundaries in a data stream.
For example, your job might have 5 separate documents that each contain 10 pages of data. This is
viewed by the exit as 50 pages of data, not 5 units of 10. The transform subsystem does not have this
limitation.

The PSF Input Record Exit is responsible for managing any memory it allocates. It can reuse the memory
across calls through the use of a work area pointer provided in aaiinnuueexxiitt..hh. PSF does not free any
memory that might be pointed to by fields in either the INDATA_EXITDATA structure or the
PSFINSERTRECS structure. The exit can point to memory that it has defined or allocated. The exit can
reuse allocated memory or free memory when it is appropriate. PSF might run out of memory if the PSF
Input Record Exit mismanages memory.

The source code (in the C programming language) for the sample input data user-exit program listed on
page Sample PSF DSS user-exit programs, p. 82 is in the install_path\exits\psf\ainuxind.c. This
sample program consists of a return code and performs no function.

The data structures for the input data user-exit program are included with the source code in the install_
path\exits\psf directory.

The declaration of this exit is:

void INDATA (INDATA_EXITDATA *exitdata)

The INDATA_EXITDATA input/output parameter contains all of the input and output data needed to
communicate between InfoPrint Manager and the user-exit program.

The INDATA_EXITDATA structure includes these fields. These fields provide input information:

version
This variable was formerly called reserved1. It is designed for use as a migration aid for future
variants of this exit. It contains a version identifier for this structure:
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• X'00'= previous version (before August, 2005)

• X'01'= August, 2005 version adding support for deletion and insertion of input records

Copy
Indicates which copy is associated with this call to the exit. Initially set to 1, it increments by one
each time the exit is called.

DataSize
Contains the length of the input data record

DataPointer
Points to the input data record to be processed.

DataType
Always set to 0 (AFP; MO:DCA data only).

If the exit is being called to indicate end of job processing:

• DataSize is set to 0,

• DataPointer is set to NULL

• DataType is set to 0 — no record is passed in at that time

The PSFINSERTRECS structure contains information about a structured field that is to be inserted at the
request of the Input Data Exit. The PSFINSERTRECS structure contains these fields:

version
Version identifies to PSF the version of the PSFINSERTRECS structure that is being supplied. The exit
must supply a value of 0x01 or the record (including the next_p pointer) is ignored.

next_p
Contains the pointer to the next record to insert.

record_p
Contains the pointer to the MO:DCA (AFP) structured field to be inserted.

Important

See more data definitions and comments in the aaiinnuueexxiitt..hh source file located in install_path\exits
\psf.

The input information fields used by some of the sample programs are available through the alternate
sample user exits. InfoPrint Manager does not provide an alternate Input Data User Exit.
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Ouput data user-exit program inputs and outputs

The InfoPrint output data user-exit program is used to monitor the outgoing print data stream from
InfoPrint. This exit is called at the end of the job before the error messages and the trailer page. The
input and output data exits are one-directional, that is, it can read the data but cannot alter it.

The source code (in the C programming language) for the sample input data user-exit program listed in
Supported types of PSF DSS user-exits, p. 82 is in the install_path\exits\psf\ainuxout.c file.
This sample program consists of a return code and performs no function.

The data structures for the output data user-exit program are included with the source code in the
install_path\exits\psf\ ainuexit.h file. The code for these structures is shown in Structure of a
user-exit program, p. 98.

The declaration of this exit is:

void OUTDATA (OUTDATA_EXITDATA \exitdata)

The OUTDATA_EXITDATA input/output parameter contains all the input and output data needed to
communicate between InfoPrint and the user-exit program.

To build the executable program, you must use the Microsoft Visual Studio 2017 Program pull-down
menu.

These fields are also found in the output data user-exit program:

Copy
Indicates which copy is associated with this call to the exit. Initially set to 1, it increments by one
each time the exit is called.

DataSize
Indicates the number of bytes in the buffer.

DataPointer
Points to a buffer containing the outgoing print data stream.

Structure of a user-exit program

All input and output variables used in InfoPrint user exits are defined through either of these two files:

install_path\exits\psf\ainuexit.h

or

install_path\exits\psf\ainurpt.h

The ainuexit.h file contains definitions for the header, trailer, separator, accounting, audit, and post-
print accounting exits, while the ainurpt.h file formats data for these executable reporting utilities:

• Accounting Log – (ainurpt1; ainurpt2; ainurpt3)

• Audit Log – (ainurpt4; ainurpt5; ainurpt6)
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• Post-print Accounting Log – (ainurpt7; ainurpt8; ainurpt9)

These user-exit program structure files are written in the C programming language. The declarations and
statements in these files show the structure of the InfoPrint PSF user-exit programs, which are imbedded
as part of the user-exit program.

User-exit programs for the line data transform

InfoPrint provides several sample user-exit programs for the line-data transform. Use of the user exits is
optional. You specify the names of the exit programs with the inpexit, indxexit, outexit, and resexit
keywords.

InfoPrint provides these sample programs:

Input-record user exit

install_path\exits\acif\apkinp.c

Output-record user exit

install_path\exits\acif\apkout.c

Resource exit

install_path\exits\acif\apkres.c

In addition, InfoPrint provides these input-record user exits programs to translate input data streams:

• apka2e, p. 99

• asciinp, p. 100

• asciinpe, p. 100

apka2e

Converts ASCII stream data to EBCDIC stream data.

install_path\exits\acif\apka2e.c

The apka2e input-record exit program translates data that is encoded in one code character set
(CCSID) to another. You should use this exit when your job uses fonts such as GT12, which has code
points that are different from your data file. The default translation is from ASCII (code set 00850) to
EBCDIC (code set 00037) if the INPCCSID and OUTCCSID parameters are not specified on the
line2afp command. INPCCSID specifies the input code page, and OUTCCSID specifies the output
code page.

To execute the apka2e input record exit program, set these keywords and values in your line-data
transform keyword file. The line2afp parmdd keyword identifies the keyword file.

inpexit=install_path\bin\apka2e.dll
cc=yes
cctype=z
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asciinp.c

Converts unformatted ASCII data that contains carriage returns and form feeds into a record
format that contains an American National Standards Institute (ANSI) carriage control
character. This exit encodes the ANSI carriage control character in byte 0 of every record.

install_path\exits\acif\asciinp.c

The asciinp input-record exit program transforms an ASCII data stream into a record format that
contains a carriage control character in byte 0 of every record. If byte 0 of the input record is an ASCII
carriage return (X'0D'), byte 0 is transformed into an ASCII space (X'20') that causes a data stream to
return and advance one line; no character is inserted. If byte 0 of the input record is an ASCII form feed
character (X'0C'), byte 0 is transformed into an ANSI skip to channel 1 command (X'31') that serves as
a form feed in the carriage-control byte.

To execute the asciinp input record exit program, set these keywords in your line-data transform
keyword file. The line2afp parmdd keyword identifies the keyword file:

inpexit=install_path\bin\asciinp.dll
cc=yes
cctype=z

asciinpe.c

Converts unformatted ASCII data into a record format just as asciinp.c does, and then converts
the ASCII stream data to EBCDIC stream data.

install_path\exits\acif\asciinpe.c

The asciinpe input-record exit program combines both of the user input-record exits described above.
To execute, specify inpexit=install_path\bin\asciinpe.dll as the exit program in the keyword
file and follow the directions specified for both apka2e and asciinp.

The asciinpe.c input-record exit program translates data that is encoded in one code character set
(CCSID) to another. You should use this exit when your job uses fonts such as GT12, which has code
points that are different from your data file. The default translation is from ASCII (code set 00850) to
EBCDIC (code set 00037) if the INPCCSID and OUTCCSID parameters are not specified on the
line2afp command. INPCCSID specifies the input code page, and OUTCCSID specifies the output
code page.

While the asciinp and asciinpe input-record exits do not recognize other ASCII printer commands, you
can modify these exits to account for these:

• backspacing (X'08')

• horizontal tabs (X'09')

• vertical tabs (X'0B')

In addition to the information above, see the prolog of the asciinp.c source file that is provided with
InfoPrint Manager in the iinnssttaallll__ppaatthh\\eexxiittss\\aacciiff directory for more information about using
and modifying these programs.

The C language header file for all ACIF exit programs is provided in iinnssttaallll__ppaatthh\\eexxiittss\\aacciiff
\\aappkkeexxiittss..hh along with the build rules for the ACIF user exits in iinnssttaallll__ppaatthh\\eexxiittss\\aacciiff
\\MMaakkeeffiillee.
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To build the executable program, you must use the Microsoft Visual Studio 2017 Program, pull-down
menu.

Input record exit

The line-data transform provides an exit that enables you to add, delete, or modify records in the line-
data input file. The program invoked at this exit is defined by the value of the inpexit keyword of the
line2afp command.

This exit is called after each record is read from the input file. The exit can request that the record be
discarded, processed, or processed with control returned to the exit for the next input record. The
largest record that InfoPrint Manager can process is 32756 bytes. This exit is not called when the line-
data transform is processing resources from directories.

This example provides a sample C language header that describes the control block that is passed to
the exit program:

/*********************************************************************/
/* INPEXIT STRUCTURE */
/*********************************************************************/
typedef struct _INPEXIT_PARMS /* Parameters for input record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char *record; /* Address of the input record */
unsigned short in_CCSID; /* input CCSID for translating @06a*/
unsigned short out_CCSID; /* output CCSID for translating @06a*/
unsigned short recordln; /* Length of the input record */
unsigned short reserved2; /* Reserved for future use */
char request; /* Add, delete, or process the record */
char eof; /* EOF indicator */

} INPEXIT_PARMS;

The address of the control block containing these parameters is passed to the input record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this parameter to save
information across calls (for example, pointers to work areas). The 16-byte work area is aligned on
a full word boundary and is initialized to binary zeros before the first call. The user-written exit
program must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information about the format of this data
structure and the information it contains, see Attributes of the line data input file, p. 107.

record (Bytes 9–12)
A pointer to the first byte of the input record including the carriage control character. The record is in
a buffer that is located in a storage allocated by the line-data transform but the exit program is
allowed to modify the input record.

in_CCSID (Bytes 13-14)
The value from the INPCCSID parameter on the line2afp command.
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out_CCSID (Bytes 15-16)
The value from the OUTCCSID parameter on the line2afp command.

recordln (Bytes 17–18)
Specifies the number of bytes (length) of the input record. If the input record is modified, this
parameter must also be updated to reflect the actual length of the record.

reserved2 (Bytes 19–20)
These bytes are reserved for future use.

request (Byte 21)
Specifies how the line-data transform processes the record. On entry to the exit program, this
parameter is X'00'. When the exit program returns control to line-data transform, this parameter
must have the value X'00', X'01', or X'02', where:

X'00'
Specifies that the line-data transform should process the record.

X'01'
Specifies that the line-data transform should not process the record.

X'02'
Specifies that the line-data transform should process the record and then return control to the
exit program to allow it to insert the next record. The exit program can set this value to save
the current record, insert a record, and then supply the saved record at the next call. After
the exit inserts the last record, the exit program must reset the request byte to X'00'.

A value of X'00' on entry to the exit program specifies that the record be processed. To ignore the
record, change the request byte value to X'01'. If you want the record to be processed, and you
want to insert an additional record, change the request byte value to X'02'. Any value greater than
X'02' is interpreted as X'00', and the exit processes the record.

Only one record can reside in the buffer at any time.

eof (Byte 22)
An end-of-file (eof) indicator. This indicator is a one-byte character code that specifies whether an
eof condition has been encountered.

When eof is signaled (eof value='Y'), the last record has already been presented to the input
exit, and the input file has been closed. The pointer record is no longer valid. Records cannot be
inserted when eof is signaled. These are the only valid values for this parameter:

Y
Specifies that eof has been encountered.

N
Specifies that eof has not been encountered.

This end-of-file indicator allows the exit program to perform some additional processing at the end of
the file. The exit program cannot change this parameter.
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Output record exit

Using the output-record exit, you can modify or ignore the records the line-data transform writes into the
output file. The program invoked at this exit is defined by the outexit keyword of the line2afp command.

The exit receives control before a record (structured field) is written to the output document file. The exit
can request that the record be ignored or processed. The largest record that the exit can process is
32752 bytes, not including the record descriptor word. The exit is not called when the line-data
transform is processing resources.

This example contains a sample C language header that describes the control block passed to the exit
program:

typedef struct _OUTEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute */

/* information */
char *record; /* Address of the record to written */
unsigned short recordln; /* Length of the output record */
char request; /* Delete or process the record */
char eof; /* Last call indicator */

}OUTEXIT_PARMS;

The address of the control block containing these parameters is passed to the output record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this parameter to save
information across calls (for example, pointers to work areas). The 16-byte work area is aligned on
a full word boundary and is initialized to binary zeros before the first call. A user-written exit
program must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information about the format of this data
structure and the information it contains, see Attributes of the line data input file, p. 107.

record (Bytes 9–12)
A pointer to the first byte of the output record. The record is in a 32KB (where KB equals 1024
bytes) buffer. The buffer is located in storage allocated by the line-data transform, but the exit
program is allowed to modify the output record.

recordln (Bytes 13–14)
Specifies the length, in bytes, of the output record. If the output record is modified, this parameter
must also be updated to reflect the actual length of the record.

request (Byte 15)
Specifies how the line-data transform processes the record. On entry to the exit program, this
parameter is X'00'. When the exit program returns control to the line-data transform, this parameter
must have the value X'00' or X'01', where:

X'00'
Specifies that the line-data transform should process the record.
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X'01'
Specifies that the line-data transform should not process the record.

A value of X'00' on entry to the exit program specifies that the record be processed. To
ignore the record, change the request byte value to X'01'. Any value greater than X'01' is
interpreted as X'00'; the exit processes the record.

Only one record can reside in the buffer at any time.

eof(Byte 16)
An end-of-file (eof) indicator. This indicator is a one-byte character code that signals when the line-
data transform has finished writing the output file.

When eof is signaled (eof value='Y'), the last record has already been presented to the output
exit. The pointer record is no longer valid. Records cannot be inserted after eof is signaled. These
are the only valid values for this parameter:

Y
Specifies that the last record has been written.

N
Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, allows the exit program to return control to the
line-data transform. The exit program cannot change this parameter.

Resource exit

The line-data transform provides an exit that enables you to filter (exclude) resources. This exit is useful
in controlling resources at the file-name level. For example, assume you only wanted to use those fonts
that are not shipped with InfoPrint Manager. You could code this exit program to contain a table of all
fonts shipped with InfoPrint and filter those from the resource file. Security is another consideration for
using this exit because you could prevent certain named resources from being included. The program
invoked at this exit is defined by the resexit keyword of the line2afp command.

This exit receives control before a resource is read from a directory. The exit program can request that
the resource be processed or ignored (skipped), but it cannot substitute another resource name in place
of the requested one. If the exit requests that any overlay be ignored, the line-data transform
automatically ignores any resources the overlay might have referenced (that is, fonts and page
segments).

This example contains a sample C language header that describes the control block passed to the exit
program:

/*********************************************************************/
/* RESEXIT STRUCTURE */
/*********************************************************************/
typedef struct _RESEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char resname[8]; /* Name of requested resource (8 byte) */
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char restype; /* Type of resource */
char request; /* Ignore or process the resource */
char eof; /* Last call indicator */
unsigned short resnamel; /* Length of resource name @05A*/
char pad1[3]; /* padding byte @05A*/
char resnamf[250]; /* Rsrc name if more than 8 bytes@05A*/

} RESEXIT_PARMS;

The address of the control block containing these parameters is passed to the resource record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this parameter to save
information across calls (for example, pointers to work areas). The 16-byte work area is aligned on
a full word boundary and is initialized to binary zeros before the first call. A user-written exit
program must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information about the format of this data
structure and the information presented, see Attributes of the line data input file, p. 107.

resname (Bytes 9–16)
Specifies the name of the requested resource. The exit program cannot modify or change this value.

restype (Byte 17)
Specifies the type of resource the name refers to. This is a one-byte hexadecimal value where:

X'03'
Specifies a GOCA (graphics) object.

X'05'
Specifies a BCOCA (barcode) object.

X'06'
Specifies an IOCA (IO image) objec.t

X'40'
Specifies a font character set.

X'41'
Specifies a code page.

X'FB'
Specifies a page segment.

X'FC'
Specifies an overlay.

The line-data transform does not call this exit for these resource types:

Page definition
The page definition (pagedef keyword) is a required resource for transforming a line-data
file.
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Form definition
The form definition (formdef keyword) is a required resource for printing a transformed line-
data file.

Coded fonts
The line-data transform must process coded fonts to determine the names of the code pages
and font character sets they reference. This is necessary in creating Map Coded Font-2
(MCF-2) structured fields.

request (Byte 18)
Specifies how the line-data transform processes the resource. On entry to the exit program, this
parameter is X'00'. When the exit program returns control to the line-data transform, this parameter
must have the value X'00' or X'01' where:

X'00'
Specifies that the line-data transform should process the resource.

X'01'
Specifies that the line-data transform should ignore the resource.

A value of X'00' on entry to the exit program specifies that the resource be processed. To ignore the
resource, change the request byte value to X'01'. Any value greater than X'01' is interpreted as
X'00'and the resource is processed.

eof (Byte 19)
An end-of-file (eof) indicator. This indicator is a one-byte character code that signals when the line-
data transform has written the last record.

When eof is signaled (eof value = 'Y'), the last record has already been presented to the
resource exit. The pointer record is no longer valid. Records cannot be inserted after eof is
signaled. These are the only valid values for this parameter:

Y
Specifies that the last record has been written.

N
Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, returns control to the line-data transform. The exit
program cannot change this parameter.

resnamel
The length of the meaningful characters in field resnamf. In resnamel, the last character is the letter
l.

pad1
A padding byte to place resnamf on a word boundary.

resnamf
An actual name of the resource if it is greater than 8 characters. If the name is 8 characters or less, it
is stored in field resname instead.
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Non-zero return codes

If the line-data transform receives a non-zero return code from any exit program, the line-data transform
issues message 0425-412 and terminates processing.

Attributes of the line data input file

This data structure is provided for informational purposes only.

The line-data transform provides information about the attributes of the line-data input file in a data
structure available to the line-data transform user exits. This example shows the format of this data
structure.

typedef struct_PFATTTR /* Print File Attributes */
{

char cc[3]; /*Carriage controls? — “YES” or “NO” */
char cctype[1]; /*Carriage control type - A(ANSI), */

/*M (Machine), Z (ASCII) */
char chars[20]; /*CHARS values, including commas */

/*(eg.. GT12,GT15) */
char formdef[8]; /*Form Definition (FORMDEF) */
char pagedef[8]; /*Page Definition (PAGEDEF) */
char prmode[8]; /*Processing mode */
char trc[3]; /*Table Reference Characters — “YES” */

/* or “NO” */
} PFATTR;

The address of the control block containing these parameters is passed to the user exits:

cc (Bytes 1–3)
The value of the cc keyword as specified with the line2afp command. The line-data transform uses
the default value (yes) if this keyword is not explicitly specified.

cctype (Byte 4)
The value of the cctype keyword as specified with the line2afp command. The line-data transform
uses the default value (z) for ANSI carriage-control characters that are encoded in ASCII, if this
keyword is not explicitly specified.

chars (Bytes 5–24)
The value of the chars keyword as specified with the line2afp command, including any commas
that separate multiple font specifications. Because the chars keyword has no default value, this field
contains blanks if no values are specified.

formdef (Bytes 25–32)
The value of the formdef keyword as specified with the line2afp command. Because the formdef
keyword has no default value, this field contains blanks if no value is specified.

pagedef (Bytes 33–40)
The value of the pagedef keyword as specified with the line2afp command. Because the pagedef
keyword has no default value, this field contains blanks if no value is specified.
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prmode (Bytes 41–48)
The value of the prmode keyword as specified with the line2afp command. Because the prmode
keyword has no default value, this field contains blanks if no value is specified.

trc (Bytes 49–51)
The value of the trc keyword as specified with the line2afp command. The line-data transform uses
the default value (no) if this keyword is not explicitly specified.

Using the uconv command to convert coded character sets

Starting with InfoPrint Manager for Windows, Version 4 Release 4, iconv was replaced with uconv
and uconv is used with the product as well for translating text strings. uconv also lets you use UTF16
characters for translation.

If you have written any line-data user-exit programs that use iconv, you need to alter them to use
uconv instead.

From a Command Prompt window, you can invoke the uconv command to convert the encoding of
characters read from either standard input or the specified file from one code character set (CCSID) to
another and then write the results to standard output (for example to convert ASCII to EBCDIC). This
command is useful when the line data coded character sets must be changed so they match the coded
character sets for the available font resources for a job. These are often applied for job resources (such
as page definitions and form definitions) that have been created on either an AIX or an z/OS operating
system and sent to Windows.

For more information about the uconv command, see RICOH InfoPrint Manager: Reference.

CCrreeaattiinngg aanndd mmaannaaggiinngg aauuxxiilliiaarryy sshheeeettss aanndd PPSSFF DDSSSS uusseerr--eexxiitt
pprrooggrraammss
Besides logical destinations, queues, and actual destinations, the InfoPrint Windows server also controls
auxiliary-sheet objects. This section contains information and procedures for creating and configuring
these objects.

This section contains these topics:

• Preparing to work with auxiliary sheets, p. 108

• Creating and configuring auxiliary sheet objects, p. 117

• Using Interrupt Message Pages, p. 119

Preparing to work with auxiliary sheets

These topics describe auxiliary-sheet terms, default auxiliary sheets, and PSF DSS user-exit programs
supplied by InfoPrint Manager, and provides examples of printed auxiliary sheets:

• Terms relating to auxiliary sheets, p. 109

• InfoPrint default auxiliary-sheet objects, p. 110
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• Sequence of user-exit programs, p. 115

• Directory locations of user-exit programs supplied with InfoPrint Manager, p. 116

Terms relating to auxiliary sheets

To understand auxiliary sheets and how InfoPrint Manager generates the information that appears on
them, you need to understand these terms:

Auxiliary sheet
Represents a particular sheet of paper, blank or otherwise, that can precede a job, separate copies
of a job, or follow a job. PSF printers print auxiliary sheets. Both Internet Print Protocol (IPP) and
Passthrough printers also print auxiliary sheets, but they do not use auxiliary sheet objects to activate
this support.

Auxiliary-sheet object
Represents a single user-exit program that you can specify for InfoPrint PSF printers. User-exit
programs process information that can be printed on an auxiliary sheet or recorded in an
accounting or audit log. Both the actual destination (PSF printer) and the auxiliary-sheet objects must
reside in the same InfoPrint server.

Some auxiliary sheet objects supplied with InfoPrint Manager generate a file that you can use with
an executable reporting utility to view job statistics. see Gathering accounting and audit data about
print jobs, p. 122 for more information about viewing statistics.

Auxiliary-sheet object name
Identifies the auxiliary sheet object. The names of some of the default auxiliary sheets indicate the
style of the auxiliary sheet: brief, full, or blank.

User exit
A point during print processing when you can tell InfoPrint Manager to run a user-exit program,
then return control of processing to InfoPrint Manager after the user-exit program ends. InfoPrint
Manager provides data at each exit point that can serve as input to the user-exit program. InfoPrint
Manager can use the output from the user-exit program for InfoPrint Manager processing; for
example, a user-exit program can pass instructions about how to format a start sheet to InfoPrint
Manager. InfoPrint Manager provides user exits for these types of auxiliary sheets:

• Start sheet

• End sheet

• Separator sheet

• Accounting log

• Accounting sheet

• Audit log

• Audit sheet

• Input data stream

• Output data stream

• Post-print accounting (log file only)
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User-exit program
Defines the data that prints and creates the format of the auxiliary sheet style. InfoPrint Manager
extends its function by providing user-exit programs that you can use to format start, end, or
separator sheets for the job. Also, InfoPrint Manager user-exit programs allow you to track
accounting and audit information, as well as extract information about the incoming and outgoing
job data streams.

Form definition
Defines the characteristics of the form or printed media, which include: overlays used, the paper
source (for cut-sheet printers), duplex printing, text suppression, and the position of composed-text
data on the form.

For more information about both form definitions, see RICOH InfoPrint Manager: Reference.

Edge marks
Marks that print at the edges of auxiliary sheets and help to identify job boundaries in printed
output.

Interrupt Message Pages
Interrupt Message Pages are pages that are similar to the message pages that print at the end of a
print job, but Interrupt Message Pages are printed at the point of an error where a possible data
loss has occurred. See Using Interrupt Message Pages, p. 119 for more information.

InfoPrint default auxiliary-sheet objects

InfoPrint Manager provides default auxiliary-sheet objects, which it creates when you first create a
server. InfoPrint Manager automatically identifies these as supported values for PSF actual destinations.
The default auxiliary-sheet objects with their associated user-exit programs and form definitions are
shown in Default auxiliary sheet objects, p. 110.

DDeeffaauulltt aauuxxiilliiaarryy sshheeeett oobbjjeeccttss

Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

none n/a InfoPrint
generates no
auxiliary
sheet.

n/a n/a

brief F1A10110 Start sheet ainuxhdr

Separator
sheet

ainuxsep

End sheet ainuxtlr

Accounting
exit

ainuxacc

Audit exit ainuxaud

full F1A10110 Start sheet ainuxhdr2
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Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

Separator
sheet

ainuxsep2

End sheet ainuxtlr2

Accounting
exit

ainuxacc2

Audit exit ainuxaud2

blank F1A10110 Start sheet pduxblkh Blank sheet of paper

Separator
sheet

pduxblks

End sheet pduxblkt

accounting-
log

n/a Accounting
exit

ainacclog Writes accounting information to the
install_path \\vvaarr\\ppssff\\
aaccccoouunnttiinngg..lloogg file. Does not
produce a printed sheet.

Audit exit ainaudlog Writes audit information to the
install_path \\vvaarr\\ppssff\\ aauuddiitt..
lloogg file. Does not produce a printed
sheet.

Post-print
accounting
exit

ainuxjob
completion

Writes post-print accounting information
to the install_path \\vvaarr\\ppssff\\
jjoobbccoommpplleettiioonn..lloogg file if the
auxiliary sheet object's psf-post-print-
accounting-program-name is set to
ainuxjobcompletion. Does not produce a
printed sheet.

job-ticket n/a Start sheet ainuxhdrp

Separator
sheet

ainuxsepp

End sheet ainuxtlrp

Accounting
exit

ainuxaccp Writes accounting information to the
install_path \\vvaarr\\ppssff\\
ppooddaaccccoouunntt..lloogg Does not produce a
printed sheet.

Audit exit ainuxaudp

64xx F1A10110 Start sheet ainuxhdrx

Separator
sheet

ainuxsepx

End sheet ainuxtlrx
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You can create your own auxiliary-sheet objects using the InfoPrint pdcreate command from a
Command Prompt window. see Creating new auxiliary-sheet objects using the pdcreate command, p.
118.

Examples of Brief-Style and Full-Style Auxiliary Sheets

These examples of auxiliary-sheet printouts were produced using the InfoPrint brief and full
default auxiliary-sheet objects.

Start Sheet Examples

In the next figure, the user-exit program ainuxhdr generated the brief style of the start sheet and user-
exit program ainuxhdr2 generated the full style of the start sheet.

Brief and Full Styles of Start Sheets

Separator Sheet Examples

In the next figure, the user-exit program ainuxsep generated the brief style of the separator sheet and
user-exit program ainuxsep2 generated the full style of the separator sheet.
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Brief and Full Styles of Separator Sheets

End Sheet Examples

In the next figure, the user-exit program ainuxtlr generated the brief style of the end sheet and user-exit
program ainuxtlr2 generated the full style of the end sheet.

Brief and Full Styles of End Sheets

Accounting Sheet Examples

In the next figure, the user-exit program ainuxacc generated the brief style of the accounting-log sheet
and user-exit program ainuxacc2 generated the full style of the accounting-log sheet.
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Brief and Full Styles of Accounting-Log Sheets
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Audit Sheet Examples

In the next figure, the user-exit program ainuxaud generated the brief style of the audit sheet and the
user-exit program ainuxaud2 generated the full style of the audit sheet.
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Brief and Full Styles of Audit Sheets
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Sequence of user-exit programs

This figure shows the order in which InfoPrint calls the user-exit programs during job processing on a
printer. You cannot change this order.

Separator sheets are printed only between copies of a job, not between documents in a job.

InfoPrint Manager user-exit program order at the printer
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Directory locations of user-exit programs supplied with InfoPrint Manager

When you create the auxiliary-sheet object, you specify the name of the user-exit program and other
options, such as the form definition and whether the program produces printed output. You identify
which auxiliary-sheet objects you want associated with each actual destination using the GUI attributes
notebook for each actual destination. InfoPrint Manager runs the referenced user-exit programs when
you submit a job to that printer.

LLooccaattiioonnss ooff IInnffooPPrriinntt MMaannaaggeerr uusseerr eexxiittss

Program Description

Start Sheets

install_path\bin\pduxblkh.dll Prints a blank start sheet.

install_path\bin\ainuxhdr.dll Prints a brief-style start sheet.

install_path\bin\ainuxhdr2.dll Prints a full-style start sheet.

install_path\bin\ainuxhdrp.dll Prints job ticket information about the start sheet.

install_path\lpp\psf\bin\ainuxhdrx.dll Prints a start sheet without vertical lines for
InfoPrint 6400 and 6500 model printers.

Separator Sheets

install_path\bin\pduxblks.dll Prints a blank separator sheet.

install_path\bin\ainuxsep.dll Prints a brief-style separator sheet.

install_path\bin\ainuxsep2.dll Prints a full-style separator sheet.

install_path\bin\ainuxsepp.dll Prints job ticket information on the separator
sheet.

install_path\lpp\psf\bin\ainuxsepx.dll Prints a separator sheet without vertical lines for
InfoPrint 6400 and 6500 model printers.

End Sheets

install_path\bin\pduxblks.dll Prints a blank end sheet.

install_path\bin\ainuxtlr.dll Prints a brief-style end sheet.

install_path\bin\ainuxtlr2.dll Prints a full-style end sheet.

install_path\bin\ainuxtlrp.dll Prints job ticket information on the end sheet.

install_path\lpp\psf\bin\ainuxtlrx.dll Prints an end sheet without vertical lines for
InfoPrint 6400 and 6500 model printers.

Accounting

install_path\bin\ainuxacc.dll Prints a brief-style accounting sheet.

install_path\bin\ainuxacc2.dll Prints a full-style accounting sheet.

install_path\bin\ainuxaccp.dll Writes accounting information to install_path\var
\psf\podaccount.log.
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Program Description

install_path\bin\ainacclog.dll Writes accounting information to install_path\var
\psf\accounting.log.

Post-print Accounting

install_path\bin\ainuxjobcompletion.dll Writes accounting information to install_path\var
\psf\jobcompletion.log

Audit

install_path\bin\ainuxaud.dll Prints a brief-style audit sheet.

install_path\bin\ainuxaud2.dll Prints a full-style audit sheet.

install_path\bin\ainuxaudp.dll Prints job ticket information on the audit sheet.

install_path\bin\ainaudlog.dll Writes audit information to install_path\var\psf
\audit.log.

Input Data

install_path\bin\ainuxind.dll Performs no tasks; use it as a model for writing
your own user-exit program.

Output Data

install_path\bin\ainuxout.dll Performs no tasks; use it as a model for writing
your own user-exit program.

In addition, you can use the source code of the sample user-exit programs to write your own user-exit
programs. InfoPrint Manager provides the source code for all of these exits in the install_path\exits\psf
directory.

Creating and configuring auxiliary sheet objects

When you first create a server, InfoPrint creates the default auxiliary-sheet objects described in InfoPrint
default auxiliary-sheet objects, p. 110.

These topics describe how you can create and configure auxiliary-sheet objects:

• Creating new auxiliary-sheet objects using the pdcreate command, p. 118

• Associating auxiliary-sheet objects with PSF printers, p. 118

• Activating auxiliary sheets for accounting or audit information, p. 118

• Associating the post-print accounting user-exit program with an actual destination, p. 119

• Associating an input data user-exit program with an actual destination, p. 119

• Associating an output data user-exit program with an actual destination, p. 119
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Creating new auxiliary-sheet objects using the pdcreate command

You create auxiliary-sheet objects from the Command Prompt window; you cannot create them
through the InfoPrint administrator's GUI. Use the pdcreate command with the -c auxiliary-sheet flag
and specify the server name and an auxiliary-sheet object name to create a new auxiliary-sheet object.
Specify a name that uniquely identifies the auxiliary-sheet object in the server. Different servers can
contain a auxiliary-sheet objects with the same name, but possibly with different values for their
attributes.

You also specify the psf-exit-form-definition, psf-exit-page-mark, and psf-exit-program-name
attributes with the command to specify the form definition, whether edge marks print, and the user-exit
program used.

For example, to create an auxiliary-sheet object named custom-start contained in Server1 that
specifies the ainuxhdr user-exit program, the F1A10110 form definition, and includes edge marks,
enter the command:

pdcreate -c auxiliary-sheet -x "psf-exit-program-name=ainuxhdr
psf-exit-form-definition=F1A10110 psf-exit-page-mark=true"
Server1:custom-start

Associating auxiliary-sheet objects with PSF printers

Use the InfoPrint Manager Administration GUI to associate auxiliary sheet objects with PSF printers.
Start the GUI and select the printer that you want to associate with an auxiliary sheet. Then, click
Printer→ Properties to open the Printer Properties notebook. To complete this task, see the online
help in the InfoPrint Manager Administration GUI, starting with the topic Using auxiliary-sheet objects.

Activating auxiliary sheets for accounting or audit information

You can use the InfoPrint Manager Administration GUI to specify auxiliary sheet objects to collect
accounting and audit information about jobs processed (as opposed to printed) by a selected PSF
printer. Start the GUI and select the printer that you want to associate with an auxiliary sheet. Then, click
Printer→ Properties to open the Printer Properties notebook. To complete this task, see the online
help in the InfoPrint Manager Administration GUI, starting with the topic Using auxiliary-sheet objects.

To activate the accounting user-exit program , specify one of the accounting user-exit programs names
as the value for the psf-exit-program-name (for example, psf-exit-program-name=ainacclog) in
the auxiliary sheet object associated with the destination. To activate the audit user-exit program,
specify one of the audit user-exit program names as the value for the psf-exit-program-name (for
example, psf-exit-program-name=ainaudlog) in the auxiliary sheet object associated with the
destination.

Each PSF actual destination can have one, both, or neither or the two accounting methods (accounting
and post-print accounting) active. If the accounting setup is intended to be the same for all PSF printers,
this can all be done with one auxiliary sheet object, which can either be one you have created or the
default accounting-log auxiliary sheet object supplied by InfoPrint.
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Associating the post-print accounting user-exit program with an actual
destination

Use the InfoPrint Manager Administration GUI to specify auxiliary sheets to collect post-print
accounting information about jobs processed by a selected PSF printer. Start the GUI and select the
printer that you want to associate with an auxiliary sheet. Then, click Printer→ Properties to open the
Printer Properties notebook. To complete this task, see the online help in the InfoPrint Manager
Administration GUI, starting with the topic Using auxiliary-sheet objects. Then set the attribute of the
auxiliary sheet object using the command shown in Activating the user-exit program, p. 85.

To activate the post-print accounting exit program, specify psf-post-print-accounting-program-
name=ainuxjobcompletion in the auxiliary sheet object associated with the destination.

Each PSF printer actual destination can have one, both, or neither of the two accounting methods
(accounting and post-print accounting) active. If the accounting setup is intended to be the same for all
PSF printers, this can all be done with one auxiliary sheet object, which can either be one you have
created or the default accounting-log auxiliary sheet object supplied by InfoPrint.

Associating an input data user-exit program with an actual destination

You can use the input data user-exit program to monitor the contents of the data stream coming into
InfoPrint Manager from the InfoPrint Manager Administration GUI. Start the GUI and select the
printer that you want to associate with an auxiliary sheet. Then, click Printer→ Properties to open the
Printer Properties notebook. To complete this task, see the online help in the InfoPrint Manager
Administration GUI, starting with the topic Using auxiliary-sheet objects.

Associating an output data user-exit program with an actual destination

You can use the output data user-exit program to monitor the contents of the data stream created by
InfoPrint from the InfoPrint Manager Administration GUI. Start the GUI and select the printer that
you want to associate with an auxiliary sheet. Then, click Printer→ Properties to open the Printer
Properties notebook. To complete this task, see the online help in the InfoPrint Manager
Administration GUI, starting with the topic Using auxiliary-sheet objects.

Using Interrupt Message Pages

Interrupt Message Pages provide a way for printer operators to find the cause and location of a printing
problem. Interrupt Message Pages are pages that are similar to the message pages that print at the end
of a print job, but Interrupt Message Pages are printed at the point of an error where a possible data
loss has occurred. This allows the operators to make sure that no data is missing or to compensate for
issues during the post-processing phase of the print job.

Interrupt Message Pages are for use with PSF TCP/IP. They are associated with an Actual Destination
(AD), and cannot be changed for each job.

Interrupt Message Pages and finishing processes are incompatible and we do not recommend
combining these functions.
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Scenario/Condition Produce interrupt message page?

Pause job Yes

Resume job Yes

Pause printer No

Resume printer No

AD shutdown - Synchronous (same as pause job) Yes

AD shutdown - Now (stop as soon as possible) No

NACKs 1 On an action code basis

Forward Spacing

– Normal in-job forward space Yes

- before NPRO2 No

- after NPRO Yes

– Forward space with no pages committed No

– Forward past the end of the job Yes

- before NPRO No

- after NPRO Yes

Back Spacing

– Normal in job back space Yes

- before NPRO2 No

- after NPRO Yes

– Back space with no pages committed No

– Back space to the beginning Yes

- before NPRO No

- after NPRO Yes

Print a page range No

Cancel job

- pdrm/pddelete Yes

- cancel button on printer Covered under NACK

Communication lost No

Stop button on the printer No - on rreeaaddyy//nnoott rreeaaddyy (other
conditions fall under NACKs)

Add new Interrupt Message Page messages to the final
message page

Yes
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Add messages to the Interrupt Message Page Yes

Print messages in currently supported NLS language Yes

1 negative acknowledgement

2 non-process run out

Enabling Interrupt Message Pages

Follow this procedure to enable a printer to produce Interrupt Message Pages:

1. Open the InfoPrint Manager Administration GUI.

2. Right-click on the printer that you want to enable and select PPrrooppeerrttiieess. The properties
notebook will open for that printer.

3. Click AAuuxxiilliiaarryy//SSeeppaarraattoorr SShheeeettss.

4. Click YYeess next to IInntteerrrruupptt mmeessssaaggee ppaaggee eennaabblleedd.

5. To use a form definition that is different than the default, enter the name of the definition in the
IInntteerrrruupptt mmeessssaaggee ppaaggee ffoorrmm ddeeffiinniittiioonn entry field.

6. To use page marks, click YYeess next to IInntteerrrruupptt mmeessssaaggee ppaaggee eeddggee mmaarrkkss. The IInntteerrrruupptt
mmeessssaaggee ppaaggee eeddggee mmaarrkkss setting prints a mark on the edge of the forms so that the mark is
visible in a stack of paper when viewed from the side. Continuous forms printers that are folding
the forms will print the mark where the fold in the pages occurs.

Interrupt Message Pages have a default message page form definition that is already assigned and is
designed to print on all paper sizes. This form definition is named FF11MMGG00111100, and has these default
settings:

• One copy

• No overlay

• Use paper from bin 1

There is also a new form definition named FF11MMGGIIMMPP that is identical to the default form definition,
except that it specifies offset stacking.

You can create your own form definition, but be aware that doing so might alter the ability of your form
definition to print on all paper sizes. To create a form definition, you must use the InfoPrint Page Printer
Formatting Aid (PPFA) feature. See the Page Printer Formatting Aid: User's Guide and Reference, S550-
0801, for more information.

If you are creating your own form definition and wish to use offset stacking, you can use PPFA and
specify JJOOGG YYEESS in the form definition.

Using Interrupt Message Report

Interrupt Message Report includes all interrupt error messages already printed on separate Interrupt
Message Pages to provide printer operators with a summary of the most critical error messages from the
entire processing phase of the print job.
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Interrupt Message Report is printed at the end of a print job, after the message pages.

The messages occurred during a print job are listed in this order:

1. Interrupt Message Page

2. Message Page

3. Interrupt Message Report

Enabling Interrupt Message Report

Follow this procedure to enable a printer to produce Interrupt Message Reports:

1. Open the InfoPrint Manager Administration GUI.

2. Right-click on the printer that you want to enable and select PPrrooppeerrttiieess. The properties
notebook will open for that printer.

3. Select AAuuxxiilliiaarryy//SSeeppaarraattoorr SShheeeettss.

4. Click YYeess next to IInntteerrrruupptt mmeessssaaggee rreeppoorrtt eennaabblleedd.

• Make sure that Interrupt Message Pages is enabled so that you are able to generate the
Interrupt Message Report. For more information, see Enabling Interrupt Message Pages, p.
121.

5. To use a form definition that is different than the default, enter the name of the definition in the
IInntteerrrruupptt mmeessssaaggee rreeppoorrtt ffoorrmm ddeeffiinniittiioonn entry field.

Interrupt Message Report has a default message report form definition that is already assigned and is
designed to print on all paper sizes. This form definition is named FF11PPIIRRMM11 and has these default
settings:

• Greyed- out background overlay

• Bottom page overlay section with the text “INTERRUPT MESSAGE REPORT”

GGaatthheerriinngg aaccccoouunnttiinngg aanndd aauuddiitt ddaattaa aabboouutt pprriinntt jjoobbss
InfoPrint Manager for Windows lets you gather accounting information about print jobs from two
sources:

• The InfoPrint Manager server (applies to all destination support systems (DSSs)). For more
information, see Working with InfoPrint Manager Accounting Information, p. 123.
You should use accounting information from the InfoPrint Manager if you:

– need to track accounting information for all types of InfoPrint DSSs.

– want to take advantage of the pdaccount command to summarize data in a spread sheet
program.

• The PSF audit, accounting, and post-print accounting user-exit programs (applies only to the PSF
DSSs). For more information, see Working with PSF Accounting and Audit User-Exit Programs, p.
131.
You should use information from these PSF audit and accounting user-exit programs if you:
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– use only PSF attached printers.

– need more detailed information than that provided by the pdaccount command.

Working with InfoPrint Manager server accounting information

While all DSSs can store accounting information about the jobs processed, the information from some
DSSs is more accurate than the information from others. All actual destination accounting logs are
enabled through the server and actual destination log-accounting-data attribute. When you specify
log-accounting-data=true, InfoPrint stores data into server accounting logs (one for each
destination), which you can either view directly through your editor of choice (such as Notepad) from
the command-line or by specifying the pdaccount command. The pdaccount command lets you obtain
summary information in a comma-delimited format (Printer1,12997,1989787763). This information
can be saved in a file, which can be imported into a spread sheet to calculate the cost of consumables,
the usage rate of printers, or the cost of printing by individual user. The summary information includes
both the total pages and total octets (the number of bytes) printed, either by destination or by user as
requested for a specified time period. You can also obtain the complete accounting records (information
for all print jobs) for a specified time period, instead of the summary data.

How does the pdaccount command collect InfoPrint Manager accounting
information?

To activate InfoPrint Manager account log support, you must change the log-accounting-data
value. By default, the InfoPrint Manager value is log-accounting-data=false, and the actual
destination default is to use the server setting. As a result, you must log-accounting-data
attribute as follows:

• To activate accounting for all destinations on a server:
set the server's log-accounting-data attribute to True (if an actual destination hasn't
specified this attribute, the server's log-accounting-data attribute is used).

• To activate accounting for a specific actual destination:
set the log-accounting-data attribute to True for that specific actual destination. If you
have not set an actual destination, the value of the log-accounting-data attribute for the
server is used.

• To deactivate accounting for all destinations on a server :
set the log-accounting-data attribute to False . If an actual destination hasn't specified
this attribute, the server's log-accounting-data attribute is used.

• To deactivate accounting for a specific actual destination:
set the log-accounting-data attribute to False for that specific actual destination. If an
actual destination hasn't specified this attribute, the server's log-accounting-data attribute is
used
.

You can change the log-accounting-data attribute with either a pdset command or the
InfoPrint Manager Administration GUI. For more information about the InfoPrint Manager Administration
GUI, see: "Using the InfoPrint Interfaces" in the RICOH InfoPrint Manager for Windows: Getting Started.
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By default, the pdaccount command obtains this accounting information from one or more InfoPrint
Manager servers:

• actual destination name

• job owner

• global job-id

• submission time

• completion time

• pages-completed

• octets-completed

• data stream

• job name

To use the accounting log version, you must set the accounting-log-version value. By default, the
accounting-log-version value is not set. To use the same accounting-log-version value for all actual
destinations on a server, set the server's accounting-log-version attribute to the desired text value and
make sure that the accounting-log-version attribute is not set on the actual destinations.

The accounting-log-version attribute is logged only if it has a value. By setting the accounting-log-
version attribute, a new field is appended after the currently fixed set of logged attributes which shifts
the previous layout of additional accounting data.

The actual destinations attribute additional-accounting-log-attributes contains the job and document
attributes that you define to record in the accounting log for each destination. You can use the actual
destination attribute additional-accounting-log-attributes to define additional job and document
attributes that you want included in the log. These attributes are:

• accounting1-text
• accounting2-text
• accounting3-text
• account-text
• actual-destinations-requested
• address1-text
• address2-text
• address3-text
• address4-text
• auxiliary-sheet-selection
• base-printer
• building-text callback-number
• chars
• color-bits-per-plane
• color-mapping-table
• color-profile
• color-rendering-intent
• color-toner-saver
• copy-count
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• creation-time
• default-input-tray
• default-medium
• department-text
• destination-accounting1-text
• destination-accounting2-text
• destination-accounting3-text
• destination-company-text
• destination-locations-requested
• destination-models-requested
• destination-name-requested
• destination-pass-through
• destinations-used
• document-comment
• document-content
• document-file-name
• document-finishing
• document-type
• email-from-address
• email-to-address
• font-resolution
• form-definition
• halftone input-tray-select
• job-batch
• job-client-id
• job-comment
• job-copies-completed
• job-deadline-time
• job-discard-time
• job-finishing
• job-media-sheet-count
• job-originator
• job-page-count
• job-priority
• job-retain-until
• job-retention-period
• media-sheets-completed
• modification-time
• mvs-destination
• mvs-forms
• mvs-segment-id
• name-of-last-accessor
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• name-text
• node-id-text
• number-of-documents
• number-up
• octet-count
• originating-company-text
• output-format
• page-count
• page-definition
• page-select
• plex
• print-quality
• processing-time
• programmer-text
• promotion-time
• queue-assigned
• record-count
• resource-context
• results-profile
• room-text
• sheet-range
• sides
• started-printing-time
• subject-text
• title-text
• user-id-text
• user-locale
• user-name
• x-image-shift
• x-image-shift-back
• y-image-shift
• y-image-shift-back

You only get the accounting-log-version attribute if you specify pdaccount —t all.

The user-defined accounting information is added at the end of the current accounting information log.
Only the attributes for the first printable document of the job are logged.

To request summary information grouped by destinations on an InfoPrint Manager server named
Server1 from 8 AM 9/20/99 to 8 AM 9/27/99, specify this from the Windows Command prompt
window:

pdaccount -t destination -s '08:00:00 AM 09/20/99' -e '08:00:00 AM 09/27/99'
Server1
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InfoPrint displays the information in a format similar to this:

DDeessttiinnaattiioonn NNaammee,,PPaaggeess CCoommpplleetteedd,,OOcctteettss CCoommpplleetteedd
Printer1,12997,1989787763
Printer2,2455,17676836
Printer3,86673,189808083

where Printer1 specifies the actual destination, 12997 indicates the pages completed, and
1989787763 indicates the octets completed within the specified start and end times (in this example,
one week).

For more information about using the pdaccount command, see RICOH InfoPrint Manager: Reference.

How do you manage the InfoPrint Manager accounting logs?

Once you specify log-accounting-data=true on either an InfoPrint Manager server or an actual
destination, these accounting logs start growing without bound. As part of your scheduled system
maintenance, the accounting logs should be managed carefully to avoid potential performance
problems. Periodically, the log files must be either deleted or moved to a different folder. If you do not
do either of these tasks, your server will run out of space on the disk drive, preventing you from printing
any more jobs.

The Windows accounting logs are in a subfolder of the server's folder. This describes the subdirectory
where the files are located in:

$ProgramData$\Ricoh\InfoPrintManager\var\pd\accounting.logs

InfoPrint Manager for Windows provides two accounting logs for each destination:

• actual_destination_name .accounting.log.v1 storing accounting information for
successful jobs

• actual_destination_name .accounting.log.error storing accounting information
for error jobs

where actual_destination_name specifies the actual destination where the job is processed.

To save a record of InfoPrint Manager server accounting data, you need to move the existing log files
to a new drive. Be sure that these logs are not being written to, then use this procedure:

1. Create a new directory in the location where you want to archive the existing (prt1.
accounting.log.* ) log files by moving to that location on your system (from the command
line prompt, specify E:, then cd \ntserver).
To create the new directory, type: mkdir 3qrt2001logs

2. Go back to your C drive to the folder where the log files are located in. Then access that location by
specifying:
cd $ProgramData$\Ricoh\InfoPrintManager\var\pd\accounting.logs

3. Copy the prt1.accounting.log.* files to a new directory on a different drive (E for this example)
named 3qrt2001 by specifying:

copy prt1.accounting.log.* E:\ntserver\3qrt2001logs\

This command copies the existing files to the new directory

4. Remove the original prt1.accounting.log.* files from the $ProgramData$\Ricoh
\InfoPrintManager\var\pd\accounting.logs folder:
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del prt1.accounting.log.*
When the next job is processed on prt1, InfoPrint creates a new accounting log file.

We recommend that you move the data to another disk drive rather than deleting it from the system. This
lets you store accounting data and delete it from the system when you no longer need to refer to it. To
delete the prt1.accounting.log.* files,

1. Specify cd $ProgramData$\Ricoh\InfoPrintManager\var\pd\accounting.logs
This command moves you into the correct path.

2. Enter

del prt1.accounting.log.*
When the MS-DOS command-line prompt returns, you know that the prt1.accounting.log.* files
have been deleted from the system.

3. Enter

dir
This command displays the contents of your directory for you to verify that the files have been
deleted. When the next job is submitted for printing to that actual destination, InfoPrint creates a new
accounting log file and writes the data into that file.

The pdaccount command only finds and processes the information in the log files in the original
location. Once you move or rename the files, you cannot use the pdaccount command to summarize
the data. You might want to use the pdaccount command to find and process the information and
summarize it, store the summaries in a different location, and then delete the logs.

Requesting information for all or error accounting records can consume a lot of the server’s memory
since all the data is read into memory to be sent to you. If you have a lot of data to retrieve, you should
consider requesting it for smaller time periods and concatenating the returned data.

For example, to retrieve all the accounting records for a one month period, you could issue four
pdaccount commands like this:

pdaccount -t all -s '00:00:00 AM 03/01/00' -e '00:00:00 AM 03/08/00'
Server A >March1.accting.data

pdaccount -t all -s '00:00:00 AM 03/08/00' -e '00:00:00 AM 03/15/00'
Server A >March2.accting.data

pdaccount -t all -s '00:00:00 AM 03/15/00' -e '00:00:00 AM 03/22/00'
Server A >March3.accting.data

pdaccount -t all -s '00:00:00 AM 03/22/00' -e '00:00:00 AM 03/31/00'
Server A >March4.accting.data

Usage considerations by DSS for accounting information

This section contains more information about server accounting information by DSS. It also gives
suggestions for working with the various DSSs when using the accounting information in InfoPrint
Manager.

BSD DSS
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The page count recorded in the accounting log for destinations using the BSD DSS is based on the
these criteria:

• If the user specifies a job-page-count job attribute or a page-count document attribute with
the print job, InfoPrint Manager records that number in the accounting log.

• If the user has not specified job-page-count or page-count, and the data being printed is PCL,
PDF or PostScript, InfoPrint Manager attempts to calculate the page count and records the
calculated page count in the accounting log.

PSF DSS with TCP/IP attachment type

• On jobs that complete successfully, the page count shown in the accounting log is the number of
AFP pages stacked on the printer, including start pages, separator pages, and end pages.

For n-up documents, up to n pages are counted for each sheet-side that prints.

• Limitations:

– When printing a multiple-document job in which all the documents are ASCII, the
accounting log only shows pages for the last document printed.

– If a job is paused or cancelled, the page count shown in the accounting log might not be
accurate.

– On paused jobs, the octet count is always zero (0).

– The number of Intelligent Printer Data Stream (IPDS) pages printed is based upon the
number of begin-page and end-page structured field pairs in the data. As a result, a 2–
up document printed duplex could provide a page count of four for a single sheet of paper.

PSF DSS with Command attachment type
The page count recorded in the accounting log for destinations using the command is the number of
pages PSF generates and sends to the printer. It is not based on the number of pages received or
printed by the printer. The page count does include start pages, separator pages, and end pages.

PSF DSS with Other-Driver attachment type

• If you are using the InfoPrint TCP/IP Network Port Monitor and the job completes successfully,
then the page count shown in the accounting log is the number pages stacked at the printer. For
example, a three-page document printed simplex records three pages in the accounting log and
three pages stacked; a four-page document printed simplex or duplex reports four pages in the
accounting log even through only 2 sheets are stacked.
The page count recorded in the accounting includes the auxiliary sheets.

A duplexed four-page job with a header sheet provides a page count of five, because the
auxiliary sheets are included in the count and both sides of each page are counted.

• If you are not using the InfoPrint TCP/IP Network Port Monitor, the page count is not based on
the number of pages stacked on the printer. Instead, the page count recorded in the accounting
log is the number of pages PSF reports it has sent to the printer driver, including start pages,
separator pages, and end pages.

• If you have set the document-formats-ripped-at-destination actual destination attribute for a
PSF DSS with Other-Driver attachment type actual destination, the accounting is handled as if it
had been submitted to a Passthrough DSS actual destination, .
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• Limitations: The page count and octet count reported in the accounting log for cancelled and
paused jobs is not accurate.

Internet Printing Protocol (IPP) DSS
The page count recorded in the accounting log for destinations using the IPP DSS is based on these
criteria:

• Depending upon the capabilities of the your particular IPP printer, if the printer reports pages
completed information through the Internet Printing Protocol and the job completes successfully,
that information is used. The auxiliary sheet is not added to the count.

• If the user specifies a job-page-count job attribute or a page-count document attribute with
the print job, InfoPrint Manager records that number in the accounting log. The auxiliary sheet is
not added to the count.

• If the user has not specified job-page-count or page-count, and the data being printed is PCL,
PDF or PostScript, InfoPrint Manager retrieves the page count from the printer, if the particular
printer supports that function. The auxiliary sheet is not included in the count.

• Limitations: Because all information is obtained through the Internet Printer Protocol, the
attributes required for pages-completed might not be supported by a particular printer model.

For accurate results with this DSS, make sure that you set the sides default (whether simplex or
duplex) in the printer to match the value on the sides actual destination attribute.

Passthrough DSS
The page count recorded in the accounting log for destinations using the Windows DSS is based on
these criteria:

• If you are using the InfoPrint TCP/IP Network Port Monitor and the job completes successfully,
then the page count shown in the accounting log is the number pages stacked at the printer. For
example, a three-page document printed simplex records three pages in the accounting log and
three pages stacked; a four-page document printed duplex reports four pages in the accounting
log even through only 2 sheets are stacked. Auxiliary sheets are not included in the count. If you
are submitting jobs using Send and Save or Print-and-Hold functions using the InfoPrint TCP/
IP Network Port Monitor, then the page count shown in the accounting log is zero.

• If you are using the InfoPrint TCP/IP Network Port Monitor and the job does not complete
successfully, or if you are not using the InfoPrint TCP/IP Network Port Monitor and the user
specifies a job-page-count job attribute or a page-count document attribute with the print job,
InfoPrint Manager records that number in the accounting log.
A duplexed four-page job with a header sheet provides a page count of four, because neither
the auxiliary sheets nor the back sides of each page are included in the count.

• If the user has not specified job-page-count or page-count, and the data being printed is PCL,
PDF or PostScript, InfoPrint Manager attempts to calculate the page count and records the
calculated page count in the accounting log. The auxiliary sheet is not included in the count.

For accurate results with this DSS, make sure that you set the sides default (whether simplex or
duplex) in the printer to match the value on the sides actual destination attribute.

DFE DSS
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• If the wait-for-job-completion attribute is set to True and the job completes successfully or is
canceled, then the page count shown in the accounting log is the number of pages stacked at
the printer. For example, a three-page document printed simplex records three pages in the
accounting log and three pages are stacked; a four-page document printed duplex records four
pages in the accounting log even though only two sheets are stacked.

• If the wait-for-job-completion attribute is set to False, the page count is not based on the
number of pages stacked on the printer. In this case, InfoPrint Manager uses these methods to
calculate a page count:

1. The page count recorded in the accounting log is the number of pages PSF reports it has
sent to the printer driver, except for the case when the document-formats-ripped-at-
destination actual destination attribute is set.

2. If the document-formats-ripped-at-destination actual destination attribute is set to the
input datastream and the job is PCL, PDF or PostScript, then InfoPrint Manager attempts to
calculate a page count and records that calculated page count in the accounting log. The
only exception occurs when the user specifies a job-page-count attribute and InfoPrint
Manager records the user specified value of that attribute.

• Limitations: The page count and octet count reported in the accounting log for canceled jobs is
not accurate.

Working with PSF accounting, post-print accounting, and audit data about the
job

The accounting, post-print accounting, and audit PSF DSS user-exit programs record data about jobs.
For each job printed, InfoPrint Manager activates the PSF DSS accounting and audit user-exit programs
before processing the print job's trailer page. InfoPrint Manager activates the PSF DSS post-print
accounting user-exit program when the job stacks. More than one InfoPrint actual destination can use
the same user-exit program to write into the same log file.

This section contains these topics:

• What do the accounting, post-print accounting, and audit PSF DSS user exits provide?, p. 131

• How do you format accounting, post-print accounting, and audit data for viewing?, p. 133

• How do you manage the contents of the data files?, p. 134

What do the accounting, post-print accounting, and audit PSF DSS user exits
provide?

The accounting and audit PSF DSS user-exit programs record statistical data on jobs processed by
InfoPrint Manager actual destinations. This table shows the most common accounting and audit user-exit
programs, the files where they record data, and the types of data that they record.
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Program Log File Records

install_path\ bin
\ainuxaccp

install_path \var\psf
\podaccount.log

Job submitter, job ID, actual
destination, submission machine
(nodeid), pages processed
(projected), sheets from bin 1,
sheets from bin 2, end time, start
date, start time, copies per job

install_path\ bin
\ainacclog

install_path \var\psf
\accounting.log

Job submitter, job name, actual
destination, submission machine
(nodeid), pages processed
(projected), sheets from bin 1,
sheets from bin 2, end time, start
date, start time, fonts, resident
fonts, overlays

install_path\ bin
\ainuxjobcompletion

install_path \var\psf
\jobcompletion.log

Job submitter, job ID, job name,
spool ID, actual destination,
global ID, user pages stacked by
tray, user sheets stacked by tray,
actual pages stacked by tray,
actual sheets stacked by tray,
copies requested, fonts and
resident fonts used, overlays used,
hard and soft segments used,
processing start and stop date/
time, job completion date/time,
file date/time, extended user ID,
extended job ID, address,
account, building, department,
programmer, room, title, job ticket
name

install_path\ bin
\ainaudlog

install_path \var\psf\audit.
log

Job submitter, job name, actual
destination, pages per job, pages
per actual destination, jobs per
output bin, start date, start time,
fonts, resident fonts, overlays

Both install_path\ bin\ainacclog and install_path\ bin\ainaudlog record the same
information in different files. This information is specified in flat ASCII format, with a single line for each
job that is processed. You can use this information to determine billing procedures, to assess the
workload of different output devices, or to determine how resources are used at your installation.

The ainuxjobcompletion exit is called when the printer reports back to InfoPrint Manager that all of
the pages for a job have printed. This includes a partial job (due to a data stream error or because the
job was paused/cancelled or forward-spaced) and also any extra pages produced as a result of a
backspace or other recovery. For the last job that prints on a continuous forms printer, the exit is not
called until an NPRO (non-print run out) is done, either by an operator or automatically by InfoPrint
Manager.
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Only one record is written for a job that prints, unless a job is paused. In this case, a record is written for
the part of the job that was printed up to the pause point; later, if the job is resumed, another record is
written for the rest of the job.

If InfoPrint Manager does not receive feedback from the printer that all pages have stacked, such as
when the printer is shut down in the middle of a job or when an error such as a server failure occurs, no
record is written.

A new procedure has been added to the InfoPrint Manager Administration GUI to show you how to
activate the default PSF ainuxjobcompletion accounting logs. The ainuxjobcompletion accounting
exit interface can be used for PSF-driven IPDS printers. It provides actual (versus projected) accounting
data and provides additional information about completed print jobs.

Customers installing a InfoPrint Manager server for the first time will see the post-print accounting exit
activated and the accounting data will be written to install_path\var\psf\jobcompletion.log.

The intent is to minimize migration issues for existing customers, but to start new customers out with the
preferred accounting exit. The default installation for new machines will not activate both accounting
exits. However, when a newer version of InfoPrint Manager is installed, both new and migrated
customers can choose to have the old, preferred, or both accounting exits active.

If a migrating installation wants to activate the preferred (new) exit, the administrator must set the psf-
post-print-accounting-program-name auxiliary sheet attribute in the appropriate auxiliary sheet
object to provide the name of either the IBM supplied sample exit or a custom version of the preferred
exit. The administrator can also choose to deactivate the old exit by resetting the value of the psf-exit-
program-name auxiliary attribute in the appropriate auxiliary sheet object to <not set>.

If a new installation wants to deactivate the preferred exit and instead run the old exit, the administrator
must reset the psf-post-print-accounting-program-name auxiliary sheet attribute in the appropriate
auxiliary sheet object to <not set>. The administrator can also choose to activate the old exit by setting
the value of the psf-post-print-accounting-program-name auxiliary sheet attribute in the appropriate
sheet object to the name of either the InfoPrint Manager supplied sample exit or a custom version of the
old exit.

In both cases, the administrator can also choose to have both exits active by setting the psf-exit-
program-name and the psf-post-print-accounting-program-name auxiliary sheet attributes to the
names of the two accounting programs (old and preferred). The administrator can also choose to
deactivate both exits by leaving both attributes unset.

How do you format accounting, post-print accounting, and audit data for
viewing?

To view this data, you can use one of these executable reporting utilities that are provided with InfoPrint
Manager. These reporting utilities only work if you open a Command Prompt window, navigate to the
install_path\bin directory, and run the program from the command line.

• Accounting utilities

ainupod1
Reports accounting data stored in podaccount.log in a summary format (one line per user),
sorted by customer ID.
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ainupod2
Reports accounting data stored in podaccount.log, sorted by job ID.

ainupod3
Reports detailed entries of times and pages printed for each job by the customer ID from
podaccount.log.

ainurpt1
Reports accounting data stored in accounting.log, sorted by actual destination.

ainurpt2
Reports summary accounting data (one line per job submitted) stored in accounting.log, sorted
by job submitter.

ainurpt3
Reports detailed entries of times and pages printed for a specific job submitter from accounting.
log.

• Audit utilities

ainurpt4
Reports audit data stored in audit.log, sorted by actual destination.

ainurpt5
Reports summary audit data stored in audit.log, sorted by job submitter.

ainurpt6
Reports detailed entries of times and pages printed for a specific job submitter from audit.log.

• Post-print accounting utilities

ainurpt7
Reports post-print accounting data stored in jobcompletion.log, sorted by actual destination.

ainurpt8
Reports summary post-print accounting data stored in jobcompletion.log, sorted by job
submitter.

ainurpt9
Reports detailed entries of times and pages printed for a specific job submitter in
jobcompletion.log.

How do you manage the contents of the data files?

An installation with a regular schedule of printing jobs will accumulate accounting, post-print
accounting, and audit data that must be managed carefully to avoid potential performance problems.
Periodically, the log files must be either purged or moved to a different folder. If you do not do either of
these tasks, your installation might run out of space on the file system, preventing you from printing any
more jobs. To avoid this problem, you should purge or move the accounting and audit logs as part of
your system maintenance.
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We recommend that you move the data to another file system rather than deleting it from the system.
That way, you can store accounting data and delete it from the system when you no longer need to
refer to it. This procedure describes one way to copy the data to a new location.

1. On your InfoPrint Manager server system, open the Management Console and click Edit→
Service Configuration.

2. Make note of the directory that is listed in the Install path field.

3. Open Windows Explorer and navigate to the install path\bin directory.

4. In that directory, find the log file that you need to move, for example, jobcompletion.log and
select it.

5. With the file selected, click Edit→ Copy.

6. Navigate to the directory that you want to archive the log file in and select the directory.

This directory might be on a different Windows system than the one you are currently working on.

7. With the directory selected, click Edit→ Paste.

8. Verify that the log file appears in the new directory.

9. Navigate back to the install path\bin directory.

10. In that directory, find the log file that you need to move, for example, jobcompletion.log and
select it.

11. With the file selected, click File→ Delete.

To delete the jobcompletion.log file without storing the data in another folder, use the procedure
above, skipping steps five through ten.

When the next job is submitted for printing, InfoPrint creates a new jobcompletion.log file and writes
the data into that file.

CCrreeaattiinngg aanndd mmaannaaggiinngg rreessoouurrccee--ccoonntteexxtt oobbjjeeccttss
Resource-context objects identify the locations of different types of Advanced Function Presentation
(AFP) resources that jobs sent to PSF physical printers can reference. Resource-context objects let you
encapsulate the directory path name in one place. Then you specify the resource-context object name
rather than directory names with documents and actual destinations when specifying where to find
resources. Later, if the location of a resource changes, you only need to modify the path name specified
in the corresponding resource-context object.

The different types of AFP resources are:

Color management resources (CMRs)
CMRs are the foundation of color management in AFP print systems. They provide all the color
management information, such as ICC profiles and halftones, that an AFP system needs to process a
print job and maintain consistent color from one device to another.
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1. CMRs are stored in resource libraries that use resource access tables (RATs). When you update
an existing CMR or add a new CMR to a resource library, the RAT is updated. You must restart
PSF so the changes take effect.

2. CMRs are considered data objects for accounting purposes.
3. For retention of resources across print jobs, CMRs are counted as part of the maximum-

presentation-object-containers-to-keep.

Data object font resources
A data object font resource can be an OpenType font collection, an OpenType set of linked fonts,
or OpenType fonts that are installed in one or more directories on your InfoPrint Manager server.
Data object font resources are the only fonts registered through a RAT that are located in the same
directory as the fonts. For more information about using data object font resources with InfoPrint
Manager, see Using OpenType Fonts, p. 299.

Data objects
Data objects can be IOCA files or types of files natively supported by a particular model of printer
(for example, an EPS file on an InfoPrint 5000). In addition, if you use the transforms that come with
InfoPrint Manager to convert objects into AFP first, these non-native types of files can be used as
data objects. In InfoPrint Manager, data objects are grouped with BCOCA and GOCA objects,
and they are collectively known as presentation object containers.

Data objects are stored in resource libraries that use RATs. When you update an existing data
object or add a new data object to a resource library, the RAT is updated. You must restart PSF so
the changes take effect.

Fonts
A font is a single size and typeface in a particular type family, including letters, numerals,
punctuation marks, special characters, and ligatures.

Form definitions
Form definitions provide instructions on how output devices position data on the page. Form
definitions can specify overlays, a paper source for cut-sheet printer devices, duplexed printing, text
suppression, data position, and the number and modifications of pages.

Page definitions
Page definitions contain the formatting controls for line data. Page definitions can include controls
for the number of lines per logical page, font selection, print direction, and the mapping of
individual fields to positions on the logical page.

Page segments
Page segments contain text and images that you can include at any addressable point on a page or
an electronic overlay.

Overlays
Overlays are collections of predefined data such as lines, shading, text boxes, or logos, that can
merge with variable data on a page or a form during printing or transmission.
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You use the pdcreate command to identify the directory or directories where the AFP resources reside
and provide a name for the resource-context object. You use the AFP Resources tab of the actual
destination and default document attributes notebooks in the InfoPrint Manager Administration GUI, or
the Command Prompt window from an InfoPrint Manager for Windows server, to identify the
resource-context object name or which paths you want to associate with that object. Jobs can also
reference resource-context objects through their contained documents. See The search order for AFP
resources, p. 137 for the search order InfoPrint uses to locate resource-context objects for a job. Both
the actual destination and the resource-context objects that are referenced must reside in the same
InfoPrint server.

You can also purchase additional resources or even create your own custom resources. To create page
definitions and form definitions, you can purchase the Page Printer Formatting Aid (PPFA) for Windows,
which is an optional feature of InfoPrint Manager for Windows.

The search order for AFP resources

This section describes the order and the conditions on which InfoPrint searches for AFP resources:

1. For fonts, paths specified by the -osrchfontlib keyword on the enq, lp, qprt, or lprafp
command

2. Paths specified by the -oreslib keyword on the enq, lp, qprt, or lprafp command

3. The path specified by the resource-context-user document attribute.

4. The paths specified by one of these document attributes, depending on the type of resource:

• resource-context-font

• resource-context-form-definition

• resource-context-overlay

• resource-context-page-definition

• resource-context-page-segment

When one of these document attributes contains a value, InfoPrint ignores any location specified by
the same attribute of a default document object if one is used with the job.

5. The path specified by the resource-context document attribute.

6. The path specified by the PSFPATH environment variable.
If you are using OpenType Fonts, you must allow the InfoPrint Fonts product to install its resource
access table for keeping track of these fonts in the default directory. On an InfoPrint Manager
Windows server, if you change the location of this table from the folder where it was installed, you
can update the global search path on your Windows system with the global resource path for these
fonts.

7. The paths specified by the resource-context attributes of the actual destination.

8. For fonts, the directory where your fonts are installed.

Once a resource is located, the search ends, and the located resource is used to process the job, as
long as the user can access the resource. If InfoPrint Manager ultimately cannot find a required
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resource, it prints an error message advising you of the missing resource. InfoPrint Manager reports that
the job completed successfully.

If the only AFP resources you use are the AFP resources that shipped with InfoPrint Manager, there is no
need to use resource-context objects. All of your resources are located automatically because these
resources reside in the reslib, fontlib, and font directories described above. If, on the other hand, you
have custom AFP resources, make sure that you do not store them in the reslib, fontlib, or font
directories listed. Any custom resources stored in these locations might be corrupted by installing,
uninstalling, or servicing the software. Store any custom AFP resources in a directory outside these
locations and use resource-context objects to provide access to them.

When InfoPrint Manager puts together the total of all resource contexts for a particular resource type,
InfoPrint Manager tries this list of extensions in order while searching each directory for a particular
resource. For example, InfoPrint Manager is searching for a 300–pel raster font named C0H20000
and these conditions are true:

• Document attributes are set to rreessoouurrccee--ccoonntteexxtt--ffoonntt==\\mmyyffoonnttss

• rreessoouurrccee--ccoonntteexxtt==\\aallll__rreessoouurrcceess

• The $PSFPATH environment variable has not been set.

• The resource-context-font actual destination attribute has not been set.

A list of files similar to this would be checked in sequence:

1. xx::\\mmyyffoonnttss\\CC00HH2200000000..330000

2. xx::\\mmyyffoonnttss\\CC00HH2200000000..FFOONNTT330000

3. xx::\\mmyyffoonnttss\\CC00HH2200000000

4. xx::\\aallll__rreessoouurrcceess\\CC00HH2200000000..330000

5. xx::\\aallll__rreessoouurrcceess\\CC00HH2200000000..FFOONNTT330000

6. xx::\\aallll__rreessoouurrcceess\\CC00HH2200000000

7. With InfoPrint Manager for Windows:

1) cc::iinnssttaallll__ppaatthh\\rreesslliibb\\CC00HH2200000000..330000

2) cc::iinnssttaallll__ppaatthh\\rreesslliibb\\CC00HH2200000000..FFOONNTT330000

3) cc::iinnssttaallll__ppaatthh\\rreesslliibb\\CC00HH2200000000

4) cc::\\ffoonntt__iinnssttaallll__ppaatthh\\ppssff\\ffoonnttlliibb\\CC00HH2200000000..330000

5) cc::\\ffoonntt__iinnssttaallll__ppaatthh\\ppssff\\ffoonnttlliibb\\CC00HH2200000000..FFOONNTT330000

6) cc::\\ffoonntt__iinnssttaallll__ppaatthh\\ppssff\\ffoonnttlliibb\\CC00HH2200000000

Once InfoPrint Manager finds a matching file, the search ends.

If InfoPrint Manager cannot find the resource in any of the paths, it stops the job and prints an error
message at the end of the job.

CMRs and data objects search order

The search order for CMRs and data objects is different from the order used for other AFP resources.
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CMRs and data objects must reside in the same directory as the RAT where the resources are identified.
That is, the CMR RAT and the data object RAT can be located in different directories, but the resources
that are associated with the specific RAT must reside in the same directory as the RAT.

The InfoPrint 5000 printer Models AS1 and AD1/AD2 and InfoPrint 4100 printers support CMRs and
data objects.

The search order for CMRs

InfoPrint Manager searches for CMRs in different locations and in a different order than it uses for other
AFP resources.

InfoPrint Manager searches for CMRs in these locations in this order:

1. Inline objects

2. The path specified by the resource-context-presentation-object-container document attribute

3. The path specified by the resource-context document attribute

4. The path specified by the PSFPATH environment variable

5. The path specified by the resource-context-presentation-object-container actual destination
attribute

6. The path specified by the resource-context actual destination attribute

7. The system dependant library:

$$ENV_PDRESLIB

1. InfoPrint searches for CMRs using the UTF-16 name provided in the data stream.

2. If a CMR changes after a job prints, recycle the actual destination by disabling and enabling the
connection.

The search order for data objects

InfoPrint Manager searches for data objects in different locations and in a different order than it uses for
other AFP resources.

InfoPrint Manager searches for data objects in these locations in this order:

1. Inline objects

2. The path specified by the resource-context-page-segment document attribute if object is IOCA
that is not installed in a data object RAT

3. The path specified by the resource-context-presentation-object-container document attribute

4. The path specified by the resource-context document attribute

5. The path specified by the PSFPATH environment variable

6. The path specified by the resource-context-presentation-object-container actual destination
attribute

7. The path specified by the resource-context actual destination attribute

8. The system dependant library:
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$$ENV_PDRESLIB

1. InfoPrint Manager searches for data objects using the UTF-16 name and the 64-character name
provided in the data stream. The search process is different from previous versions. InfoPrint
Manager now searches items one through four by UTF-16 name and then search items one through
four by eight byte name. Then, InfoPrint Manager searches items five through eight by UTF-16 name
and then by eight byte name.

2. If a data object changes after a job prints, recycle the actual destination by disabling and enabling
the connection.

Reuse of CMRs and data objects across printer jobs

Using CMRs and data objects in more than one print job can improve printer performance. InfoPrint
Manager includes two actual destination attributes that you can use to specify reuse: maximum-
presentation-object-containers-to-keep and capture-inline-cmr-resources.

If you use the same resources (such as company logos) in different print jobs, you can improve print
performance by storing those resources on the printer.

Use the maximum-presentation-object-containers-to-keep actual destination attribute to specify the
maximum number of CMRs and data objects to store in the memory of the printer device between jobs.
The default value is 100 objects. Both CMRs and data objects are included in this count.

The printers control the actual retention of resources based on the value of the maximum-
presentation-object-containers-to-keep actual destination attribute and the available resources
downloaded to the printer.

If the printer is reset, the printer memory is cleared.

If you include CMRs inline with your print jobs, you can use the capture-inline-cmr-resources actual
destination attribute to indicate whether inline CMRs can be captured and reused by PSF TCP/IP
printers. Capturing a CMR means the resource is downloaded to the printer and remains resident in the
printer memory for future reuse. The default for this attribute is false (not active).

File extensions for resources

This table contains file extensions for specific types of resources and lists the order that the extensions
are tried by InfoPrint when searching for that resource.
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FFiillee eexxtteennssiioonnss ffoorr rreessoouurrcceess

Type of Resource File Extensions Searched (see note)

BCOCA (bar code) objects
1. No file extension

2. OBJ

3. OBJECT

Code pages
1. ECP

2. No file extension

3. FONT3820

4. FONT38PP

5. CDP

6. FONT300

Coded fonts
1. No file extension

2. FONT3820

3. FONT38PP

4. CFT

5. FONT300

Font character sets, 240-pel resolution
1. No file extension

2. 240

3. FONT3820

4. FONT38PP

5. CFT

6. CDP
Font character sets, 300-pel resolution

1. No file extension

2. 300

3. FONT300

4. CFT

5. CDP

Outline fonts
1. No file extension

2. OLN

3. FONTOLN

4. CFT

5. CDP
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Type of Resource File Extensions Searched (see note)

TrueType and OpenType fonts, CMRs, and data
object resources

Entire file name, including extension; comes from
the Resources Access Tables (RATs) creaetd by
the AFP Resource Installer. If a CMR or a data
object RAT is altered, PSF must be restarted for
the changes to take effect.

Form definitions
1. No file extension

2. FDEF3820

3. FDEF38PP

4. FDE

5. FIL

GOCA (graphics) objects
1. No file extension

2. OBJ

3. OBJECT

IOCA (IO image) objects
1. No file extension

2. OBJ

3. OBJECT

MO:DCA Objects
1. No file extension

2. OBJ

3. OBJECT
Overlays

1. No file extension

2. OVLY3820

3. OVLY38PP

4. OVL

5. OLY

6. OVR

Page definitions
1. No file extension

2. PDEF3820

3. PDEF38PP

4. PDE
Page segments

1. No file extension

2. PSEG3820

3. PSEG38PP

4. PSG
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Type of Resource File Extensions Searched (see note)

5. PSE

Color mapping table
1. No file extension

2. SETUP

3. SET

Presentation object container

For data object resources not installed in a
Resource Access Table (RAT).

1. No file extension

2. DOR

Setup data
1. No file extension

2. SETUP

3. SET

4. COMSETUP

1. All file extensions must be in uppercase.

2. If a file name includes a period (.), the file extension is that part of the file name that follows the
period. For example, the file extension of the file name ARTWORK.PSEG3820 is PSEG3820.

Processing resources installed with Resource Access Tables

A RAT maps a resource name specified in the MO:DCA-P data stream to information used to find and
process the resource. The resources that are installed with a RAT include:

• TrueType and OpenType fonts

• Color management resources (CMRs)

• Data object resources

In order for line2afp to process resources installed with a RAT, you must:

1. Use the InfoPrint AFP Resource Installer or a similar product to install the resources and create
RATs in the appropriate resource directories on your system.

2. When invoking line2afp, use these parameters on AIX, Linux, or Windows systems to specify the
path names where the RATs and resources are installed in:

Parameter Resource Type

FONTPATH TrueType and OpenType fonts

OBJCONDDD, RESLIB, and USERLIB Object containers and CMRs

USERPATH Any RAT-installed resource
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3. Modify your application to include the RAT-installed resources in a page definition, form
definition, or Map Data Resource (MDR) structured field.

See InfoPrint Page Printer Formatting Aid for Windows: User's Guide, S550-0801, for more information
about including resources.

You can use the RESTYPE parameter with line2afp to control what type of resources are included
in the resource type.

Creating a new resource-context object

You create resource-context objects from the Command prompt window; you cannot create them
through the InfoPrint Manager Administration GUI.

To create a new resource-context object from the command line, type a pdcreate command using -c
resource-context and typing:

1. The context-address

2. The server name

3. The resource-context object name

For example, to create a resource-context object named Resfont1 contained in server Server1 that
identifies x:\resource\fonts\group1 as the context-address or directory containing AFP font
resources, enter the command:

pdcreate -c resource-context -x
"context-address=x:\resource\fonts\group1" Server1:Resfont1

1. Specify a name that uniquely describes the resource-context object in the server.
All resource-context objects in a server appear in the selection lists for the fields in the PSF
Resource tab of the Printer Properties window. Two servers can each contain a resource-context
object with the same name, but possibly with different values for their attributes.

2. InfoPrint uses resource-context object names as values for the lists associated with the fields in the
actual destination attributes notebook (Printer Properties window) or as valid values you can enter
in the fields of the default document attributes notebook. Job submitters can also use them as values
for attributes of a document in a job.

For more information about the attributes used in creating resource-context objects, see "Attributes for
Resource Contexts" in RICOH InfoPrint Manager: Reference.

Changing a directory path for a resource-context object

To change the path to a resource-context object, use the pdset command.

For example, to change the path for the resource-context object named Resfont1 contained in server
Server1 to x:\resource\fonts\group2 as the directory containing AFP font resources, enter the
command:
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pdset -c resource-context -x "context-address=x:\resource\fonts\group2"
Server1:Resfont1

UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr SSyysstteemm MMiiggrraattiioonn UUttiilliittyy ((IISSMMUU))
You can use the InfoPrint System Migration Utility (ISMU) for backing up, restoring, or migrating your
InfoPrint Manager environment. This utility is based on the existing server archive functionality, and it
backs up your current configuration from a specific level of InfoPrint Manager and restores it on the
same InfoPrint Manager environment.

Using this utility, you can back up any level of your InfoPrint Manager environment.

When using this utility for restoring purposes, we recommend that you have the InfoPrint Manager and
the backup archive at the same level. If they are not at the same level and you proceed with the
restoration or migration process, two warning messages are displayed, stating that you are not on the
same level and the results might be unpredictable. This still enables you to run the backup or restore
process at slightly different levels (for example x.2.0.255 versus x.2.0.256).

If you need to perform a migration between different levels of InfoPrint Manager, follow these steps:

• Perform the backup and restore required operations, as documented in the appropriate RICOH
InfoPrint Manager: Procedures for your operating system.

• If necessary, upgrade InfoPrint Manager to the required level.

• The ISMU utility was not intended to perform crossover migrations, such as migrating the AIX or
Linux environment to the Windows environment and backwards. However, migrating objects that
are commonly supported across platforms does work, but it does not successfully migrate platform-
specific objects (such as AIX DSS to Linux or Windows).

• You can run the ISMU utility directly from the InfoPrint Manager Management Console.

• Only a person with root user authority or the InfoPrint Manager user can run this command.

Prerequisites

To run the ISMU utility, make sure you are aware of these requirements:

• You must have administrative rights on the system where InfoPrint Manager is running.

• InfoPrint Manager must be installed and running at all times.

• These programs and tools must be installed on your machine:

– zip and unzip

– reg.exe to control the Windows Registry

• ISMU also requires Oracle Java Runtime Environment 7.0 or later installed on your computer.
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• You can only run ISMU locally. This utility does not have network functionality.

• When running the ISMU command, make sure to run it as Administrator. When running on a
Windows system with User Account Control (UAC) enabled, right click on the ISMU command and
select "Run as Administrator" or open a Command Prompt (Admin) console and run the ISMU
command from there.

Migrating your InfoPrint Manager settings

Before migrating your InfoPrint Manager settings and objects, read the following sections to find out
more about what files are automatically backed up and what files are not automatically backed up. For
the files and settings that are not automatically backed up, you should use the manual backup
procedure.

Automatic process

This section lists the files and settings that ISMU automatically backs up and restores.

• Custom 64xx GRID mapping tables

• Custom ICU tables

• Custom notification and PSF exits

• Custom or modified halftones

• Federated authentication settings

• FST security settings

• MVS download receivers created with the InfoPrint Manager GUIs

• PSF Direct configuration

• PSF printer profiles

• Server Admin/Operator GUI configuration/customization

• Transform configuration files

• Web server configuration

Automatic tasks during migration

This section details all sections of InfoPrint Manager that are automatically backed up during the
migration process.

Custom notification and PSF exits

The program automatically backs up and restores any custom exits or PSF exits it finds including these
two server exits:

lower-memory-usage-exit

upper-memory-usage-exit

1 Administrative Procedures: Configuring InfoPrint Manager



1

147

FSTsecurity settings

ISMU automatically backs up and restores all the files within the <install_path>\var\pddir\acl
directory.

PSF Direct configuration

ISMU copies all the <install_path>\var\psf\psfdirect\*.profile files from the source server
to the target server.

Custom or modified halftones

ISMU backs up and restores all files from the <install_path>\psf\config\custom directory.

Transform configuration files

By default, InfoPrint Manager comes with these transforms: gif2afp, img2afp, jpeg2afp, pcl2afp,
ps2afp, tiff2afp, and xml2afp. There are two other transforms that are installed separately: afp2pdf and
sap2afp. The configuration files for all the transforms are located in <install_path>\InfoPrint
Manager\<transform_name_directory>, and if you modified them, then ISMU copies the modified
files to the new server.

Server Admin/Operator GUI configuration/customization

ISMU copies all the ipgui_*.cfg files from <install_path>\ipgui directory to the new server.

Custom 64xx GRID mapping tables

ISMU copies all the customized *.grd files from <install_path>\var\psf\<printer_name>.

Custom ICU tables

ISMU copies all the customized .cnv files from <install_path>\unicode\data\mappings.

By default it contains 6 .cnv files:

• icudt24b_ibm-1388-sap2afp.cnv

• icudt24b_ibm-933-sap2afp.cnv

• icudt24b_ibm-937-sap2afp.cnv

• icudt24b_ibm-939-sap2afp.cnv

• icudt24b_ibm-1399-sap2afp.cnv

• icudt24b_IBM-943C.cnv

If these files exist, ISMU copies and restores all the files from <install_path>\usr\lpp\psf
\afp2pdf\cnv.

Manual process

This list contains parts that ISMU does not automatically back up and restore.

• Associated installed products and/or InfoPrint Manager features

• Channel configuration
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• "Communication Ports" MMC registry

• Custom auxiliary-sheets

• Custom exits for ACIF and MVS Download

• Custom fonts paths

• Custom LPD parameters mapping tables

• DPF and MVS Download settings

• Gateway printer definitions

• IPPGW configuration

• LDAP security settings

• MMC "Edit –> Service Configuration" checkboxes

• Multi-server environment and credentials (user/password)

• Port monitors

• Registries

• Registry data about psfin

• Samba software and configuration for /ipdata and interoperating

• Third-party applications

• Web Server databases

Specific tasks during migration

During the migration process, it is very important to make sure that all objects are correctly backed up
and your initial configuration is correctly restored. Therefore, these sections list all important areas
where you should take extra steps for an accurate migration process.

Samba software and configuration for //iippddaattaa and interoperating

If the source pdserver that must be migrated is interoperated with another server, you must set up the
interoperating environment on the new server.

To find more information about this procedure, follow the instructions from Configuring InfoPrint systems
for interoperability, p. 153.

If job ticketing is used, you must configure the /ipdata folder. For more information about this task, see
the Using the InfoPrint Submit Express Client section in RICOH InfoPrint Manager for Windows: Getting Started.

Associated installed products and InfoPrint Manager features

PPFA
If you have this feature installed, you must install it from the InfoPrint PPFA Feature DVD on the new
server. If you have customized PPFA source files, you need to copy them to the new server for later
processing.

AFP Resource Installer
This is an independent Windows application. You need to make sure that the resources used by the
InfoPrint Manager objects are available on the new system.

1 Administrative Procedures: Configuring InfoPrint Manager



1

149

Custom auxiliary-sheets

If the output shows more than the default sheets that come with InfoPrint Manager (64xx, accounting-
log, blank, brief, full, job-ticket and none), ISMU automatically copies the customized sheets to the new
server. The customized user-exits from <install_path>\usr\lpp\psf\exits\psf are also copied.

IPPGW configuration

Make sure that the service is started by following these steps:

1. Go to Control Panel→ Administrative Tools→ Services.

2. If the service InfoPrint Manager IPP Gateway is started, start it on the new server too.
To do it, follow these steps:

1) From the Management Console, select Edit→ Service Configuration.

2) Select the Automatically start IPP gateway.. option.

3) To verify that the gateway is working, open a browser and enter the following address,
replacing serverhostname with the DNS hostname of the system where the IPP gateway daemon
is running: http://serverhostname:631/printers.

• IPPGW can be run only with the default port which is 631.

• Only a person with root user authority or the InfoPrint Manager user can run this command.

Custom exits for ACIF and MVS Download

If there are any ACIF exits, you need to copy and restore all the MVS Download exits located in \bin
\mvsdsubm.exe and \exits\mvsd (source files and objects) to the right location on the target server.
Also, you need to copy all the ACIF exits located in \bin\ (apk*.dll, asciinp*.dll and dbblank.dll)
and the source files located in \exits\acif\ directory.

Windows port monitors

To check for Windows port monitors, enter this command:

# pdls -c destination -r attachment-type -U <server_name>

If there is a destination with attachment-type=other-driver, you need to complete these migration
steps for the port monitor:

1. Enter this pdls command:

# pdls -c destination -r device-name -U <server_name>:<ADname>

2. The output shows the name of the port where this DSS sends the data.

3. FromWindows Printers and Faxes, right-click one of the printers, select Properties, and then
select the Ports tab.

4. From the list of ports, you need to locate the one that was returned by the previous pdls command.
Select it and press the Configure Port button to get all the details of the port monitor used (port
monitor type, IP address, and so on).

5. Install the same port monitor on the target machine and create a port with the same properties
identified in Step 4.
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Registry data about psfin

You need to check first if the psfin data contains the default values. To do it, follow these steps:

1. Open the Management Console.

2. Go to Options→ Customize Input Manager.

3. Check if these values are the default ones:

• Directory for segment lists: %APPDATA%\RICOH\InfoPrint Manager\var\psf\seglist

• Directory for segments and percent usage threshold: %APPDATA%\RICOH\InfoPrint Manager
\var\psf\segments

• Workspace management: automatic

• Default segment size: 5000

• Percentage of workspace for retained segments: 5

• Enable trace: unchecked

4. If the values match the default ones, no work needs to be done; otherwise, you need to modify the
defaults on the new server to match the ones from the source server.

Custom fonts paths

If you use other fonts than the ones shipped with the product, you have to migrate them.

To migrate the fonts, follow these steps:

1. Open the Management Console.

2. Go to Edit→ Service Configuration.

3. Locate the Default font search path filed.
If it has a value different from the default one (\fontlib), make sure that the same path is set on the
new server, that it exists, and that it contains the same fonts as the one on the original server.

4. If you have set the resource-context or resource-context-font attributes for any actual destination
to point to a custom path, you have to migrate the custom path.

5. If you have set the above attributes for a default document object, you need to have the path and
fonts on the new server too.

6. To check the values of these attributes, use the following pdls commands:

#pdls -c destination -r resource-context <server_name>

#pdls -c initial-value-document -r resource-context <server_name>

#pdls -c destination -r resource-context-font <server_name>

#pdls -c initial-value-document -r resource-context-font <server_name>

7. Copy the font folders pointed to by the attributes listed above to the new server. Also, set the Default
font search path field in the Management Console to match the one from the original server.

Multi-server environment and credentials (user/password)

The Management Console Registry can be seen by opening the Management Console and selecting
Edit→ Service Configuration. There are 8 paths listed there. The default values for them are:
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• Install path:

C:\Program Files\RICOH\InfoPrint Manager

• Base namespace path:

C:\ProgramData\RICOH\InfoPrint Manager\var\pddir

• Remote namespace folder: none

• Workspace path:

C:\ProgramData\RICOH\InfoPrint Manager\var\pd

• AFP support workspace path:

C:\ProgramData\RICOH\InfoPrint Manager\var\psf

• Default fonts search path:

C:\Program Files\RICOH\InfoPrint Manager\fontlib

• Default resource search path:

C:\Program Files\RICOH\InfoPrint Manager\reslib

• Shared client path: none

If you have modified any of these paths, you need to make the same changes on the target server:

1. On the new installation, stop the pdserver and open the Service Configuration dialog.

2. Change the paths that were customized to match the ones from the original server.

3. Copy the contents of the font and resource folder from the original server to the new one.

4. Start the pdserver.

Management Console Edit→ Service Configuration checkboxes

1. Open the Management Console.

2. Go to Edit→ Service Configuration.

3. Check if the following checkboxes have these default values:

• Automatically start server during system startup = checked

• Automatically start IPP gateway during system startup = not checked

• Confirm object delete = checked

• Run notification server on this system = checked

• Run InfoPrint Manager LPD service = checked

4. If any of these values do not match, open the Service Configuration dialog on the new server and
check the same checkboxes as on the original server.

“Communication Ports” Management Console registry

1. Open the Management Console.

2. Go to Edit→ Service Configuration.

3. Check if the following fields have these default values:
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• Server interface port numbers: 6880 through 6889

• Client interface port numbers 6874 through 6877

4. If any of these do not match, open the Service Configuration dialog on the new server and make the
same modifications as on the original server.

Windows Gateway printer definitions

Check if Windows Gateway printers are installed on the source system:

1. Open the Management Console and select Objects→Windows Gateway Printers.

2. If there are printers defined, then you need to migrate them:

• In the Management Console, look at these Gateway Printer normal settings (share name, target
destination, Windows driver name, poll interval, and so on) and the Advanced settings and
write them down.

• On the target system, install the printer driver used by each gateway printer and then go to the
Management Console and create the gateway printer with the same settings from the first step.

DPF and MVS Download settings

If there are folders in the \var\pd\dpf\receivers directory, these folders must be copied to the new
server. Each of these folders represents one DPF Host Receiver.

After that, check if the configuration of the receivers was customized:

1. Open the Management Console.

2. Go to Options→ Preferences.

3. Check these default values:

• The field "MVS Download receivers view interval" is by default 0.

• The field "DPF Host receivers view interval" is 30.

• "DPF Resources view interval" is 0.

• The "Disk Usage for Jobs/Resources directory" is unchecked.

• All three checkboxes for "Optional DPF Resource columns to display" are checked.

4. If the existing values are different from the defaults listed above, make the same changes on the
target server.

5. For every receiver from theManagement Console→MVS Download Receivers, follow these
steps:

• Double-click on each receiver and write down the settings of the receiver.

• On the new server, recreate each receiver from theManagement Console→MVS
Download Receivers by right-clicking it and selecting New.

• Use the same settings that were previously written down.

• Also, for each receiver you check the file from the “Destination Control File” field. The default
file should be \var\pd\mvsd\mvsdmap.txt. If this is not the default file or if the default file has
been customized, copy it to the same location on the new server.
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• For each receiver in the Advanced properties window, check if the field “Exit Program Name”
points to a file. If it does, copy this file at the same location on the new server.

Example of migration

Example of using ISMU to migrate a pdserver (and its objects) from an existing InfoPrint Manager
server to a new InfoPrint Manager server:

1. Export command (run on existing server):

ismu -pdname=pdserver -pdarchive -pdtemp=/tmp/server_archive -pdsave_cfg_files

2. If necessary, change the pdserver name to the new machine hostname on the new InfoPrint
Manager server (run on new machine):

ismu –pdname=pdserver -pdmodify_to=hostname_of_new_machine –pdtemp=/tmp/server_archive

3. Import command (run on new Server):

ismu –pdrestore -pdtemp=/home/server_archive -pdrestore_cfg_files

This series of commands needs to be run for each pdserver you want to migrate to a new InfoPrint
Manager server.

CCoonnffiigguurriinngg IInnffooPPrriinntt ssyysstteemmss ffoorr iinntteerrooppeerraabbiilliittyy
This section describes this interoperating information:

• Understanding interoperating environments, p. 153

• Configuring a primary Windows server with a secondary Windows server, p. 165

• Configuring a primary AIX server with a secondary Windows server, p. 156

• Configuring a primary Linux server with a secondary Windows server, p. 160

Understanding interoperating environments

When you install an InfoPrint Manager server, the install process creates a namespace for that server.
The namespace is a directory structure where InfoPrint Manager stores the location information of all of
your InfoPrint objects, including the server itself, queues and destinations, and the Access Control Lists
(ACLs) used by InfoPrint Manager Security. On a Windows system, the namespace is located by default
at <install path>\var\pddir, where <install path> is the directory that you installed InfoPrint
Manager in.

If you install a second InfoPrint Manager server on another system on your network, that server will
create its own namespace and the two servers will operate entirely independent of each other. In some
cases, however, you might want your servers to be able to work together. To make InfoPrint Manager
servers work together, you set up an interoperating environment in which two or more InfoPrint Manager
servers share the same namespace. The namespace is on one of the servers and the other servers are
granted permissions that allow them to use that directory.
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In InfoPrint Manager for Windows, you should only set up two or three servers to interoperate (not four
or more). Those servers can all be installed on the Windows supported version. In addition, if you have
InfoPrint Manager for AIX, it can be one of the three interoperating servers as well.

When configuring InfoPrint Manager servers to support interoperability, make sure that this rule is
followed:

• Each InfoPrint Manager server must be accessible by all of the other InfoPrint Manager servers
using the same host name.
For example, if Server1 is an InfoPrint Manager server with a host name of server.local, then all
other InfoPrint Manager servers must use server.local to access Server1.

Reasons for setting up an interoperating environment

Not every printing system needs multiple InfoPrint servers. In fact, in many environments one InfoPrint
server is adequate. However, in print environments that do very high volume printing or that print in
remote locations (for example, a main office with branch offices in different parts of the city),
interoperating InfoPrint servers can provide important benefits:

• Interoperating servers are much more scalable than single servers.

– If your print volume increases and you find that you need more processing power or memory to
be able to meet the demand, you can add a second server. However, by making the servers
interoperate, you still only have one printing system to administer.

– If your business expands and you add another office, you can add another server to the
namespace. You'll have to define any new printers that you add to the network, but you won't
have to redefine existing printers or move resources again to be able to use them from the new
location.

• Interoperating servers allow you to distribute print server functions across systems.
Remote locations can have their own local servers, but you can administer them from a central
location.

Multiserver configuration examples

There are various ways to set up multiple InfoPrint Manager servers and have them work together.
Below are some example configurations and the benefits they provide.

• Install two InfoPrint Manager servers in the same physical location.
One of the servers contains all of the InfoPrint print queues and logical destinations, and the other
contains all of the actual destinations. In this setup, you balance processing between the two
systems by spooling and scheduling on one system and transforming and printing on the other.

• Install one InfoPrint Manager server in the main office and one in each branch office.
The namespace is located on the InfoPrint Manager server in the main office, and the other two
servers are set up to share it. All three servers have logical destinations, queues, and actual
destinations defined in them, and the users submit their print jobs to their local server. About 90% of
the time, the servers handle local print jobs, so it makes sense for each location to have its own
server. However, several times each week, the main office generates reports that are needed at the
branches. Instead of printing the reports and sending them across town or faxing several hundred
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pages to each office, they simply send the print job to printers at the branch offices. If necessary, the
branch offices can do the same thing.

In addition, because of the common namespace, the system administrator can monitor all of the
servers from a central location; if there's a problem at one of the branches, he can investigate it from
the main office.

Important issues in interoperating environment

Before you set up an interoperating environment, consider these issues.

Which system should contain the namespace?
The namespace does not contain large volumes of data (so it does not have to reside on the system
with the most disk space) and it does not move a lot of data across the network. However, because
all of the other servers will rely on the namespace server, it must be available and reliable. Put the
namespace on the system that is the most available (always running) and most reliable (does not
have to be rebooted often).

How can I share the namespace across servers?
There are two methods to share the namespace from the primary server, which depends on what
operating system the secondary server is. You can do that using Network File Sharing (NFS) when
the secondary server is located on the AIX or Linux operating system, or Samba when the
secondary system is a Windows operating system. When NFS is used, the exported namespace
filesystem by the primary system is mounted by secondary server using the hostname. Samba is
used to export namespaces from the primary AIX or Linux server to a Windows secondary server. It
is also used for the additional /ipdata sharing required by Submit Express job preflight.

Primary vs.
Secondary server
platform

Namespace
Share Method

Namespace
Share User

/ipdata Share
Method

/ipdata Share
User

AIX (primary) -
AIX (secondary)

NFS ipm1 (UID must
match)

NFS ipm1 (UID must
match)

AIX (primary) -
Linux (secondary)

NFS ipm1 (UID must
match)

NFS ipm1 (UID must
match)

Linux (primary) -
AIX (secondary)

NFS ipm1 (UID must
match)

NFS ipm1 (UID must
match)

Linux (primary) -
Linux (secondary)

NFS ipm1 (UID must
match)

NFS ipm1 (UID must
match)

AIX (primary) -
Windows
(secondary)

Samba ipm1 Samba ipm1
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Linux (primary) -
Windows
(secondary)

Samba ipm1 Samba ipm1

Windows
(primary) -
Windows
(secondary)

Windows Share Windows
Domain User

Windows Share ipm1

Interoperating multiple InfoPrint Manager Windows servers is supported only when running under
Windows Domain controlled environments.

InfoPrint Manager Security
All of the information that InfoPrint Manager Security uses to protect your printing system (groups
and Access Control Lists (ACLs)) is stored in the namespace. When you share the namespace, the
groups and ACLs that you set on the namespace server apply to all of the servers; the groups and
ACLs that you set on the other servers before they joined the common namespace disappear. As a
result, you should wait until you have the interoperating environment set up before you set up any
security on the systems.

If the Pull Print Feature is installed on one of the servers that share the namespace, you have to
recreate the groups and the ACL used by these features.

Printer drivers
If you are setting up an interoperating environment with mixed versions of operating systems , make
sure that the printer drivers you choose work correctly in all Windows versions.

Configuring a primary AIX server with a secondary Windows server

By performing this set of procedures on both an InfoPrint AIX server and an InfoPrint Windows
workstation, you can configure InfoPrint Manager to support interoperability between InfoPrint AIX
servers and InfoPrint Windows servers.

If you are interested in configuring two or more InfoPrint AIX servers for interoperability, see "Installing
secondary InfoPrint servers" in RICOH InfoPrint Manager for AIX: Getting Started.

When configuring InfoPrint Manager AIX and Windows servers to support interoperability, make sure
that these rules are followed:

1. Each InfoPrint Manager server must be accessible by all of the other InfoPrint Manager servers
using the same host name.
For example, if Server1 is an InfoPrint Manager server with a host name of server.local, then all
other InfoPrint Manager servers must use server.local to access Server1.

2. The host name for each InfoPrint Manager server must be the address that is identified for the first
(or primary) network card that is defined to that server.
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3. All printer objects (whether logical destination, actual destination, or queue) must have unique
names if they are used by interoperating InfoPrint servers.
If the printer objects do not possess unique names, you might have trouble viewing them through the
InfoPrint Manager Interface from a non-namespace server.

LPD service for AIX can be used however, by submitting jobs with the lpr command to actual
destinations on the AIX server. The lpr command can also still be used as before with Windows printer
destinations (just not InfoPrint Manager printers).

Setting up the InfoPrint AIX server for interoperability

Perform these procedures on your InfoPrint AIX server to prepare for interoperability with an InfoPrint
Windows server. This presumes that you have installed InfoPrint Manager for AIX on your AIX server
and have logged onto the server as root.

Adding users to and modifying permissions for FST security groups

1. Set up the FST Security groups on your AIX server by taking the InfoPrint Printing System→
Security→ Groups→ Show Group path. From the single-select list pop-up dialog, you should
see these three groups: acl_admin, admin, and oper.

2. Once you have verified the existence of these groups and other custom groups, you should make
sure that users in the admin group can issue all the InfoPrint pd* commands. From SMIT, take the
InfoPrint Printing System→ Security→ Access Control→ Access Control for Operations
→ Show Access Control List path.

3. Take the InfoPrint Printing System→ Security→ Groups→ Add Users to a Group path.
Then specify acl_admin for the Group Name field. Enter the name of the Windows
administrative user you normally log in to the InfoPrint Manager for Windows server machine as
for the User or Users to Add field. For the remainder of this procedure we will refer to this
Windows administrative user as Administrator*.

The Administrator user must be followed by an asterisk (*) to account for the fully qualified
host name. (For example, Administrator@ipwinservermachine.infoprint.com.)

From the Add Users to a Group panel, specify admin for the Group Name field. Enter the
name of the Windows administrative user you normally log in to the InfoPrint Manager for
Windows server machine as for the User or Users to Add field. Note that you do not have to do
this step for the oper group.

4. Once completed, click OK to make sure the changes take effect.

Configure Windows servers for interoperability

Some print environments require more than one InfoPrint Manager server to handle their print
management. If you are adding one or more InfoPrint Manager for Windows servers to your print
environment, this section will tell you what you need to do to make those servers work with the InfoPrint
Manager AIX server.

Notes:
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1. In an interoperating environment that includes an AIX server and Windows servers, the
namespace will reside on the AIX server.

2. You can only install one InfoPrint Manager server on a given Windows workstation or server.

3. If your users will be submitting jobs directly to actual destinations, the actual destination and the
associated queue and logical destination must be on the same server.

4. Once you have your multi-server system running, if one of your Windows servers shuts down or is
restarted, InfoPrint Manager server will not restart automatically when the system restarts. You
must open the Management Console for that server and start it manually.

Granting appropriate user rights to the domain user on all InfoPrint Manager
Windows servers when using a different user than ipm1

To make sure that the Windows InfoPrint Manager servers can run as a Windows service using the
domain userid at your choice you must make sure that this userid has the proper level of authority on
each Windows InfoPrint Manager server system. This userid should be included in the Administrators
group.

1. Log on to one of the preferred systems as a user who is a member of the Domain Administrators
group.

2. Click the Windows Start button and select Settings→ Control Panel.

3. In the Control Panel window, double-click Administrative Tools.

4. In the Administrative Tools window, double-click Local Security Policy.

5. In the right pane of the Local Security SettingsWindow, double-click Local policies.

6. Double-click User Rights Assignment in the right pane.

7. In the list of user rights, select Act as part of the operating system and double-click it.

8. In the Local Security Policy Setting dialog, click Add.

9. In the Select Users or Groups dialog, click the arrow on the drop-down list box and select the
domain that your InfoPrint Manager servers exist in.

Find and select the domain user you created, and click Add.

10. Click OK in the Select Users or Groups dialog.

11. Click OK in the Local Security Policy Setting dialog.

12. Repeat from step 7 for two other user rights: Create permanent shared objects and Log on as
a service.

For working interoperability, follow these steps as root:

1. Add a disabled AIX user using the same name as the user running InfoPrint Manager on the
Windows server.

2. Add a Samba user for the user created above.
For example:

smbpasswd -a <above_user>

3. Edit the Samba configuration file, smb.conf. For each available share (default_cell and/or
ipdata) add the above Samba user to the list of valid users:

1 Administrative Procedures: Configuring InfoPrint Manager



1

159

valid users = ipm1 windows_user_1 windows_user_2 windows_user_3 ...

Creating the mapped drive to the Linux namespace that allows interoperability
on Windows

From each InfoPrint Windows server, you must verify that you have access to the namespace on the
InfoPrintLinux server. You can perform this action by mapping a network drive, using the default user
iippmm11, from the Windows server to shared namespace on the InfoPrint Linux server.

1. From the main Windows view, right-click theMy Network Places icon, selectMap Network
Drive. In the dialog, use the Folder field to specify:

\\servername\default_cell

Where servername is the name of the InfoPrint Linux server.

2. Check the Reconnect at Login check box.

3. Click on the Connect Using Different User Name link.

4. A dialog box will open asking for a username and password associated with ipm1. Specify the
ipm1 password from the Samba server.

5. Click OK when the window opens.

6. Click Yes to accept the current login.

If the drive mapped correctly, a new window should open to the mapped drive's contents, and
Map Network Drive windows should be gone.

7. Click Finish to map the drive.

Do not follow steps 2 through 6 when logged as ipm1 user. Map the network drive manually before
starting InfoPrint Manager Management Console when logged as ipm1 user.

Set the drive letter for this network drive as specified in step 4, in the Configuring interoperability on the
InfoPrint Windows servers, p. 164 section.

The password for the ipm1 Windows user must be the same as the password for the ipm1 SAMBA user.

Configuring interoperability on the InfoPrint Windows servers

Make sure that you complete this procedure on all InfoPrint Windows servers.

On all Windows servers:

1. From the Start menu, click Programs→ InfoPrint Manager→Management Console.

2. Click Edit→ Service Configuration.

3. In the Settings group box, clear both the Run notification server on this system and Run
InfoPrint Manager LPD service check boxes.
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A notification server was installed with each of your InfoPrint Manager servers. However, now
that the namespace is shared, you only need to run one of them . The notification server must be
run on the namespace server. Disable all but one of the InfoPrint Manager Notification servers.

4. Clear the Base namespace path field and type the drive letter that you want to use to link to the
namespace followed by a colon (for example, type x:). Use the same drive letter that you used
when mapping the network drive in step 4 .

5. In the Remote namespace folder field, enter the Universal Naming Convention (UNC) name of
the shared directory on the namespace server in this format: \\namespaceserver\sharename.
The sharename of the namesapce on an AIX server is default_cell. For this example, \\prince
\var\pddir\default_cell .

6. Click OK.

7. Restart all of the InfoPrint Manager servers by selecting File→ Start Server on each
Management Console.

8. Verify that all of the servers are now sharing the namespace.

• Log on to any one of the machines that holds an InfoPrint Manager server, open a command
prompt.

• Start the InfoPrint Manager Administration Interface.

• Click Server→ Show All Servers.

You should see a list of all of the servers that are using the namespace. If any of them do not
appear, stop the servers and check the settings that you changed in step 2 for that server.

Configuring a primary Linux server with a secondary Windows server

In order to interoperate InfoPrint Manager for Linux with InfoPrint Manager for Windows:

• The Linux system must have Samba for Linux installed.

For more information on Samba, go to www.samba.org.

Samba Server and Client software to interoperate Linux with Windows machines allows Linux servers
and workstations to share files and printers with personal computer clients running Windows operating
systems. Because Samba for Linux uses industry-standard Microsoft networking protocols, PC clients can
access Linux files using Microsoft networking client software. PC users can use remote Linux file systems
directly from their machines like local file systems. The namespace will appear on the network just like
any other Windows shared folder. Samba for Linux provides these services by implementing the SMB
networking protocol to run on NetBIOS over TCP/host name.

By doing this set of procedures on both an InfoPrint Manager for Linux server and an InfoPrint Manager
for Windows workstation, you can configure InfoPrint Manager to support interoperability between
InfoPrint Manager for Linux servers and InfoPrint Manager for Windows servers.

1 Administrative Procedures: Configuring InfoPrint Manager
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When configuring InfoPrint Manager for Linux and InfoPrint Manager for Windows servers to support
interoperability, make sure that these rules are followed:

1. Each InfoPrint Manager server must be accessible by all the other InfoPrint Manager servers using
the same host name.
For example, if Server1 is an InfoPrint Manager server with a host name of server.local, then all
other InfoPrint Manager servers must use server.local to access Server1.

2. The host name address for each InfoPrint Manager server must be the host name that is identified
for the first or primary network card that is defined to that server.

3. All printer objects, whether logical destination, actual destination, or queue, must have unique
names if they are used by interoperating InfoPrint Manager servers.
If the printer objects do not possess unique names, you might have trouble viewing them through the
InfoPrint Manager Interface from a non-namespace server.

4. InfoPrint Manager Notifications should only run on the primary server and should be stopped on the
secondary servers.

LPD service for Linux can be used however, by submitting jobs with the lpr command to actual
destinations on the Linux server. The lpr command can still be used as before with Windows printer
destinations, but not with InfoPrint Manager printers.

Setting up the InfoPrint Linux server for interoperability

Perform these procedures on your InfoPrint Linux server to prepare for interoperability with an InfoPrint
Windows server. These procedures presume that you have installed InfoPrint Manager for Linux on your
Linux server and have logged onto the server as .

Adding users to and modifying permissions for FST security groups

1. Set up the FST Security groups on your Linux IPMMI server by taking the InfoPrint Manager→
Security→ Groups→ Show Group path. From the Single Select List pop-up dialog, you
should see these three groups: acl_admin, admin, and oper.

2. Once you have verified the existence of these groups and other custom groups, you should make
sure that users in the admin group can issue all the InfoPrint pd* commands. From IPMMI, take
the InfoPrint Manager→ Security→ Access Control→ Access Control for Operations→
Show Access Control List path.

3. From the Single Select List pop-up dialog, highlight each command and make sure thatGROUP:
admin: r** displays for each command.

If a particular pd command does not show admin group read authority, use the IPMMIInfoPrint
Manager→ Security→ Access Control→ Access Control for Operations→ Change
Access Control List path to specify GROUP:admin in the Users or Groups field of the Change
Access Control List panel for that pd command. Note that the admin group requires only read
authority for each pd command.

If you have installed InfoPrint Manager on a "clean" machine, the admin group will have read
authority for all pd commands by default.

4. Once complete, return to the first IPMMI panel displayed in step 2.

5. Take the InfoPrint Printing System→ Security→ Groups→ Add Users to the Group path.
Then select acl_admin for the Group field. Enter the name of the Windows administrative user,
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either local or domain, you normally log in to the InfoPrint Manager for Windows server machine
as for the User or Users to Add field. SelectMember type as FST User.
For the remainder of this procedure we will refer to this Windows administrative user as
Administrator*.

The Administrator user must be followed by an asterisk (*) to account for the fully qualified
host name. (For example, Administrator@ipwinservermachine.infoprint.com.)

From the same panel, specify admin for the Name field. Enter the name of the Windows
administrative user you normally log in to the InfoPrint Manager for Windows server machine as
for the User or Users to Add field. You do not have to do this step for the oper group.

6. Once complete, click OK to make sure the changes take effect and return to the first IPMMI panel
displayed in step 2.

Configuring Windows servers for interoperability

Some print environments require more than one InfoPrint Manager server to handle their print
management. If you are adding one or more InfoPrint Manager for Windows servers to your print
environment, this section will tell you what you need to do to make those servers work with the InfoPrint
Manager for Linux server.

1. In an interoperating environment that includes an Linux server and Windows servers, the namespace
will reside on the Linux server.

2. You can only install one InfoPrint Manager server on a given Windows workstation or server.

3. If your users will be submitting jobs directly to actual destinations, the actual destination and the
associated queue and logical destination must be on the same server.

4. Once you have your multiserver system running, if one of your Windows servers shuts down or is
restarted, that InfoPrint Manager server will not restart automatically when the system restarts. You
must open the Management Console for that server and start it manually.

Granting appropriate user rights to the domain user on all InfoPrint Manager
Windows servers when using a different user than ipm1

To make sure that the Windows InfoPrint Manager servers can run as a Windows service using the
domain userid at your choice, you must make sure that this userid has the proper level of authority on
each Windows InfoPrint Manager server system. This userid should be included in the Administrators
group.

1. Log on to one of the preferred systems as a user who is a member of the Domain Administrators
group.

2. Click the Windows Start button and select Settings→ Control Panel.

3. In the Control Panel window, double-click the Administrative Tools icon.

4. In the Administrative Tools window, double-click the Local Security Policy icon.

5. In the right pane of the Local Security SettingsWindow, double-click Local policies.
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6. Double-click User Rights Assignment in the right pane.

7. In the list of user rights, select Act as part of the operating system and double-click it.

8. In the Local Security Policy Setting dialog, click Add.

9. In the Select Users or Groups dialog, click the arrow on the drop-down list box and select the
domain that your InfoPrint Manager servers exist in.

Find and select the domain user you created, and click Add.

10. Click OK in the Select Users or Groups dialog.

11. Click OK in the Local Security Policy Setting dialog.

12. Repeat from step 7 for two other user rights: Create permanent shared objects and Log on as
a service.

For working interoperability, follow these steps as root:

1. Add a disabled AIX user using the same name as the user running InfoPrint Manager on the
Windows server.

2. Add a Samba user for the user created above.
For example:

smbpasswd -a <above_user>

3. Create the default_cell Samba share by running this command:

/usr/lpp/pd/install/fstconn.sh -n /var/pddir/default_cell

4. Edit the Samba configuration file, smb.conf. For each available share (default_cell and/or
ipdata) add the above Samba user to the list of valid users:

valid users = ipm1 windows_user_1 windows_user_2 windows_user_3 ...

Creating the mapped drive to the Linux namespace that allows interoperability
on Windows

From each InfoPrint Windows server, you must verify that you have access to the namespace on the
InfoPrintLinux server. You can perform this action by mapping a network drive, using the default user
iippmm11, from the Windows server to shared namespace on the InfoPrint Linux server.

1. From the main Windows view, right-click theMy Network Places icon, selectMap Network
Drive. In the dialog, use the Folder field to specify:

\\servername\default_cell

Where servername is the name of the InfoPrint Linux server.

2. Check the Reconnect at Login check box.

3. Click on the Connect Using Different User Name link.

4. A dialog box will open asking for a username and password associated with ipm1. Specify the
ipm1 password from the Samba server.

5. Click OK when the window opens.

6. Click Yes to accept the current login.
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If the drive mapped correctly, a new window should open to the mapped drive's contents, and
Map Network Drive windows should be gone.

7. Click Finish to map the drive.

Do not follow steps 2 through 6 when logged as ipm1 user. Map the network drive manually before
starting InfoPrint Manager Management Console when logged as ipm1 user.

Set the drive letter for this network drive as specified in step 4, in the Configuring interoperability on the
InfoPrint Windows servers, p. 164 section.

The password for the ipm1 Windows user must be the same as the password for the ipm1 SAMBA user.

Configuring interoperability on the InfoPrint Windows servers

Make sure that you complete this procedure on all InfoPrint Windows servers.

On all Windows servers, do these steps:

1. From the Start menu, click Programs→ InfoPrint Manager→Management Console.

2. Click Edit→ Service Configuration.

3. In the Settings group box, clear both the Run notification server on this system and Run
InfoPrint Manager LPD service check boxes.

A notification server was installed with each of your InfoPrint Manager servers. However, now
that the namespace is shared, you only need to run one of them . The notification server must be
run on the namespace server. Disable all but one of the InfoPrint Manager Notification servers.

4. Clear the Base namespace path field and type the drive letter that you want to use to link to the
namespace followed by a colon (for example, type x:). Use the same drive letter that you used
when mapping the network drive.

5. In the Remote namespace folder field, enter the Universal Naming Convention (UNC) name of
the shared directory on the namespace server in this format: \\namespaceserver\sharename. The
sharename of the namespace on anLinux server is default_cell. For this example, \\prince\var
\pddir\default_cell .

6. Click OK.

7. Restart all of the InfoPrint Manager servers by selecting File→ Start Server on each
Management Console.

8. Verify that all of the servers are now sharing the namespace.

• Log on to any one of the machines that holds an InfoPrint Manager server, open a command
prompt.

• Start the InfoPrint Manager Administration Interface.

• Click Server→ Show All Servers.

You should see a list of all of the servers that are using the namespace. If any of them do not
appear, stop the servers and check the settings that you changed in step 2 for that server.
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Configuring a primary Windows server with a secondary Windows server

Some print environments require more than one InfoPrint Manager server to handle their print
management. If you are installing and configuring more than one InfoPrint Manager for Windows
server in your print environment, this section will tell you what you need to do to make those servers
work together.

When you install InfoPrint Manager, the install process creates a namespace for that server. The
namespace is a directory structure where InfoPrint Manager stores the location information of all of your
InfoPrint objects, including the server itself, queues and destinations, and the Access Control Lists (ACLs)
used by InfoPrint Manager Security. On a Windows system, the namespace is located by default at
<install path>\var\pddir, where <install path> is theInfoPrint Manager installation directory.

If you install a second InfoPrint Manager server on another system on your network, that server will
create its own namespace and the two servers will operate entirely independent of each other. In some
cases, however, you might want your servers to be able to work together. To make InfoPrint Manager
servers work together, you set up an interoperating environment in which two or more InfoPrint Manager
servers share the same namespace. The namespace is on one of the servers (the namespace server) and
the other servers (the non-namespace servers) are granted permissions that allow them to use that
directory.

With InfoPrint Manager for Windows you should only set up two or three servers to interoperate (not
four or more). Those two or three servers can all be installed on Windows systems, or on a combination
of Windows systems. In addition, if you have InfoPrint Manager for AIX, it can be one of the three
interoperating servers as well.

1. You can only install one InfoPrint Manager server on a given Windows workstation or server.

2. For your InfoPrint Manager servers to work together, they must all operate in the same domain.

3. If your users will be submitting jobs directly to actual destinations, the actual destination and the
associated queue and logical destination must be on the same server.

4. Once you have your multi-server system running, if the system that one of your non-namespace
servers is installed on shuts down or is restarted, that InfoPrint Manager server will not restart
automatically when the system restarts, even if you have that option selected in the Management
Console. You must open the Management Console for that server and start it manually.

5. You must set up each of your InfoPrint Manager servers so that all of the other InfoPrint Manager
servers can access them using the same IP address. For example, Ipserv1 sometimes uses the IP
address 9.99.155.122 and other times uses 9.89.214.162, depending upon the machine that is
trying to connect to it. Ipserv2 and Ipserv3 must be able to access Ipserv1 through the same one of
those addresses; if Ipserv2 uses 9.99.155.122 to access Ipserv1, Ipserv3 must use 9.99.155.122
as well.

6. If you have more than one network adapter card in the system that InfoPrint Manager runs on, the
other InfoPrint Manager systems must be able to access the system through the IP address that
corresponds to the first (or primary) network card in the system.
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Configuration example

The recommended way to set up interoperating Windows servers is to create one domain user account
and let all of the InfoPrint Manager services use it as their login account. The steps below describes how
to set up this type of configuration.

It is possible to configure your system so that each InfoPrint Manager service has its own domain user
account. If you want set up this alternate configuration, you can follow the same basic instructions.
However, in step 4, you would create a domain user for each server. Then, when you assign user rights
and set up sharing in subsequent steps, you must make sure you use the same user and password
consistently on each system.

To have your InfoPrint Manager services share a namespace and a log in account.

1. Install all of your InfoPrint Manager servers.
Follow the installation instructions in RICOH InfoPrint Manager for Windows: Getting Started. When you
are finished, your servers will be operating independently.

2. Stop all of your InfoPrint Manager servers.
On each system that an InfoPrint Manager server runs on, open the InfoPrint Manager Management
Console and click File→ Stop Server.

If you are using the SAP Print Feature with an OMS configuration, you must stop the SAP Service
from the Control Panel. Click the Windows Start button and select Settings→ Control Panel. Go
to SAP Service Properties and select to stop the service. For more details on this and other
considerations for SAP systems, see the SAP R/3 Configuration and Printing Guide available on the
RICOH website.

3. Decide which server you want to use as the namespace server.
It is highly recommended that you choose your most reliable server to be the namespace server
since any disruption of service in the namespace server has an impact on all of the servers in the
configuration.

4. Set up the common domain user account that the servers will run under.
Windows

1) Log on to the domain that your InfoPrint Manager servers operate in as a domain administrator.

2) Click the Windows Start button and select Programs→ Administrative Tools→ Active
Directory Users and Computers.

3) In the left pane of the Active Directory Users and Computers window, find the Users item.

4) Right-click the Users directory and click New→ User from the pop-up menu.

5) In the first dialog of the New Object – User wizard, type a name for this user in the Full name
and the User logon name fields.

You do not have to fill in the other name fields.

6) Click Next.
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7) In the second dialog of the New Object – User wizard, enter a password for this user. It is
recommended that you select the Password never expires check box so you do not have to
change the password and update all of your servers on a regular basis, and clear all of the
others.

8) Click Next to verify the settings for the user and complete the wizard.

9) Once you have created the user, right-click the user in the right pane of the Active Directory
Users and Computers window and select Add members to a group from the pop-up menu.

10)In the Select Group dialog, find and select the Domain Administrators (or Domain Admins)
group. Click OK to add your user to the group.

You can leave the Name field blank.

5. Grant the appropriate user rights to the new domain user on all of the systems that InfoPrint
Manager is installed on.

Windows

1) Log on to one of the systems as a user who is a member of the Domain Administrators group.

2) Click the Windows Start button and select Settings→ Control Panel.

3) In the Control Panel window, double–click Administrative Tools.

4) In the Administrative Tools window, double–click Local Security Policy.

5) In the right pane of the Local Security SettingsWindow, double-click Local policies.

6) Double-click User Rights Assignment in the right pane.

7) In the list of user rights, select Act as part of the operating system and double-click it.

8) In the Local Security Policy Setting dialog, click Add.

9) In the Select Users or Groups dialog, click the arrow on the drop-down list box and select the
domain that your InfoPrint Manager servers exist in.

10)Find and select the domain user you created, and click Add.

11)Click OK in the Select Users or Groups dialog.

12)Click OK in the Local Security Policy Setting dialog.

13)Repeat from step 5.7 for two other user rights: Create permanent shared objects and Log on
as a service.

6. Set up sharing for the namespace directory on the namespace server.

1) Log on to the namespace server.

2) Open the InfoPrint Manager Management Console and select Edit→ Service Configuration.

3) Make note of the directory listed in the Base namespace path field. The path will be
<install path>\var\pddir.

4) Open Windows Explorer and navigate to that directory.

5) Right–click the folder for that directory and select Sharing from the pop–up menu.
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UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr lliinnee pprriinntteerr ddaaeemmoonn ((LLPPDD))
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit print jobs from other
operating systems using a Line Printer (LPR) client. The InfoPrint Manager LPD replaces the LPD that is
supplied with the Windows operating system (TCP/IP Print Services); however, it submits the files it
receives directly to an InfoPrint destination, not to a Windows printer. It also supports the -o options that
are available with some LPR clients (-o options allow you to specify advanced InfoPrint print options,
such as formdefs and pagedefs).

Only one LPD can run on your InfoPrint Manager server system at a time. If you have TCP/IP Print
Services installed, InfoPrint Manager will disable it and enable the InfoPrint Manager LPD. If you would
prefer to use TCP/IP Print Services, use the Management Console to change the service configuration.
See the Management Console help for further instructions.

If you have a different LPD installed, InfoPrint Manager will not disable it, but will install and start the
InfoPrint Manager LPD. You must stop one of the LPDs before you try to submit a print job using an LPR
client.

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client. However, to be able to
specify advanced InfoPrint options on the –o flag, you should use the lprafp sample code package.
lprafp is an LPR client that is available as a free download from the Ricoh Web site. The package
includes executable forms of the lprafp client for the Windows and AIX platforms. You can compile this
code to use it on other platforms as well. Ricoh does not provide support for the package.

For information about downloading, configuring, and using the lprafp sample code package, see
Submitting print jobs through the InfoPrint Manager LPD, p. 365.

UUssiinngg tthhee IInntteerrnneett PPrriinnttiinngg PPrroottooccooll ((IIPPPP)) wwiitthh IInnffooPPrriinntt MMaannaaggeerr
The Internet Printing Protocol (IPP) is an application protocol that uses the Hypertext Transfer Protocol
(HTTP) to allow you to print your documents to any IPP-enabled printer whose web address (or Uniform
Resource Identifier-URI) you know. You can use IPP to send print data over both LANs and the Internet
so users who are directly connected to your LAN as well as those who work remotely have access to
the same printers. InfoPrint Manager for Windows provides two ways to configure your system to print
using IPP.

Printing to an IPP-enabled printer

If you have an IPP-enabled printer, you can create an IPP printer just as you would any other actual
destination using the Create IPP Printer Wizard in the InfoPrint Administration GUI. To print to the new
destination, you can submit jobs using a print command such as pdpr, or you can install InfoPrint Select
on your workstation and create a Select printer that uses that destination or any other job submission
method.
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Printing through the IPP Gateway

The IPP gateway is a service in InfoPrint Manager that lets you print using IPP even if you do not have
an IPP-enabled printer, as long as you (and your users) have IPP client software installed on your
workstation.

The Windows system comes with IPP client software built in. Users on other Windows platforms can
download IPP client software. The Printer Working Group, the organization that is leading the
development of IPP, provides a list of IPP client software that you can use to find an appropriate client at
http://www.pwg.org/ipp/.

Once you have an IPP client installed, to set up the gateway:

1. Enable the IPP Gateway using the InfoPrint Manager Management Console. For more information
about completing this task, see the Management Console online help .

1) The IPP Gateway runs as a Windows service called InfoPrint Manager IPP Gateway. On the
Windows system, the IPP Gateway is not set to start automatically by default. For information
about changing the default settings, see the Management Console online help.

Selecting this box does not start the IPP Gateway Service immediately. You must either restart
the system that the InfoPrint Manager server is installed on or start the service from the Windows
Control Panel.

2) To start the IPP Gateway service from the Windows Control Panel:

1. Navigate to the Control Panel and click Administrative Tools.

2. In Administrative Tools, click Services.

3. In Services, highlight InfoPrint Manager IPP Gateway, and then select Action→ Start.

2. Verify that the gateway is working. Open your Internet browser and enter this web address,
replacing serverhostname with the DNS hostname of the system that InfoPrint Manager is installed
on:

http://serverhostname:631/printers

If you do not have a DNS name server running on your network, replace serverhostname with the
dotted-decimal IP address of the system that InfoPrint Manager is installed on instead.

If the gateway is working correctly, you will see a list of the printers that are available through the
gateway. All of your InfoPrint destinations should be listed. Find the address (URI) of the destination
you want your users to print to.

3. Refer your users to http://www.pwg.org/ipp/. This step varies depending on which IPP client you
are using; follow the instructions for adding a printer as provided by the IPP client. For the printer
address, have your users enter the address that you found in step 2.

Using the Internet Printing Protocol (IPP) with InfoPrint Manager

http://www.pwg.org/ipp/
http://www.pwg.org/ipp/
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22.. Administrative Procedures: Configuring for Host
Printing

•Configuring MVS Download
•Using the Distributed Print Facility (DPF)

CCoonnffiigguurriinngg MMVVSS DDoowwnnllooaadd
The MVS Download feature of InfoPrint Manager uses a Destination Control File (DCF) to map Job Control
Language (JCL) parameters to InfoPrint Manager submission parameters. A default DCF called
mvsdmap.txt is provided with InfoPrint Manager; it is installed in the <install path>\var\pd\mvsd
directory, where <install path> is the directory that you installed InfoPrint Manager in. MVS
Download receives JCL parameters from the host system, applies the DCF to it, and generates a
corresponding list of InfoPrint parameters. The list of InfoPrint parameters is then passed to the MVS
Download Exit Program (or Exit) so InfoPrint Manager can process the job.

The MVS Download feature of InfoPrint Manager also invokes an Exit for every file received. This Exit is
responsible for performing some action on the received file. One Exit is provided with InfoPrint
Manager: Microsoft Visual Studio 2017. The Exit submits the file to InfoPrint Manager using pdpr and
logs any errors. The exit also stops the MVS Download receiver if the pdpr fails. Microsoft Visual Studio
2017 supports AFP Download Plus and multiple data set functions.

You must do these tasks to be able to print using the MVS Download feature of InfoPrint Manager:

1. Create the InfoPrint destination or destinations that you want to submit your print jobs to.

2. Make the AFP resources that you need to use for your print jobs available to InfoPrint Manager.

3. [Optional]Modify the DCF.

4. [Optional]Modify the Exit Program.

5. Create an MVS Download receiver that will accept print jobs from the host and tie all of the other
elements together.

All printing configurations must complete steps 1, 2, and 5. For information about creating destinations,
see the RICOH InfoPrint Manager for Windows: Getting Started. See Making your AFP resources available to
InfoPrint Manager, p. 189 for information about completing step 2. If you can use the sample DCF and
Exit that are provided with InfoPrint Manager (the default configuration), you do not have to do steps 3
and 4. See Setting up a default MVS Download configuration, p. 172 for instructions on completing
step 5 for the default configuration. You can use the default configuration if all of these conditions
apply:

1. On jobs that are sent to this MVS Download receiver, the DEST listed on the job when it is
received from the host (converted to lowercase) identifies the InfoPrint actual or logical
destination that the job should be submitted to

OR

Jobs with no DEST specified will be submitted to the InfoPrint actual or logical destination that you
set as the default for this receiver.

2. You do not use InfoPrint job scheduling functions based on media type.

3. When submission of a print job fails (for example, because the server is stopped or because the
DEST requested does not exist), you will accept the default action that the receiver automatically
stops.

4. You will not use the multiple data set function of MVS Download.
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If you do not meet all of the criteria, you will need to modify the DCF, the Exit, or both. Some of the
reasons that you would need to modify the DCF are:

1. You want to use alternate attributes or no attributes for some mvs_keywords.

2. You do not want the DCF to change the DEST value it receives to lowercase.

3. You want to use InfoPrint job scheduling based on media type.

4. You see that some of the MVS to InfoPrint mappings in the sample DCF are not what you want.

5. You want to identify MVS job defaults that are not communicated from MVS (for example
PAGEDEF).

6. You want to identify InfoPrint submission parameters to use on all jobs (for example, the font
resource directory on your Windows system).

7. You use the multiple data set function of MVS Download.

See these sections for instructions on modifying your DCF and Exit, and creating an MVS Download
receiver:

• Understanding and using the MVS Download destination control file, p. 173

• Understanding the MVS Download Exit Program, p. 185

• Creating an MVS Download Receiver, p. 187

Setting up a default MVS Download configuration

Once you have made your resources available, the only tasks you need to do on your Windows system
to set up a Default configuration are:

• Create an InfoPrint destination.
For information about creating destinations, see the RICOH InfoPrint Manager for Windows: Getting
Started.

• Create and configure an MVS Download receiver that uses the default DCF and Exit to send print
jobs to that destination.
For instructions, see Creating an MVS Download Receiver for a default configuration, p. 172.

Creating an MVS Download Receiver for a default configuration

Before you can begin sending jobs from the MVS JES spool to InfoPrint Manager through the MVS
Download feature, follow this procedure to set up an MVS Download Receiver:

1. Open the InfoPrint Manager Management Console.

2. Left-click theMVS Download Receiver item in the left pane to select it.

3. Right-click theMVS Download Receiver item in the left pane to open a pop-up menu.

4. In the menu that pops up, select New.
The Add MVS Receiver dialog opens.

5. Fill in the fields according to these specifications. For more information about the dialog and the
fields it contains, see the Management Console online help.
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• Port Number: Enter the port number that you want this receiver to use when it communicates
with the host system. This number must match the port number that is specified in the Routing
Control File used by the MVS Download FSA for this computer's IP address or the PORTNO in
the PRINTDEV for the AFP Download Plus FSA.

• Target Destination: Select the default InfoPrint destination that you want this receiver to submit
jobs to from the drop-down list. InfoPrint Manager will only submit a job to this destination if the
jobs does not have a DEST specified when it comes from the host system.

• Destination Control File: Do not change this path.

• In the Processing Options group box, both options are selected by default and can be left that
way.

When the Retain command files check box is selected, InfoPrint Manager saves the control
files for any MVS Download print jobs that failed in print submission. Therefore, when you want
to resubmit those jobs, you do not have to download them from the host system again; the files
are still on your InfoPrint server. You can deselect this box, but any jobs that fail in processing
will need to be resubmitted from the host to be printed.

Operators should evaluate any processing failures, correct the problems that caused the
failures, and resubmit the jobs either from the host system (if this box is deselected) or from the
receiver (if this box is selected).

For more information, see Resubmitting or deleting MVS Download Receiver orphaned files, p.
197.

6. In the Error Processing Options group box, neither option is selected by default and can be left
that way.

7. In theMapping Options group box, none of the options are selected by default and can be left
that way.

8. Click OK.
One or more pop-up informational messages might appear; read them and click OK to dismiss
them.

9. Select theMVS Download Receivers item in the left pane of the Management Console.
You should see the receiver you just created in the right pane. The receiver status might be
STOPPED, but it should start momentarily. Click Refresh View on the toolbar until the status
changes to RUNNING.

Once the receiver is running, it is ready to receive print jobs from the host system.

Understanding and using the MVS Download destination control file

The MVS Download Destination Control File (DCF) is a flat text file that consists of Control Statements,
blank lines, and comments. Each line has a maximum length of 1023 bytes. Tabs are treated as blank
spaces.

If you change the DCF, the changes will not become active until you stop and restart the receivers that
use that DCF.
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The DCF maps the MVS keywords and parameters it receives from the host to the pdpr –x and –p
attributes and parameters. The supplied MVS Download Exit uses pdpr to submit jobs to the target
destination. To modify any of the other pdpr options, you must change the Exit Routine.

The sample DCF that comes with InfoPrint Manager is set to perform the mappings listed in Mappings in
the Sample DCF, p. 174.

This table only lists the Mapping statements in the sample DCF. It does not reflect the Default statements
and Global statements that are set.

MMaappppiinnggss iinn tthhee SSaammppllee DDCCFF

mvs_definition InfoPrint Attribute and Value for
MVS Download

InfoPrint Attribute and Value for
AFP Download Plus

ACCOUNT account-text account-text

ADDRESS1 address1-text address1-text

ADDRESS2 address2-text address2-text

ADDRESS3 address3-text address3-text

ADDRESS4 address4-text address4-text

BUILDING building-text building-text

CC=NO carriage-control-type=none ignored

CC=YES ignored ignored

CCTYPE=ANSI carriage-control-type=ansi-
ebcdic

ignored

CCTYPE=MACHINE carriage-control-type=
machine

ignored

CCTYPE=ASCII carriage-control-type=ansi-
ascii

ignored

CHARS chars ignored

CLASS printer-pass-through=-opa=
class

printer-pass-through=-opa=
class

COPIES copy-count results-profile

DATACK=UNBLOCK data-fidelity-problem-
reported=all

data-fidelity-problem-
reported=all

DATACK=BLOCK data-fidelity-problem-
reported=none

data-fidelity-problem-
reported=none

DATACK=BLKPOS data-fidelity-problem-
reported=character

data-fidelity-problem-
reported=character

DATACK=BLKCHAR data-fidelity-problem-
reported=position

data-fidelity-problem-
reported=position

DATATYPE=AFP Not applicable document-format=modca-p

DATATYPE=LINE document-format=line-data Not applicable
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DEPT department-text department-text

DEST target-destination-name and target-destination-name and

printer-pass-through=-opa=
destination

printer-pass-through=-opa=
destination

DUPLEX=NO sides=1 sides=1

DUPLEX=NO plex=simplex plex=simplex

DUPLEX=NORMAL sides=2 sides=2

DUPLEX=NORMAL plex=simplex plex=simplex

DUPLEX=TUMBLE sides=2 sides=2

DUPLEX=TUMBLE plex=tumble plex=tumble

FCB page-definition ignored

FILEFORMAT=RECORD new-line-option=counted-4-
octet-aligned

ignored

FILEFORMAT=STREAM new-line-option=lf or cr-and-
lf

ignored

FILETYPE ignored ignored

FORMDEF form-definition form-definition

FORMLENGTH form-length=nnnn.nnn form-length=nnnn.nnn

FORMS printer-pass-through=-opa=
forms

printer-pass-through=-opa=
forms

INTRAY printer-pass-through=-obin printer-pass-through=-obin

IPADDR printer-pass-through=-opa=
ipaddr

printer-pass-through=-opa=
ipaddr

JOBID printer-pass-through=-opa=
jobid

printer-pass-through=-opa=
jobid

JOBNAME job-name and job-name and

job-owner job-owner

NAME name-text name-text

NODEID node-id-text node-id-text

OFFSETXB x-image-shift-back x-image-shift-back

OFFSETXF x-image-shift x-image-shift

OFFSETYB y-image-shift-back y-image-shift-back

OFFSETYF y-image-shift y-image-shift

OUTBIN output-bin output-bin

OVERLAYB overlay-back overlay-back

OVERLAYF overlay-front overlay-front

PAGECNT job-page-count job-page-count

PAGEDEF page-definition ignored
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PRMODE=SOSI1 shift-out-shift-in=one ignored

PRMODE=SOSI2 shift-out-shift-in=two ignored

PRMODE=SOSI3 shift-out-shift-in=three ignored

PRMODE=[anything
else]

ignored ignored

PROGRAMMER programmer-text programmer-text

PRTQUEUE printer-pass-through=-
oprtqueue

printer-pass-through=-
oprtqueue

RESFMT=P240 font-resolution=P240 font-resolution=P240

RESFMT=P300 font-resolution=P300 font-resolution=P300

ROOM room-text room-text

SEGMENTID printer-pass-through=-opa=
segmentid

printer-pass-through=-opa=
segmentid

SHEETCNT ignored ignored

SYSOUT printer-pass-through=-opa=
class

printer-pass-through=-opa=
class

TITLE title-text title-text

TRC table-characters-reference ignored

UCS chars ignored

USERID user-id-text user-id-text

Types of control statements

There are three kinds of Control Statements in a DCF:

1. Default statements identify a default parameter for an mvs_keyword when one is not received
from MVS. They consist of only an mvs_definition.

If you include multiple Default statements that use the same mvs_keyword, InfoPrint only uses the last
one.

2. Global statements identify an InfoPrint parameter that should be used on all data set submissions.
This statement uses GLOBAL as the mvs_definition value.

If you include multiple Global statements that use the same infoprint_attribute, InfoPrint only uses the
last one.

3. Mapping statements match mvs_keyword with their InfoPrint equivalents. These statements must
contain both an mvs_keyword and a control. If there is no Mapping statement listed in the DCF for
one or more of the mvs_keywords and parameters that are received, InfoPrint adds those mvs_
keywords and parameters as unchanged printer-pass-through attributes.
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1) If you include multiple Mapping statements that use the same mvs_definition but map to different
infoprint_attributes, all of them will be honored.

2) If you include multiple Mapping statements that use the same mvs_keyword and map to the
same infoprint_attribute, the last one mapped will be used.

3) If you define a Mapping statement that maps to an infoprint_attribute that is also used in a
Global statement, and the Mapping statement is used due to the MVS keywords in a received
file, the Mapping statement will override the Global statement.

4) If no matching Mapping statement is found for a received mvs_keyword and parameter, it will
automatically be added to the printer-pass-through parameter. A null Mapping statement can
be used to throw the mvs_keyword away entirely. A null Mapping statement contains an mvs_
definition and a control, but no infoprint_definition.

Syntax of control statements

Each Control Statement consists of three parts as described below. The entire statement must reside on a
single line (it can't contain a carriage return until it is complete) and it must follow this syntax:

mvs_definition [control [infoprint_definition]]

mvs_definition

The mvs_definition identifies a keyword that is generated by the host and, for Default and some
Mapping statements, its associated parameter. It follows this format:

mvs_keyword[=mvs_parameter]

In Control Statements, mvs_definitions, controls, and infoprint_definitions themselves cannot contain any
white space (spaces or tabs). The first occurrence of white space separates the mvs_definition from the
control and the second separates the control from the infoprint_definition. As a result, if the elements
contain white spaces, the DCF will not complete the mapping correctly.

These values are described below.

mvs_keyword

The mvs_keyword represents the string that InfoPrint Manager receives from an MVS system. It is what
the MVS system uses to refer to information about a print job (for example, whether it should be
duplexed or what overlay it uses, if any). The keywords identified in Mappings in the Sample DCF, p.
174 are the standard set of mvs_keywords that are available for you to use. The keywords that MVS
uses to refer to these job characteristics are not the same as the InfoPrint attribute names that do the
same things.

mvs_parameter

The optional mvs_parameter is a case-sensitive free-format field. The purpose of an mvs_parameter
depends upon what type of Control Statement it is used with.

• Default Statement
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The mvs_parameter value is required. This value identifies the default value of the mvs_keyword
when the mvs_keyword has not been sent by the host system with a job. For example, in the Defaults
section of the mvsdmap.txt file, CHARS=GT13 is identified. Therefore, GT13 is the mvs_parameter
default font value, and will be used whenever InfoPrint Manager does not receive a font value from
the host system.

• Global Statement
The mvs_parameter value is ignored.

• Mapping Statement
The mvs_parameter value is optional. If an mvs_parameter value is specified for an mvs_keyword
on a Mapping statement, the mvs_keyword is not always mapped to the infoprint_definition
specified. The mvs_keyword is only mapped to the infoprint_definition when the mvs_keyword and
the mvs_parameter combination that comes from the host system matches the mvs_keyword and
mvs_parameter combination specified on the Mapping statement.

For example, these four lines appear in the Mapping section of the mvsdmap.txt file:

CCTYPE:: carriage-control-type=none

CCTYPE=ANSI :: carriage-control-type=ansi-ebcdic

CCTYPE=MACHINE :: carriage-control-type=machine

CCTYPE=ASCII :: carriage-control-type=ansi-ascii

If InfoPrint Manager receives a job from the host system with the mvs_keyword CCTYPE=ANSI
specified, InfoPrint Manager will map that keyword to the InfoPrint attribute carriage-control-
type and set its parameter to ansi-ebcdic. If the next job comes with the mvs_keyword CCTYPE=
MACHINE specified, InfoPrint Manager will map that keyword to the InfoPrint attribute carriage-
control-type and set its parameter to machine instead. But, if InfoPrint Manager receives a job
with the mvs_keyword CCTYPE set to anything besides ANSI, MACHINE, or ASCII, it will map that
keyword to the InfoPrint attribute carriage-control-type and set its parameter to none.

For certain mvs_keywords, special mvs_parameters are recognized. These keywords are listed in
Special mvs_parameters, p. 178.

SSppeecciiaall mmvvss__ppaarraammeetteerrss

mvs_keyword mvs_parameters

CC YES NO

CCTYPE ANSI MACHINE ASCII

DATACK BLOCK UNBLOCK BLKPOS BLKCHAR

DATATYPE LINE AFP

DUPLEX NO NORMAL TUMBLE

FILEFORMAT RECORD STREAM

RESFMT P240 P300

TRC YES NO

control

A control is a symbol that is used for delineation and which can also tell the MVS Download receiver
what it has to do to the mvs_keyword if it converts the mvs_keyword to an InfoPrint keyword. Every
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Mapping statement contains a control. Some of the controls listed below are used in the mvsdmap.txt
file.

::
Do not do any special processing. (Standard delineation)

:+
Change all of the characters in the mvs_parameter into uppercase when converting it to an infoprint_
parameter.

:-
Change all of the characters in the mvs_parameter into lowercase when converting it to an infoprint_
parameter.

:!
Do not convert this mvs_parameter into an infoprint_parameter. This control is only necessary if no
infoprint_parameter is specified on this statement.

In Control Statements, mvs_definitions, controls, and infoprint_definitions themselves cannot contain any
white space (spaces or tabs). The first occurrence of white space separates the mvs_definition from the
control and the second separates the control from the infoprint_definition. As a result, if the elements
contain white spaces, the DCF will not complete the mapping correctly.

Controls behave differently in the different types of Control statements.

• In Default statements, you cannot specify a control.

• In Global statements, you must specify a control, but the operator is only recognized as a
delineator; no matter what operator you use, it acts like the :: control.

• InMapping statements, you must specify a control.

infoprint_definition

The infoprint_definition identifies the attribute and parameter that will be specified on the pdpr command
when InfoPrint Manager sends the job to the printer. The infoprint_definition identifies an InfoPrint
attribute and (optionally) the value that it should be set to. infoprint_definitions follow this syntax:

infoprint_attribute[=infoprint_parameter]

In Control Statements, mvs_definitions, controls, and infoprint_definitions themselves cannot contain any
white space (spaces or tabs). The first occurrence of white space separates the mvs_definition from the
control and the second separates the control from the infoprint_definition. As a result, if the elements
contain white spaces, the DCF will not complete the mapping correctly.

The infoprint_attribute is the InfoPrint attribute name as it is listed in RICOH InfoPrint Manager:
Reference under –x options, plus the specially recognized target-destination-name, which is used
to identify the –p option of the pdpr command. The infoprint_parameter is the value that is
assigned to that attribute.

infoprint_definitions work differently in each kind of control statement.

• In Default statements, you cannot specify an infoprint_definition.
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• In Global statements, you must specify an infoprint_definition.

• InMapping statements, you should specify an infoprint_definition to map the mvs_definition to.
However, if you specify an infoprint_attribute, you do not have to specify an infoprint_
parameter with it. If you only list an infoprint_attribute, the mvs_parameter value from the
mvs_keyword becomes the infoprint_attribute value.

1. If you do not provide an infoprint_definition in a Mapping statement, the information contained
in that mvs_keyword will be discarded.

2. If you provide multiple Mapping statements that lead to the same attribute only one will be used,
but it is impossible to predict which one that will be.

• To identify an infoprint_attribute that you want to use on the -x option of the pdpr command, omit
the -x, for example: media-id.

• To identify an infoprint_attribute that you want to use on the printer-pass-through attribute of
the pdpr command, prefix the infoprint_attribute with an -o flag for example, -ojobid. All
generated—o attributes will be collected and added to a single printer-pass-through attribute.

• To identify an infoprint_attribute that you want to use on the -opa option of the printer-pass-
through attribute of the pdpr command, prefix the infoprint_attribute with an -opa, for example,
-opa:class. All generated—opa attributes will be collected and added to a single -opa keyword
on the printer-pass-through attribute.

• To identify that the mvs_definition is to map to the name of the target destination for submission,
specify target-destination-name, which is a specially-recognized infoprint_attribute that
overrides the third parameter that is passed to the sample MVS Download Exit.

• To handle complex, multi-valued infoprint_attributes, begin the infoprint_parameter with as many
colons (:) as necessary to move the parameter into the correct position. For example, the results-
profile attribute follows this syntax:

-x "results-profile=name@node:method:number:'message text':bin"
In use, the attribute would look like this:

-x "results-profile=nr645@bld25:pickup:2:'Please read this'"

So, if you wanted to map the COPIES value to the 'number' parameter of results-profile, you
would enter two colons (::) in the mapping statement. The two colons indicate that the program
should skip over the first two parameters in the results-profile (name@node and method), and
insert the value in the third position (number). The mapping statement would look like this:

COPIES :: results-profile=::

You can include a hard-coded infoprint_parameter in the statement, but you do not have to. If you
do not include one, the normal rules for determining the resulting infoprint_parameter apply.

Copying the sample DCF

To create a copy of the sample DCF provided with InfoPrint Manager:

1. Open the file <install path>\var\pd\mvsd\mvsdmap.txt, (where <install path> is the
directory where InfoPrint Manager is installed) in a text editor such as Notepad.
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2. Click File→ Save as, and save the file into a directory outside of the <install path> directory.
Make note of the directory and file name for reference later.

1) You can change the file name if you like, but do not need to.

2) If you do not save the file to another directory outside the <install path> directory, it could be
overwritten or deleted if you ever need to reinstall, apply service, or upgrade InfoPrint
Manager.

3) This step creates a copy of the sample/default file and leaves the original, unedited version in
the directory listed above so you can use it to create another customized DCF later if you need
to.

Editing the DCF

See this section to edit either the sample DCF provided with InfoPrint Manager or an existing DCF.

1. Open the file you want to edit in a text editor.

Notice that most of the lines begin with a *. Every line that begins with a * is a line that is
commented out, so InfoPrint Manager ignores it during processing. When you need to comment
out a line, insert a * at the beginning of the line; to uncomment a line, delete the * at the
beginning of the line.

2. Read the notes and instructions in the file before you make any changes to it.

3. Change the Control Statements as you need to.

• In the Defaults section, you can set the defaults as you need them to be.

• In the Globals section, the only value that is set is carriage-control-type attribute value.
The statements that are commented out are examples of how to specify alternate resource
search orders.

– The first example specifies a location that InfoPrint Manager will search for all fonts
(resource-context-font=C:\fonts\reslib).

– The second example specifies a location and search order for page definitions
(resource-context-pagedef=C:\joeski\pagedefs;c:\bills\pdefs).

You should put any other pdpr parameters to be specified on the –x option on all jobs here.

• In theMapping section, there are two sections: Commonly changed mappings and Less
commonly changed mappings. Follow the instructions provided in the text file to make your
changes, keeping these additional considerations in mind:

– If you plan to send print jobs to different logical destinations based upon the media type
of the job, you should uncomment the FORMS :: default-medium mapping.

– The default mapping uses the MVS JCL keyword DEST to specify the target destination
(printer) that the downloaded jobs are sent to. If you comment out this mapping or
remove the target-destination-name from the right side, all jobs are submitted to the
target destination that you specify in the Target destination field when you set up your
MVS Download Receiver.

Configuring MVS Download



2

182

– If your host MVS system uses the newer PRTQUEUE JCL keyword to identify the target-
destination, comment out the DEST :: target-destination-name mapping and
uncomment the lines:

PRTQUEUE :: target-destination-name
DEST ::

Debugging your changed DCF

The sample DCF contains a DEBUG statement that is commented out. To use this statement to check your
DCF:

1. Uncomment the DEBUG statement in the DCF that you changed.

2. Save the file.

3. Stop the MVS Download receiver that uses this DCF.

4. Restart the MVS Download receiver that uses this DCF.

5. Submit a job from MVS that runs through this MVS Download receiver.
Information will be written into the server log. You can view the server log by clicking the Server
Log item in the left pane of the Management Console.

6. Once you are satisfied with the results, open the DCF and comment the DEBUG statement out
again.

7. Save the file.

8. Stop the MVS Download receiver that uses this DCF.

9. Restart the MVS Download receiver that uses this DCF.

Changing the sample DCF advanced information

If you use MVS Exit 15, understand that the predefined mvs_keywords are internally converted using
MVS keyword internal conversions, p. 183. To add lines to the DCF you will need to be aware of these
internal mappings and what additional information your lines need to contain.

For example, the sample DCF contains the line:

DATACK=BLKPOS :: data-fidelity-problem-reported=character

But, because in MVS keyword internal conversions, p. 183 DATACK maps to -odatac, this line would
produce the same results:

-odatac=blkpos :: data-fidelity-problem-reported=character

When the MVS host actually sends -odatac=blkpos, this mapping statement is used. For information
about the actual keywords that the MVS host sends, see Print Services Facility for z/OS: MVS Download,
S544-5624, which you can download from the Ricoh website at https://www-01.ibm.com/servers/
resourcelink/svc00100.nsf/pages/zOSV2R4G5500430/$file/apsa000_v4r7.pdf.

The mvs_definition (all of the information to the left of the control) is case-sensitive and must exactly
match the information that comes from the host system for the mapping to be made.
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Some parameter information is received from the MVS host as -o keywords and other information is
received as sub-keywords of the -opa keyword. For example, CLASS information is received as -opa=
class=xxx.

When the DCF is processed by an MVS Download receiver, the receiver looks at each mvs_keyword to
determine if it will be received from MVS as a keyword or as a sub-keyword of the -opa keyword. The
receiver tries to convert the specified mvs_keyword according to MVS keyword internal conversions, p.
183. If the receiver does not find a mapping conversion for the specified mvs_keyword, the mvs_
keyword is left unchanged. If the result of the conversion begins with -o, the receiver assumes that the
mvs_keyword will be received as a keyword. If the result of the conversion does not begin with -o, the
receiver assumes that the mvs_keyword will be received as a sub-keyword of the -opa keyword.

For example, the mvs_keyword SYSOUT is internally converted (according to MVS keyword internal
conversions, p. 183) to class. Since class does not begin with -o, the receiver assumes that class is
a sub-keyword of the -opa keyword.

MMVVSS kkeeyywwoorrdd iinntteerrnnaall ccoonnvveerrssiioonnss

mvs_keyword MVS Values Passed to InfoPrint

ACCOUNT -AC
ADDRESS1 -oaddress1
ADDRESS2 -oaddress2
ADDRESS3 -oaddress3
ADDRESS4 -oaddress4
BUILDING -obu
CC -occ

CCTYPE -occtype

CHARS -ochars
CLASS class
COPIES -ocop

DATACK -odatac
DATATYPE -odatat
DEPT -ode
DEST destination
DUPLEX -odu
FCB -opagedef

FILEFORMAT -ofileformat
FILETYPE -ofiletype

FORMDEF -of
FORMLEN -oformlength

FORMS forms
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INTRAY -oin
IPADDR -oipdest

JOBID jobid

JOBNAME -ojobn

NAME -ona

NODEID -ono

OFFSETXB -ooffxb
OFFSETXF -ooffxf
OFFSETYB -ooffyb

OFFSETYF -ooffyf

OUTBIN -ooutbin
OVERLAYB -oovlyb

OVERLAYF -oovlyf

PAGECNT -opagecount

PAGEDEF -opagedef

PRMODE -oprmode

PROGRAMMER -opr

PRTQUEUE -oprtqueue

RESFMT -ore

ROOM -oro

SEGMENTID segmentid

SHEETCNT -osheetcount
SYSOUT class
TITLE -oti
TRC -otrc
UCS -ochars
USERID -ous

MVS Exit 15 lets users add sub-keywords to the -opa keyword only. The mvs_keyword that would be
used in the DCF is the (case-sensitive) sub-keyword only. For example, if an MVS Exit 15 added
OUTGRP=n, where n was the number of the dataset in the job, and you wanted to map this value to the
printer-pass-through=-opa=segmentid parameter (instead of the supplied mapping), you would
replace the existing DCF mapping statement of:

SEGMENTID :: -opa:segmentid

with

OUTGRP :: -opa:segmentid
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To add multiple sub-keywords to the —opa keyword using MVS Exit 15, each keyword/parameter pair
must be delineated with a comma. It is highly recommended that you not use any blank spaces or tabs
around the comma or around the "=" sign that you place between your generated sub-keyword and the
parameter.

For more information, see Print Services Facility for z/OS: MVS Download or Print Services Facility for z/OS: AFP
Download Plus, which you can download at https://www-01.ibm.com/servers/resourcelink/
svc00100.nsf/pages/zOSV2R3S5500433/$file/apsp000_v4r6.pdf.

Understanding the MVS Download Exit Program

The MVS Download Exit Program (or Exit) takes the InfoPrint Manager submission parameters
generated by the DCF and uses them to process the print job appropriately. The Exit is invoked once per
file received from MVS.

A sample exit routine is provided with InfoPrint Manager: written in Microsoft Visual Studio 2017. The
Visual Studio file set includes: mvsdsubm.dsp and mvsdsubm.opt (project files), mvsdsubm.dsw (a
workspace file), and mvsdsubm.c (a source file). They are installed in the <install path>\exits
\mvsd directory, where <install path> is the directory that you installed InfoPrint Manager in.

Using the sample MVS Download exit program

In the sample mvsdsubm files, the Exit performs these operations using the eight parameters that are
passed to it.

1. Issues a pdpr print command to submit the file (parameter #1) to the specified target destination
(parameter #3), with the indicated InfoPrint print parameters (parameter #5).

2. If the job prints successfully, the Exit will erase the print job file (parameter #1).

3. If the job does not print, the Exit will log an error in the MVS Download error file and terminate the
receiver.

Parame-
ters

Definition

#1 The name of the file that contains data received from the MVS JES spool

#2 MVS JES destination control parameters

#3 InfoPrint target destination (printer) where the job is submitted

#4 MVS Download receiver name

#5 InfoPrint print parameters

#6 The port number used by this receiver

#7 Additional exit parameter specified when the receiver was created

#8 Indicator that indicates whether trace is on. A value of zero indicates trace is off. Any
other value indicates trace is on.
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In addition, the Visual Studio exit has support for the multiple data set function in MVS Download and
AFP Download Plus.

Customizing the sample exit program

You can customize the mvsdsubm.c to allow the Exit to perform differently. For example, you might
want to modify the Exit so that it ignores the InfoPrint Manager print parameters (parameter #5) and
processes only the MVS JES destination control parameters themselves (parameter #2). Or, you could
remove the pdpr call and change it to any applicable program or OS command call. For instance, you
could have the Exit copy or archive the data file (parameter #1).

If you specify a DCF that contains no statements, InfoPrint will pass parameter #5 as a null string.

Copying the sample exit

To customize the sample Exit, you should not change the sample itself, because if you ever need to
reinstall InfoPrint Manager, all of your changes will be lost. Instead, copy the fileset into a directory
outside of the directory that you have InfoPrint Manager installed in and make your changes to that
version.

You must have access to Microsoft Visual Studio 2017 to customize the Exit.

To complete the process:

1. Log on to the system that your InfoPrint Manager server is installed on.

2. Decide which directory you would like to store your new exit in or create a new one for it.

3. Navigate to the <install path>\exits\mvsd directory, where <install path> is the directory that
you installed InfoPrint Manager in, using Windows Explorer or theMy Computer icon.
You will see four files.

4. Copy these files you want to modify into the directory you selected or created in step two.

5. Open the copy of the project and make your changes.

6. Save and compile the Exit.

By default, the sample Exit builds a Debug compile version of the Exit. The pre-installed executable
version of the sample (mvsdsubm.exe) is a Release version. You can change the Active
Configuration of the mvsdsubm project to build the Release version of the Exit.

Changes to custom scripts/exits are only required if any of these new functions are desired:

• AFP Download Plus multiple data set

• Support for the pdpr retry count and retry interval

• Displaying the AFP Download Plus page count on the Admin/Operator GUI

• Printing/discarding AFP Download Plus failed jobs

• Using inline resources with MVS Download multiple data set
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• Support for separator pages with AFP Download Plus multiple data set

• Using any of the Error Processing Options

If none of these functions are used, the existing custom scripts can be used.

See the current sample script/exit provided and the sample script/exit that your custom script/exit is
based on to determine the changes. From this, you will identify the proper approach for updating and
testing your custom script/exit.

Creating an MVS Download Receiver

Before you can begin sending jobs from the MVS JES spool to InfoPrint Manager through MVS
Download, follow this procedure to set up an MVS Download Receiver.

1. Open the InfoPrint Manager Management Console.

2. On the menu bar, click Edit→ New→MVS Download Receiver.
The Add MVS Download Receiver dialog opens.

3. Fill in the fields according to these specifications. For more information about the dialog and the
fields it contains, see the Management Console online help.

• Port Number: Enter the port number that you want this receiver to use when it communicates
with the host system. This number must match the port number that is specified in the Routing
Control File used by the for MVS Download FSA for this computer's IP address or the
PORTNO in the PRINTDEV for the AFP Download Plus FSA.

• Target Destination: Select the InfoPrint destination that you want this receiver to submit jobs
to from the drop-down list. InfoPrint Manager will only submit a job to this destination when
the job does not have a target-destination-name value assigned to it after its mvs_
keywords have been processed against the DCF.

• Destination Control File: Click Browse and locate the destination control file that you want
to use with this receiver. Select the file and click Save.

• In the Processing Options group box, both of the options are selected by default.

– When the Retain command files check box is selected, InfoPrint Manager saves all of
the files that pertain to MVS Download jobs that fail in processing. When MVS Download
print jobs are processed successfully, these files are cleaned up regardless of what you
select here. If you need to resubmit failed jobs, you do not have to download them from
the host system again; the files are still on your InfoPrint server. If you deselect this box,
you will have to download any jobs that fail in processing from the host again to print
them.

You can diagnose errors by clicking the Server Log item in the left pane of the
Management Console.
Operators should evaluate any processing failures, correct the problems that caused the
failures, and resubmit the jobs.

For more information, see Resubmitting or deleting MVS Download Receiver orphaned
files, p. 197.
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– When the Enable parallel processing check box is selected, this MVS receiver will
process multiple jobs simultaneously. When it is cleared, the receiver will wait until the Exit
for one print job completes before it starts to process the next job.
This option is normally left selected unless a custom Exit has been written that requires
only one instance of the exit to run at a time and in the order the files are received.

This option must be unchecked if the multiple data set function of MVS Download or AFP
Download Plus is used.

• In the Error Processing Options group box, neither of the options are selected by default:

– When the Provide Extended Error Information to AFP Download Plus check box is
selected, internal errors or exit errors are reported to the host for assistance in problem
determination if requested by AFP Download Plus. When the check box is cleared, neither
internal errors nor exit errors are reported to the host for assistance in problem
determination. To report internal error messages, you must check this box to report
internal error messages. In addition, you must also check the Provide Exit Program
Errors to z/OS check box to report exit messages. For all new and existing view
receivers, the default status of the box is cleared.

– When the Provide Exit Program Errors to z/OS check box is selected, the success of
the exit is monitored by the receiver. A zero return code from the exit causes the receiver
to indicate success to the mainframe. A non-zero return code from the exit causes the
receiver to indicate failure to the mainframe. When this check box is selected and the exit
reports an error on a file in an multiple data set job, the mainframe might retry the file. In
addition, any error messages generated by the exit are provided to the mainframe when
you check this box if the Provide Exit Program Errors to z/OS check box is also
checked. When you do not check this box, the success of the exit is not monitored by the
receiver. For all new and existing view receivers, the default status of the box is cleared.

• In theMapping Options group box, neither of the options are selected by default:

– Select Basic, to use a limited hard-coded conversion table.

– Select Custom, to specify the Host Code Page and, optionally, the Local Code Page
for conversion.

♦ Host Code Page: Enter the name of the code page from where your JCL is submitted.

♦ (Optional)Local Code Page: Enter the name of the local code page that you want to
use. If this field is left empty, the receiver queries the system code page and uses it
instead.

4. (Optional) Click Advanced to open the Add MVS Download Receiver Advanced dialog.

In this dialog, you can specify these options. For more information about the dialog and the fields
it contains, see the Management Console online help.

• Select Standard Exit Program Options, to specify the Print AFP Download Plus Jobs
with Errors on z/OS, the Server Submission Retry Count, and the Server Submission
Retry Interval.

These options are only functional if you are using the new InfoPrint Manager provided exit. If
you are using an older InfoPrint Manager provided exit, these options will be ignored. If you
are using a custom exit, consult the writer of the exit.
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– If you select the Print AFP Download Plus Jobs with Errors on z/OS check box, and
AFP Download Plus detects an error in any file in the job, the job is printed including the
error messages provided by AFP Download Plus. The error messages provided by AFP
Download Plus are printed where the file would normally be printed in the job. If you
clear this check box and AFP Download Plus detects an error in any file in the job, the
entire job is discarded. For all new and existing view receivers, the default status of the
box is cleared.

– Server Submission Retry Count: Enter the number of times the pdpr should be tried. If
no value, or a value of 0 is entered, the pdpr is retried.

– Server Submission Retry Interval: Enter the time interval in seconds between the pdpr
retries. The value entered must be a integer from 0 to 32767. If no value or a value of 0
is entered, the pdpr is retried immediately.

• Select the Custom Exit Program Options check box, if you are using custom exits. Consult
with the person responsible for the custom exits to determine whether this box should be
selected.

– Exit Program Name: Enter the path and filename of the custom Exit Program that you
want this receiver to use. Consult with the person responsible for the custom exit program
to determine the name of the exit.

– Additional Exit Program Parameters: Consult with the person responsible for the
custom exit program to determine the Additional Exit Parameters.

• Click OK to close the Add MVS Download Receiver Advanced dialog.

5. On the Add MVS Download Receiver dialog, click OK.
One or more pop-up informational messages might appear; read them and click OK to dismiss
them.

6. Select theMVS Download Receivers item in the left pane of the Management Console.

You should see the receiver you just created in the right pane. The receiver status might be
STOPPED but it should start momentarily. Click Refresh View on the toolbar until the status
changes to RUNNING.

If the receiver does not start within a few minutes, select Edit→MVS Download Manager and
manually start the receiver by selecting it and clicking Start

Receivers that will not start more than likely have destination control file errors. You can diagnose
errors by clicking the Server Log item in the left pane of the Management Console.

Making your AFP resources available to InfoPrint Manager

When the MVS Download feature of PSF for z/OS is used with MVS Download, the AFP resources you
use for your printing jobs must be available to InfoPrint Manager, so the jobs can process correctly.
When the AFP Download Plus feature of PSF for z/OS is used with MVS Download, the resources are
usually sent with the print jobs and the AFP resources do not need to be available to InfoPrint Manager,
and this section can be skipped. However, AFP Download Plus can be configured to not send all AFP
resource types to InfoPrint Manager. If this configuration is used, the resource types not sent must be
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made available to InfoPrint Manager as described in this section. This section assumes that these
resources currently reside on your host system in AFP format, and that you (or someone) can locate
them.

If you currently use the Distributed Print Function (DPF) of PSF for OS/2, the resource files you use are in
Intelligent Printer Data Stream (IPDS) format. However, the Advanced Function Presentation (AFP)
versions of those files exist on your host system as well. Make sure that you use the AFP versions with
MVS Download.

There are several ways that you can make your resources available to InfoPrint Manager; three of them
are described below. Read through the options and decide which is best for your configuration.

Manually transfer the resources from the host to your Windows system

You can move your resources directly from your host system using any method you like, though the most
common is ftp. If you decide to ftp your files, make sure that you transfer the files as binary data, not as
text. In general, the steps you should follow are:

1. Create a directory on your Windows system that will receive your resources.

2. ftp your resources to that directory as binary data.

3. Identify that directory to InfoPrint Manager.
You can either identify the directory using a resource context object or by changing the default
resource search path in the Management Console. For information about changing the default
resource search path, see the online help for the Management Console under Service
Configuration.

This method is effective and relatively easy to implement. However, every time you change your AFP
resources, you will have to ftp them to the correct directory on your Windows system. If you do not
change your resources often, this method might work well for you. If you change your AFP resources
often, you might want to consider a different option.

Store your resources in a central location

Another option is to store your AFP resources on any machine in your network (including the host system
that they currently reside on), and NFS mount a directory on the Windows system that your InfoPrint
Manager server is installed on to that machine. Then, identify that directory to InfoPrint Manager just as
in the option above (either by using a resource context object or by changing the default resource
search path). To implement this option, you will need to install NFS server and client software, which is
available from a variety of vendors.

The main drawback to this solution is that it generates a significant amount of network traffic as the
system retrieves the resources. The increase in traffic and time needed to retrieve the resources when
needed could cause printer clutching.

Move the resources using MVS Download

A third option is to move your AFP resources using the MVS Download feature of InfoPrint Manager
itself. You can achieve this by setting up a MVS Download receiver that receives jobs and copies them
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into a particular directory without printing them. You would only use this receiver to move your
resources. Setting up this configuration is different depending on your environment. Each time you
modify a resource, you submit a job that sends the modified resource to each system that you are
running an InfoPrint Manager server on. To accomplish this task, you might need to customize the JES
inish deck, the Host MVS Download routing control data set, the Destination Control File (DCF), and the
Exit Program. The modifications needed will depend on your existing MVS Download configuration
used for sending jobs, although the process of getting the AFP resources to the InfoPrint Manager
computer is the same in all cases:

1. Place the resource on the spool for MVS Download to process with identification that it is an AFP
resource, the resource name, and the desired target path. (Target path is optional)

2. Set up the routing control data set to send the AFP resources to unique MVS Download receivers on
the InfoPrint Manager system. (Optional)

3. Set up the routing control data set to not prefix each record with a record length field for AFP
resources.

4. Set up the DCF to map the desired resource path/name to the target-destination-name. (Optional)

5. Modify the supplied Exit to copy the received AFP resource into the proper resource directory with
the provided resource name. The full functions of this Exit would depend on the options chosen
above. For example:

1) If the target path was not supplied, the Exit would either need to have it hardcoded or determine
it using other means.

2) If both AFP resources and print jobs are being sent to the same receiver, the exit would need to
distinguish between the two by some mechanism and take the proper action for each.

3) If the DCF does not map the resource path/name to the target-destination-name, it will
either need to parse it from the other parameters or determine it using other means.

This option is more difficult to set up than the other two, but is less time consuming once you have it
implemented, because every time you change your AFP resources all you have to do is resubmit a job
for transmission to your Windows systems. If you have multiple Windows systems to update or can
further automate this process, this method might work well for you. One possible configuration example
follows.

Example

Assume that JES is configured to schedule all jobs with DEST=NTPRT1 to an MVS Download FSA that
downloads them to an InfoPrint Manager system that then uses the default supplied DCF and Exit to
submit the jobs to an IPDS printer, ntprt1. The MVS Download FSA uses a routing control data set that
contains this statement:

DEST=NTPRT1
IPADDR=dept01.myststem
PORTNUM=5002
RETRYNUM=3
RETRYINTV=60

We have decided this about the configuration:

• Leave the existing MVS Download receiver (on our Windows system) alone.

• Create a new receiver to processes the AFP resources, but continue using the existing MVS
Download FSA.
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• Pass only the AFP resource name, not the directory path for it to be stored in.

• Use the FORMS keyword to identify the job as an AFP resource since the Routing Control Statements
can use FORMS to direct files to different receivers.

• Use the NAME JCL keyword to identify the AFP resource name.

In the JCL job for putting modified AFP resources on the spool, we have an OUTPUT statement with:

OUTPUT DEST=NTPRT1,FORMS=AFPRES,NAME='C0MYFNT.300',....

No changes to the JES inish deck are required since the MVS Download FSA already receives jobs with
DEST=NTPRT1.

We change the routing control file as follows to send this job to a separate receiver and to prefix these
resources with no length field. Jobs that do not have FORMS=AFPRES would continue to be sent to the
existing receiver.

DEST=NTPRT1
FORMS=AFPRES
IPADDR=dept01.mysystem
PORTNUM=5003
SEND_REC_LENGTH=NO
RETRYNUM=3
RETRYINTV=60
DEST=NTPRT1
IPADDR=dept01.myststem
PORTNUM=5002
RETRYNUM=3
RETRYINTV=60

Now we need to define a new receiver on the dept01.mysystem machine. The new receiver will use
port number 5003 (as identified in the routing control statement), a modified DCF, and a user-written
Exit.

We make a copy of the supplied DCF and modify it to change the mapping of the NAME keyword from
MVS. The existing statement:

NAME :: name-text

would be changed to:

NAME :: target-destination-name

Also, the existing statement that maps DEST to target-destination-name would be commented out as
follows:

* DEST :: target-destination-name

Due to this change in the DCF, the Exit will now receive the AFP resource name as the third passed
parameter.

Next, we make a copy of the supplied Exit. We modify the Exit so it copies the received file instead of
submitting it to InfoPrint Manager using pdpr. The Exit must use the first passed parameter as the name
of the resource file and the third passed parameter to derive the target resource file name, because the
DCF mapped it that way. Since we did not pass the desired resource directory name in the JCL, the Exit
needs to determine the drive and directory and pre-pend it to the target resource file name. Since this
Exit will only be used on a receiver that receives AFP resources, it does not need to identify the file as an
AFP resource and have a paths for both copying resources and submitting non-resources to InfoPrint
Manager to be printed. The Exit can also be coded to detect and react to error situations as
appropriate.
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Lastly, we use the Management Console to create the receiver that will use the DCF and Exit that we
created. In this example, the Target Destination that we specify when we create the receiver is
irrelevant and will only be passed to the Exit if no NAME is specified in the JCL that submitted the
resource.

Submitting multiple data set jobs

MVS Download and AFP Download Plus send each JES SYSOUT data set separately to the MVS
Download receiver on Windows. By default, the receiver spools each data set as a separate file. On
MVS, a job can contain multiple data sets. Use this procedure to customize your installation for MVS
Download multiple data set job support, so that the data sets in a job sent to InfoPrint Manager through
MVS Download print in sequence, with no intervening files, no NPRO processing between files, and
only one header and trailer page for the set.

InfoPrint Manager now enables multiple data sets to be received, individually transformed by ACIF into
MO:DCA-P, and then combined into a single file and spooled. InfoPrint Manager uses the medium
maps (copy groups) from the form definition that is associated with each data set to build a
comprehensive inline form definition that it inserts at the beginning of the combined file.

Use these procedures to install and configure MVS Download support for printing multiple data set jobs.

• Requirements to use multiple data set support, p. 193

• Installing multiple data set support with MVS Download, p. 194

• Limitations of multiple data set support, p. 195

• Technical description of multiple data set support, p. 196

Requirements to use multiple data set support

To support the printing of multiple data sets in a job as a single unit using MVS Download, you must:

• Install a special MVS Download user exit 15 program on MVS.

• Create a MVS Download Receiver on your InfoPrint Manager system with parallel processing
turned off.

To support the printing of multiple data sets in a job as a single unit using AFP Download Plus, you must:

• Install AFP Download Plus with APAR OA15317.

• Set the dataset-grouping parameter in the control statement data set to Yes.

• Create an MVS Download Receiver on your InfoPrint Manager system with parallel processing
turned off.

The sample user exit 15 program (apsux15m) provided with MVS Download, adds a parameter that
identifies data sets that belong to multiple data set jobs and indicates whether the data set is first, next,
or last in a job.

Turning off parallel processing ensures that the MVS Download receiver receives the data sets in the
correct sequence by creating only one child process. If parallel processing is turned on, MVS
Download can create more than one child process, and thus can receive more than one data set from a

Configuring MVS Download



2

194

multiple data set job at the same time. Data sets could be received out of order and might not print
correctly.

Make sure you have set up your shared resources so thatMVS Download can find them. See Preparing
for shared resources with MVS Download, p. 67 for instructions.

Installing multiple data set support with MVS Download

Use this procedure to install the MVS Download multiple data set support.

1. Install the MVS Download user exit 15 program, apsux15m, on MVS. The program must be
assembled and linked into a data set referenced in the STEPLIB of your MVS Download startup
PROC.

2. Run MVS Download on MVS using SEND_REC_LENGTH=YES either by specifying it explicitly in
the MVS Download Routing Control data set on MVS or by allowing it to default. If you specify
SEND_REC_LENGTH=NO, ACIF might be unable to process some variable length line mode data.
In these cases, ACIF issues a message that it cannot read the input file with a return code of 310.

3. Make sure that ACIF can locate your resources.

It looks in the directories specified in the Service Configuration dialog of the Management
Console. If you specify resource directories using any of these attributes, you must specify those
same directories in the Default resource search path field in the Service Configuration dialog
of the Management Console:

• resource-context

• resource-context-font

• resource-context-overlay

• resource-context-page-segment

• resource-context-page-definition

• resource-context-form-definition

You must delimit each directory using a semicolon (;), not a colon (:).

4. Do not specify these attributes either directly or in Initial Value Job or Initial Value Document
objects:

• transform-message-file-name

• resource-context-page-definition

• You can use the resource-context attribute instead of the resource-context-page-
definition attribute.

5. Make sure that all of the receivers you plan to use have parallel processing turned off. If parallel
processing is enabled, you cannot use those receivers with multiple data set jobs. To see the
status of parallel processing:

1. Open the Management Console and click the MVS Download Receivers item in the left pane.

A list of receivers appears in the right pane.

2. Double-click each receiver to open the Viewing dialog.
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3. In the Processing Options box, see if Parallel Processing is enabled. If it is enabled, you
cannot use that receiver with multiple data set jobs.

Installing multiple data set support with AFP Download Plus

Use this procedure to install the AFP Download Plus multiple data set support.

1. Install AFP Download Plus with APAR OA15317. To enable the multiple data set function, set the
dataset-grouping parameter in the control statement data set to Yes. For more information about
installing AFP Download Plus, see the "Installing AFP Download Plus" chapter in Print Service Facility
for z/OS: AFP Download Plus, S550-0433. Using the MVS Download exit 15 program to enable
multiple data set on AFP Download Plus is not supported.

2. Do not specify these attributes either directly or in Initial Value Job or Initial Value Document objects:

• transform-message-file-name

• resource-context-page-definition

You can use the resource-context attribute instead of the resource-context-page-definition
attribute.

3. Make sure that all of the MVS Download receivers that you plan to use have parallel processing
turned off. If parallel processing is enabled, you cannot use those receivers with multiple data set
jobs. To see the status of parallel processing:

1) Open the Management Console and click theMVS Download Receivers item in the left pane.
A list of receivers appears in the right pane.

2) Double-click each receiver to open the Viewing dialog.

3) In the Processing Options box, see if Parallel Processing is enabled. If it is enabled, you
cannot use that receiver with multiple data sets.

Limitations of multiple data set support

This support has these limitations:

1. You cannot use custom MVS Download exits on Windows with this function— you must use the
sample exit that comes with InfoPrint Manager.

2. This solution applies only to line mode, mixed mode, or MO:DCA-P data sets.

3. You cannot have inline resources with the same name and different content in the same job, except
for page definitions and form definitions.

4. The job-page-count attribute includes the separator pages when the host separator page is
enabled, but the separator pages are not included in the job-page-count for any other jobs.

5. When the separator page support is enabled in the host but the data set does not contain the
separator page, the receiver will print the job with InfoPrint Manager separators. In order to
suppress the InfoPrint Manager separators, you can perform one of the following options:

• Change the scripts/exits to set the auxiliary-sheet-selection job attribute to none
permanently.
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• Set the printer-start-sheet, printer-separator-sheet, and printer-end-sheet job attributes to
none for the actual destination.

• Set the auxiliary-sheet-selection job attribute to none for the logical destination.

6. You must disable parallel processing when you create the MVS Download Receiver, so that it only
receives one data set at a time. You cannot change processing options on existing receivers. As a
result, you will have to delete and re-create any receivers that have parallel processing enabled.

7. You must have enough disk space on the Windows system to receive and transform all of the data
sets in a multiple data set job. If you do not use this solution, data sets might be received and
transformed individually, so less space might be required.

8. This solution does not create three types of form definition (FORMDEF) statements in the generation
of a comprehensive inline form definition:

• MSU (Map Suppression)

• PFC (Presentation Fidelity Control)

• MFC (Medium Finishing Control)

• PEC (Presentation Environment Control)

• MDR (Map Data Resource)

If you enable multiple data set support using MVS Download, and you need to configure multiple MVS
Download FSA's, you must have one receiver for each Download FSA that is submitting jobs to the
InfoPrint Manager server. If you do not do this and two MVS Download FSA systems send jobs at the
same time, the job data sets can become intermingled and errors or incorrect output can result. This
restriction does not apply to AFP Download Plus. Multiple AFP Download Plus FSAs can be enabled for
multiple data set and use one receiver.

Technical description of multiple data set support

This describes the sequence of the multiple data set support.

1. The MVS Download receiver receives a data set into a file.

2. The MVS Download receiver invokes the InfoPrint Manager sample exit to spool the file. (You
associated the sample exit with this receiver when you created it.)

3. If MVS user exit 15 or AFP Download Plus marked the file as part of a multiple data set job, the
sample exit does not immediately spool the file. Instead, the sample exit calls a second program,
which invokes ACIF to transform the file into MO:DCA-P if it is from MVS Download.

4. After the last file in a multiple data set job is received and transformed to MO:DCA-P for MVS
Download, the sample exit invokes the afpconcat program to create one file with a comprehensive
inline form definition and all the MO:DCA-P documents. The afpconcat program can combine the
multiple MO:DCA-P files received from MVS Download into a single MO:DCA-P file. The
comprehensive inline form definition contains medium maps (copy groups) from all of the form
definitions associated with the individual data sets. The formdefs requested for each input file are
merged into a single combined formdef that is placed inline in the output MO:DCA-P document.

5. If medium map names collide, the afpconcat program assigns unique names and updates
references in the MO:DCA-P documents.
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6. The afpconcat program merges the inline resource group, discarding page definitions and the
original form definitions. Resources with matching resource names and types are compared to verify
that they are identical.

7. The sample exit spools the combined MO:DCA-P file.

Displaying the page count for your MVS Download jobs

To be able to see the page count for your MVS Download jobs listed in the InfoPrint Manager GUI, you
must install the multiple data set support as described in Submitting multiple data set jobs, p. 193. All of
the requirements and limitations apply, even if you do not plan to use multiple data set support.

To be able to see the page count for your AFP Download Plus jobs listed in the InfoPrint Manager GUI,
you can either turn on multiple data set support, or you can turn on page-accounting-support in AFP
Download Plus.

Performance considerations with the Direct Download method

The performance of the download receiver/daemon on the InfoPrint Manager server decreases when
using the Direct download function. The Direct download support can be enabled or disabled from
the host (see AFP Download Plus guide for further reference).

When enabled, there is an impact upon the throughput of the file from the beginning of file reception
across TCP/IP until first page is printed. Also, the CPU and disk usage may increase during the
operation.

The memory usage is not expected to be affected.

Using Direct download causes additional temporary files in the download working directory. You must
ensure that you have sufficient space in the file system where the download working directories reside.
No additional file system space is required.

Resubmitting or deleting MVS Download Receiver orphaned files

Orphaned files are old files left in the Windows file system because you selected the Keep CMD file
for Resubmitting Jobs check box when you started the MVS Download Receiver to submit the jobs,
and errors prevented InfoPrint from processing these print jobs. Their file names follow the MVS
Download Destination Control file naming format: MVS_system_name.job_name.dataset_name.
forms_name.yyddd.hhmmsstABCD.PRD

Because orphan files can cause performance problems, you should either correct the problem that
prevented the job from processing and then resubmit the job to MVS Download, or delete the orphan
files from the system.

Configuring MVS Download
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Also, when enabling the MVS Download Receiver tracing using the MVS Download Receiver Tracing
dialog in InfoPrint Manager Management Console, the MVS Download daemon saves the processing
files for debugging purposes.

Resubmitting jobs

Use this procedure to resubmit jobs through MVS Download:

1. In theManagement Console, double-click the MVS Download receiver that received the failed
print job.

2. In the Viewing: Receiver xxx dialog, find the View Job Data field and click Browse. The orphan
and .CMD files that remain on the InfoPrint Manager server are listed in theMVS Download
Receiver Data dialog that opens.

3. Right-click the .CMD file that failed.

4. Click Edit from the menu that appears to open the .CMD file as a text file.

5. Edit the file as you need to and save it.

6. Close the text editor.

7. Back in theMVS Download Receiver Data dialog, select and right-click the .CMD file again.

8. Click Open from the menu that appears to run the file.

9. In theMVS Download Receiver Data dialog, click Cancel.

10. In the Viewing: Receiver xxx dialog, click Cancel.

If you identify and correct print errors, re-submission of the file to MVS Download should delete the file
once it is successful.

Deleting orphaned files from the system

Orphan files should only occur when there's an error. If you do not want to identify and correct errors,
delete all files that are older than some site-determined period, such as three days.

To manually delete individual files:

1. In theManagement Console, double-click the MVS Download receiver that you want to clean
out.

2. In the Viewing: Receiver xxx dialog, find the View Job Data field and click Browse. The orphan
and .CMD files that remain on the InfoPrint Manager server are listed in theMVS Download
Receiver Data dialog that opens.

3. Highlight the job to be deleted and right-click it, then select Delete from the menu that appears.

UUssiinngg tthhee DDiissttrriibbuutteedd PPrriinntt FFaacciilliittyy ((DDPPFF))
See these sources for information about using DPF to manage and control printing from the host
console:

• "Planning to print with host systems" in the RICOH InfoPrint Manager for Windows: Planning Guide.

2 Administrative Procedures: Configuring for Host Printing
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• "Preparing InfoPrint Manager to connect to your host system" in RICOH InfoPrint Manager for Windows:
Getting Started.

• "Create/change/view DPF Host Receiver" topic in the online Help for the InfoPrint Manager
Management Console.

Using the Distributed Print Facility (DPF)



2

200



3

201

33.. Administrative Procedures: Customizing for Special
Jobs

•Working with transforms
•Understanding the transform objects and the custom steps (transforms) subsystem
•Using print rules
•Color and Grayscale Printing
•Working with fonts
•Working with global resource identifiers
•Generating and submitting color mapping table source and output files
•Using the InfoPrint 5000 and RICOH Pro VC series models with hot folders from InfoPrint

Manager to print PostScript and PDF
•Limitations of actual screen frequencies and angles on InfoPrint 4000 and 4100 printers
•Specifying a halftone for printing on the InfoPrint Manager server
•Submitting specialized print jobs

WWoorrkkiinngg wwiitthh ttrraannssffoorrmmss
InfoPrint Manager provides transform programs for these data streams:

• Printer control language (PCL)

• PostScript

• Portable document format (PDF)

• Tag image file format (TIFF)

• Joint photographic experts group (JPEG)

• Graphic interchange format (GIF)

• Line (ASCII, both formatted and unformatted)

• Double Byte text stream

• Extensible Markup Language (XML)

These transforms also support color management:

• ps2afp

• jpeg2afp

• tiff2afp

• gif2afp

The transforms convert the incoming data stream into the Advanced Function Presentation (AFP) format.

When a job in any of these formats is submitted to print on a PSF printer, InfoPrint Manager
automatically invokes the appropriate transform. You can also run the transforms from the Command
Prompt window without printing the generated output. You might find this useful if you intend to print the
job later. You can also use these transforms in transform objects and transform-sequences associated
with actual destinations. For more information about this function, see Configuring custom steps
(transforms), p. 244. Jobs print more quickly if they have already been transformed.

Most transforms have flags or option keywords that you can use to specify processing information. For a
list of the flags or options and values for each transform, see RICOH InfoPrint Manager: Reference.
Configuration files, environment variables, and user-exit programs allow you to specify processing
information for InfoPrint Manager to use when it invokes the transform automatically. You can also use
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configuration files and environment variables instead of typing flags on the command line whenever you
run a transform.

This section consists of these:

• Customizing the PCL, PostScript, and PDF transforms, p. 202

• Customizing the img2afp transform, p. 221

• Customizing the TIFF, JPEG, and GIF transforms, p. 225

• Working with the transform for line data, p. 227

• Working with the transform for double byte text streams, p. 232

For information about the fonts used with the double-byte (db2afp) transform, see Working with
fonts, p. 296.

• Working with the XML transforms, p. 234

• Color management resource transform support, p. 242

Customizing the PCL, PostScript, and PDF transforms

You can customize the transforms for PCL, PostScript, and PDF data by specifying values in the transform
configuration files. InfoPrint Manager transforms and configuration files, p. 202 shows the default
configuration files that InfoPrint Manager provides.

In the table, install_path is the directory that InfoPrint Manager is installed in. If you do not know the
install path, you can find it in theManagement Console. Open the Management Console, click Edit
-> Change Service Configuration and find the Install path field.

You can either modify these files or create your own.

IInnffooPPrriinntt MMaannaaggeerr ttrraannssffoorrmmss aanndd ccoonnffiigguurraattiioonn ffiilleess

Data Stream Transform Configuration File Daemon
Configuration File

PCL pcl2afp install_path
\pcl2afp\pcl2afp.
cfg

install_path
\pcl2afp\pcl2afpd.
cfg

PostScript ps2afp install_path
\ps2afp\ps2afp.cfg

install_path
\ps2afp\ps2afpd.
cfg

PostScript ps2afp install_path
\ps2afp\ps2afp.cfg

install_path
\ps2afp\agspdld.
cfg

3 Administrative Procedures: Customizing for Special Jobs
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PDF pdf2afp install_path
\ps2afp\ps2afp.cfg

install_path\
ps2afp\ps2afpd.cfg

PDF pdf2afp install_path
\ps2afp\ps2afp.cfg

install_path\
ps2afp\agspdld.cfg

PDF pdf2afp install_path
\ps2afp\ps2afp.cfg

install_path\
ps2afp\apped.cfg

The PostScript and PDF transforms use the same default configuration files.

Client configuration files

This is an example of a configuration file for the PostScript and PDF transforms when using CPSI
processing engine.

Sample PostScript or PDF client configuration file (ps2afp.cfg)

# ps2afp configuration file

######################################################################
# CPSI, APPE and AGSPDL GENERAL SETTINGS
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
######################################################################

port = 8251 # -P which TCP/IP port to use
appe_port = 8250 # -P which TCP/IP port to use for appe
agspdl_port = 8254 # -P which TCP/IP port to use for agspdl
server = localhost # -S which server to connect with

ps_max_memory = 48000K # -M maximum amount of memory that
# PostScript uses; the 'K' is ignored

ps_job_timeout = 9999 # -j maximum number of minutes
# to process PostScript job

ps_server_timeout = 360 # -s maximum number of minutes
# server waits between jobs

ps_document_processor = cpsi # -psproc which ps document
# processor to use

pdf_document_processor = cpsi # -pdfproc which pdf document
# processor to use

######################################################################
# CPSI SPECIFIC SETTINGS
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
######################################################################

ps_width = 8.5i # -w width of generated image
ps_length = 11i # -l length of generated image
ps_x_offset = 0i # -x left and right margins
ps_y_offset = 0i # -y top and bottom margins
ps_resolution = 300 # -r resolution of target printer
ps_output_type = IO1_G4 # -a type of AFP image to generate
ps_imgsmall = 0.5i # default value for imgsmall
ps_linesmall = 0.5i # default value for linesmall
ps_txtsmall = 0.5i # default value for txtsmall

Working with transforms
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#ps_is = 1 # the is afp compliance flag
#ps_compress_type = jpeg-sub

# -cmp JPEG subsampled compression
# other options: jpeg, lzw

######################################################################
# APPE SPECIFIC SETTINGS
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
######################################################################

appe_width = 8.5i # -w width of generated image
appe_length = 11i # -l length of generated image
appe_x_offset = 0i # -x left and right margins
appe_y_offset = 0i # -y top and bottom margins
appe_resolution = 300 # -r resolution of target printer
appe_output_type = IO1_G4 # -a type of AFP image to generate
#appe_is = 1 # the is afp compliance flag
#appe_compress_type = jpeg-sub

# -cmp JPEG subsampled compression
# other options: jpeg, lzw

#appe_pagetype = DOCUMENT
# type of afp structured field
# for each individual page

######################################################################
# AGSPDL SPECIFIC SETTINGS
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
######################################################################
agspdl_output_type = IO1_G4 # -a type of AFP image to generate
agspdl_resolution = 300 # -r resolution of target printer
agspdl_width = 8.5i # -w width of generated image
agspdl_length = 11i # -l length of generated image
agspdl_is = 1 # the is afp compliance flag
#agspdl_compress_type = lzw

# -cmp JPEG subsampled compression
# other options: jpeg, jpeg-sub

#agspdl_page_size_control
# -psc page size control options
# ArtBox, BleedBox, CropBox, TrimBox

######################################################################
# APPE and CPSI

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################
# APPE and CPSI

# ENABLING THE FINISHING FLAG ONLY
# If you want your users to be able to allow finishing operations,
# such as staple operations or punch operations, uncomment the
# following line.

# device_controls = finishing

######################################################################
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# APPE and CPSI

# ENABLING THE PLEX COMMAND ONLY
# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################
# APPE and CPSI

# ENABLING BOTH PLEX AND FINISHING
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND allow finishing
# operations, such as staple operations or punch operations,
# uncomment the following line.

# device_controls = plex,finishing

######################################################################
# APPE and CPSI

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.
# Replace size with one of the supported paper sizes \
(LETTER, LEGAL, A3, A4, B4, B5, LEDGER)

# device_controls = plex,inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ), \
inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

######################################################################
# APPE and CPSI

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output, AND allow finishing
# operations, AND specify which paper tray to use, uncomment the line
# below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.
# Replace size with one of the supported paper sizes \
(LETTER, LEGAL, A3, A4, B4, B5, LEDGER)

# device_controls = plex,finishing,inputX=(size,type=ZZZ,weight=ZZZ, \
color=ZZZ), inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

Sample pcl2afp client configuration file (pcl2afp.cfg)

# pcl2afp configuration file

Working with transforms
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# KEYWORD EQUIVALENT pcl2afp FLAG PURPOSE
######################################################################

port = 8253 # -P which TCP/IP port to use
server = localhost # -S which server to connect with

pcl_max_memory = 6000K # -M maximum amount of memory that
# PCL uses; the 'K' is ignored

pcl_job_timeout = 20 # -j maximum number of minutes
# to process a PCL job

pcl_width = 8.5i # -w width of generated image
pcl_length = 11i # -l length of generated image
pcl_x_offset = 0i # -x left and right margins
pcl_y_offset = 0i # -y top and bottom margins
pcl_resolution = 300 # -r resolution of target printer
pcl_output_type = IO1_G4 # -a type of AFP image to generate

#pcl_is = 1 # -is the is afp compliance flag
#pcl_compress_type = lzw # -cmp lzw compression

# other options: jpeg, jpeg-sub

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################

# ENABLING THE PLEX COMMAND ONLY
# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the PCL bin number (between 1 and 59).

# You can list up to 20 mappings.

# device_controls = plex,inputX=(pcl_bin=Z),inputX=(pcl_bin=Z)

The configuration file uses keyword equivalents of the transform flags. For the keywords and values that
you can specify in the configuration file, see RICOH InfoPrint Manager: Reference.

3 Administrative Procedures: Customizing for Special Jobs
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Daemon configuration files

The PCL, PostScript, and PDF transforms all require a daemon to be running before you can use them.
The pcl2afpd daemon manages the PCL interpreter portion of the pcl2afp transform. The
ps2afpd daemon manages the PostScript or PDF CPSI interpreter portion of the ps2afp and
pdf2afp transforms. The apped daemon manages the PDF APPE processing portion of the ps2afp
and pdf2afp transforms. The agspdld daemon manages the PDF and PostScript Artifex GhostPDL
(AGSPDL) processing portion of the ps2afp and pdf2afp transforms. For more information about these
daemons, see RICOH InfoPrint Manager: Reference.

Each daemon, like the corresponding transform, uses a configuration file. The daemon configuration file
can contain the same keywords as the transform configuration file (except server), plus some keywords
that control the operation of the daemon. For the daemon keywords, see the RICOH InfoPrint Manager:
Reference.

Sample AGSPDL daemon configuration file (agspdld.cfg)

# agspdld configuration file

######################################################################
# KEYWORD PURPOSE
######################################################################

port = 8254 # which TCP/IP port to use

work_directory = <AFP Support Path>\agspdl
# directory to put work files into

log_file = <AFP Support Path>\agspdl\agspdl.log
# where to write log messages

log_size = 1024 # maximum log size in KB

ps_font_directory = <AFP Support Path>\agspdl\Resource
# list of resource files

ps_output_type = IO1_G4 # type of AFP image to generate
ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_resolution = 300 # resolution of target printer
agspdl_is = 1 # the is afp compliance flag
#agspdl_compress_type = lzw

# lzw compression
# other options: jpeg, jpeg-sub

#agspdl_page_size_control
# -psc page size control options
# ArtBox, BleedBox, CropBox, TrimBox

Sample APPE daemon configuration file (apped.cfg)

# apped configuration file

######################################################################
# KEYWORD PURPOSE
######################################################################

port = 8250 # which TCP/IP port to use

Working with transforms
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appe_work_directory = <AFP Support Path>\appe
# directory to put APPE work files into

log_file = <AFP Support Path>\appe\apped.log
# where to write daemon log messages

log_size = 100 # maximum log size in KB

#transform_trace_file = <AFP Support Path>\appe\appeTraceFile.log
# where to write APPE transform traces
# comment out to disable tracing

#transform_trace_size = 200 # maximum trace size in KB
# use 0 to disable trace size checking

#transform_trace_level = MDFL@-1
# APPE traces level
# MMST@-1 output most trace statements
# MINT@-1 output intermediate level of tracing
# MDFL@-1 output default trace statements

#appe_fonts_path =
#list of directories where extra APPE fonts are located

appe_font_map_files = <Install Path>\appe\fontmaps\FontMapSample.cfg

appe_width = 8.5i # width of generated image
appe_length = 11i # length of generated image
appe_x_offset = 0i # left and right margins
appe_y_offset = 0i # top and bottom margins
appe_resolution = 300 # resolution of target printer
appe_output_type = IO1_G4 # type of AFP image to generate
#appe_is = 1 # the is afp compliance flag
#appe_compress_type = jpeg-sub

# JPEG subsampled compression. Other options: jpeg, lzw
#appe_pagetype = DOCUMENT

# type of afp structured field for each individual page

Sample pcl2afp daemon configuration file (pcl2afpd.cfg)

# pcl2afpd configuration file

######################################################################
# KEYWORD PURPOSE
######################################################################

port = 8253 # which TCP/IP port to use

work_directory = <AFP Support Path>\pcl2afp
# directory to put work files into

log_file = <AFP Support Path>\pcl2afp\pcl2afpd.log
# where to write log messages

log_size = 100 # maximum log size in KB

pcl_program = <Install Path>\bin\pcl6.exe
# name of PCL interpreter program

pcl_fonts_path = <Install Path>\pcl2afp
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# location of .FCO files for PCL6
pcl_max_memory = 12000K # maximum amount of memory that

# PCL uses; the 'K' is ignored

pcl_job_timeout = 20 # maximum number of minutes
# to process a PCL job

pcl_width = 8.5i # width of generated image
pcl_length = 11i # length of generated image
pcl_x_offset = 0i# left and right margins
pcl_y_offset = 0i # top and bottom margins
pcl_resolution = 300 # resolution of target printer
pcl_output_type = IO1_G4 # type of AFP image to generate

#pcl_is = 1 # the is afp compliance flag
#pcl_compress_type = lzw # lzw compression

# other options: jpeg, jpeg-sub

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################

# ENABLING THE PLEX COMMAND ONLY
# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the PCL bin number (between 1 and 59).

# You can list up to 20 mappings.

# device_controls = plex,inputX=(pcl_bin=Z),inputX=(pcl_bin=Z)

Sample ps2afp daemon configuration file for InfoPrint 4000 and InfoPrint 4100
printers (ps2afpd.cfg)

# ps2afpd configuration file

######################################################################
# KEYWORD PURPOSE
######################################################################

port = 8251 # which TCP/IP port to use

work_directory = <AFP Support Path>\ps2afp
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# directory to put work files into
log_file = <AFP Support Path>\ps2afp\ps2afpd.log

# where to write log messages
log_size = 100 # maximum log size in KB

ps_program = <Install Path>\cpsibin\ps2afpi.exe
# name of PostScript interpreter program

ps_init_file = <Install Path>\ps\ps2afp.ps
# name of PostScript interpreter
# initialization file

ps_files_path = <Install Path>\ps;\
<Install Path>\config;\
<Install Path>\reslib

# path to search for jobInit files

ps_max_memory = 48000K # maximum amount of memory that
# PostScript uses; the 'K' is ignored

ps_job_timeout = 9999 # maximum number of minutes
# to process PostScript job

ps_server_timeout = 360 # maximum number of minutes
# server waits between jobs

ps_font_map_files = <Install Path>\ps\fonts.map
# list of font mapping files

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
ps_resolution = 300 # resolution of target printer
ps_output_type = IO1_G4 # type of AFP image to generate
#following three parameters will apply only if threshsmall specified
ps_imgsmall = 0.5i # default value for imgsmall
ps_linesmall = 0.5i # default value for linesmall
ps_txtsmall = 0.5i # default value for txtsmall
#ps_is = 1 # the is afp compliance flag
ps_compress_type = jpeg-sub # JPEG subsampled compression. \
Other options: jpeg, lzw

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################

# ENABLING THE FINISHING FLAG ONLY
# If you want your users to be able to allow finishing operations,
# such as staple operations or punch operations, uncomment the
# following line.

# device_controls = finishing

######################################################################

# ENABLING THE PLEX COMMAND ONLY
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# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################

# ENABLING BOTH PLEX AND FINISHING
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND allow finishing
# operations, such as staple operations or punch operations,
# uncomment the following line.

# device_controls = plex,finishing

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.
# Replace size with one of the supported paper sizes \
(LETTER, LEGAL, A3, A4, B4, B5, LEDGER)

# device_controls = plex,inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ), \
inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output, AND allow finishing
# operations, AND specify which paper tray to use, uncomment the line
# below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.
# Replace size with one of the supported paper sizes \
(LETTER, LEGAL, A3, A4, B4, B5, LEDGER)

# device_controls = plex,finishing,inputX=(size,type=ZZZ,weight=ZZZ, \
color=ZZZ), inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

Sample ps2afp daemon configuration file for cut sheet IPDS printers (3160d.cfg)

# ps2afpd configuration file

######################################################################
# KEYWORD PURPOSE
######################################################################

port = 8252 # which TCP/IP port to use

work_directory = <AFP Support Path>\ps2afp2
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# directory to put work files into
log_file = <AFP Support Path>\ps2afp2\ps2afpd.log

# where to write log messages
log_size = 100 # maximum log size in KB

ps_program = <Install Path>\cpsibin\ps2afpi.exe
# name of PostScript interpreter program

ps_init_file = <Install Path>\ps\ps2afp.ps
# name of PostScript interpreter
# initialization file

ps_files_path = <Install Path>\ps;\
<Install Path>\config;\
<Install Path>\reslib

# path to search for jobInit files

ps_max_memory = 48000K # maximum amount of memory that
# PostScript uses; the 'K' is ignored

ps_job_timeout = 9999 # maximum number of minutes
# to process PostScript job

ps_server_timeout = 360 # maximum number of minutes
# server waits between jobs

ps_font_map_files = <Install Path>\ps\fonts.map
# list of font mapping files

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
ps_resolution = 300 # resolution of target printer
ps_output_type = IO1_G4 # type of AFP image to generate
ps_compress_type = jpeg-sub # JPEG subsampled compression. \
Other options: jpeg, lzw

pragma = jobInit 3160.ibm85lpi.tf.dt.ps; \
jobInit 3160.ibm85lpi.ta.ps; \

wglRotate yes;

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################

# ENABLING THE PLEX COMMAND ONLY
# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
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# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.
# Replace size with one of the supported paper sizes \
(LETTER, LEGAL, A3, A4, B4, B5, LEDGER)

# device_controls = plex,inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ), \
inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

Hierarchy of transform options

InfoPrint Manager assigns a hierarchy to its use of flags and configuration file information when it runs
the PCL, PostScript, or PDF transform program. This lists the order in which InfoPrint Manager uses flags
and information specified in configuration files:

1. Any values you specify on the command line, including values in the configuration file you specify
with the -C flag.
InfoPrint commands process flags from left to right. If you enter the same flag more than once,
InfoPrint Manager uses the last occurrence of the flag to determine the value to use. For example, if
you enter this command:

ps2afp -Cconfig.file -r240 -r300 myfile.ps

the ps2afp command transforms the file using 300-pel resolution. InfoPrint Manager ignores the
resolution value specified in the configuration file config.file as well as the first -r240 flag and
value.

2. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in the current directory, if one
exists and if you enter the transform command directly. InfoPrint Manager ignores values in the
current directory if you invoke the transform command indirectly by submitting a job to print.

3. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in your home directory, if one
exists.

4. Values specified in the default transform command configuration file named in Client configuration
files, p. 203.

5. Values specified in a customized configuration file identified with the -C flag of the apped,
pcl2afpd, or ps2afpd command when the transform daemon started.

6. Values specified in the default transform daemon configuration file named in Client configuration
files, p. 203.

7. Default values that are built into InfoPrint Manager. These are the same as the transform defaults
except that the default PostScript or PDF output type is an IM1 uncompressed image.

Stapling and punch options PostScript available from the ps2afp transform

You can use the ps2afp transform to specify both staple and punch finishing options. To use this
support, you must:

1. Make sure that the IPDS (Intelligent Printer Data Stream) capable printer supports either staple or
punch finishing options.
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2. Make sure that the PostScript input file contains either staple or punch information.

3. Make sure that the keyword finishing is assigned to the device_controls option in the ps2afpd.
cfg configuration file, as shown in the bold-faced example in Sample PostScript Daemon
configuration file sections with staple and punch options, p. 215.

4. Make sure that the application or driver that generated the PostScript supports the subset of staple
or punch operations enabled in the ps2afp transform. See Staple and punch PostScript operations
supported by the ps2afp transform, p. 217 for a list of these staple and punch options.

If you are interested in using this finishing support, the PostScript drivers available with these printers
contain this support. You can specify these InfoPrint printers as TCP/IP:

• InfoPrint 2085

• InfoPrint 2105

• InfoPrint 2060ES

• InfoPrint 2075ES

• InfoPrint 2090ES

• InfoPrint 2105ES

Specifying finishing in the ps2afpd.cfg file

This shows how you can specify finishing values in the ps2afp data stream transform:

1. From a command line, access the ps2afpd.cfg file that is in either the /usr/lpp/psf/ps2afp/
directory on an AIX server or the install_path\ps2afp folder on a Windows server.

2. Using your editor of choice, edit the file.

3. Find the heading #ENABLING STAPLING OR PUNCH FINISHING OPTIONS THROUGH THE
TRANSFORM and remove the hash mark (#) that comments out this line:

device_controls=finishing

4. Save and close the file.

1. The device_controls option also accepts bin numbers and plex key words.

2. If you omit plex, the ps2afp transform creates duplex output.

3. If you omit bin numbers, the ps2afp transform creates output that indicates that the first input tray
should be used.

4. Not all printers support using the staple and punch options that the ps2afp transform generates. If
you send a document with staple or punch operations to an IPDS printer that does not support the
request, InfoPrint Manager issues a message and completes the job, without either staples or punch
holes. Refer to your printer documentation to determine which (if any) staple or punch operations
are available.

For further examples, see the ps2fpd.cfg file shipped with the latest version of InfoPrint Manager, which
includes the device_controls option.
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Sample PostScript Daemon configuration file sections with staple and punch options

# ps2afpd configuration file

# KEYWORD PURPOSE
######################################################################

port = 8251 # which TCP/IP port to use

######################################################################
# CPSI SPECIFIC SETTINGS
# KEYWORD PURPOSE
######################################################################

work_directory = /var/psf/ps2afp
# directory to put work files into

log_file = /var/psf/ps2afp/ps2afpd.log
# where to write log messages

notify = root # who to notify if problems encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2afpi

# name of PostScript interpreter program
ps_init_file = /usr/lpp/psf/ps2afp/ps2afpe.ps

# name of PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config :\
/usr/lpp/psf/reslib

# path to search for jobInit files

ps_max_memory = 48000K # maximum amount of memory that
# PostScript uses; the 'K' is ignored

ps_job_timeout = 9999 # maximum number of minutes
# to process PostScript job

ps_server_timeout = 360 # maximum number of minutes
# server waits between jobs

ps_font_map_files = /usr/lpp/psf/ps/psfonts.map :\
/var/psf/psfonts/user.map

# list of font mapping files

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
ps_resolution = 300 # resolution of target printer
ps_output_type = IO1_G4 # type of AFP image to generate
#following three parameters will apply only if threshsmall specified
ps_imgsmall = 0.5i # default value for imgsmall
ps_linesmall = 0.5i # default value for linesmall
ps_txtsmall = 0.5i # default value for txtsmall
#ps_is = 1 # the is afp compliance flag
#ps_compress_type = jpeg-sub # JPEG subsampled compression.
#Other options: jpeg, lzw
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######################################################################

# Customize if desired
#pragma = jobInit 4000.ibm85lpi.tf.dt.ps; \
# jobInit 4000.ibm85lpi.ta.ps;

#

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# NOTE: Uncomment only one of the options below.

######################################################################

# ENABLING THE FINISHING FLAG ONLY
# If you want your users to be able to allow finishing operations,
# such as staple operations or punch operations, uncomment the
# following line.

# device_controls = finishing

######################################################################

# ENABLING THE PLEX COMMAND ONLY
# If you want your users to be able to choose between single-sided and
# double-sided (duplexed) output, uncomment the following line.

# device_controls = plex

######################################################################

# ENABLING BOTH PLEX AND FINISHING
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND allow finishing
# operations, such as staple operations or punch operations,
# uncomment the following line.

# device_controls = plex,finishing

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output AND specify which paper
# tray to use, uncomment the line below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.

# device_controls = plex,inputX=(size,type=ZZZ,weight=ZZZ,
color=ZZZ),inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

######################################################################

# ENABLING THE PLEX COMMAND AND MAPPING BINS TO TRAYS
# If you want your users to be able to both choose between single-
# sided and double-sided (duplexed) output, AND allow finishing
# operations, AND specify which paper tray to use, uncomment the line
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# below and fill in the correct values:

# Replace the Xs with the number of the AFP tray (between 1 and 255).
# Replace the Zs with the appropriate values.

# device_controls = plex,finishing,inputX=(size,type=ZZZ,weight=ZZZ,
color=ZZZ),inputX=(size,type=ZZZ,weight=ZZZ,color=ZZZ)

Staple and punch PostScript operations supported by the ps2afp transform

These tables list the subset of PostScript information transformed to Advanced Function Presentation
(AFP) MO:DCA-P structured fields and triplets to support staple and punch operations. The changes
described below should only be performed by someone with extensive knowledge of the PostScript
language, such as someone writing their own PostScript driver.

The << /Staple 3 information below is a particular example drawn from Default staple locations, p.
218 and Additional PostScript staple details, p. 218. Both tables contain pertinent information for
adding stapling operations to your PostScript data stream.

{ << /Staple 3 /StapleDetails << /Type 17 /Position 17 >>
>> setpagedevice }
{ << /Staple 3 /StapleDetails << /Type 17 /Position 18 >>
>> setpagedevice }

This example indicates that the printer will place two staples at the top of a page, whether the page has
either a Portrait or a Landscape orientation.

/Staple 3
The key that introduces the StapleDetails Dictionary.

/Type 17
A required key reserved for future use.

/Position
A key that indicates the placement of the staples, using the settings displayed in Additional
PostScript staple details, p. 218.

The << /Punch 4 information below is a particular example drawn from Default punch locations, p.
220, Additional PostScript punch details, p. 220, and Punch Setting for the /Pattern value, p. 220. All
three tables contain pertinent information for adding stapling operations to your PostScript data stream.

{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0
/Position 1 >> >> setpagedevice }
{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0
/Position 5 >> >> setpagedevice }

This example indicates that the printer will place a punch on the left side of a page, whether the page
has either a Portrait or a Landscape orientation.

/Punch 4
The key that introduces the PunchDetails Dictionary.

/Type 7
A required key reserved for future use.
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/Pattern 0
A key that indicates the default punch setting, using the settings displayed in Punch Setting for the
/Pattern value, p. 220.

Most PostScript drivers use /Pattern 0 because Finishers tend to have one particular setting.
/Pattern 0 works with all Finishers. If you specify /Pattern 6 in the PostScript driver and your
Finisher only supports two-hole punch, InfoPrint Manager will print the job and generate an error
message without performing the finishing.

/Position
A key that indicates the placement of the staples, using the settings displayed in Additional
PostScript punch details, p. 220.

DDeeffaauulltt ssttaappllee llooccaattiioonnss

Staple Key name PostScript Staple

Do not staple None /Staple 0

Staple Not supported /Staple 3

AAddddiittiioonnaall PPoossttSSccrriipptt ssttaappllee ddeettaaiillss

Staple details Key name PostScript staple details

Do not staple None Portrait:

/Position 0

Landscape:

/Position 0

Single left diagonal LeftDiagonal Portrait:

/Position 1

Landscape:

/Position 5

Single left horizontal LeftHorizontal Portrait:

/Position 3

Landscape:

/Position 7

Single left vertical LeftVertical Portrait:

/Position 2

Landscape:

/Position 6
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Single right diagonal RightDiagonal Portrait:

/Position 9

Landscape:

/Position 13

Single right
horizontal

RightHorizontal Portrait:

/Position 11

Landscape:

/Position 15

Single right vertical RightVertical Portrait:

/Position 10

Landscape:

/Position 14

Double left DoubleLeft Portrait:

/Position 4

Landscape:

/Position 8

Double right DoubleRight Portrait:

/Position 12

Landscape:

/Position 16

Double top DoubleTop Portrait:

/Position 17

Landscape:

/Position 18

Booklet Booklet Portrait:

/Position 20

Landscape:

/Position 20
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DDeeffaauulltt ppuunncchh llooccaattiioonnss

Punch Key name PostScript Punch

Do not punch None /Punch 0

Punch Not supported /Punch 4

AAddddiittiioonnaall PPoossttSSccrriipptt ppuunncchh ddeettaaiillss

Punch details Key name PostScript punch details

Do not punch None Portrait:

/Position 0

Landscape:

/Position 0

Left PunchLeft Portrait:

/Position 1

Landscape:

/Position 5

Top PunchTop Portrait:

/Position 3

Landscape:

/Position 7

Right PunchRight Portrait:

/Position 2

Landscape:

/Position 6

Bottom PunchButtom Portrait:

/Position 4

Landscape:

/Position 8

PPuunncchh SSeettttiinngg ffoorr tthhee //PPaatttteerrnn vvaalluuee

Punch Key Name PostScript Punch Details

Default Punch* /Pattern 0

2–holes Punch*2 /Pattern 6
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3–holes Punch*3 /Pattern 5

4–holes Punch*4 /Pattern 7

Collate PostScript options available from the ps2afp transform

When a PostScript file contains the collate key, the ps2afp transform recognizes that key, and the
resulting AFP output has the copies collated. Not all PostScript printers natively support the PostScript
collate key, but if you used a PSF other-driver DSS, InfoPrint Manager exploits this new transform
feature and creates PCL that you can print on that same printer and get collated copies.

The collation function requires more disk space, so increase the space in /var/psf to store the
temporary file for collation.

Customizing the img2afp transform

The img2afp transform can be used to transform color (FS45) images into monochrome bilevel (FS10)
images for printing. This transform is valuable for transforming color images so that they print well in
black-and-white. You can customize the img2afp transform only by specifying options on the command
line. Unlike other transforms shipped with the InfoPrint Manager, this transform is not invoked
automatically. Instead, you must specify it at the command line to preprocess the data before printing.
For specific information about the syntax and use of this command, see RICOH InfoPrint Manager:
Reference.

While you can create an img2afp.cfg file, InfoPrint Manager supplies a series of img2afp.cfg
configuration files that are based on the printer model. For example, the img2afp.4000-708cfg file on
an InfoPrint Manager for AIX server contains these settings:

#img2afp InfoPrint 4000-708 configuration file

a=fs10
respath=.:/usr/lpp/psf/config
thresh=4000-708.ibm106lpi.ta.ps
gcorr=4000-708.ibm106lpi.tf.dt.ps
pagetype=page
v=yes
r=600

On an InfoPrint Manager for Windows server, the respath value should be set to the path where the
img2afp configuration files is located in: install_path\config where install_path is the fully qualified path
where InfoPrint Manager for Windows is installed on your system.

In each device-specific configuration file, only the thresh and gcorr values change

img2afp.cfg files observe these basic rules:
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1. Any item specified in a configuration file can be overridden on the command line.

2. Configuration file syntax is attribute = value.

3. A hash mark (#) indicates a comment to the end of the line.

4. All attribute names are the same as the command-line names.

5. For options that do not take values, you must type yes in the configuration file (as shown below).

#sample img2afp configuration file

v = yes #equivalent to -v flag
a = fs10 #bilevel output

To invoke the transform from the command line, you must specify at least:

• -a fs10 to indicate bilevel output .

• -thresh {name} to specify the PostScript level 3 halftone dictionary that you are using.
When you install some printers with InfoPrint Manager, the product makes PostScript level 3
halftone dictionaries available on your server. For example, an InfoPrint HD1-HD2, HD3-HD4,
HD5-HD6, HS1, HS3, MD1-MD2, MS1. PS-1, or PD1-PD2 4100 printer models provides these:

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm71lpi.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm71lpirot90.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm85lpi.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm85lpirot90.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm106lpi.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm106lpirot90.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm141lpi.ta.ps

– C:\Program Files\RICOH\InfoPrint Manager\config\4100-model.ibm141lpirot90.ta.ps

• -gcorr filename to specify grayscale mapping tables to halftone the grayscale and color images to
bilevel for output.
When you install particular printers with InfoPrint Manager, you also install these grayscale
mapping tables for each type of PostScript level 3 halftone dictionary option.

For example, an InfoPrint HD3–HD4, HD5–HD6, HS2, HS3, MD1–2 MS1, PD1–PD2, PS1, TD1-
2, TD3-4, TD5-6, TS1, TS2, or TS3 4100 printer models provides these:

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpi.tf.ap.ps for
dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpi.tf.dt.ps for
midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpi.tf.lr.ps for
standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpi.tf.ls.ps for
accutone halftones
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– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpi.tf.oc.ps for
dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpiRot90.tf.ap.ps
for dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpiRot90.tf.dt.ps
for midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpiRot90.tf.lr.ps
for standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpiRot90.tf.ls.ps
for accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm71lpiRot90.tf.oc.ps
for dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpi.tf.ap.ps for
dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpi.tf.dt.ps for
midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpi.tf.lr.ps for
standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpi.tf.ls.ps for
accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpi.tf.oc.ps for
dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpiRot90.tf.ap.ps
for dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpiRot90.tf.dt.ps
for midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpiRot90.tf.lr.ps
for standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpiRot90.tf.ls.ps
for accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm85lpiRot90.tf.oc.ps
for dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpi.tf.ap.ps for
dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpi.tf.dt.ps for
midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpi.tf.lr.ps for
standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpi.tf.ls.ps for
accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpi.tf.oc.ps for
dark2 halftones
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– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpiRot90.tf.ap.ps
for dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpiRot90.tf.dt.ps
for midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpiRot90.tf.lr.ps
for standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpiRot90.tf.ls.ps
for accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm106lpiRot90.tf.oc.ps
for dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpi.tf.ap.ps for
dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpi.tf.dt.ps for
midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpi.tf.lr.ps for
standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpi.tf.ls.ps for
accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpi.tf.oc.ps for
dark2 halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpiRot90.tf.ap.ps
for dark halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpiRot90.tf.dt.ps
for midtone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpiRot90.tf.lr.ps
for standard halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpiRot90.tf.ls.ps
for accutone halftones

– C:\Program Files\IBM\InfoPrint Manager\config\4100-model.ibm141lpiRot90.tf.oc.ps
for dark2 halftones

and -gcorr and -thresh must be used to select an appropriate halftone.

Limitations of the img2afp transform

When using the img2afp transform, be aware of these limitations:

• Only jobs that contain either pure IOCA data or IOCA overlaid by other bilevel-compatible OCAs
print correctly.

• img2afp does not support one bit per spot CMYK data (FS42) data conversions.
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Examples

For each of these examples, the user has an AFP input file of an FS45 image that they are converting to
an FS10 file for printing on a black-and-white printer. To obtain their FS45 input file, they might have
used either the tiff2afp, gif2afp, jpeg2afp, pdf2afp, or ps2afp transform to convert an image file
from one of those formats

To convert an FS45 image (sampleFS45.afp) to an FS10 image (outFS10.afp) from an InfoPrint
command line for printing on an InfoPrint 21 printer, type this on the command line:

img2afp -a fs10 -thresh 4322.ibm106lpi.ta.ps -gcorr \
4322.ibm106lpi.tf.dt.ps sampleFS45.afp -o outFS10.afp

To print the resulting FS10 image (outFS10.afp) on an InfoPrint 21 printer, type this on the command
line:

pdpr -p ip21-ld outFS10.afp

To convert an FS45 image (DSC011FS45.afp) to an FS10 image (DSC011FS10.afp) with standard
halftones from an InfoPrint command line for printing on an InfoPrint 4100–HD3/HD4 Advanced
Function Printing System printer, type this on the command line:

img2afp -a fs10 -thresh 4100-HD3-HD4.ibm106lpi.ta.ps -gcorr \
4100-HD3-HD4.ibm106lpi.tf.lr.ps DSC011FS45.afp -o DSC011FS10.afp

To print the resulting FS10 image (DSC011FS10.afp) on an InfoPrint 4100–HD3/HD4 Advanced
Function Printing System printer, type this on the command line:

pdpr -p silver-ld DSC011FS10.afp

To convert an FS45 image (DSC015FS45.afp) to an FS10 image (DSC011FS10.afp) with dark
halftones from an InfoPrint command line for printing on an InfoPrint 4000 Advanced Function Printing
System printer, type this on the command line:

img2afp -a fs10 -thresh 4000.ibm106lpi.ta.ps -gcorr \
4000.ibm106lpi.tf.ap.ps DSC015FS45.afp -o DSC011FS10.afp

To print the resulting FS10 image (DSC011FS10.afp) on an InfoPrint 4000 Advanced Function Printing
System printer, type this on the command line:

pdpr -p ip40001-ld DSC011FS10.afp

Customizing the TIFF, JPEG, and GIF transforms

You can customize the transforms for TIFF, JPEG, and GIF data by specifying values in the transform
configuration files. Default TIFF, JPEG, and GIF Transform Configuration Files, p. 225 shows the default
configuration files that InfoPrint Manager provides. You can either modify these files or create your own.

DDeeffaauulltt TTIIFFFF,, JJPPEEGG,, aanndd GGIIFF TTrraannssffoorrmm CCoonnffiigguurraattiioonn FFiilleess

Data
Stream

Transform Configuration Files

TIFF tiff2afp install_path\tiff2afp\tiff2afp.cfg
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Data
Stream

Transform Configuration Files

install_path\tiff2afp\tiff2afp.3160cfg

install_path\tiff2afp\tiff2afp.3900cfg

JPEG jpeg2afp install_path\jpeg2afp\jpeg2afp.cfg

install_path\jpeg2afp\jpeg2afp.3160cfg

install_path\jpeg2afp\jpeg2afp.3900cfg

GIF gif2afp install_path\gif2afp\gif2afp.cfg

install_path\gif2afp\gif2afp.3160cfg

install_path\gif2afp\gif2afp.3900cfg

InfoPrint uses the .3160cfg and .3900cfg configuration files to transform documents that have been
submitted to print on an InfoPrint 60 printer or InfoPrint 4000 laser printer respectively.

Sample configuration file

This is an example of a configuration file for the TIFF transform. The configuration files for the JPEG and
GIF transforms are similar.

a=ioca10
choice=full
cmp=g4
ms=5120
msf=0.01
nosniff=yes
noterm=yes
v=yes
pagetype=page
r=600
x=0
y=

The configuration file uses options in the same format as the transform options that you specify on the
command line, except that command line options begin with a dash (–). For the options and values that
you can specify in the configuration file, see RICOH InfoPrint Manager: Reference.

Hierarchy of transform options

InfoPrint Manager assigns a hierarchy to its use of options and configuration-file information when it
runs the TIFF, JPEG, or GIF transform program. This lists the order in which InfoPrint uses command–line
options and information specified in configuration files:

1. Any values you specify on the command line, including values in the configuration files you specify
with the -C option.
InfoPrint Manager commands process options from left to right. If you enter the same option more
than once, InfoPrint Manager uses the last occurrence of the flag to determine the value to use. For
example, if you specify this command:

tiff2afp -Cconfig.file -r240 -r300 myfile.tif
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the tiff2afp command transforms the file using 300-pel resolution. InfoPrint Manager ignores the
resolution value specified in the configuration file config.file and the first -r240 flag and value.

2. Values specified in the default transform command configuration file named in Default TIFF, JPEG,
and GIF Transform Configuration Files, p. 225.

3. Default values that are built into InfoPrint Manager. These are the same as the transform defaults.

Working with the transform for line data

InfoPrint Manager includes a line-data transform program that transforms line data into the Advanced
Function Presentation (AFP) data stream. Converting the line data lets you print it on high-speed AFP
printer devices.

The line2afp command and its keywords are a subset of the AFP Conversion and Indexing Facility
(ACIF) acif command. When you use this transform and if errors occur, you might receive some error
messages that make references to ACIF.

This section describes these:

• What is line data?, p. 227

• What are ANSI and machine carriage controls?, p. 228

• What are variable-length and fixed-length files?, p. 229

• How does the imageout keyword affect processing?, p. 231

• Customizing the line data transform, p. 231

What is line data?

Line data is simply unformatted data; data with few or no embedded control characters to create font
changes, page breaks, and so on. The term line data can cover a variety of data streams, such as:

• Traditional line printer format, also called 1403 format

• Unformatted ASCII files without escape sequences

• DBCS (double-byte character set) ASCII files generated for an IBM 5577 or 5587.

1. The line2afp transform does not handle DBCS ASCII files. For this type of input, use the db2afp
transform.

2. ACIF accepts EBCDIC DBCS line data files that use SOSI (shift-out/shift-in) characters. ACIF must
be coded with the PRMODE control statement set to SOSI1, SOSI2 or SOSI3, as documented in
the ACIF User's Guide.

Line data is typically created by an application program. For example, an application might produce a
bank statement that has line data indicating an account's daily balance.

The InfoPrint line-data transform lets you format these kinds of data with a page definition and form
definition for printing on InfoPrint-managed printer devices:
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• S\370 line-mode data
This type of line data was originally designed for a 1403 printer, is typically generated on a S\370
host processor, and is usually EBCDIC characters with embedded control characters (carriage
control, table reference characters, and so on). This type of line data can have double-byte code
points and shift in\shift out controls.

• Mixed-mode data
S\370 line-mode data embedded with certain AFP structured fields (for example, Include Page
Segment)

• Single-byte ASCII data with no embedded control characters except for newlines.

• Single-byte ASCII data that contains ANSI carriage-control characters, table-reference characters,
or both.

• Single-byte ASCII data that contains carriage returns and form feed controls, if you specify the
asciinp or asciinpe user-exit program.

When you transform the line-data job, you must specify a page definition and a form definition. For
more information about the page definitions and form definitions available to you, see RICOH InfoPrint
Manager: Reference. For more information about associating page definitions and form definitions with
jobs, see the online help in the InfoPrint Manager Administration GUI.

1. You cannot use the line-data transform when printing files containing Proprinter ASCII.

2. When the line2afp command processes any unrecognized or unsupported keyword, line2afp
issues a message, ignores the keyword, and continues processing any remaining keywords. The
line2afp command then stops processing.

3. InfoPrint Manager also lets you transform and print DBCS ASCII data and DBCS EUC data without
a page definition. For more information, see the db2afp command in RICOH InfoPrint Manager:
Reference.

What are ANSI and machine carriage controls?

In many environments (including IBM mainframes and most minicomputers), printable data normally
contains a carriage control character. The carriage control character acts as a vertical tab command to
position the paper at the start of a new page, at a specified line on the page, or to control skipping to
the next line. The characters can be one of two types: ANSI carriage control or machine carriage
control.

ANSI carriage control characters

The most universal carriage control is ANSI, which consists of a single character that is a prefix for the
print line. The standard ANSI characters are listed in ANSI carriage controls, p. 228.

AANNSSII ccaarrrriiaaggee ccoonnttrroollss

ANSI Action
space Single space the line and print.

0 Double space the line and print.
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ANSI Action
- Triple space the line and print.

+ Do not space line and print.

1-9 Skip to a vertical position on the page as defined by a vertical tab record ( which is
either printer- or system-dependent) or by a Page Definition.

A,B,C Skip to a vertical position on the page as defined by a vertical tab record ( which is
either printer- or system-dependent) or by a Page Definition.

All ANSI control characters perform the required spacing before the line prints. Using line2afp
command keywords and values, ANSI controls might be encoded in EBCDIC (cctype=a) or in ASCII
(cctype=z).

Machine carriage control characters

Machine carriage controls were originally the actual hardware control commands for printers, and are
often used on other systems. Machine controls are binary values, not symbols. They are not represented
as characters in any encoding and, therefore, machine controls cannot be translated. Some typical
machine controls are listed in Machine carriage control characters, p. 229.

MMaacchhiinnee ccaarrrriiaaggee ccoonnttrrooll cchhaarraacctteerrss

Machine Action

X'09' Print the line and single space

X'11' Print the line and double space

X'19' Print the line and triple space

X'01' Print the line (do not space)

X'0B' Space one line immediately (do not print)

X'89' Print the line, then skip to channel 1 (top of form)

X'8B' Skip to channel 1 immediately (do not print)

Machine controls print before performing any required spacing. There are many more machine control
commands than ANSI.

Carriage controls can be present in a file, but to use carriage controls at all, every record in the file must
contain a carriage control. If the file contains carriage controls but the line2afp command keyword and
value cc=no is specified, the carriage controls are treated as printing characters. If no carriage controls
are specified, the file prints as though it were single spaced.

What are variable-length and fixed-length files?

The line-data transform program needs to know two things about a file to transform it:

• The length of each print record

• The kind of carriage control used
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Some files contain information in each record that describes the record length; these are called
variable-length files. Other files require an external definition of length; these are called fixed-length
files.

MO:DCA structured fields are treated as a special case. All such structured fields are self-identifying
and contain their own length. They do not need to contain a length prefix to be correctly interpreted, but
are also processed correctly if the length prefix is present.

Variable-length and fixed-length files

Variable-length files might use a length prefix, which means they contain a prefix that identifies the
length of the record in the file. Each record contains a field that gives the length of the record. If the
record contains a length, that length must be a prefix for each record and it must be a 16-bit binary
number that includes the length of the 2-byte length prefix. Use the fileformat=record keyword and
value to identify files with length prefixes.

Variable-length files might use either a separator or a delimiter to indicate the end of a record, instead
of using a length prefix. All of the bytes up to, but not including, the delimiter are considered part of the
record. For compatibility with other systems, the default record separator for the line2afp command is
X'0A'.

InfoPrint Manager reads the first six bytes and tests for all ASCII characters (code points from X'00' to
X'7F') to determine if a file is encoded in ASCII or EBCDIC. If no non-ASCII characters are found, the
line-data transform program assumes that the file uses the ASCII newline character, X'0A'. Otherwise,
the transform assumes the file uses the EBCDIC newline character, X'25'. Because an input file can
misguide the line-data transform, a set of rules has been established to determine how the transform
processes the file.

Data Type Newline Character

All EBCDIC EBCDIC X'25'

All EBCDIC ASCII X'0D0A' or X'0A' (see Notes)

All ASCII EBCDIC X'25' (see Notes)

All ASCII ASCII X'0D0A' or X'0A'

These combinations are possible only if a file contains a prefix with a string that indicates a different
code set than actually exists.
• For EBCDIC data with ASCII newlines, use X'0320202020200A' as the first seven bytes of the

file.
• For ASCII data with EBCDIC newlines, use X'03404040404025' as the first seven bytes of the

file.

Fixed-length files

Fixed-length files contain records that are all the same length. No other separators or prefixes or self-
identifying information exists that indicates the record length. You must know the record length and use
the fileformat=record, nnn keyword and value, where nnn represents the length of each record.
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How does the imageout keyword affect processing?

The line-data transform converts image formats (IM1) in the input file, in overlays, and in page segments
to uncompressed IOCA format, if line2afp imageout=ioca keyword and value is specified (the
default). An uncompressed IOCA image might use a significantly higher number of bytes than an IM1
image and might take more processing time to convert, especially for shaded or patterned areas.
Although IOCA is the MO:DCA-P standard for image data, and some data stream receivers might
require it, all products cannot accept IOCA data. All software products from the Ricoh do, however,
accept IOCA data as well as IM1 image data.

If you are using non-InfoPrint products, you might want to specify imageout=asis.

Customizing the line data transform

InfoPrint Manager provides several sample programming exits to assist you in customizing the line-data
transform. Use of the programming exits is optional. You specify the names of the exit programs with the
inpexit, outexit, and resexit keywords. Each of these keywords is described in the RICOH InfoPrint
Manager: Reference.

InfoPrint Manager provides these sample exits:

Input record exit

install_path\exits\acif\apkinp.c

Output record exit

install_path\exits\acif\apkout.c

Resource exit

install_path\exits\acif\apkres.c

In addition, InfoPrint Manager provides these user input record exits to translate line-data data streams:

install_path\exits\acif\apka2e.c

Converts the ASCII stream data into the EBCDIC stream data. The default conversion is from code page
850 to code page 037. You can override the defaults with the inpccsid and outccsid parameters.

install_path\exits\acif\asciinp.c

Converts unformatted ASCII data that contains carriage returns and form feeds into a record format that
contains ANSI carriage control characters. This exit encodes the ANSI carriage control character in
byte 0 of every record.

install_path\exits\acif\asciinpe.c

Converts unformatted ASCII data into a record format as does asciinp.c, and then converts the ASCII
stream data into EBCDIC stream data. The default conversion is from code page 850 to code page
037. You can override the defaults with the inpccsid and outccsid parameters.

install_path\exits\acif\dbblank

Processes EBCDIC double-byte line data downloaded from the z/OS spool by adding an extra blank
to the end of the input record if:
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1. The last byte in the record is a blank (x'40' in EBCIDIC).
2. The second to the last byte is not a blank.
3. The input record is line data; that is, it is not a structured field.
This exit also updates the record length by 1 if the blank is added. The exit has no way of determining if
the data is DBCS or not, so this will happen to every input record that ends in a single blank. The exit
assumes that the input data is EBCIDIC, and that the output data is also EBCIDIC. In other words, the
exit does not do any code page translation, but it simply adds an extra blank if needed.

1. This exit is only intended to be used if the spool file consists of double-byte or mixed single- or
double-byte data that has blank truncation. Adding a blank to other types of data files could cause
formatting errors, depending on how the page definition is coded.

2. This exit only checks for a single trailing blank, so if a different number of odd blanks is present in
the data, it is up to the user to make sure the data is formatted with the correct font.

The C language header file for all line-data transform exit programs is provided in the install_path
\exits\acif\apkexits.h directory, and the build rules for the line-data transform user exits reside in
install_path\exits\acif\exit_program.

The source code for the sample exits is provided in install_path\exits\acif. You can modify these
source files or create your own. You must have the Microsoft Visual Studio 2017, installed on your
InfoPrint Windows server to compile and build user-exit programs. Be sure to apply the latest service
available. Sample project files for Microsoft Visual for each exit program are also installed in the same
directory.

For more information about compiling user exit programs, see Configuring custom steps (transforms), p.
244.

Working with the transform for double byte text streams

InfoPrint Manager includes the db2afp transform, a program that transforms both double-byte
character set (DBCS) ASCII and Extended UNIX Code (EUC) files into the Advanced Function
Presentation (AFP) data stream.

This section describes:

• What are DBCS ASCII and EUC?, p. 232

• What font resources are needed to print DBCS ASCII and EUC?, p. 233

• Determining what code page your print jobs use and setting the correct environment variable, p.
233

What are DBCS ASCII and EUC?

In ideographic languages like Japanese, Chinese, and Korean, there are thousands of characters. All of
these characters cannot be represented with a single byte of information because a single byte only
accomodates 256 characters. Therefore, at least one more byte of information is required.
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In DBCS ASCII files, each ideographic character is exactly two bytes. In EUC files, each ideographic
character can be two, three, or four bytes, depending on the EUC implementation and language.
Single-byte ASCII characters can be mixed in with DBCS and EUC characters.

InfoPrint Manager for Windows supports printing DBCS ASCII files in the Japanese and Traditional
Chinese languages, which can contain formatting controls for the IBM 5577 or 5587 printers. InfoPrint
Manager for Windows also supports printing EUC files in the Japanese, Traditional Chinese, and
Korean languages, but you must submit those jobs from a UNIX or AIX workstation. EUC files cannot
contain any formatting control characters.

What font resources are needed to print DBCS ASCII and EUC?

You can use the db2afp command to transform DBCS ASCII and EUC files that use these code pages:

• 932 (Japanese PC)

• 950 (Traditional Chinese PC)

• 33722 or eucJP (Japanese EUC)

• 964 or eucTW (Traditional Chinese EUC)

• 970 or eucKR (Traditional Korean EUC)

Your InfoPrint Manager server must be able to access the appropriate DBCS fonts when you print the
transformed files. DBCS fonts are available for the MVS, VM, Windows, and AIX operating systems as
separately orderable licensed programs. To make the fonts available on your InfoPrint Windows
system, you must make sure that you have installed the fonts on your system and then make the double-
byte fonts known to InfoPrint Manager for Windows.

For more information about setting up font resources to print DBCS fonts, see Fonts for printing DBCS
ASCII and EUC, p. 303.

Determining what code page your print jobs use and setting the correct
environment variable

Before you transform a print job, you need to determine what code page it uses, then set the
PSFDBLANG environment variable to that code page. If the job was created on an AIX or a Windows
workstation, you can determine the code page that the job uses by finding out what code page is active
on that system. On the system that the job was created on, open a Command Prompt window and
type:

chcp

then press Enter. The system responds with

Active code page: xxx

where xxx represents a three- to five-digit number. Use this number to set the PSFDBLANG environment
variable with these steps.

1. On your InfoPrint Manager server system, click the Windows Start button and select Settings –
>Control Panel.
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If you have more than one InfoPrint Manager server system, you need to set this environment
variable on all of the servers that contain actual destinations that will use the db2afp transform.

2. In the Control Panel window, double-click System.

3. In the System Properties dialog, click Environment.

4. In the Variable field, type PSFDBLANG.

5. In Code pages and their associated PSFDBLANG values, p. 234, locate the Code Page Value
that you got from your system above.

CCooddee ppaaggeess aanndd tthheeiirr aassssoocciiaatteedd PPSSFFDDBBLLAANNGG vvaalluueess

Code Page Value PSFDBLANG Value Language

932 J Japanese PC

950 T Traditional Chinese PC

33722 or eucJP JE Japanese EUC

964 or eucTW CE Traditional Chinese EUC

970 or eucKR KE Traditional Korean EUC

6. Find the PSFDBLANG Value that corresponds to that code page and type it in the Value field of
the System Properties dialog.

The PSFDBLANG Value is case-sensitive. Be sure to type it in all caps.

7. Click OK.

The db2afp command assumes that all jobs use this code page as long as you do not specify either the
-i flag or the -e flag when running the command from a Command Prompt window.

Working with the XML transforms

XML provides a standard method for the exchange and processing of data across different computing
platforms. XML data is structured according to standards from the World Wide Web Consortium
(W3C). Specifically designed for Web applications, XML differs from HTML in that, while HTML
contains information about how data is formatted for presentation on Web pages, XML contains data
with no presentation information. A W3C standard stylesheet language, called Extensible Stylesheet
Language (XSL), uses formatting objects to describe how XML data is presented. XML data containing
XSL formatting objects is called XSL-FO. XSL-FO describes document presentation details, such as
pagination, layout, and styling information.
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Using the XML transforms with InfoPrint Manager

XML has become the key standard in the deployment of new technologies for Web services, data
interchange, messaging, and application integration. Support for XML is found in several InfoPrint
products, including XML Extender and Print Services Facility (PSF) for z/OS.

The XML transforms are the preferred method for printing highly-dynamic XML data on AFP printers
because the transforms can efficiently process data that changes from job to job. The XML transforms
are also an efficient, cost-effective alternative to paper-based communication because it can transform
XML data to PDF documents for electronic delivery to customers.

Other benefits of using xml2afp and xml2pdf to transform XML data to AFP or PDF include:

• You can use your existing AFP output system to print or view your XML data without worrying about
compatibility issues.

• The XML transforms provide you with significant formatting flexibility for your XML documents.

• Print delivery is guaranteed when you transform your XML data to AFP and then print to an AFP
printer.

• Once XML data is transformed, you can use different tools to:

– Print to an AFP printer or transform AFP data to PostScript (PS) or printer control language (PCL)
for printing on a PS or PCL printer.

– Send PDF data to an electronic destination.

– View or archive AFP or PDF data.

The XML transforms let you take advantage of XML for data interchange and content management
while using AFP's print and presentation technology and PDF's electronic document exchange.
Scenarios for using XML data that has been transformed to AFP or PDF, p. 235 shows what you can do
with XML data when you use the XML transforms.

Scenarios for using XML data that has been transformed to AFP or PDF

The Ricoh products you can use with the AFP or PDF output include:

AFP view/browse
AFP Viewer plug-in or Content Manager OnDemand

PDF view/browse
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Content Manager OnDemand

Distributed AFP print
InfoPrint Manager and PSF for z/OS

Distributed PS/PCL print
InfoPrint Manager, Infoprint Server, and Infoprint Server Transforms

E-mail
IP PrintWay component of Infoprint Server

Archive
Content Manager OnDemand

How do the XML transforms work?

You use the xml2afp and xml2pdf to transform XML data to an AFP or a PDF data stream. To do this,
you must supply one of these to the XML transforms::

• XML files (or data sets), which do not contain data placement and presentation information, and an
accompanying XSL style sheet

• XSL-FO files (or data sets), which contain XML data with XSL formatting objects

To transform XML data to AFP or PDF, the XML transforms use the data you supply and do one of these:

• Uses the XSL style sheet to transform the XML files into XSL-FO and then completes the
transformation to AFP or PDF

• Directly transforms your supplied XSL-FO files to AFP or PDF

Process for transforming XML data to AFP or PDF, p. 236 shows how the XML transforms process data
from XML to AFP or PDF data.

Process for transforming XML data to AFP or PDF
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Running the XML transforms

You can run the XML transforms as:

• A standalone transform

• A transform managed by InfoPrint Manager

Capabilities and limitations

The XML transforms have these capabilities and limitations, depending on how data is being
transformed:

• Capabilities and limitations for transforming all data

• Capabilities and limitations for transforming data to AFP

• Capabilities for transforming data to PDF

General capabilities and limitations for transforming all data

Output document size
Output document size is dependent on the amount of memory available; however, no checking is
done between document size and available memory. If the output document is too big for the
available memory, you receive an out of memory error and the transform stops processing.

XSL support
The transforms support most, but not all, formatting objects, properties, and features of the XSL
Version 1.0 standards as documented by the W3C (http://www.w3.org/TR/xsl/). See Supported
formatting objects, p. 390 for the formatting objects that the supports.

Style sheets embedded and referenced in XML files are not supported.

Capabilities and limitations for transforming data to AFP

Bar code support
The transform does not support bar codes.

Font support
The first font in the font index with properties that most closely match the desired characteristics is
used. Condensed and expanded fonts are usually only used when the font-stretch property is
selected. Italic and oblique fonts are considered the same and are used interchangeably.

The XML transforms support converting double-byte character set (DBCS) fonts from one code page
to another.

The XML transforms work with the OpenType fonts from the command line. For more information
about OpenType Fonts, see Using OpenType Fonts in an AFP System.

To use the xml2afp transform, you must install the appropriate font features for either Infoprint
Fonts, Version 1.1.0, or AFP Font Collection, Version 2.1.0.

Graphic support
You can specify graphic data in one of these AFP resources:
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Overlay
An overlay contains a collection of constant image data (such as lines, shading, boxes, or
logos) that can be merged with variable data during printing. The AFP output file references
the name of an overlay, which is located in a resource directory. Because the overlay is not
included but is only referenced in the output file, you must specify the image size in the XSL
external-graphic formatting object. For example:

<fo:external-graphic src="overlay:corplogo" content-height="4in"
content-width="2in"/>

Page segment
A page segment contains image data (such as bar codes, signatures, logos, or graphics in
image format) that can be merged with variable data during printing. The AFP output file
references the name of a page segment, which is located in a resource directory. Because
the page segment is not included but is only referenced in the output file, you must specify
the image size in the XSL external-graphic formatting object. For example:

<fo:external-graphic src="pageseg:corpsign" content-height="4in"
content-width="2in"/>

IOCA object
An Image Object Content Architecture (IOCA) object contains a series of picture elements
(pels) arranged in rows and columns, and specifies where the image is placed on a page.
The XML transforms access the first IOCA object in a specified MO:DCA-P file and place it
inline in the AFP output file (only MO:DCA-P image data is supported). The transforms
obtain the actual size from the image; therefore, you do not need to specify the size in the
XSL external-graphic formatting object. If you do specify the size with the external-graphic
formatting object, the transforms crop the image to make it the specified size or add
whitespace to the bottom-right corner, so the image appears in the upper-left portion of the
allotted space. Here is an example of the formatting object you specify for an IOCA object:

<fo:external-graphic src="myfile/image.afp"/>

MO:DCA-P output
Output from the transform conforms to the MO:DCA Interchange Set 1 (IS/1) architecture (see
Mixed Object Document Content Architecture Reference, SC31-6802).

Capabilities for transforming data to PDF

PDF output
The transform converts XML data to PDF 1.1 data streams.

Customizing the XML transforms

The system administrator can customize the XML transforms as standalone transforms or as transforms
managed by InfoPrint Manager. If you have InfoPrint Manager installed, we recommend you to use it to
manage the XML transforms.

This section details the common, standalone, and InfoPrint Manager customization tasks the
administrator must perform before the job submitter can run the XML transforms. The administrator
performs the common customization tasks and either the standalone or InfoPrint Manager customization
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tasks, depending on whether the XML transforms are run as a standalone transform or managed by
InfoPrint Manager.

Common customization tasks

The common customization tasks you perform depend on whether you are using the XML to AFP
transform or the XML to PDF transform.

Tasks for using the XML to AFP transform

The sample xml2afp configuration file is provided in install_path\xmltransform\xml2afp.cfg
on Windows. These items are set in the file and can be modified:

1. The default location of the AFP fonts.
2. The default paper size.
Additionally, defaults for all the xml2afp options can be set in the configuration file.

The syntax of the configuration file is exactly the same as the command line syntax with these additional
rules:

1. Blank lines are ignored.

2. All data on a line after a pound sign is ignored. The pound sign might occur anywhere on a line.

3. To include a pound sign in parameter data, it must be escaped; that is, it must be preceded by a
backwards slash.

4. White space before and after parameter data is removed.

5. Parameter data on successive lines is concatenated with a single space between them.

6. Parameters might span lines as long as they follow rules 1 through 5.

Customizing the xml2afp.cfg file

You can either create a new configuration file or modify the sample that is provided:

1. Create a new xml2afp configuration file, xml2afp.cfg, which lets you configure the xmp2afp
transform.
To create the file on Windows, copy the sample configuration file, iinnssttaallll__ppaatthh
\\xxmmllttrraannssffoorrmm\\xxmmll22aaffpp..ccffgg, to a temporary location.

To modify the sample configuration file, you still need to copy it.

2. Edit the file using your preferred editor, such as vi or notepad.

3. Add -C xml2afp.cfg to other-transform-options for your XML transform. You can also add -C
xml2afp.cfg to the IVD to apply the xml2afp transform to all the jobs on the associated logical
destination.

Customizing the font index file for xml2afp

The sample font index file for xml2afp is provided in //uussrr//llpppp//ppssff//xxmmllttrraannssffoorrmm on AIX and
install_path\xmltransform on Windows. The samples include a outline_font_index and a
raster_font_index that you use to map XML font names to both outline FOCA fonts and raster fonts
in the font path.
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If you are using OpenType fonts, the font index files are not necessary.

A font is referenced in XSL-FLO using these attributes:
family
size
style
weight

Font index files describe AFP fonts using these attributes. In addition, a map is defined that maps
unicode code points to AFP code points.

The font index file consists of a sequence of key and value pairs, separated by whitespace (such as a
space, tab, or a newline). Comments can be inserted anywhere between the delimiters /* and */. You
can also use // to indicate that the remainder of the current line is a comment.

The keys and their meanings are:

map
Select the named character map, creating it if it does not exist. A character map is used to map
unicode code points to AFP code page names and code points. The default is default.

codepage
Set the code page to use for subsequent character mappings.

to
End a range of mapped unicode code points. The value must be an integer representing a valid
unicode code point, and it must be greater than the beginning value of the range given by the
closest preceding value for the char keyword. The value must be a valid unicode code point.

at
Creates a mapping using the closed range given by a preceding char value and an optional to
value. The unicode characters from begin to end are mapped to the AFP code point range from the
at value to the at value + end - begin, inclusive, using the closest preceding codepage value. This
value must be an integer from 0 to 65535.

family
Establish the current font family name. The value must be a string containing no whitespace
characters.

size
A font size, expressed as a floating point value giving the vertical size of the font, in points (1/
72nds inches). Size must be omitted when defining outline technology fonts, since they can take any
size.

style
A font style. The value must be one of these keywords:

normal
italic
oblique
backslant
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The default is normal.

weight
A font weight. The value can be one of these keywords:

normal
bold

The value might also be one of the values between 100 and 900 inclusive, in increments of 100.
The keyword normal is equivalent to 400, and the keyword bold is equivalent to 700. The default
value is normal (400).

charset
Define a font with the preceding values given for the font properties (family, size, style, and weight),
or default values if no preceding property values have been established. The currently selected
character map is associated with the font, and it is used for mapping unicode code points when the
font is selected. If modifications are made to the map later in the file, those changes do not affect the
defined font.

alias
Establish a font family alias for the current family.

Of the keywords listed, only two are active: at and charset. The other keywords collect values used
when an active keyword is found. This allows for a variety of possible arrangements for a font
index. For example:

family courier
alias monospace
size 7
weight normal
style normal
charset C04200070
style italic
charset C0430070
weight bold
style normal
charset C0440070
style italic
charset C0450070

defines the same set of fonts as:

family courier size 7 weight normal style normal charset C0420070
family courier size 7 weight normalstyle italic charset C0430070
family courier size 7 weight bold style normal charset C0440070
family courier size 7 weight bold style italic charset C0450070
alias monospace

, but can be considered more difficult to read.

Tasks for using the XML to PDF transform

The sample xml2pdf configuration file is provided in install_path\xmltransform\xml2pdf.cfg
on Windows. The default paper size can be modified. Additionally, defaults for all the xml2pdf options
can be set in the configuration file.

The syntax of the configuration file is exactly the same as the command line syntax with these additional
rules:
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1. Blank lines are ignored.

2. All data on a line after a pound sign is ignored. The pound sign can occur anywhere on a line.

3. To include a pound sign in parameter data, it must be escaped; that is, it must be preceded by a
backwards slash.

4. White space before and after parameter data is removed.

5. Parameter data on successive lines is concatenated with a single space between them.

6. Parameters can span lines as long as they follow rules 1 through 5.

These are the common tasks you must do when using the XML to PDF transform:

1. Create the XML Extender configuration file, xml2pdf.cfg, which lets you configure XML Extender.
To create the file:
Copy the sample configuration file, install_path\xmltransform\samples\xml2pdf.cfg, to
install_path\xmltransform\xml2pdf.cfg:

To modify the sample configuration file, you still need to copy it.

2. Edit the file using your preferred editor.

Color management resource transform support

InfoPrint Manager enables these transforms to do color management:

• ps2afp

• jpeg2afp

• tiff2afp

• gif2afp

The PCL and SAP transform do not support color management.

Transforms capable of color management allows the specification of color resource information at job
submission time and the implementation of color management at the transform level within InfoPrint
Manager. This support will provide color fidelity with better printer performance.

Submitting job using transforms for color management

Before you use transforms to do color management, make sure that you have installed the ICC Profiles
using the Resource Installer into the Resource library as Color Management Resources (CMRs). For
more information, see Color Management Resources, p. 275 and RICOH AFP Resource Installer, p.
287.
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• You can specify the ICC Profile directly in a pure PS/PDF transform.

• Only audit color conversion, instruction color conversion, and link color conversion CMRs are
supported.

To submit a job:

1. Select your destination printer.

2. Right-click and select Job and Document Defaults.

3. ClickModify.

4. Click Document AFP Color. If this tab is not visible, click Show more and then select
Document AFP Color.

5. Enter one or more input color management resources in Input color management resources.

6. Next, enter an output color management resource in Output color management resource.

7. From Color rendering indent, select one option.

8. Then, select the output color resource tagging from Tag output CMR.

9. In the Place CMR inline option, click Yes to inline the color resource information in the FS45.
Default is No.

10. Click Submit.

For more information about the values that you can specify, see RICOH InfoPrint Manager: Reference.

UUnnddeerrssttaannddiinngg tthhee ttrraannssffoorrmm oobbjjeeccttss aanndd tthhee ccuussttoomm sstteeppss
((ttrraannssffoorrmmss)) ssuubbssyysstteemm
Transforms are InfoPrint Manager objects (like queues and destinations) that you create and configure in
InfoPrint Manager. Transforms can be viewed as custom steps that receive data in a particular format or
formats, process the data in some way, and output the changed data. When you create a transform,
you have complete control over what data format or formats it operates on and what type of processing
it does. The processing that the transform performs can be anything from simply copying the data to a
different place on disk, to filtering the data stream that the transform receives (for example, to remove a
particular PostScript order), to transforming the data to a completely different format (for example,
converting PCL to AFP).

When you create a transform, you specify several things, including:

• Input data format
The data stream that is sent to the transform. The input data format is what the transform uses to
determine whether it has any work to do. If you send a PostScript job through a transform that has its
input data stream set only to PCL, the job will bypass the transform without being changed at all.
You can set the transform to accept multiple input data formats.

• Transform options
The program or command that actually does the work of the transform; what happens during the
processing stage. The transform options can be system commands (such as copy), programs
provided with InfoPrint Manager (such as ps2afp), or your own custom transform programs (for
example, mypclfixup).
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When you create a transform, you specify the complete command line needed to invoke this
program or command. In this command line, you can also specify various substitution variables, place
holders which InfoPrint Manager replaces with a value when InfoPrint Manager runs the transform.
For example, if you include %i in the line, InfoPrint Manager will replace it with the name of the file
that the transform receives; if you include %o, it will be replaced with the name of the file that the
transform needs to put the changed data into.

• Output data format
The data stream that results from the transform. You can only specify one output data format.

In addition, you can specify whether you want the file that the transform produces to be printed. If the
transform does not return the file to be printed (for example, if the transform completes its processing
and saves the file to a different location), it is called a terminating transform. In addition to the terminating
transform, you can also create a conditionally-terminating transform. To create this, define a unique return
code to indicate the transform was successful but does not return data to print.

Transforms do not do anything by themselves. They remain inactive until you associate them with an
actual destination as a transform sequence. A transform sequence is an attribute of an actual destination
that contains an ordered list of transforms. Every job that is submitted to that actual destination is sent
through that list of transforms in the order specified before it is printed.

InfoPrint Manager lets you create a sequence for transforming print data before the system sends it to a
printer. This provides users with a feature similar to the configurable transform sequences that you could
create in PSF/2 using the XFMFLTR utility. For more information about creating transform sequences,
see Defining a custom step (transform) sequence, p. 259.

1. If you include a terminating transform in a transform sequence, it must be the last transform in the
sequence.

2. If you invoke a terminating transform for a document in a job, the entire job ends after all the
documents in that job finish processing. It does not matter whether any other documents in the job
use the terminating transform.

Configuring custom steps (transforms)

To configure a custom step (transform), you must do these two tasks:

1. Creating custom steps (transforms), p. 244.

2. Associating a custom step (transform) with an actual destination, p. 249.

Creating custom steps (transforms)

You can create a transform sequence through the InfoPrint Manager Web Administration Interface.

Due to terminology changes, the equivalent term used for Configurable Transforms in the InfoPrint
Manager Web Administration Interface is Custom Steps. For more information about Custom Steps, go
to the InfoPrint Manager Web Administration Interface help system.
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To create a transform, an InfoPrint Manager system administrator must use this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click , the Menu icon, and select Custom Steps (Transforms)....

4. Click the New button in the upper right corner.

5. In the Create New Custom Step (Transform) dialog, fill in these values:

Name
Type a meaningful name for the transform.

InfoPrint Manager references the transform name in transform sequences that are associated
with actual destinations.

Server
If not filled in, either type or select the InfoPrint Manager server in which you want to create the
transform.

Transforms can only be associated with actual destinations in the same server. If the InfoPrint
Manager Web Administration Interface is only monitoring one server, this field contains that
server name.

Output File Format
Select a format for the output file produced from this transform.

Description
Type a description of this transform that will appear whenever you show this transform through
the InfoPrint Manager Web Administration Interface.

Transform Options
Type the command-line transform and its options, including any InfoPrint Manager substitution
variables.

Final Step
Specify if the transform step is the last one.

Force Sequence Stop Return Code
Specify a return code that indicates the transform step was successful, but the transform step is
not returning data for further processing by InfoPrint Manager.

Document Formats Allowed
Add a format for the input file or files that are being transformed.

You can specify either one or multiple document formats. The format of the input file determines
whether this transform is called for a job sent to this actual destination.

Use Server Locale
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Specify whether to use the locale language of the server (On - default) or English (Off) for input
and output of information defined in the %% substitution variables in the Transform Options
field.

The transform examples that follow demonstrate common uses of transform objects, using the substitution
values shown in the “Transform substitution variables” table. Some of these examples presume that an
application programmer has created a program with the name specified at the start of the Transform
Options field.

1. If you are specifying any substitutions for which the passed values might contain a blank space, such
as job name, be sure to put quotes around the substitution so it is passed correctly. Note that this
only applies to single % substitution variables. Do not put quotes around any %% substitution
variables.

2. The examples that follow presume that the PATH environment variable has been set to the
appropriate path so you do not have to specify the fully qualified path name in the Transform
Options field.

TTrraannssffoorrmm ssuubbssttiittuuttiioonn vvaarriiaabblleess

Transform options substitution variables Meaning

%i The name of the input file to transform.

%o The name of the file in which to store the output of
the transform.

If this is a non-terminating transform, data must be
stored in the file named by %o.

%e The name of the file in which to store any
transform information or error messages. If
anything is written to this file, it is logged in the
InfoPrint Manager server log.
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Transform options substitution variables Meaning

1. If the transform exits with an exit code of 0 or
the value set in the Force Sequence Stop
Return Code field, the error messages from
the transform are logged as debug severity.

2. If the transform exits with a non-zero return
code, but not with the value set in the Force
Sequence Stop Return Code field transform
attribute, the error messages from the
transform are logged as error severity.

3. InfoPrint Manager writes transform error
messages to either the file specified through
this substitution variable, or to standard error
(stderr). You should not mix output to %e and
stderr in a single run of the exit program. You
should use either one or the other in any given
run.

%u The name of the file for updating the pages-
completed and job-page-count job attributes.

This file should only be accessed through the
transform_update utility.

%j The name of the original print file, minus the path
(from the document-file-name attribute).

This should only be used to construct another
name, such as a temporary file.

%n The name of the original print file, minus the path
and minus the extension (from the document-file-
name attribute).

This should only be used to construct another
name, such as a temporary file.

%d A text string that represents the document format
of the input file. This value might be:
• ASCII for ASCII line data.
• AFPDS for Advanced Function Presentation

data
• PCL for Printer Control Language data
• PS for PostScript data
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Transform options substitution variables Meaning

You can also acquire document format through
the %%Ddocument-format substitution value.

%p The value of the document's destination-pass-
through attribute.

This value is passed to all subsequent transforms
and the actual destination.

%q The actual destination that is processing the job.

%s The document-sequence-number for the
document.

%t The value of the document's other-transform-
options attribute.

To write one transform, but use it differently for
different actual destinations or jobs, you can pass
values into the transform with this parameter.

%g The global job identifier for the job.

%# The job-identifier (10 digits maximum).

%%Aad_attribute%% The value of the InfoPrint Manager actual
destination attribute specified. For example, if %%
Aresource-context%%, InfoPrint Manager
passes the actual destination's resource-context
attribute value.

See the "Considerations when using the %%
Nattributename substitution control sequences"
topic under the "Usage guidelines" for the other-
transform-options attribute for transforms in the
RICOH InfoPrint Manager: Reference before using
this substitution variable.
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Transform options substitution variables Meaning

%%Ddoc_attribute%% The value of the InfoPrint Manager document
attribute specified. For example, if you use %%
Ddepartment-text%%, InfoPrint Manager passes
the document's department-text attribute value.

See the "Considerations when using the %%
Nattributename substitution control sequences"
topic under the "Usage guidelines" for the other-
transform-options attribute for transforms in the
RICOH InfoPrint Manager: Reference before using
this substitution variable.

%%Jjob_attribute%% The value of the InfoPrint Manager job attribute
specified. For example, if you use %%Jjob-owner
%%, InfoPrint Manager passes the job-owner
attribute value of the job that owns the document
being transformed.

See the "Considerations when using the %%
Nattributename substitution control sequences"
topic under the "Usage guidelines" for the other-
transform-options attribute for transforms in the
RICOH InfoPrint Manager: Reference before using
this substitution variable.

Associating a custom step (transform) with an actual destination

Now that you have created a transform object, you must associate it with an actual destination before
you can use it.

To associate a data stream transform with an actual destination from the InfoPrint Manager Web
Administration Interface, use this procedure:

1. In the left-hand Objects panel, click the Printers tab and select the printer that you want to send
the job to.

2. Click , the Menu icon, and select the Properties option.

3. In the Properties for... dialog, click Configuration.
The data stream transforms that this printer can use are listed in the Steps to Use field.

4. Select the transforms that you want to use (the equivalent of setting the transforms-sequence
actual destination attribute from the command line).

You can string multiple transforms together to do a sequence of tasks. For more information about
this feature, see Defining a custom step (transform) sequence, p. 259.
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5. Click OK to associate this transform sequence with the selected printer.

If you prefer to use the command line, you can use these InfoPrint Manager commands from either an
AIX or Linux command line or an MS/DOS window with transform objects:

• pdcreate

• pddelete

• pdset

• pdls

For more information about the attributes in creating transform sequences or custom steps, see the
"Attributes for Transforms" topic in the "InfoPrint Object Attributes" chapter of the RICOH InfoPrint Manager:
Reference.

Examples of creating custom steps (transform) objects

The following shows four specific examples (from simple to more advanced) for creating transform
objects. The third and fourth examples require additional programming to create the programs that are
called from the Transform Options field. This topic should suggest how you can use custom steps to
customize your InfoPrint Manager installation.

Creating a custom step (transform) object to copy to a file without printing

To define a data stream transform object from the InfoPrint Manager Web Administration Interface that
takes an AFP input file and copies it to a file location on the hard drive without printing the output, use
this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click , the Menu icon, and select Custom Steps (Transforms)....

4. Click the New button in the upper right corner.

5. In the Create New Custom Step (Transform) dialog, fill in the fields as shown in the following
figures, depending upon your operating system. These values create a transform that copies AFP
input data to an \afp folder on a specific drive on Windows or a /usr/samp file system on AIX
and Linux. Also, it names the transformed file with the name of the original file name because of
the %n substitution variable.

6. Since you do not want the job to be printed, click Final Step to indicate that this transform is a
terminating transform.
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Create New Custom Step (Transform) dialog: Define a transform that copies an AFP
file to a folder without printing on Windows
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Create New Custom Step (Transform) dialog: Define a transform that copies an AFP
file to a folder without printing on AIX and Linux

7. Click OK.
InfoPrint Manager creates a transform object under the name you provided in the Name field. To

see the values of this transform, click , the Menu icon, on the Servers tab and select the
Custom Steps (Transforms)... option.

Creating a custom step (transform) object to convert AFP data into PDF data and
store it for later usage

To define a data stream transform object from the InfoPrint Manager Web Administration Interface that
takes an AFP input file and converts it into PDF data and stores it in a location on the hard drive without
printing the output, use this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click , the Menu icon, and select Custom Steps (Transforms)....
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4. Click the New button in the upper right corner.

5. In the Create New Custom Step (Transform) dialog, fill in the fields as shown in the following
figures, depending upon your operating system. These values create a transform that converts
AFP input data into PDF data and saves the output in a file indicated by the afp2pdf -o flag
value. Also, it names the transformed file with the name of the original file name because of the %
n substitution variable.

6. Since you do not want the job to be printed, click Final Step to indicate that this transform is a
terminating transform.

Create New Custom Step (Transform) dialog: Define a transform that converts AFP
data into PDF data and store it for later usage on Windows
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Create New Custom Step (Transform) dialog: Define a transform that converts AFP
data into PDF data and store it for later usage on AIX and Linux

7. Click OK.
InfoPrint Manager creates a transform object under the name you provided in the Name field. To

see the values of this transform, click , the Menu icon, on the Servers tab and select the
Custom Steps (Transforms)... option.

• See RICOH InfoPrint Manager AFP2PDF Transform Feature: Installing and Using for information about
installing and using the afp2pdf transform.

Creating a custom step (transform) object to convert data and print only smaller
files

If your transform might want to terminate the processing of the job in some cases but return data to be
printed in other cases, you can create a conditionally terminating transform. For example, you might
want to transform and store some documents but transform and return for printing other documents. You

3 Administrative Procedures: Customizing for Special Jobs



3

255

can define a return code that your transform can return to indicate when it has completed its task
successfully, but is not returning any data for printing.

In the example below, the actual destination activates the pics2gif transform when incoming JPEG and
TIFF jobs enter the system. These jobs are transformed into GIF format and then uploaded to the Internet
by an application outside of InfoPrint Manager. When the transformed GIF files are smaller than 3 KB,
they are returned to InfoPrint Manager for printing on a proof printer. To observe cost-cutting mandates
across the installation, transformed GIF files that are larger than 3 KB are not printed. The transform
checks the size of the transformed file and sends a return code of 5 if the job is too big to be printed.

To define a data stream transform object from the InfoPrint Manager Web Administration Interface as a
conditionally-terminating transform, use this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click , the Menu icon, and select Custom Steps (Transforms)....

4. Click the New button in the upper right corner.

5. In the Create New Custom Step (Transform) dialog, fill in the fields as shown in the following
figure. These values create a transform that transforms both JPEG and TIFF input data into GIF
output and then provides a return code of 5 if the transform has completed successfully without
returning to InfoPrint Manager for printing.

In the Transform Options field, you can use a series of substitution variables to provide special
options for the transform sequences. In this example, besides the standard input (%i) and output
(%o), this transform object also uses the %q flag so the InfoPrint Manager server passes the name
of the actual destination processing the job.
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Create New Custom Step (Transform) dialog: Define a conditionally terminating
transform

6. Click OK.
InfoPrint Manager saves the transform under the name you provided in the Name field. To see

the values of this transform, click , the Menu icon, on the Servers tab and select the Custom
Steps (Transforms)... option.

Creating a custom step (transform) object that updates the job's page count

By default, InfoPrint Manager has no knowledge of the number of pages in a transformed job.
However, if you have a transform that knows how many pages are in the job, you can create a
transform object that can update InfoPrint Manager with this information. InfoPrint Manager can pass
transform objects an update_file with the %u option. This update_file can be updated with the number of
pages that are in the transformed job, and InfoPrint Manager then updates the job with this information.
To modify the update_file, the user supplied transform needs to call the transform_update utility that is
supplied with InfoPrint Manager. For the syntax of the transform_update utility, see Using the
transform_update utility, p. 258.

3 Administrative Procedures: Customizing for Special Jobs



3

257

To define a data stream transform object from the InfoPrint Manager Web Administration Interface, use
this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click , the Menu icon, and select Custom Steps (Transforms)....

4. Click the New button in the upper right corner.

5. In the Create New Custom Step (Transform) dialog, fill in the fields as shown in the following
figure.

For this example, the passvals program that is called by the PASSVALUES transform object gets
passed both the resource-context document attribute and the job-owner job attribute, as well
as an update file. You should change the passvals program to your transform program that
knows how many pages are in the job, and then change the parameters in Transform Options
to what your program expects with the %u being the update_file that will be passed to the
transform_update utility when your transform calls it. Other attributes, like resource-context
and job-owner, can be included or omitted as required by the needs of your transform.

Create New Custom Step (Transform) dialog: Define a transform to pass job attributes
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6. Click OK.
InfoPrint Manager saves the transform under the name you provided in the Name field. To see

the values of this transform, click , the Menu icon, on the Servers tab and select the Custom
Steps (Transforms)... option.

Using the transform_update utility

Use the transform_update utility to update InfoPrint Manager about the job page count or number of
pages completed.

You can use the %u transform option to access an update file that lets you update the document page
count or the job's pages-completed attribute. Never access the file identified with %u directly. The
transform should only use the transform_update utility. InfoPrint Manager only checks for updates
while the transform is running and immediately after it completes. The transform_update utility can be
called either once or multiple times while the transform is running. Once the transform returns, InfoPrint
Manager deletes the update file.

The transform_update utility provides these return codes:

1
An English message for basic problems, including:

Invalid option specified.
No option or option value specified.
No status file name specified.
Cannot open status file named ____.
Cannot read status file named ____.

0
A successful update

-1
The update of the status file was not successful.

ttrraannssffoorrmm__uuppddaattee [--tt delta_pages_transformed]
[--dd delta_pages_delivered]
update_file

-t
Specifies the number of additional pages since the last update in the transformed document file.
InfoPrint Manager uses this information to recalculate the job's job-page-count attribute. The total
of values that this option passes cannot exceed 2,147,483,647.

-d
Specifies the number of additional pages delivered by the transform since the last update. InfoPrint
Manager uses this information to update the job's pages-completed attribute. The total of values
that this option passes cannot exceed 2,147,483,647.

Often, it is unnecessary for transforms to update the pages-completed attribute because it indicates
how many pages have actually printed or stacked for the job, and this attribute is updated by the
print backend in InfoPrint Manager with the number of pages that were printed. Any pages
referenced here should have been removed from any file returned to InfoPrint Manager for further
processing.
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update_file
The file passed to the transform through the %u option.

1. If a transform calls the transform_update utility more than once, each call should pass a value for
the change since the last call, not a cumulative value.

2. If InfoPrint Manager can neither open nor read the file, it logs an error and continues processing.

3. If you use a transform to update the job-page-count attribute, you must provide a page-count for
the document. This page-count information provided by the transform should be the pages in the
transformed document for a single copy of that document.

4. If a transform updates the pages-completed attribute and returns a job for printing, the pages the
actual destination completes are added to the pages the transform reported it had completed.

Defining a custom step (transform) sequence

A custom step sequence lets you string together a series of transform objects to do a series of tasks. This
topic provides an example of a custom step sequence, followed by the specific procedure you can use
to create a sequence of transform objects.

You want to define an actual destination that will copy AFP versions of all print jobs sent to it into a
directory on your InfoPrint Manager server system. This directory is used as an archive of AFP versions
of print jobs that might need to be viewed later.

To accomplish this, use the InfoPrint Manager Web Administration Interface to create these three custom
steps (transforms):

1. transps
You set the input data format to PostScript, the Transform Options to use ps2afp, and the Output
File Format to MODCA-P (Mixed Object Document Content Architecture).

2. transpcl
You set the input data format to PCL, the Transform Options to use pcl2afp, and the Output File
Format to MODCA-P.

3. saveafp
You set the input data format to AFP, the Transform Options to issue a copy command, and the
Output File Format to MODCA-P. In addition, you make this a terminating transform by selecting
Final Step in the Create New Custom Step (Transform) dialog.

Then, create an actual destination that you want to do the sequence. When you create the printer,
select CREATE and EDIT, then click the Configuration tab to define the steps to use as follows:

1. transps

2. transpcl

3. saveafp
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If you already have the destination created, open the Properties dialog for that actual destination and
click the Configuration tab to define the steps sequence.

When you send a job to this actual destination, this sequence of actions occurs:

1. transps checks to see if the incoming data is PostScript. If it is PostScript,transps transforms the data
into AFP using ps2afp. If it is not PostScript, transps does nothing.

2. transpcl checks to see if the incoming data is PCL. If it is PCL, transpcl transforms it to AFP using
pcl2afp. If it is not PCL, transpcl does nothing.

3. saveafp copies the AFP file produced by either of the above steps into a specific directory.

4. Since saveafp is a terminating transform, the job is not printed but is marked complete at this point.

To create a custom step (transform) sequence, use this procedure from the InfoPrint Manager Web
Administration Interface:

1. In the left-hand Objects panel, click the Printers tab and select the printer that you want to send
the job to.

2. Click , the Menu icon, and select the Properties option.

3. In the Properties for... dialog, click Configuration.
The data stream transforms that this printer can use are listed in the Steps to Use field.

4. Select the transforms that you want to use and drag and drop them in the desired order.

For example, you might want to create the three-step transform sequence that runs the transps ,
transpcl, and saveafp transforms in sequence as described above.

5. When you have entered the transforms in the correct sequence, click OK to associate this
transform sequence with the selected printer.

UUssiinngg pprriinntt rruulleess
Print rules are optional rules that are applied to an InfoPrint Manager job if certain criteria are met. You
can create, edit, copy, or delete a print rule.

Configuring print rules

To create a print rule, an InfoPrint Manager system administrator must follow this procedure:

1. Connect to the InfoPrint Manager server using the InfoPrint Manager Web Administration
Interface.

2. In the left-hand Objects panel, click the Servers tab.

3. Click the menu icon ( ) and select Print Rules.

4. Click the New button in the upper right corner.

5. In the Create New Print Rule dialog, fill in or select these values:

Name
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Type a meaningful name for the rule. InfoPrint Manager references the print rule name in print
rule sequences that are associated with logical destinations.

Server
If not filled in, either type or select the InfoPrint Manager server on which you want to create
the rule.

Use Server Locale
Specify whether to use the locale language of the server (On - default) or English (Off) for
input and output of information.

Description
Type a description of this print rule to appear whenever you show this print rule through the
InfoPrint Manager Web Administration Interface. A detailed description of the print rule can
be helpful to users who need to determine which rule to use.

Find items which
Indicate the logical conditions between existing attribute values to trigger the actions to be
performed. Choose one of the options:

Match all conditions (AND logic)
All conditions must be satisfied for the defined actions to be performed.

Match any conditions (OR logic)
At least one of the conditions must be satisfied for the defined actions to be
performed.

Add condition
Define one or more conditions for a print rule. From left to right, each condition consists of:

• a job or document attribute

• a condition operator

• a value

attribute
Select from the list the job or document attribute that you want to use for the condition.

condition operator
Specify the relation between the attribute and the value to decide whether a job
meets the condition.

• The list of available condition operators depends on the selected job or document
attribute.

• All attributes allow the condition operators Has a value (set) and Has no value
(not set), for which you cannot select or enter any value.

• You can activate or deactivate the case-sensitive option for some attribute values.

value
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Specify the value that InfoPrint Manager uses to decide whether a job meets the
condition. Depending on the attribute, you can either choose from a list or enter an
alphanumeric value.

• To define an additional condition, click the Add condition button. To delete a condition,

click the delete button ( ) to the right of the condition you want to delete.

Add action
Select one or more actions to be performed if the defined logical conditions are met. Choose
one of the options:

Hold job
Change the state of the job to held.

Set attribute
Select a job or document attribute and specify a value to it. This action can be added
multiple times.

Run script
Specify the custom script to be run if the defined logical conditions are met. You can
use the supported substitution control sequences described in Running a script in print
rules, p. 264.

In the Script success return code box, enter the return code that indicates the custom
script has been executed successfully.

Route job
Specify the actual destination where to move the job.

• You can select one value at a time from the list of possible destinations or enter a
value.

• The Route job and Split job actions are mutually exclusive.

Split job
Specify the actual destinations to which to split the job, based on the number of
pages.
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• This action is available only if the document format is MODCA-P and the
condition Number of Pages Is Greater Than or Equals is applied. The
maximum number of pages for each of the resulting jobs is equal to the number of
copies multiplied by the number specified for the Number of Pages Is Greater
Than or Equals condition.

• The maximum number of pages for each of the resulting jobs cannot exceed the
number of pages of the document.

• The actual destinations attribute of the job is overwritten.

• If you select specific printers from the list, those printers must be assigned to the
same queue as the queue of the logical destination where the print rule is
attached.

Send email
Send an email to a specific recipient. Choose one of the options:

Send on error (default)
The email is sent only when errors occur.

Send always
The email is sent on all jobs from the rule.

• For multiple recipients, use ‘,’ as a separator.

Terminating rule
Specify whether a rule is the last one in a sequence.

• This action is added automatically after the Split job and Route job actions.

• A terminating rule affects only the current print rule sequence. If a rule moves the
job to a different logical destination, any existing print rule sequence assigned to
that logical destination will still be run.
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• For the Set attribute and Route job actions, you can use the following supported
substitution control sequences:

%%Jjob_attribute
Passes the job attribute value from the job containing the document being processed.

%%Ddoc_attribute
Passes the document attribute value from the document being processed.

If an attribute is multi-valued (such as %%Jattribute-name, %%Dattribute-name), only
the first value of the attribute is used.

• To define an additional action, click the Add action button. To delete an action, click the

delete button ( ) to the right of the action you want to delete.

6. Click the OK button.

Running a script in print rules

You can specify a command that executes when a print rule is run using the substitution values shown in
the “Print rules substitution variables” table.

PPrriinntt rruulleess ssuubbssttiittuuttiioonn vvaarriiaabblleess

Substitution variable Meaning

%i The name of the input file.

%o The name of the file in which to store the output.

%j The name of the original print file, minus the path
(from the document-file-name attribute).

This should only be used to construct another
name, such as a temporary file.

%n The name of the original print file, minus the path
and minus the extension (from the document-file-
name attribute).

This should only be used to construct another
name, such as a temporary file.

%d A text string that represents the document format
of the input file.
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Substitution variable Meaning

You can also acquire document format through
the %%Ddocument-format substitution value.

%p The value of the document's destination-pass-
through attribute.

%s The document-sequence-number for the
document.

%t The value of the document's other-transform-
options attribute.

%g The global job identifier for the job.

%# The job-identifier (10 digits maximum).

%%Ddoc_attribute%% The value of the InfoPrint Manager document
attribute specified. For example, if you use %%
Ddepartment-text%%, InfoPrint Manager passes
the document's department-text attribute value.

See the "Considerations when using the %%
Nattributename substitution control sequences"
topic under the "Usage guidelines" for the other-
transform-options attribute for transforms in the
RICOH InfoPrint Manager: Reference before using
this substitution variable.

%%Jjob_attribute%% The value of the InfoPrint Manager job attribute
specified. For example, if you use %%Jjob-owner
%%, InfoPrint Manager passes the job-owner
attribute value of the job that owns the document.

See the "Considerations when using the %%
Nattributename substitution control sequences"
topic under the "Usage guidelines" for the other-
transform-options attribute for transforms in the
RICOH InfoPrint Manager: Reference before using
this substitution variable.

• Each substitution variable must be passed as a single parameter to the script. You must not
concatenate substitution variables with one another or with any other text.

• If you are specifying any substitutions for which the passed values might contain a blank space, such
as job name, be sure to put quotes around the substitution so it is passed correctly. Note that this
only applies to single % substitution variables. Do not put quotes around any %% substitution
variables.
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• You cannot run a job modification command such as pdset or pdmod.

Defining a print rule sequence

A print rule sequence lets you string together a series of rules to do a series of tasks. This topic provides
the specific procedure you can use to create a sequence of print rules.

To create a print rule sequence, use this procedure from the InfoPrint Manager Web Administration
Interface:

1. In the left-hand Objects panel, click the Logical Destination tab and select the destination that
you want to send the job to.

2. Click , the Menu icon, and select the Properties option.

3. In the Properties for... dialog, click General.
The available print rules are listed in the Print Rule Sequence field.

4. Select the print rules that you want to use and drag and drop them in the desired order.

For example, you might want to create a three-step print rule sequence that runs the previously
defined print rules in a determined order as described above.

5. When you have entered the print rules in the correct sequence, click OK to associate this print
rule sequence with the selected destination.

CCoolloorr aanndd GGrraayyssccaallee PPrriinnttiinngg
Printing documents in full color or with very high-quality black and white (grayscale) images is more
complex than printing black and white or spot-color documents. Understanding some of the principles
of color and grayscale printing and how various products can fit into color and grayscale solutions can
help you integrate color and grayscale printing with your current operations or expand to implement
new color workflows.

AFP color and grayscale solutions

You can assemble printing products from Ricoh and other companies in different configurations to
support Advanced Function Presentation (AFP) color and grayscale printing, including configurations
that use the AFP Color Management Object Content Architecture (CMOCA) to provide optimal
performance and color accuracy in high-speed color printing.

Color printing without explicit color management

You can include color images or specify colors for AFP objects in your print jobs and send them to an
AFP color printer. The color images and objects print in color, based on the default settings in your print
server and printer.

If you like the colors that the default color management settings provide, or if it is not essential that you
print in exactly the right colors, you probably do not need to implement a full color management
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solution. However, if you want better control over the consistency and accuracy of your colors for
devices, you might consider color management at some point in the future.

To understand some of the basic concepts about color printing, see:

• Color Printing Concepts, p. 268

• Grayscale Printing Concepts, p. 272

Resources that document composition software includes inline

Most often, print bureaus use document composition software to generate highly customized and
personalized color output. AFP color management is largely built into the document composition tools
that support their processes. The software puts all the resources that the printer needs into the print job
and sends it to a print server. The print server sends the print job to the printer, and the printer uses the
resources as appropriate.

By using this method, you know that the required resources, including the resources required for color
management, are available for any print job that is sent to the printer. However, including all the
resources can make the print job very large, and moving large print jobs through your system might
slow down system performance. Also, you might not be able to save resources that are downloaded
with a print job on the printer so they can be reused without being downloaded later.

For more information about color printing, see:

• General information about color printing and color management:

– Color Printing Concepts, p. 268

– Color Management, p. 273

• Tips for images, p. 284

• Scenario describing a possible implementation:
Eliminating physical inserts, p. 294

For a list of the companies that participate in the AFP Consortium and support AFP color management in
their products, see:

http://www.afpcinc.org

Resources stored and managed centrally

To take full advantage of the AFP CMOCA, you can store your color and image resources in a central
resource library, and let your print system manage those resources. This option optimizes system
performance by:

• Creating some of the color management resources for you automatically

• Reducing the number of color conversion resources that the system creates at print time by
generating link color conversion color management resources in advance

• Reducing the size of some images by removing embedded profiles when you store them, yet still
retaining the association between the image and the profile

• Letting you mark resources as capturable, so they can be saved on the printer and used in other print
jobs without being downloaded again

For an introduction to the full AFP CMOCA and how you might implement it, see:
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• General information about color and grayscale printing and color management:

– Color Printing Concepts, p. 268

– Grayscale Printing Concepts, p. 272

– Color Management, p. 273

• AFP Color Management, p. 275

• RICOH AFP Resource Installer, p. 287

• RICOH AFP color and grayscale products, p. 285

• AFP color solution scenarios, p. 289

• Related publications, p. 295

• Scenario describing a possible implementation:
Replacing pre-printed forms, p. 291

Color Printing Concepts

Color printing is significantly more complicated than black and white printing. If you understand some of
the complexities, you can make the transition from black and white printing to grayscale or color
printing more smoothly.

Color Spaces and ICC profiles

Presentation devices, such as computer monitors and printers, create colors differently. Because of these
differences, colors must be described differently for each device. The different methods of describing
colors are called color spaces. In addition, each device might have one or more International Color
Consortium (ICC) profiles associated with it. ICC profiles are used when an image or another object is
converted to the color space of a different device.

Each device has its own individual color space and range of colors that it can display or print. The color
space specifies how color information is represented in an image when it is displayed on a particular
device. As the image is passed from one device to the next, the color information about the image is
converted from the color space of the source device to the color space of the destination device.
Because color spaces do not exactly match between devices, some of the color information can be lost
or modified in the conversion process.

A color space is a representation of the individual colors that can be combined to create other colors.
Some color spaces that are relevant to printing are:

• RGB
In an RGB color space, red, green, and blue light are combined in different amounts and intensities
to create different colors. RGB colors are often specified as single-byte integers numbered from 0
through 255. You can specify 256 levels of intensity for each of the three colors. For example:

– R=0, G=0, B=0 yields black

– R=255, G=255, B=255 yields white

– R=251 , G=254 , B=141 yields a pale yellow
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– R=210, G=154, B=241 yields a light purple

Devices such as monitors, digital cameras, and scanners generally use RGB color spaces to
describe colors. Two standard implementations of RGB color spaces are sRGB, which is most often
used for Web graphics, and Adobe RGB (1998), which we recommend for graphics that are
printed.

• CMYK
In a CMYK color space, cyan (bright blue), magenta (bright red-pink), yellow, and black pigments
are combined to create different colors. CMYK values are often represented as a percentage. The
percentage represents the portion of a particular area of paper that is covered by ink or toner. For
example:

– C=0%, M=0%, Y=0%, K=100% yields black

– C=0%, M=0%, Y=0%, K=0% yields a blank area on the page

– C=1.6%, M=0%, Y=44.7%, K=.4% yields a pale yellow

– C=17.6%, M=39.6%, Y=5.5%, K=5.5% yields a light purple

Color printers use the CMYK color space; they are loaded with ink or toner in each color. When the
printer places dots of the correct sizes next to and on top of each other on a page, your eye
interprets them as the intended color.

Implementations of the CMYK color space vary from printer to printer and from paper to paper.
Because the original color space of most images is an RGB color space, it is best to leave images in
an RGB color space so they retain their original characteristics. That way, your print server or printer
has as much of the original color information as possible when it converts the images to the most
appropriate CMYK color space for the printer and paper combination.

If you save an image by using the CMYK color space, make sure that you either save an ICC profile
for that color space or use a standard non-device specific CMYK color space like SWOP or
Coated FOGRA27 and associate the appropriate ICC profile with the image.

• Both RGB and CMYK values can be expressed in different ways. For example, in the PostScript data
stream, the values range from 0.0 to 1.0, while in some graphic arts programs they can be
expressed in hexadecimal numbers or as percentages.

An ICC profile contains information for converting an image between a device-specific color space and
a device-independent color space. A device-independent color space is a color space that does not
depend on or relate to the characteristics of any particular device, but rather contains all colors for all
gamuts. The ICC identified a specific profile connection space (PCS) as the target device-independent
color space for all ICC profiles.

You can use an input ICC profile to translate color data created on one device (such as a digital
camera) into the PCS. Then you can use an output ICC profile to convert from the PCS into the native
color space of a different device (such as a printer). Converting images from one color space to another
is process-intensive and can affect performance in your print system, although it is the best way to
maintain consistent color for the devices in your system.
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Gamut and Rendering Intent

Every device has a gamut, a range of colors or shades of colors that it can display or print. Some
devices have larger gamuts than others; some devices have gamuts that are similar sizes, but that
contain slightly different colors. When an image or a print job is created on a device with a gamut that
is different from the printer, you can use a rendering intent to tell the printer how to adjust the colors that
are outside the gamut of the printer.

The gamut of a printer is almost always significantly smaller than the gamut of a monitor, digital camera,
or scanner. Images or graphics nearly always have to be adjusted to print appropriately because some
of the colors that they require might be outside the gamut of the printer.

A rendering intent tells the printer how to adjust the image when it encounters colors that it cannot
reproduce. Each rendering intent has different benefits and trade-offs, so you can choose one based on
how the print output should look.

Color Mixing and Calibration

Four standard colors (cyan, magenta, yellow, and black) are blended to create all the colors in the
gamut of a printer. A printer mixes colors by printing four layers of a page or an image, one in each
color. If the printer registration is not set correctly, the images do not line up properly and the colors
appear wrong. In addition, the printer must be calibrated to ensure that all its systems are functioning
correctly and that it is in a known good state.

By using the color information described in its color space, each device determines the amount of cyan,
magenta, yellow, or black to use. Dots of each color are printed in overlapping patterns that, when
interpreted by your eyes, blend the colors appropriately. To ensure the colors are created accurately,
the color planes must be perfectly aligned. If they are not, you might see moire patterns, unintended
patterns in the printed images, or poorly blended colors, which are especially noticeable on the edges
of your images.

Color printers must be calibrated regularly, in some cases daily, to ensure that the colors they produce
are consistent. In addition, follow the recommended printhead maintenance procedures and schedule to
ensure that the printer operates optimally. Even when a printer is calibrated correctly, its gamut is much
smaller than that of any monitor, so images do not look the same when they are printed as they do
when they are displayed on a monitor.

Halftones and Tone Transfer Curves

Halftones are used to convert images (such as photographs, drawings, logos, or charts) from the
continuous tones that you see on a monitor into a pattern of dots that a printer can put on paper. Tone
transfer curves are used to modify the values of a particular color component and thus adjust the look
and feel of some of the colors. For example, you can apply a tone transfer curve to emphasize the
brightest parts of an image.

Halftones and tone transfer curves are used with both color and grayscale print jobs.

There are several different kinds of halftones, including clustered-dot, stochastic, and error diffusion. For
simplicity, this discussion only covers clustered-dot halftones.

Clustered-dot halftones are generally characterized by:
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• Line screen frequency
Line screen frequency is a measure of the resolution of a halftone, expressed in lines per inch (lpi). A
low line screen frequency, such as 80 lpi, creates coarser images because they use larger halftone
dots. A high line screen frequency, such as 150 lpi, can produce higher quality images by using
smaller halftone dots.

• Halftone pattern
Halftone dots are printed in various shapes and patterns. For example, dots can generally be
round, elliptical, or square, and they can be arranged in slightly different orientations. The halftone
pattern also describes how the size of the dot is increased to cover a larger percentage of the total
area and yield darker colors. Different patterns might produce better results for some print jobs.

• Rotation
Lines of halftone dots do not run parallel with the top or side of the paper because that could cause
unintended patterns to emerge, resulting in lower quality output.

In addition, the dots for each of the four colors in a CMYK printer cannot all be printed at the same
angle because they would overlap incorrectly and the colors would not appear as intended.
Instead, the lines of dots are printed on the page at specific angles so your eye blends them
appropriately.

For example, the black layer of an image might be printed so the lines of dots run across the page
at a 45 degree angle to the top of the paper, while the cyan layer is printed so that its lines of dots
are at a 105 degree angle to the top of the paper.

Tone transfer curves are most often used to offset the effects of dot gain. Dot gain is the tendency for
printed dots to be larger than intended, often because of the way ink reacts with paper. If the ink soaks
into the paper and spreads out, the resulting dot is much larger (and possibly much lighter in color) than
the printer intended it to be. Tone transfer curves can increase or reduce the amount of ink used in
proportion to the dot gain.

File Size

Color print jobs can have a file size that is much larger than black and white print jobs. The larger file
size can lead to longer processing times and increased traffic on your network.

Because color images must contain data about each layer of color, the file might contain three to four
times more information than a grayscale file and over 24 times more information than a black and white
file. In addition, ICC profiles are embedded in some file types (such as EPS, JPEG, and TIFF images).
While ICC profiles by themselves might not be very large, they do increase the size of an image. If you
only have one image repeated throughout a print job, and if you construct your job so the image is
downloaded only once, the embedded profile is of little concern.

However, if you use a variety of different images, each with an embedded profile, or if you construct
your print job so that each image is downloaded every time it appears, the embedded profiles can add
unnecessary volume to the print job. If you plan to use a wide variety of color images, create or save
them with the same color space so they all use the same ICC profile. You can also install color images in
a resource library so they can be reused.
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Grayscale Printing Concepts

With grayscale printing you can reproduce color images as high-quality black and white images by
using many shades of gray to represent subtle variations in color and light. Printing solutions that
produce high-quality grayscale output use color printing concepts with a black and white printer that
supports them to achieve that effect.

Moving to grayscale printing might be a first step in a migration to full color printing. You can start to
create color print jobs and print them on an existing printer until you are ready to invest in color printers.
In addition, you can use a grayscale printer as a backup system for a full color printer.

Some color concepts are much less important in grayscale printing than they are in color printing:

• The gamut of a black and white printer is much smaller than that of a color printer; essentially all the
colors in an image must be adjusted.

• The rendering intent you choose has little effect on the appearance of the image because the colors
are already being changed significantly.

• Page registration is less important. Because the printer only uses one color, you do not have to line
up the color planes to create the correct color.

• Paper characteristics have minimal effect on grayscale output; one output profile is usually adequate
for all types of paper.

Other color concepts are more essential to grayscale printing.

Color spaces and ICC profiles

The color space of a black and white printer is much smaller than that of a color printer. Even so,
printers that can print grayscale images have output ICC profiles, just like color printers. The ICC profiles
for black and white printers map colors from the profile connection space (PCS) to shades of gray.
Otherwise, the color conversion process is the same.

The print job should specify the appropriate input profile; if there is no input ICC profile, the printer uses
a reasonable default. The printer has its own default ICC profile installed and available; it should be
adequate for nearly all print jobs.

Halftones

Grayscale printers apply halftones to print jobs to print them; halftones let the printer produce many
shades of gray and high-quality images. Generally, the most important characteristic to consider for
halftones in grayscale printing is line screen frequency, expressed in lines per inch (lpi). Each printer
supports a set of line screen frequencies natively; when you specify the desired line screen frequency in
a print job, the printer chooses the available line screen frequency that best matches it.

Tone transfer curves

Tone transfer curves are used in grayscale printing to adjust the amount of toner that is used at different
levels of gray, thus adjusting the appearance of images. You can use the appearance value of a tone
transfer curve in grayscale printing to indicate how much the tone transfer curve should adjust the color
values. Some sample appearance values could be:

• Dark
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• Highlight Midtone

• Standard

Color Management

Images, graphics, and photographs often appear different depending on the monitor or the printer you
use. The colors printed by one printer might not match the colors printed on another printer, even if they
came from the same source. If it is important that colors stay consistent from camera, scanner, or monitor
to printer, you must use color management practices.

It is virtually impossible to accurately reproduce the colors that you see on your monitor on a printed
page. Because printers typically have smaller color gamuts than other devices, some of the colors must
always be adjusted when images are transformed for printing. With color management, you can control
the adjustments so they are less noticeable than they might be if you use the default settings of your
image creation software, print server, and printer.

Several factors play significant roles in color management, including ICC profiles, rendering intents, and
paper characteristics.

ICC Profiles

The International Color Consortium (ICC) is an organization that has established open standards for
color management. These standards help products work together by identifying a device-independent
color space and defining the elements of an ICC profile.

The device-independent color space that the ICC defined is called the profile connection space (PCS).
The PCS is a color space large enough to include all the color gamuts of different input, display, and
output devices. An ICC profile contains methods that map the colors that a device can create or display
to the values of the corresponding colors in the PCS. The ICC profile can be used to convert an image
from a device-specific color space to the PCS, or from the PCS to a device-specific color space.

Product manufacturers create ICC profiles that you can use with their devices. For example, if you take
a photograph with a digital camera, you can associate the photograph with the ICC profile for your
camera. Then, when you want to print that photograph, the color management system converts the
color data from the camera into the PCS. The printer then uses its ICC profile to convert the photograph
data from the PCS into its color space, and prints the photograph as accurately as it can.

For more information about the ICC, ICC profiles, and the PCS, see the ICC Web site:

http://www.color.org
To visit this website, make sure you are on a system that is connected to the Internet.

Rendering Intents

Rendering intents indicate what you want a printer to do with colors that are outside its gamut.

ICC profiles support these rendering intents:

• Perceptual
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If an image includes any colors that are out-of-gamut for the printer, the printer adjusts all the colors
in the image, even those that are already in the gamut of the printer, so they are all in-gamut and
maintain their color relationships to each other. The result is an image that is visually pleasing, but is
not colorimetrically accurate. The perceptual rendering intent is useful for general reproduction of
images, particularly photographs.

• Saturation
If a print job includes colors that are out-of-gamut for the printer, the printer replaces the out-of-
gamut color with the nearest color in the gamut. It also adjusts the in-gamut colors so that they are
more vivid. Saturation is the least used rendering intent, but it is useful for business graphics, such as
images that contain charts or diagrams.

• Relative colorimetric
If a print job includes colors that are out-of-gamut for the printer, the printer substitutes the nearest
in-gamut color; in-gamut colors are not adjusted. Colors printed on papers with different media
white points might not match visually. The media white point is the color of the paper that the print job
is printed on. For example, if you print an image on white paper, on off-white paper, and on blue
paper by using the relative colorimetric rendering intent, the printer uses the same amount of ink or
toner for each one and the resulting color is technically the same. However, the images might seem
different because your eyes adjust to the color of the background and interpret the color differently.
This rendering intent is typically used for vector graphics.

• Absolute colorimetric
All colors are mapped by using the same method as the relative colorimetric rendering intent,
however, all colors are adjusted for the media white point. For example, if you print an image on
white paper, on off-white paper, and on blue paper by using the absolute colorimetric rendering
intent, the printer adjusts the ink or toner used for each one. The resulting color is technically not
same, but the images might look the same because of the way your eyes interpret them in
relationship to the color of the paper. The absolute colorimetric rendering intent is typically used for
logos.

Paper Characteristics

The paper that you use has a significant impact on the colors that you see. Even if you use the same ICC
profile and the same printer, printing on a different paper can result in a very different color
appearance.

Colors can change from paper to paper, particularly if you change from coated to uncoated paper or
from sheet-fed to continuous forms paper. The changes can be so noticeable that printer manufacturers
generally test and certify papers with certain characteristics for use with their printers. They also create
different ICC profiles for their printers based on paper characteristics. Some ICC profiles can be used
for groups of papers that have similar characteristics.

When you load paper, you set certain paper characteristics on the printer. When the printer chooses
the correct device-specific output profile to use, it takes the characteristics into consideration. The paper
characteristics are:

• Media brightness
The percentage of light that the paper reflects

• Media color
The color of the paper
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• Media finish
The characteristics of the surface of the paper, such as: glossy, satin, matte

• Media weight
The basic weight of the paper

AFP Color Management

There are various ways to print color data with Advanced Function Presentation (AFP). However, to
implement an AFP color printing solution with full color management, you must use color management
resources (CMRs). We also recommend that you install all your color images as data objects and
associate CMRs with them.

Color Management Resources

Color management resources (CMRs) are the foundation of color management in AFP print systems. They
are AFP resources that provide all the color management information, such as ICC profiles and
halftones, that an AFP system needs to process a print job and maintain consistent color from one device
to another.

CMRs share some characteristics with other AFP resources, but are different in some important ways.

CMRs are similar to other AFP resources in these ways:

• CMRs can be associated with elements of a print job at various levels of the hierarchy.
Typical hierarchy rules apply, so CMRs specified at lower levels override those at the higher level.
For example, a CMR set on a data object overrides a default CMR set on a print file.

• CMRs can be included in a print job in an inline resource group and referenced in a form definition,
page environment, object environment, or an include Object (IOB) structured field.

– CMRs can vary in size from several hundred bytes to several megabytes. If your print job uses
relatively few CMRs, including them in the print file might not have an impact on the
performance of your system. However, if your print job uses more than 10 CMRs, the size of the
print job can increase so much that file transfer rates and network traffic are affected.

• CMRs can be stored centrally in a resource library, so you do not need to include them in every
print job.
You can configure all your print servers so they can access the CMRs.

• For the print server to find CMRs, the resource library must be listed in the AFP resource search path
on the print server.

CMRs are different from other AFP resources in these ways:

• You cannot copy CMRs into a resource library as you can other AFP resources.
To store CMRs in a central resource library, you must install them by using an application such as
RICOH AFP Resource Installer.

• CMRs and data objects must be stored in resource libraries that have resource access tables (RATs).
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AFP Resource Installer creates the RAT when CMRs and data objects are installed. We recommend
that CMRs and data objects be installed in separate resource libraries and that you store resources
that do not require RATs (such as form definitions, page definitions, and overlays) in other resource
libraries.

• CMRs installed in a resource library can have names longer than 8 characters, and you can use the
names in the print data stream.
These names are created when you install the CMR by using AFP Resource Installer and are UTF-
16BE encoded.

Types of CMRs

Different situations call for different types of CMRs. Some CMRs are created by product manufacturers
so you can download and use them, while others are created by your printer or other color
management software. If you have the appropriate information, you can also create CMRs yourself.

Some CMRs are used to interpret input files (similar to the function performed by ICC input profiles),
while others are used to prepare the final print job output for a specific printer (similar to the function
performed by ICC output profiles).

Color Conversion CMRs

Color conversion (CC) CMRs are used to convert colors to and from the ICC profile connection space
(PCS), a device-independent color space. You can use them to prepare images for color or grayscale
printing.

Color conversion CMRs are an essential element of any AFP color management system because they
are ICC profiles encapsulated in AFP structures. The AFP structures add information that your color
management system can use, but it leaves the ICC profile unaltered.

You can use color conversion CMRs to produce consistent colors on different devices. In a color system,
they help ensure that the colors on your monitor are as close as possible to those that are printed. If you
move the print job to a different printer, the colors are adjusted again to match the new printer.

In a grayscale system, color conversion CMRs map colors to appropriate shades of gray to produce
high-quality black and white images.

Passthrough CMRs are color conversion CMRs that indicate that no color processing should be done if
the color space of the presentation device is the same as the color space of the CMR. Passthrough
CMRs contain no data.

Link Color Conversion CMRs

Link color conversion CMRs combine the processing information required to convert an image directly
from the color space of an input device to the color space of the output device. Essentially, link color
conversion CMRs replace a pair of color conversion CMRs.

Converting color images to and from the PCS takes a significant amount of processing resources, in part
because the process includes two conversions. Link color conversion CMRs combine the two
conversions and make them more efficient. The printer can use the link color conversion CMR to convert
colors directly from the color space of the input device to the color space of the output device with the
same color fidelity they would have if the printer did both of the conversions. As a result, link color
conversion CMRs can improve system performance.

The two types of link color conversion CMRs are:
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Link CMRs
Link (LK) CMRs are unique. You cannot create a link CMR yourself and you do not include
references to link CMRs in your print jobs. The print system creates and uses link CMRs
automatically.

If you use AFP Resource Installer, link CMRs are generated automatically when you create or install
a color conversion CMR. As a result, your resource library always contains link CMRs for every
combination of color conversion CMRs in audit (input) and instruction (output) processing modes.
When link CMRs are created, AFP Resource Installer marks them as capturable, so the printer can
save them to be used in other print jobs.

If you do not use AFP Resource Installer, some printers can create link CMRs when they process
print jobs. Then, the print controller looks at the link CMRs that it has available to find one that
combines the audit color conversion CMR with the appropriate instruction color conversion CMR. If
it does not find one, the print controller creates the link CMR and uses it. The print controller can be
configured to save the link CMRs that it creates. However, the link CMRs are sometimes removed
during normal operation, for example, if the printer runs out of storage or is shut down. If the link is
removed, the printer must create a new link CMR the next time it is needed.

When a link CMR is created, the print system evaluates the conversion algorithms to and from the
PCS. The system then combines the algorithms, so a data object can be converted directly from one
color space to the other without actually being converted to the PCS.

Device link CMRs
Device link (DL) CMRs use an ICC device link profile to convert directly from an input color space to
an output color space without reference to an audit-mode or instruction-mode CMR. An ICC device
link profile is a special kind of ICC profile that is used to convert the input device color space to the
color space of an output or display device. ICC device link profiles are not embedded in images.

You can create, install, and uninstall device link CMRs yourself. Device link CMRs are referenced in
the MO:DCA data stream and take precedence over audit color conversion CMRs. A device link
CMR specifies its own rendering intent, which is indicated in the header of the ICC device link
profile. This rendering intent overrides any other rendering intent that is active.

The biggest advantage of using device link CMRs is that they preserve the black channel (K
component) of the input color space when converting from CMYK to CMYK.

Halftone CMRs

Halftone (HT) CMRs carry the information that a printer uses to convert print jobs into a pattern of dots
that it can put on paper. Halftone CMRs can be used with both color and grayscale print jobs.

Halftone CMRs generally specify the line screen frequency, halftone pattern, and rotation of the
halftone that they carry. Some device-specific halftone CMRs also include the printer resolution.

A printer that uses AFP color management to print color or grayscale print jobs must use a halftone CMR
to convert the print job into a format that the printer can reproduce in ink or toner. If a halftone CMR is
not specified in the print job, the printer applies a default halftone CMR.

You can associate device-specific halftone CMRs or generic halftone CMRs with print jobs:

• If you know which printer is printing the job, you can associate a device-specific halftone CMR with
the print job (or with AFP resources inside the print job). The printer uses the halftone CMR that you
specify.
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• If you do not know which printer is printing the job, but you want to ensure that it uses a halftone
CMR that has certain characteristics, such as a specific line screen frequency, you can associate a
generic halftone CMR with the print job.

Because it is difficult to know which halftone CMRs should be used for the current conditions on the
current printer, we recommend that you specify halftone CMRs generically and let the printer choose the
most appropriate CMR that it has available.

Generic halftone CMRs

You can use generic halftone CMRs when you want to choose one or more characteristics of the
halftone CMR for a print job, but you do not know exactly which halftone CMRs are available.

When a print job specifies a generic halftone CMR, the print server looks in the resource library for
halftone CMRs that match the printer device type and model. If the print server finds an appropriate
CMR, it sends the device-specific halftone CMR to the printer with the print job. If the print server does
not find an appropriate halftone CMR, it sends the generic halftone CMR to the printer.

If a print job arrives at the printer requesting a generic halftone CMR, the printer compares the
requested characteristics with the available device-specific halftone CMRs. If there is a match, the
printer uses the selected device-specific halftone CMR when it processes the print job. If there is no
match, the printer uses the halftone CMR whose line screen frequency value is closest to the one
requested.

The Color Management Object Content Architecture (CMOCA) has defined a variety of generic
halftone CMRs, which cover the most common line screen frequencies and halftone types. A print server
that supports CMOCA can interpret generic halftone CMRs if it has device-specific halftone CMRs
available to it in a resource library. If you use AFP Resource Installer, the generic halftone CMRs are
installed in every resource library that you create and populate by using AFP Resource Installer.

Printers that support CMOCA should be able to interpret those generic CMRs and associate them with
device-specific halftone CMRs.

Tone Transfer Curve CMRs

Tone transfer curve (TTC) CMRs are used to carry tone transfer curve information for an AFP print job,
so you can modify the values of a particular color component and adjust the appearance of some of the
colors by increasing or decreasing the amount of ink used to emphasize or reduce the effects of dot
gain on the final output.

Like halftone CMRs, tone transfer curve CMRs are associated with print jobs specifically or generically.
If they are specified generically, the print server looks in the resource library for tone transfer curve
CMRs that match the printer device type and model. If the print server finds an appropriate CMR, it
sends the device-specific tone transfer curve CMR to the printer with the print job. If the print server does
not find an appropriate tone transfer curve CMR, it sends the generic tone transfer curve CMR to the
printer.

If a print job arrives at the printer requesting a generic tone transfer curve CMR, the printer compares
the requested characteristics with the device-specific tone transfer curve CMRs that it has available. If
there is a match, the print server or printer uses the selected device-specific tone transfer curve CMR
when it processes the print job. If the printer cannot find a good match for the generic tone transfer
curve CMR, it ignores the request and uses its default tone transfer curve CMR.
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The Color Management Object Content Architecture (CMOCA) defines several generic tone transfer
curve CMRs with different appearance values. You can use the appearance values to specify how to
print your job with regard to the reported dot gain of the printer.

Generic tone transfer curves can be used to select these appearance values:

Dark
The output is adjusted to show a dot gain of 33% for a 50% dot.

Accutone
The output is adjusted to show a dot gain of 22% for a 50% dot.

Highlight Midtone
The output is adjusted to show a dot gain of 14% for a 50% dot. This appearance is often used to
emphasize the brightest part of an image.

Standard
The output is adjusted just enough to account for the effects of dot gain, effectively counteracting the
dot gain.

If you use AFP Resource Installer, it installs the generic tone transfer curve CMRs on your system
automatically.

CMR Processing Modes

CMR processing modes tell the print system how to apply a CMR to the print data it is associated with.
You specify a CMR processing mode whenever you specify a CMR, although not all modes are valid
for all CMR types.

Audit Processing Mode

CMRs with the audit processing mode refer to processing that has already been applied to a resource.
In most cases, audit CMRs describe input data and are similar to ICC input profiles.

The audit processing mode is used primarily with color conversion CMRs. In audit processing mode,
those CMRs indicate which ICC profile must be applied to convert the data into the profile connection
space (PCS).

For example, to take a photograph with a digital camera and then include the photograph in an AFP
print job, you can use AFP Resource Installer to:

1. Create a color conversion CMR by using the ICC profile of your camera.

2. Install your photograph in a resource library.

3. Associate the color conversion CMR with the data object, indicating the audit processing mode.

Then, you create a print job that includes the data object. When processing the print job, the system
uses the color conversion CMR to convert the colors in the image into the PCS. The colors can then be
converted into the color space of the printer that is printing it.
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Instruction Processing Mode

CMRs with the instruction processing mode refer to processing that is done to prepare the resource for a
specific printer that uses a certain paper or another device. Generally, instruction CMRs refer to output
data and are similar to ICC output profiles.

The instruction processing mode is used with color conversion, tone transfer curve, and halftone CMRs.
In instruction processing mode, these CMRs indicate how the system must convert a resource so it prints
correctly on the target printer. The manufacturer of your printer should provide ICC profiles or a variety
of CMRs that you can use. Those ICC profiles and CMRs might be installed in the printer controller,
included with the printer on a CD, or available for download from the manufacturer's Web site.

If you send a color AFP print job to a printer that supports AFP Color Management, color conversion
and tone transfer curve CMRs in instruction processing mode can be associated with the job. When the
printer processes the print job, it applies the CMRs in this order:

1. Color conversion CMRs in audit processing mode to convert the resources into the ICC profile
connection space (PCS).

2. Color conversion and tone transfer curve CMRs in instruction processing mode to convert the
resources into the color space of the printer.

3. Halftone CMR in instruction processing mode to convert the job pages from their digital format into
the pattern of dots that the printer can produce.

In some cases, CMRs that are usually used as instruction CMRs can be used as audit CMRs. For
example, if you send a very large print job to a high-speed printer, the images in the print job are
converted into the color space of that printer by using a color conversion CMR with the instruction
processing mode. However, if you have to reprint part of the job on a different printer, the system must
convert the print job into the color space of the second printer. In that case, the color conversion CMR
of the first printer is used in the audit processing mode to move the images back into the PCS. Then, the
system uses a color conversion CMR of the second printer in instruction mode to convert the images into
its color space.

Link Processing Mode

CMRs with the link processing mode are used to link an input color space in the presentation data
(sometimes defined by an audit CMR) to the output color space of the presentation device (sometimes
defined by an instruction CMR). Only link (LK) and device link (DL) CMRs can be used in link processing
mode.

Whenever you install or uninstall audit or instruction color conversion CMRs in your resource library by
using AFP Resource Installer or a similar software product, the AFP Resource Installer automatically
creates or deletes link (LK) CMRs for every combination of audit and instruction color conversion CMR.

When a print job calls for a given audit-instruction combination, the print server checks the resource
library for a link (LK) CMR for that combination. If the print server finds an appropriate link CMR, it
sends the CMR to the printer with the print job. Your printer can use the link (LK) CMRs whenever a print
job indicates that it uses a particular combination of audit and instruction CMRs.

If you do not use AFP Resource Installer or a similar program to install your resources, your color printer
must either create link (LK) CMRs while it processes your print jobs or convert the colors in your jobs
twice, first from the original color space to the PCS and then from the PCS to the color space of the
printer.
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CMR Creation and Installation

Device manufacturers and groups that support AFP color standards create CMRs that you can use in
your color printing systems. You can also create CMRs yourself, based on your needs.

The AFP Consortium, the group that defined the AFP Color Management Object Content Architecture
(CMOCA), identified a set of color conversion CMRs that are most often used in audit processing
mode. The set includes color conversion CMRs for common color spaces, such as:

• Adobe RGB (1998)

• sRGB

• SMPTE-C RGB

• SWOP CMYK

The standard CMRs are included with AFP Resource Installer, although they are not installed by default.
You can install the standard CMRs that you plan to use. In addition, AFP Resource Installer
automatically installs all the generic halftone and tone transfer curve CMRs in any resource library you
create.

If you need more CMRs, you can create them by using wizards provided in AFP Resource Installer. See
the online help for details about the wizard.

If you use AFP Resource Installer to create a CMR, the software automatically installs the CMR in a
resource library. You can also use AFP Resource Installer to install CMRs that you get from your printer
manufacturer.

Data Objects

Presentation data objects contain a single type of data (such as GIF, JPEG, and TIFF images) and can
be used in your print jobs. These data objects can be placed directly in a page or overlay or can be
defined as resources and included in pages or overlays. Using a data object as a resource is more
efficient when that object appears more than once in a print job; resources are downloaded to the
printer just once and referenced as needed.

Data objects can either be included inline with a print job or installed in a resource library by using
software such as AFP Resource Installer. If you install your data objects in a resource library, you can
associate color conversion CMRs with them.

Types of Data Objects

Image data objects can be stored in a number of different formats, including AFPC JPEG Subset, EPS,
GIF, IOCA, PDF, PNG, and TIFF. These image types are device-independent so they can be used by
different systems and still be interpreted consistently.

• AFPC JPEG Subset (JPEG)
AFPC (AFP Consortium) JPEG Subset files, formerly called JPEG File Interchange Format (JFIF) files,
are bitmap image files that are compressed by using Joint Photographic Experts Group (JPEG)
compression. As a result, AFPC JPEG Subset files are most commonly referred to as JPEG files. JPEG
files most commonly use the file extension .jpg, but can also use .jpeg, .jpe, .jfif, and .jif.

JPEG compression deletes information that it considers unnecessary from images when it converts
them. JPEG files vary from having small amounts of compression to having large amounts of
compression. The more an image is compressed, the more information is lost. If the image is
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compressed only once, there usually is no noticeable effect on the image. However, if the image is
compressed and decompressed repeatedly, the effects of deleting information become more
noticeable.

JPEG compression is commonly used for photographs, especially photographs that are transmitted
or displayed on Web pages. The compression makes the files small enough to transmit on a network
efficiently, but leaves enough information that the image is still visually appealing.

• Encapsulated PostScript (EPS)
EPS is a PostScript graphics file format that follows conventions that Adobe Systems defined. EPS
files support embedded ICC profiles.

• Graphics Interchange Format (GIF)
GIF files are bitmap image files that are limited to a palette of 256 RGB colors. Because of the
limited color range that it can contain, GIF is not a good format for reproducing photographs, but it
is generally adequate for logos or charts. GIF images are widely used on the Internet because they
are usually smaller than other image formats. GIF files use the file extension .gif.

• Image Object Content Architecture (IOCA)
IOCA is an architecture that provides a consistent way to represent images, including conventions
and directions for processing and exchanging image information. The architecture defines image
information independently of all data objects and environments in which it might exist and uses self-
identifying terms; each field contains a description of itself along with its contents.

• Portable Document Format (PDF)
PDF is a standard file format that Adobe Systems developed.

PDF files can be used and stored on various operating systems and contain all the required image
and font data. Design attributes in a PDF are kept in a single compressed package.

– Single-page and multiple-page PDF files can be used as data objects in AFP print jobs.

• Portable Network Graphics (PNG)
PNG files are bitmap image files that support indexed colors, palette-based images with 24-bit RGB
or 32-bit RGBA colors, grayscale images, an optional alpha channel, and lossless compression.
PNG is used for transferring images on the Internet, but not for print graphics. PNG files use the file
extension .png.

• Tagged Image File Format (TIFF)
TIFF files are bitmap image files that include headers to provide more information about the image.
TIFF files use the file extensions .tif or .tiff.

TIFF files support embedded ICC profiles. If an ICC profile is embedded in a file, the characteristics
of the input color space are known whenever the file is used; however, the profiles increase the file
size. When you save a file in the TIFF format, you can use various compression algorithms.

– Single-image and multiple-image TIFF files can be used as data objects in AFP print jobs.

Not all printers support all types of data objects.

The embedded ICC profiles in EPS, JPEG, and TIFF files contain the information that a printer uses to
convert colors in the image from an input color space into the profile connection space (PCS). The input
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color space is either an industry-standard space or a custom space that describes the color
reproduction capabilities of a device, such as a scanner, digital camera, monitor, or printer.

Data Object Creation and Installation

You can use a wide variety of software applications to create or manipulate images to include in print
jobs. If you want to store them in central resource repositories, you can use AFP Resource Installer to
install them.

Data object creation

Most types of data objects are images of some kind. Examples include: photographs taken with a digital
camera; charts or diagrams generated by a software tool; and digital drawings created using graphics
software. Regardless of how images are created, you generally need to manipulate them to include
them in print jobs.

The changes include:

• Convert the image into a file type that is appropriate for printing. For example, the file types that
many graphics applications (such as Adobe Illustrator, CorelDRAW, and Corel Paint Shop Pro) use
to store images while you work on them are not appropriate for printing. To use images that you
create from any of those programs, you can save or export those files as a different file type, such
as EPS, JPEG, or TIFF.

• Make sure that your image files are associated with an appropriate color space or input profile.
Follow the instructions provided with your graphics software to set up color management, including
installing and using ICC profiles for digital cameras and monitors, and customizing color
management settings. The instructions should also explain how to change the color profile that an
image uses and how to save an image with an embedded profile.

• Follow the tips and best practices provided in the other sections below for creating images and
managing them as data object resources.

Data object installation

You can use AFP Resource Installer to install your images in a resource library. AFP Resource Installer
includes wizards that can guide you through the process of installing an image as a data object. When
you install an EPS, JPEG, or TIFF image with an embedded ICC profile by using AFP Resource Installer,
you can choose how you want to handle the profile:

• Leave the profile in the file without creating a CMR.

• Leave the profile in the file, but also copy the profile and create a CMR from the copy. Associate the
new CMR with the data object.

• To reduce the file size, remove the profile from the file and make the profile into a CMR. Associate
the new CMR with the data object.

Resource Library Management

If you store CMRs and data objects in central resource libraries, you must understand some of the
characteristics of resource libraries to make sure that your resources are available when and where you
need them.

Color and Grayscale Printing



3

284

Resource libraries that AFP Resource Installer creates use a resource access table (RAT) as the index of
the resource library. The index is stored as a file in the library that it refers to. You must store CMRs in
resource libraries that use a RAT. We recommend that you store data objects in resource libraries that
use a RAT as well.

When you use AFP Resource Installer to create a resource library, it creates a RAT and stores it in the
library. When you install a CMR or data object, AFP Resource Installer updates the RAT with
information about the resource. When a print server looks in a resource library for a resource, it first
looks in the RAT to see if the resource is listed.

The print server relies on the RAT; if it is incorrect, the print server cannot find resources in the resource
library. As a result, you must always use AFP Resource Installer to manage your resource libraries,
including to:

• Add CMRs and data objects to a resource library.
Do not copy CMRs or data objects directly into the resource libraries that AFP Resource Installer
uses. If you copy CMRs or data objects into these resource libraries, the RAT is not updated so the
print server cannot use it to find the CMRs or data objects.

• Modify properties of data objects and CMRs listed in the RAT.
Do not directly edit the RAT or any of the files in a resource library. Do not replace an existing
version of a CMR or data object with a new version by copying the new version directly into the
resource library; use AFP Resource Installer to update the resource.

• Install CMRs or data objects in a different resource library or replicate a resource library in a
different location.
Do not copy CMRs or data objects from a resource library and store them in another location.

For more information about completing these tasks, see the AFP Resource Installer online help.

Tips and Best Practices

These general guidelines about creating and managing images and other color resources can improve
the performance of your AFP color printing system.

Tips for images

To optimize the performance of your AFP color printing system, we recommend that you follow some
guidelines for creating and including images in print jobs.

When you want to use color images in your print jobs:

• Get the original electronic versions of images instead of scanning existing documents.
Almost unnoticeable specks of color in the background of images that have been scanned can
greatly increase the size of the image. If you must scan an image, use an image editing tool to clean
up the background as much as possible.

• Save all images in the same standard color space so you only need one input profile for all of them.
Adobe RGB (1998) is the recommended color space for images that are to be printed.

• Flatten multi-layer images (such as the ones you can create in graphics tools like Adobe Illustrator
and Corel Paint Shop Pro) before including them in print jobs.
Unflattened images are extremely large and more difficult to work with. Save a copy of the original
image for future editing, but flatten the version that you include in your print job.
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Tips for Resources

To optimize the performance of your AFP color printing system, we recommend that you follow some
guidelines for managing color resources.

You can use AFP Resource Installer to:

• Install all the CMRs for your printer in a resource library.

• Install the data objects that you use frequently in a resource library.

• Mark the CMRs and data objects that are reused regularly as non-private, capturable resources so
they can be saved on the printer and used for other print jobs without being downloaded every
time.

– This option is not advisable for secure resources, such as signature files.

• Install CMRs and data objects in resource libraries that the print server can access, so they only
need to be stored in one place and can be used by all print servers.

• Associate audit color conversion CMRs with data objects that require color management, so the
embedded profiles can be removed from the image files.

RICOH AFP color and grayscale products

Ricoh provides a variety of products that support AFP color and grayscale printing. They can be used in
various combinations to create color workflow solutions.

The RICOH products that support AFP color management
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Printers

Some RICOH printers support color or grayscale printing with full AFP color management, while others
support AFP color printing without color management.

InfoPrint 5000

The InfoPrint 5000 is a full-color, high-speed, continuous forms Intelligent Printer Data Stream (IPDS)
printer that supports AFP color management.

The InfoPrint 5000 uses piezo-electric drop-on-demand inkjet technology with water-based pigment
inks that are designed to resist fading and smearing.

The InfoPrint 5000 receives AFP print jobs from RICOH print servers. When used as part of a full AFP
color management system, the InfoPrint 5000 can receive color conversion, link, and tone transfer
curve CMRs and apply them to print jobs. Because the printer engine applies its own halftones, it does
not support halftone CMRs.

The InfoPrint 5000 can capture resources and store them in a repository in its controller so they can be
reused in other print jobs. The printer only captures resources that are marked non-private and
capturable using an application such as AFP Resource Installer.

You can also submit PostScript and Portable Document Format (PDF) jobs to hot folders on the InfoPrint
5000, but those print jobs are not processed using AFP color management.

InfoPrint 4100

The InfoPrint 4100 family of printers uses a laser, electrophotographic print technology and Advanced
Function Presentation (AFP) licensed programs to create high-quality text and graphics output. InfoPrint
4100 printers with the InfoPrint POWER architecture and microcode release 15.4 or later support the
AFP color management architecture and can be used to print very high-quality grayscale images.

The base level of AFP color management support in InfoPrint 4100 printers with the InfoPrint POWER
architecture and microcode release 15.4 or later lets you apply color management to grayscale text,
graphics (GOCA), bi-level images (IOCA FS10), and barcodes. To use color management functions
with other types of objects, the AFP Color Emulation feature is required.

The AFP Color Emulation feature lets you print color objects in grayscale. When the feature is installed,
AFP Color Management lets you natively print GIF, IOCA FS11, IOCA FS45, JPEG, and TIFF images in
high-quality grayscale.

• Single-page PDF and EPS data objects are not supported on the InfoPrint 4100.

InfoPrint 4100 printers support these types of CMRs:

• Color conversion

• Link color conversion

• Tone transfer curve

• Halftone

For even better images on InfoPrint 4100 Models MS1, MD1, and MD2, you can also install the
Image Enhancement feature. Benefits of this feature include:
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• Enhanced fusing technology to minimize toner distortion

• Optimized developer unit for high coverage and high-density applications

• Improved halftones tailored to new hardware and toner technology

InfoPrint 1xxx series

The InfoPrint 1xxx series of workgroup printers and multifunction devices includes a wide range of cut-
sheet color and monochrome devices, although they do not support AFP Color Management.

For general office purposes, the InfoPrint 1000 series lets you manage color output efficiently and cost-
effectively through advanced technologies such as access controls, confidential print, and data stream
encryption. Through the 1000 family of printers, Ricoh offers output strategies and color printers that
address diverse requirements for high quality, security, and cost.

RICOH AFP Resource Installer

RICOH AFP Resource Installer is a key element of an AFP color management system when resources are
stored in central libraries. You can use it to create, install, and manage color management resources
(CMRs) and data objects for use in your system.

AFP Resource Installer is a Java application that you install on a Windows workstation. You can use it to
install and work with fonts in addition to CMRs and data objects.

You can use AFP Resource Installer to:

• Create CMRs from existing data, including ICC profiles.
You can use a wizard to guide you through the process.

• Install CMRs, fonts, and data objects in resource libraries on the local system or on any system that
you can access with FTP.

• Associate CMRs with data objects, so data objects can be reproduced accurately on different
printers.
In some cases, you can reduce the file size of your images by removing the embedded color profile
from the file and using an associated CMR.

• Mark resources as capturable.
Capturable resources can be captured and saved in the printer for use with other print jobs, which
can help improve system performance. The print server queries the printer before it sends any
resources; if the printer already has the resource, the print server does not have to send it.

• Mark resources as private.
Private resources cannot be captured in the printer and must be downloaded with every print job
that uses them. For example, you can mark signature files used for company checks as private for
security reasons.

When you use AFP Resource Installer to install a color conversion CMR, the software automatically
creates link (LK) CMRs between the new color conversion CMR and the existing color conversion
CMRs. When a print file references the new CMR, the print server automatically downloads the link
CMRs that match the target device type and model and sends them to the printer with the print job. If
one of those link CMRs is appropriate, the printer can use it instead of having to spend extra time
creating a link CMR.

Color and Grayscale Printing



3

288

To let a print server use resources installed by AFP Resource Installer, you must add the path to the
resource libraries to the AFP resource path in the server.

Print servers

RICOH print servers receive print jobs from various sources and prepare them to be sent to a printer.
After print jobs have been prepared, the print server interacts with the printer to make sure that all the
required resources are available, then sends the print job data to be printed.

Several different print servers are available. Although they provide much of the same function, they are
appropriate for different environments.

RICOH InfoPrint Manager

RICOH InfoPrint Manager is a flexible and scalable print management solution for AIX, Linux, or
Windows that provides many choices in expanding and managing your print environment. RICOH
InfoPrint Manager can process print jobs that contain references to color management resources and
interact with centralized resource libraries.

When RICOH InfoPrint Manager receives AFP or line data print jobs, it processes CMRs and data
objects similar to the way it processes other AFP resources. You can add the resource libraries that you
create using AFP Resource Installer to the Location of presentation object containers property (also
called the resource-context-presentation-object-container attribute) of your actual destinations. Then,
RICOH InfoPrint Manager can search those resource libraries to find data objects and CMRs when print
jobs request them.

Enabling capture for CMRs

If the jobs that run through your system use the same CMRs, you might want to enable your actual
destination to capture inline CMRs.

These inline CMRs must have an object identified (OID) so RICOH InfoPrint Manager can capture them.

From the RICOH InfoPrint Manager Administration GUI:

1. Click on the actual destination and select Printer→ Properties.

2. From the actual destination's Printer Properties notebook, click the Tuning tab.

3. Find the Capture inline CMR resources radio button.

If you can't see the Capture inline CMR resources radio button, click Show more.

4. Scroll to the bottom of the screen and click the Yes radio button for the Capture inline CMR
resources setting.

Page Printer Formatting Aid (PPFA)

PPFA is a feature of RICOH InfoPrint Manager that lets you create form definitions and page definitions
for use with your AFP print jobs. You can use PPFA to associate CMRs with form definitions and page
definitions for your color print jobs.

The form definitions and page definitions that you create using PPFA can be used in print jobs that are
sent to RICOH InfoPrint Manager and RICOH ProcessDirector.
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RICOH ProcessDirector

RICOH ProcessDirector is a database-driven print workflow system that lets you manage all aspects of
your printing process. The server runs on Linux or Windows systems and is accessed using a Web
browser-based interface. RICOH ProcessDirector can receive and process AFP print jobs that include
AFP color management objects.

RICOH ProcessDirector can also receive line data print jobs that refer to CMRs and data objects and
convert them into AFP using a step based on the ConvertLineDataJobIntoAFP step template.

RICOH ProcessDirector processes CMRs and data objects similar to the way it processes other AFP
resources. You can add the resource libraries that you create using AFP Resource Installer to the AFP
resource path property on a print job or in the job defaults for your workflows. Then, RICOH
ProcessDirector can search those resource libraries to find data objects and CMRs when print jobs
request them.

AFP color solution scenarios

AFP color solutions from Ricoh can be assembled in a variety of configurations based on your
environment and needs.

Printing high-quality grayscale output on an InfoPrint 4100 printer

An insurance company wants to migrate to AFP color printing slowly, so they start the process by using
AFP color management to print high-quality grayscale output on their InfoPrint 4100 printers.

The insurance company runs an in-house print shop that has four duplex InfoPrint 4100 lines. They use
a document composition tool to create AFP print jobs and submit the jobs to InfoPrint Manager for
Windows, which they use to balance the printing loads and keep all the printers running as much as
possible.

They have decided that they want to add images to some of their output. To start, they want to add
photographs of their insurance agents to the letterhead on letters to their clients. They are not ready to
move into full color printing, so they want to print black and white images using their existing printers.
Unfortunately, they have not been satisfied with the appearance of the images; they are too black and
one-dimensional, so they look unprofessional.

The solution

The Ricoh team suggests these changes to improve image quality:

• Upgrade the printer to use a controller with the InfoPrint POWER architecture with microcode
release 15.4 or later.
This update adds support for the AFP color management, which includes high-quality grayscale
printing using halftones and tone transfer curves.

• Purchase and install the AFP Color Emulation feature for the printer.

• Use AFP Resource Installer to manage the images, including associating them with the correct
halftones and tone transfer curves to create the best quality output.
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Solution diagram for adding AFP Resource Installer and a resource library, and
updating one InfoPrint 4100 printer line to use microcode release 15.4 and the AFP
Color Emulation Feature.

Implementation

To implement the solution, the print shop works with their Ricoh representatives to upgrade one of their
print lines to try the new function. They:

• Upgrade the print controller to the microcode release 15.4 or later.

• Install the AFP Color Emulation feature on the printer controller.

• Install AFP Resource Installer.

• Use AFP Resource Installer to:

– Create and install the color conversion CMRs for the InfoPrint 4100 printer and for the digital
camera used to take the photographs.

– Choose the generic halftone and tone transfer curve CMRs to use with the InfoPrint 4100 based
on the line screen frequency and appearance values that you want to use.

– Install the photographs of the insurance agents in a resource library, then associate them with
the appropriate CMRs.
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• Update the RICOH InfoPrint Manager destinations so they send the print jobs that contain
photographs to the printer line that has the AFP Color Emulation feature installed.

• Create print jobs that call the images using the names that they were given when they were installed.

Replacing pre-printed forms

A bank wants to reduce the amount of paper that it stores. If the bank eliminates some of the pre-printed
forms that they use by printing some statements on a color printer, they can use the same type of plain
paper for various applications.

Over the last five years, the bank has purchased ten smaller banks and is in negotiations for several
others. The parent bank uses an AFP system to print statements in-house on pre-printed forms. All the
pre-printed forms contain color logos. Some of them also contain background images or blocks of color
that divide the page into regions. The existing system consists of:

• RICOH InfoPrint Manager, including the Page Printer Formatting Aid (PPFA) feature

• Three duplex InfoPrint 4000 lines

• Two duplex InfoPrint 4100 lines

Print jobs are submitted as line data and RICOH InfoPrint Manager transforms them into AFP. AFP
resources are stored in a central location. There are no color production printers in use.

The banks that were acquired handled printing in different ways. Some of them had their own print
shops; some of them outsourced print to other companies. The print staff at the parent bank has spent a
significant amount of time moving the printing operations of the acquired banks to their in-house print
operation, starting with the ones that outsourced their print. Five of them have been converted. The print
shop administrators are starting to face some interesting issues:

• The increased workload for the in-house operation means that they need to increase their print
capacity.

• Each of the banks that the parent has purchased has maintained its own logo and branding. Each
time one of the banks has been integrated with print operations, it has brought with it at least five
different pre-printed forms that need to be ordered and stored.

• Even though each kind of pre-printed form comes from the same vendor, the colors vary noticeably.

• The acquired banks will eventually replace their old logos and forms with the logo and forms of the
parent bank, but the dates are not yet planned.

With the increase in the number of forms that must be stored, space is becoming a problem. The team
knows that they have to expand printing capacity, but they do not have space for a new duplex line. If
they could eliminate some of the paper that they have to store, they could use that space for the new
line.

The solution

The Ricoh team proposes an AFP color solution to:

• Transform their pre-printed forms to simple color statements and eliminate the need for pre-printed
forms, thus reducing the paper that needs to be stored.

• Streamline the process of moving the acquired banks to the parent bank’s logo and forms.

• Optimize resource management to maximize throughput.
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• Make the colors more uniform from job to job.

The solution adds a duplex InfoPrint 5000 line and AFP Resource Installer to the existing system and
updates the other components to add AFP color support. The bank can choose which applications to
move to the color workflow, taking into consideration the fact that the throughput of the InfoPrint 5000
line is less than that of an InfoPrint 4100 line. In addition, those print jobs cannot be run on the existing
InfoPrint 4100 or InfoPrint 4000 printers, since those printers cannot print the required color elements.

As the printing staff becomes proficient in using the system, they can start to prepare more applications
for an eventual move to color by migrating them to use the high-quality grayscale function available on
their InfoPrint 4100 printers. Then, when they are ready to add another color line (either by eliminating
more paper storage or by replacing one of the InfoPrint 4000 lines), they can move those print jobs to
the color printers.
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Solution diagram for adding RICOH AFP Resource Installer and an InfoPrint 5000
printer

Implementation

To implement the color solution, the bank printing staff works with the Ricoh team through several
phases:

• Planning the color solution

– Determine where the resource library should be located so that it is accessible to all the
applications that need to use it.
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– Determine which types of resources can or should be saved on the printer for reuse. For
example, signature files should probably not be saved on the printer; company logos and
background images probably should be saved.

• Installing and configuring the system

– Install the InfoPrint 5000 printers.

– Apply service updates to RICOH InfoPrint Manager and PPFA to add color support.

– Install AFP Resource Installer.

• Configuring resource management for optimal performance

– Use AFP Resource Installer to install the CMRs for the InfoPrint 5000 printers.

– Get the PDF file of the pre-printed form or use graphic art software to create a full page image
to use as the background image.

– Use AFP Resource Installer to install the PDF or image as a data object resource and associate a
color conversion CMR with it.

– Configure RICOH InfoPrint Manager to recognize the resource libraries that AFP Resource
Installer uses and to send print jobs to the new printer.

– Use PPFA to create a form definition and page definition that calls the new data object resource.
Refer to the object using the ID that you specified when you installed it.

– Copy any new form definitions or page definitions that you created into an existing resource
library.

• Testing system operations

– Create a print job that calls the form definition and page definition, and that points to the new
resource libraries.

– Submit the print job.

– Check the color output.

Eliminating physical inserts

A print service bureau wants to reduce the number of physical inserts that they have to add to envelopes
by printing full color electronic inserts in blank areas on credit card statements.

The print service bureau prints statements and one-to-one advertising brochures for a variety of
customers. The customers send their resources and print job data to the service bureau. The pre-press
staff uses a document composition tool to create AFP jobs. The AFP print jobs are submitted to RICOH
ProcessDirector, which sends them to ten duplex InfoPrint 4100 systems. After the jobs are printed, they
go to post-processing to be folded, inserted, and mailed.

The service bureau asks all their customers to submit required resources with every print job; they do not
store resources indefinitely. Many of their customers (such as credit card companies) include inserts in
the envelope with their statements. Some problems with this arrangement are:

• Inserters often ruin mailpieces, so they frequently have to reprint individual statements. Reprinting
adds time and cost to the process.
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• Customers tend to ignore the inserts, separating them from the statement immediately after opening
the envelope and discarding them.

The service bureau would like expand its offerings to include full-color variable-data printed using an
AFP color solution. They also think that they can save time, money, and paper by reducing the
complexity of the tasks that their inserters do. If the inserter only has to fold each statement and put it in
an envelope (instead of adding two more sheets of paper, folding, and inserting), it has fewer
opportunities for ruining mailpieces.

The solution

The service bureau works with the Ricoh team to create a solution based on its existing process and
environment that will help their customers move away from using physical inserts for advertising and
toward electronic inserts. They hope to eliminate one of their inserters by printing full color ads directly
in blank areas or on sides of customer statements.

If a credit card company can identify data and rules that determine the characteristics of each customer,
the electronic inserts can be targeted for each statement. For example, the bill could show an ad for a
minivan, a sports car, or a motorcycle depending on the demographics of the customer.

Implementation

To take advantage of this new color capability, the service bureau makes a few changes to their
workflow:

• They add a duplex InfoPrint 5000 system and configure RICOH ProcessDirector to submit print jobs
to it.

• They give guidelines to their customers so that it includes guidelines for using color images and
logos in addition to fonts and graphics.

• They train the pre-press department is trained to use a graphics application for color profile
management and image normalization.

• They add a step to their process to make sure that their customers have followed the guidelines. If
they have not, the pre-press staff adjusts the resolution and input color profiles to conform to the
guidelines before they submit the print job.

Related publications

You can find more information about AFP color printing on the Web sites of Ricoh and the AFP Color
Consortium.

For more information about the AFP color management and the Color Management Object Content
Architecture, see:

• AFP Color Management Architecture, G550-0526

• Color Management Object Content Architecture Reference, S550-0511

These AFP Architecture reference books contain information about color management resources:

• Mixed Object Document Content Architecture Reference, SC31-6802

• Advanced Function Presentation: Programming Guide and Line Data Reference, S544-3884
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• IPDS Reference, S544-3417

To download or order these publications or, for more information about the activities and publications
of the AFP Color Consortium, see the Consortium Web site:

http://afpcinc.org

For more information about the ICC, ICC profiles, and the PCS, see the ICC Web site: http://www.
color.org

WWoorrkkiinngg wwiitthh ffoonnttss
This section describes the fonts required for printing different data formats. It also describes what you
must do so that InfoPrint can use them. This material covers these font topics:

• Fonts for printing transformed PostScript and PDF data, p. 296

• Fonts for printing DBCS ASCII and EUC, p. 303

• Fonts for printing line data , p. 305

Fonts for printing transformed PostScript and PDF data

The InfoPrint PostScript transform program uses Type 1 outline fonts when transforming PostScript and
PDF files. InfoPrint includes the Type 1 outline fonts and these fonts are installed in the install_
path \ps\fonts path during installation. If you have other Type 1 outline fonts, you can also use them
with the transform program.

install_path indicates the path where you have installed InfoPrint Manager. You can view that
path from theManagement Console for InfoPrint Manager Server by clicking on the Edit→
Service Configuration path and checking the Install path field.

Note:When InfoPrint runs the PostScript transform program during job submission, it can search other
directories for fonts.

The following section contains these topics:

• Font mapping files, p. 296

• Specifying font substitution through initialization files, p. 298

Font mapping files

A font-mapping file identifies the file names of the Type 1 outline fonts on the Windows operating
system. The InfoPrint PostScript transform program requires at least one font-mapping file. InfoPrint
installs the default font-mapping file, fonts.map in the install_path\ps path during installation. If you
have other Type 1 outline fonts installed on your system, you can create additional font-mapping files to
define their names.

Creating a PostScript font mapping file

When you create your own font-mapping files, consider that:
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• You can create more than one font-mapping file.

• At least one font-mapping file must contain the Courier font. The PostScript transform program
substitutes Courier for any missing fonts.

• Fonts cannot span network file systems.

Use the InfoPrint mkfntmap command to create a font-mapping file for use with the InfoPrint PostScript
transform program. You specify one or more input files containing Type 1 outline fonts and a name for
the font-mapping file.

For example, to use the input file FontFile and create a font-mapping file named font.map, enter:

mkfntmap FontFile >font.map

Using font-mapping files with the ps2afp or pdf2afp command

By default, InfoPrint uses the fonts.map font-mapping file when you enter the ps2afp or the pdf2afp
command; you do not have to specify the name of the default font-mapping file with the command.

To use font-mapping files that you have created when you issue the ps2afp command, you must:

• Enter the path and name of the font-mapping file as the value of the ps_font_map_files keyword in
the transform daemon configuration file, which is named ps2afpd.cfg and located in the install_path
\ps2afp\ folder. For performance reasons, this is the recommended method. You can specify more
than one font-mapping file, if necessary. Separate the font-mapping files with colons.
For example, to specify the font-mapping files font1.map and font2.map, enter:

ps_font_map_files=c:\path\font1.map; c:\path\font2.map

• Enter the path and name of the font-mapping file as the value of the ps_font_map_files transform
command configuration file. Use the same syntax as described for entering the value in the
transform daemon configuration file. Using this method can result in significant performance
degradation.

• Specify the font-mapping file, including its path name, from the command line using the -F flag of
the ps2afp or the pdf2afp command. You can specify multiple files using multiple -F flags; InfoPrint
concatenates them from left-to-right (first entered to last entered) in that order:

ps2afp -F c:\path\font.map -F C:\path2\font2.map

This method can also result in degraded performance.

• If the path to the font mapping file contains blanks, you must surround the qualified pathname in
double-quotes:

ps2afp -F"D:\Program Files\ps\fonts.map"
Do not enclose a path that contains spaces in quotes(""); the transform will fail with incorrect font
mapping file errors.

• To specify two mapping files in a command, you must make sure that each file's full pathname is
specified, as in these examples:

ps2afp -F"D:\Program Files\ps\font1.map; D:\Program Files\ps\font2.map"

ps2afp -F"D:\Program Files\ps\font1.map" -F"D:\Program Files\ps\font2.map"

• If you do not specify a drive letter, but expect the transform to find a mapping file using a relative
path, the default drive is based on the install_path because that is where the ps2afp
executables reside.
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If your file is on the D: drive, the command line is on the C: drive, and the product is installed on the
E: drive, InfoPrint attempts to use the E:\samp1.map font mapping file:

C:\> ps2afp -oout.afp -F\samp1.map d:\incoming.ps

However, if your specify this command, InfoPrint attempts to use the C:\ps\files\samp1.map font
mapping file:

C:\ps\files> ps2afp -oout.afp -F\samp1.map d:\incoming.ps

If you create your own font mapping file – either by using the mkfntmap command or manually – and
the path to the fonts contains blanks, the font mapping file needs to double-quote the paths as well. For
example, if your fonts reside in E:\Program Files\ps\fonts , the font-mapping file could have any of
these variations:

PPAATTHH::

"E:\Program Files\ps\fonts"

FFOONNTT::

AvantGarde-Book AvantGarde-Book

FFOONNTT

AvantGarde-Book "E:\Program Files\ps\fonts\AvantGarde-Book"

You can use either the ps2afp -F or the pdf2afp -F command flag or the ps_font_map_files keyword
in the transform command configuration file to specify a font-mapping file. If the value from those three
sources is different than that specified in the transform daemon configuration file, the transform daemon
restarts the PostScript interpreter so that the new value for the font-mapping file takes effect for that one
job. However, restarting the PostScript interpreter decreases performance, because the interpreter is
restarted again with the font-mapping file in the configuration file for the very next PostScript job.

Specifying font substitution through initialization files

You can issue specific PostScript commands to specify whether printers substitute fonts for those defined
in job tickets that are neither inline with the job nor resident on the printer. To do this task, modify the
UserInit file that is located in the install_path\ps file system.

To make sure that fonts not inline with the job or resident on your printer substitute Courier fonts to allow
the job to print, specify this in the UserInit file:

%!
turnFontSubstitutionOn

To make sure that fonts not inline with the job or resident on your printer do not print, specify this in the
UserInit file:

%!
turnFontSubstitutionOff
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Using OpenType Fonts

This section describes what you need to use OpenType Fonts for printing with InfoPrint Manager.

These fonts offer many benefits over printing with standard font resources. They provide users with these
benefits:

• A wide range of non-Latin typefaces from which to choose

• A multilingual presentation environment through the support of Unicode

• A migration path towards a single font technology across all presentation environments

OpenType Fonts have these three characteristics in the font file:

1. A Microsoft Unicode version of Version 3 Release 1.

2. Microsoft Unicode Full Font Names

3. A Unicode character map (CMAP)
A CMAP defines the mapping of code points to glyph indices, which are used to index the actual
character shape information.

If your fonts do not contain all these elements, they cannot be used with InfoPrint Manager. If the
InfoPrint AFP Resource Installer (Program Number 5639-EE2) does not install a font, that font does not
meet this criteria.

You can use the standard AFP code pages you use for other font resources with OpenType fonts. For
more information about doing this task, see Using OpenType Fonts in an AFP System.

Using the Resource Installer to install OpenType fonts

If you have OpenType fonts, you must install them using the InfoPrint AFP Resource Installer (Program
Number 5639-EE2). If you create a new library or subdirectory for these fonts, you must also update
the global search path on your InfoPrint Manager server. If you place them in an existing subdirectory,
InfoPrint Manager should already have this location in its global search path.

Each time you either add new OpenType fonts or modify existing ones, you must reinstall them with the
Resource Installer to make sure that InfoPrint Manager can access them correctly. The search order of
directories for a data object font resources is the same as the search order for AFP font resources. Make
sure that the path where you install the OpenType Fonts is in the font search order that InfoPrint
Manager uses. For more information about how the font search order is defined see .

An administrator installs the OpenType fonts in a particular directory on each system. On an AIX server,
the default path for installing these fonts is the /usr/lpp/ipfonts directory. On a Linux or Windows
server, the default path is set up by the administrator who configured the system.

Once the OpenType fonts have been installed through the InfoPrint Fonts Collection product, you must
run the Resource Installer to create the Resource Access Table (IBM_DataObjectFont.rat) and store it
in the same directory where the fonts reside. The Resource Installer does not prompt you to do this task
because the Resource Installer is not aware of changes to the directory. As a result, the system
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administrator who installed the new fonts must do this task whenever fonts are either added or removed
from the directory.

The Resource Access Table contains an entry for each installed font so that InfoPrint Manager can
access it.

For more information about how to use the Resource Installer of InfoPrint Fonts, either access the online
help system of the Resource Installer or see Using OpenType Fonts in an AFP System.

Using font capture with OpenType fonts

Font capture allows a printer to capture a downloaded font and treat it as if it were a printer-resident
font. Treating a downloaded font as a printer-resident font improves performance for future jobs that use
the same fonts. Printers retain captured fonts across job boundaries and power cycles. Captured fonts
can be deleted from the printer when additional space is required. Because OpenType fonts are large,
you might want to make sure that your InfoPrint printer is set to support font capture.

If you want to capture OpenType fonts that reside in a library on a particular drive, click the Font
Installer's Capture check box. (far right column of the Top pane) for each font that you want to capture.
For more information, see the Resource Installer online help system.

Do not capture sensitive fonts, such as signatures, because an unauthorized person could access the
captured font, even from another system.

Enabling font capture for inline fonts

If the jobs that you run through your system use the same fonts, you might want to enable your actual
destination to capture inline font resources. These inline fonts must have an object identifier (OID) so
InfoPrint can capture them.

For many systems, this procedure is not recommended because captured inline fonts can be deleted
when your printer needs more storage. If InfoPrint Manager cannot access these fonts, the jobs can
either fail or print incorrectly.

From the InfoPrint Manager Administration GUI:

1. Click the actual destination and select Printer→ Properties.

2. From the actual destination's Printer Properties notebook, click Tuning.

3. Find the Capture inline OTF resources radio button. If you can't see it, click Show more.

4. Scroll to the bottom of the screen and select the Yes radio button for the Capture inline OTF
resources setting.

Using multiple fonts with limited printer memory

When you are using the OpenType fonts and you receive the Out of memory error message, you can
decrease theMaximum fonts to keep configuration item for InfoPrint Manager or increase the size of
the character cache from the Printer console.
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To decrease the number ofMaximum fonts to keep, complete these steps:

1. Right-click the actual destination in the InfoPrint Manager GUI and click Properties.

2. Click Tuning.

3. Find and change theMaximum fonts to keep value to a smaller number, such as 5.

To increase the character cache size from the Printer's console, complete these steps:

1. Click Printer Definition.

2. Click Printer.

3. Click Resource Utilization.

4. Increase Font Usage to the highest setting.

Using Unicode extended code pages

Unicode Extended Code Pages (ECP) are code pages with additional information used by OpenType
and TrueType fonts. This is a introduction for using extended code pages:

• If OpenType and TrueType fonts are used without ECP, Unicode scalars must be defined in the
hardcoded GUM (GCGID-to-Unicode-Mapping, where GCGID stands for Graphic Character
Global IDentifier) table resident in the printer or code points will be undefined. While the use of
predetermined mappings might meet many needs, if customization of GCGID to Unicode mappings
is required, an extended code page must be used.

• The extended code pages can be used on printers that do not support the extensions. However, the
extensions will be stripped out of the code page as it is downloaded to the printer appearing as if
an unextended code page was used.

• The extended code pages are files on disk just like unextended code pages. The search order
defined in RICOH InfoPrint Manager: Reference in the description of the resource-context-font attribute
still applies. However, a new file extension of .ECP is supported for all code pages. Inside the same
directory, a code page with the .ECP file extension will be selected before any other code page
with a matching name but a different file extension.

• File extensions are secondary search criteria. The search order of directories is the primary search
criterion when searching for any code page resource, including Unicode extended code pages. The
first possible match on the resource name is used. For example, there might be two code pages
called T1USV500.ECP and T1USV500. The T1USV500.ECP code page is located in a directory
only specified by resource-context. The T1USV500 code page is located in a directory specified in
resource-context-font. In this case, the T1USV500 code page is used. Conversely, if T1USV500.
ECP and T1USV500 are located in the same directory, the T1USV500.ECP code page is used.

• Code pages created or modified by the AFP Resource Installer will always have an .ECP file
extension. Use installation software to manage the installation of this new kind of resource.

• To force a code page to be downloaded instead of using a printer resident code page and to
prevent run-time substitution of code pages, do the procedure Using the 'no resident' version of the
sample grid files, p. 314.
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Updating the global search path on an InfoPrint Manager Windows server

To update the global search path on an InfoPrint Manager Windows server, follow these steps.

If you do not update the global search path, you must update each actual destination that you use to
print OpenType fonts.

1. To start the InfoPrint Manager Management Console, click the Windows Start button and select
Programs→ InfoPrint Manager→Management Console.

2. Stop the InfoPrint Manager server by selecting File→ Stop Server.

If you are not able to stop the server because you are not authorized for that action, check the
InfoPrint Manager Access Control List (ACL) for the Shutdown operation. Log off and log back on
as a user who is on the access control list.

3. Select Edit→ Service Configuration.

4. Update both the Default Font Search Path field and the Default Resources Search Path fields
with the directory where the OpenType fonts reside.

Using OpenType fonts with line data

When printing line data with OpenType fonts through InfoPrint Manager, you need to specify the
appropriate parameters on the line2afp command. To define the location of the OpenType fonts to the
line2afp command, you can either use the InfoPrint Manager global search path (using Updating the
global search path on an InfoPrint Manager Windows server, p. 302) or use the appropriate values on
the line2afp command. For more information about these values, see either Using OpenType Fonts in an
AFP System or ACIF: User's Guide.

For more information about either creating or modifying page definitions for line data jobs to print with
OpenType fonts, see Page Printer Formatting Aid: User's Guide

Limitations when printing line data with OpenType fonts

Before you can print this data, you must transform it to Unicode Transformational Format (UTF-16), with
big-endian byte order. Big-endian byte order means that in a two-byte UTF-16 code point the high-
order byte is specified first, followed by the low-order bytes. You can transform it through the uconv
utility, or any other application that transforms ASCII to Unicode. For more information about the uconv
utility see the operating system documentation.

Line data using OpenType fonts supports using the Byte Order Mark (BOM) and little endian data

InfoPrint Manager can process the Unicode Byte Order Mark (BOM) when printing line data with
OpenType fonts. (For UTF8 or UTF16-BE data, the BOM is skipped and not printed. For UTF16-LE, the
data is reversed to BE before it is printed, and the BOM is not printed.) In addition, InfoPrint Manager
can now recognize multi-byte carriage return and line feed characters when parsing Unicode line data.

This support lets you process UTF8 and UTF16 line data in either little-endian or big-endian order using
a traditional line data or record-format page definition. As many editors default to UTF8 or UTF16LE
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encodings and automatically insert a BOM at the beginning of the file, you can now print documents
created with these editors using Unicode-enabled Open Type Fonts.

Mixed mode data is line data mixed with MODCA structured fields. You can use mixed mode data with
UTF8, UTF16LE, and UTF16BE with a BOM as long as the BOM is the first bytes (following any cc or
trc bytes) of the first line of data.

To mix UTF8 or UTF16BE data with other data encodings, you can do that if there is no BOM. In this
case, the font selected for the data tells InfoPrint Manager the data encoding. You can't do this with
UTF16LE data because it always requires a BOM.

This support includes a -o newlineencoding flag for the -o flag, a stream,(newline=characters,
encoding) value for the fileformat parameter on the line2afp transform, and a new-line-option-
data-encoding document/default document attribute. For more information about this support, see
RICOH InfoPrint Manager: Reference.

Fonts for printing DBCS ASCII and EUC

In ideographic languages, like Japanese, Chinese, and Korean, there are thousands of characters. A
single byte of information cannot represent all of these characters because a single byte only
accommodates 256 characters. Therefore, at least one more byte of information is required.

For DBCS ASCII files, each ideographic character is either one byte or two bytes for each character.
For Extended UNIX Code (EUC) files, each ideographic character can be two, three, or four bytes,
depending on the EUC implementation and language. Single-byte ASCII characters can be mixed in
with DBCS ASCII and EUC characters.

InfoPrint supports printing DBCS ASCII and EUC files in these formats:

• DBCS ASCII files in the Japanese and Traditional Chinese languages, which can contain formatting
controls for the InfoPrint 5577 or 5587 printers.

• EUC files in the Japanese, Traditional Chinese, and Korean languages. EUC files cannot contain
any formatting control characters.

The following section contains these topics on printing with DBCS Fonts:

• Fonts required to print a double-byte transformed file, p. 303

• Installing DBCS fonts on Windows, p. 304

• Setting up font resources for DBCS ASCII and EUC printing, p. 304

• Printing Japanese DBCS messages at the end of a job, p. 304

Fonts required to print a double-byte transformed file

You can use the db2afp transform command to transform input files that use these code pages:

• Japanese PC (code page IBM-932)

• Japanese EUC (code page IBM-eucJP)

• Traditional Chinese PC (code page IBM-950)
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• Traditional Chinese EUC (code page IBM-eucTW)

• Korean EUC (code page IBM-eucKR)

The transformed files contain font references to the double-byte character set. You set the character set
and code page you want by either setting the PSFDBLANG environment variable or using the default-
character-mapping default document attribute defined in RICOH InfoPrint Manager: Reference. When
using the default-character-mapping default document attribute, you must also specify document-
format=debs-ascii for each applicable document or default document.

To set the PSFDBLANG environment variable, see the Determining what code page your print jobs
use and setting the correct environment variable section in Working with transforms, p. 201.

After you have used the db2afp command to transform DBCS ASCII and EUC files to AFP data stream
files, you must have access to DBCS fonts when you print the transformed files. The DBCS fonts for
Japanese, Traditional Chinese, and Korean are available with Infoprint Fonts, which is a separately
orderable feature of InfoPrint Manager.

Installing DBCS fonts on Windows

To make the fonts available to InfoPrint on your system once you have the licensed programs, you can
use the Windows licensed programs to install the fonts, or copy the fonts to a particular directory on
your Windows system.

Setting up font resources for DBCS ASCII and EUC printing

To print the transformed files that contain font references to the double-byte character set, you must
make the double-byte fonts known to InfoPrint through one of these methods:

• Create a resource-context object that identifies the location of the double-byte fonts and associate
the resource-context object with a default-document object and an InfoPrint logical destination.
Using this method makes the fonts known to InfoPrint for any job submitted to the logical destination
associated with the default-document object.

• Add the drives and specific folders to the search path for actual destinations using this procedure
from the InfoPrint Administration GUI:

1. From the InfoPrint Administration GUI main window, highlight the actual destination.

2. From the main menu, select the Printer→ Properties path to open the selected printers' Printer
Properties window.

3. From the Printer Properties window, click AFP Resources.

4. From AFP Resources, you can specify the fully qualified path where the double-byte fonts are in
the Location of Resources field.

This makes the fonts known to InfoPrint for any job processed by this actual destination.

Printing Japanese DBCS fonts at the end of a job

You can have DBCS messages print in Japanese at the end of each DBCS print job. As with printing any
DBCS jobs, you must have already installed the appropriate DBCS fonts on your system, and your
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printer must be DBCS-enabled. Also, you must have installed the font from the AFP Font Collection –
Japanese Fonts DVD-ROM to support printing the Japanese DBCS message page. If you have installed
this prerequisite and can print DBCS output in Japanese, this support is enabled and messages print in
Japanese automatically.

Note that if you do not install the appropriate fonts, InfoPrint Manager defaults to printing the
appropriate message in English.

Fonts for printing line data

When you specify a coded font name with the chars keyword of the line2afp command or with the
chars document attribute, the font name is limited to four characters, excluding the two-character prefix.

This table provides a list of the InfoPrint Expanded Core Fonts for use with unformatted ASCII input data.
InfoPrint stores these coded fonts in the install_path\fontlib path. There are copies of the eight-character
names that correspond to the six-character names that reside in the same location.

For the names of other coded fonts, see InfoPrint AFP Fonts: Font Summary.

IInnffooPPrriinntt EExxppaannddeedd CCoorree FFoonnttss

Type Family Point Size Coded Font Name Short Name (for
chars keyword)

Courier 7 X0423072 X04272

Courier 8 X0423082 X04282

Courier 10 X0423002 X04202

Courier 12 X04230B2 X042B2

Courier 14 X04230D2 X042D2

Courier 20 X04230J2 X042J2

Helvetica 6 X0H23062 X0H262

Helvetica 7 X0H23072 X0H272

Helvetica 8 X0H23082 X0H282

Helvetica 10 X0H23002 X0H202

Helvetica 11 X0H230A2 X0H2A2

Helvetica 12 X0H230B2 X0H2B2

Helvetica 14 X0H230D2 X0H2D2

Helvetica 16 X0H230F2 X0H2F2

Helvetica 18 X0H230H2 X0H2H2

Helvetica 20 X0N230J2 X0N2J2

Helvetica 24 X0N230N2 X0N2N2

Helvetica 30 X0H230T2 X0H2T2

Helvetica 36 X0H230Z2 X0H2Z2
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Times New Roman 6 X0N23062 X0N262

Times New Roman 7 X0N23072 X0N272

Times New Roman 8 X0N23082 X0N282

Times New Roman 9 X0N23092 X0N292

Times New Roman 10 X0N23002 X0N202

Times New Roman 11 X0N230A2 X0N2A2

Times New Roman 12 X0N230B2 X0N2B2

Times New Roman 14 X0N230D2 X0N2D2

Times New Roman 16 X0N230F2 X0N2F2

Times New Roman 18 X0N230H2 X0N2H2

Times New Roman 20 X0N230J2 X0N2J2

Times New Roman 24 X0N230N2 X0N2N2

Times New Roman 30 X0N230T2 X0N2T2

Times New Roman 36 X0N230Z2 X0N2Z2

Printing with the DBCS Simulation Fonts with the font metric adjustment triplet

InfoPrint Manager includes support for printing the DBCS Simulation Fonts (available with InfoPrint Fonts
Collection) with the font metric adjustment triplet. The DBCS Simulation Fonts are available on the AIX
and Windows operating systems.

When you use the DBCS Simulation Fonts, set the requested-font-resolution appropriately or use the
NORES grid files.

Installing the Japanese PostScript font feature

You can install Japanese PostScript fonts on your InfoPrint Manager server to print documents requiring
these specialized fonts.

To enable your InfoPrint Manager server to support Japanese PostScript fonts, use the InfoPrint installer
located on the InfoPrint Manager DVD-ROM. You will be prompted to supply your customer ID as well
as the access key located on the invoice that was shipped with your DVD.

WWoorrkkiinngg wwiitthh gglloobbaall rreessoouurrccee iiddeennttiiffiieerrss
InfoPrint can identify the fonts required for a job, access AFP font files that are installed on or NFS-
mounted to your Windows system, and download the appropriate fonts to an InfoPrint-managed printer
device. However, some InfoPrint printers can use fonts that are resident in the printer, which saves the
time it takes to download these fonts. Because the font files on the Windows system do not share the
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same names as the printer-resident fonts, InfoPrint uses global resource identifiers (GRIDs) to map the
system-resident fonts to the printer-resident fonts.

Uses of GRID files

GRID files contain preassigned mappings that you can modify to map system-resident font file names to
printer-resident font identifiers. These preassigned mappings include both single-byte character set
(SBCS) and double-byte characters set (DBCS) outline fonts.

If you have a printer that supports outline fonts, you can use the GRID files to map raster character-set
names to outline font global identifiers.

GRID files also support Mixed Object Document Content Architecture for Presentation (MO:DCA-P) files
that specify fonts using GRIDs rather than character-set names. You can customize the GRID files to
define which fonts InfoPrint uses when the data stream of the job specifies GRIDs.

If a data stream specifies only GRID parts instead of specific names, the fgid.grd table is used to find
the name of the font to download or the outline font to activate. In this case, the data stream must
specify a specific width value

GRID files that come with InfoPrint Manager

InfoPrint Manager provides four GRID files that you can customize to use with the types of printer
devices that you have and the types of jobs that you print. These files are charset.grd.sample,
codepage.grd.sample, cpgid.grd.sample, and fgid.grd.sample, and they are installed in the
<install path>\grd directory.

You can either shut down and restart the InfoPrint server (pdserver process) or shut down and restart all
your printers to make sure that .grd file changes are applied.

Descriptions of each file are provided below.

charset.grd.sample
Specifies which printer-resident fonts are activated for the character-set names found in the data
stream of the job.

This file maps the font character-set name to a:

• Font global identifier (fgid)

• Graphic character set global identifier (gcsgid)

• Font width

• Vertical size value

• Set of font attributes (bold, italic, and doublewide)

The next figure shows an example of the format of a line in the character set sample file.
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Sample File for a Character Set

# FCS name -> fgid gcsgid width vsize attr #
#----------------------------------------------------------------#

C0L00GSC 398 - 96 120 - # GOTHIC CONDENSED 1

codepage.grd.sample
Specifies which printer-resident fonts are activated for the code page names found in the data
stream of the job.

This file maps a code page to the:

• Code page global identifier (cpgid)

• Graphic character set global identifier (gcsgid)

The next figure shows an example of the format of a line in the code page sample file.

Sample File for a Code Page

# code page name -> cpgid gcsgid #
#--------------------------------------------------------------#

T1000038 38 123 # US-ASCII Character Set 1

fgid.grd.sample
Specifies which font character set InfoPrint should download when substituting for a global resource
identifier that it finds in the data stream of the job.

This file maps these to a font character set (FCS) name:

• A font global identifier (fgid)

• A graphic character set global identifier (gcsgid)

• A font width

• A vertical size value

The next figure shows an example of the format of a line in the font global identifier sample file.

Sample File for a Global Identifier

# fgid gcsgid width vsize -> FCS name #
#--------------------------------------------------------------#

3 0 144 240 C0E0DE10 # DELEGATE 12 POINT 1

cpgid.grd.sample
Specifies which code page InfoPrint should download when substituting for a global resource
identifier that it finds in the data stream of the job.

This file maps a code page global identifier and a graphic character set global identifier to a code
page name. The next figure shows an example of the format of a line in the code page identifier
sample file.

Sample File for a Code Page Identifier

# cpgid gcsgid -> code page name #
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#----------------------------------------------------------#
29 0 T1V10871 # OLD ICELANDIC 1

For a detailed explanation of how the different types of identifiers combine to produce fonts, see AFP
Fonts: Font Summary.

If you have a job that specifies a font that is not resident on your printer, you can use the GRID files to
map the missing font to one with the same point size that does reside on your printer. To understand
what resident fonts your printer device has, see both your printer documentation and Advanced Function
Presentation: Printer Information.

InfoPrint search order for GRID files

InfoPrint searches these directories, in the order shown, for GRID files:

1. An internal list that matches the charset.grd.sample file.

2. <install path>\grd

3. <install path>\var\psf\printername, where PrinterName is the name of a valid InfoPrint actual
destination.

When the same mapping is found in one of these files, InfoPrint uses the last one.

When you install InfoPrint Manager, sample GRID files are installed in the <install path>\grd
directory. You can maintain a central location for new or modified GRID files for specific printers by
storing files in the <install path>\var\psf\PrinterName directory.

If you are mapping raster fonts to outline fonts, you can map multiple names to the same GRID part so
that different sized fonts can apply to your print job.

1. The new or modified GRID files you create have the same names as the sample files except that you
delete .sample from each file name.

2. After creating or modifying GRID files, you must shut down and restart the physical printer
represented by PrinterName for the changes in the file to take effect.

Understanding the general syntax rules and allowable values for GRID files

To tailor the InfoPrint-supplied GRID files for your own system needs, you need to understand the
general syntax rules for the four GRID files and the allowable values for the fields in the files.

Syntax rules that apply to all types of GRID files

GRID files are simple ASCII text files that you can modify using any standard text editor. These rules
apply to all of the GRID files.

• No line in the file can contain more than 255 characters
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• Fields in a line must be separated with one or more delimiters (spaces)

• The pound sign (#) indicates the start of a comment, which causes InfoPrint to ignore the remainder
of that line

• A dash (–), indicates the absence of a particular value, for which InfoPrint substitutes a zero (0)

• An asterisk (*) indicates that a wildcard value (any numeric decimal) is accepted.

• InfoPrint ignores blank lines and extraneous fields

Allowable values for the charset.grd file

You can specify these values for fields in the GRID file for a character set for a font:

fgid Identifies the character set identifier for the font. Specify a numeric value from 1 to 65534 or
enter a dash (–) to disable the mapping of this character set to GRID values.

gcsgid Identifies a global identifier for the font. Specify a numeric value from 0 to 65534 or enter a
dash (–) to specify no gcsgid. If you specify an asterisk (*), InfoPrint issues an error message.

width Identifies the width specified in the character set. Specify a numeric value from 0 to 65534 or
enter a dash (–) to specify no width. If you specify an asterisk (*), InfoPrint issues an error
message.

vertical_
size

Identifies the vertical size specified in the character set. Specify a numeric value from 0 to
65534 or enter a dash (–) to specify no vertical size. If you specify an asterisk (*), InfoPrint
issues an error message.

attrib-
ute_field

Indicates the attributes of the character set. Specify a lowercase b (bold), i (italic), d
(doublewide), or enter a dash (–) to specify no attribute.

Allowable values for the codepage.grd file

You can specify these values for fields in the GRID file for a code page for a font:

cpgid Identifies the code page identifier for the font. Specify a numeric value from 1 to 65534 or
enter a dash (–) to disable the mapping of this character set to GRID values.

gcsgid Identifies a global identifier for the code page. Specify a numeric value from 0 to 65534 or
enter a dash (–) to specify no gcsgid. If you specify an asterisk (*), InfoPrint issues an error
message.

Allowable values for the fgid.grd file

You can specify these values for fields in the GRID file for a font global identifier:

fgid Identifies the global identifier for the font. Specify a numeric value from 1 to 65534 or enter
an asterisk (*) to indicate a wildcard value. If you specify a dash (–), InfoPrint issues an error
message.
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gcsgid Identifies the global identifier for the font. Specify a numeric value from 0 to 65534 or enter
an asterisk (*) to indicate a wildcard value. If you specify a dash (–), InfoPrint issues an error
message.

width Identifies the number of characters per horizontal inch. Specify a numeric value from 1 to
65534 or enter an asterisk (*) to indicate a wildcard value. If you specify a dash (–),
InfoPrint issues an error message.

vertical_
size

Identifies the vertical size of the font. Specify a numeric value from 1 to 65534 or enter an
asterisk (*) to indicate a wildcard value. If you specify a dash (–), InfoPrint issues an error
message.

Allowable values for the cpgid.grd file

You can specify these values for fields in the GRID file for a code page global identifier:

cpgid Identifies code page identifier for the font. Specify a numeric value from 1 to 65534.

gcsgid Identifies the global identifier for the font. Specify a numeric value from 0 to 65534 or enter
an asterisk (*) to indicate a wildcard value. If you specify a dash (–), InfoPrint issues an error
message.

Modifying GRID files

The following section describes the two ways you can modify GRID files to support the printer devices
and types of jobs in your production printing environment.

If you are using InfoPrint Manager to print from either the 6400 and 6500 series in both native and
4234 emulation mode, you must modify both the charset.64xx.grd and the codepage.64xx.grd files
as described in Modifying the charset and codepage GRID files, p. 311 and Modifying the FGID and
CPGID GRID files, p. 312.

Modifying the charset and codepage GRID files

You can avoid having InfoPrint download fonts by adding font entries that map the font character set or
code page that is most referenced in jobs to a global identifier for a resident font.

For example, if your jobs specify the Prestige 10-point font, which is character set C0S0PR10, and that
font is not available you can map the Prestige 10-point font to a similar font that is either resident on
your printer or available for InfoPrint to download to your printer. In this procedure, you map the
Prestige 10-point font to Gothic 10-point font, character set C0D0GT10.

Do these steps:

1. Open the file <install path>\grd\charset.grd.sample in a text editor such as Notepad.
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2. Click File→ Save as. Rename the file charset.grd and save it into the <install path>\var\psf
\PrinterName directory, where PrinterName is the name of the InfoPrint actual destination
representing the actual device.

3. Edit the charset.grd file you just created. Copy this line for the Gothic 10 point printer-resident font
and paste it at the end of the charset.grd file:

C0D0GT10 40 - 144 240 # GOTHIC TEXT 10

4. Change the first entry in the copied line (in the FCS name column) to the character set identifier of
the Prestige 10 point font that you want to map to the Gothic 10 point font. You can change the
comment at the end of the copied line to identify the mapping change you are making.

C0S0PR10 40 - 144 240 # PRESTIGE 10 mapped to GOTHIC TEXT 10

5. Search the remainder of the charset.grd file to make sure that it contains no other C0S0PR10
entries. A later entry of the same character set would replace the entry you just made.

6. Save your changes and close the file.

If you want to print jobs that specify the personal computer ASCII codepage for Iceland, T1000861,
but that codepage is not available, you can map codepage T1000861 to the personal computer
multilingual codepage for ASCII data, T1000850.

Do these steps:

1. Open the file <install path>\grd\codepage.grd.sample in a text editor such as Notepad.

2. Click File→ Save as. Rename the file codepage.grd and save it into the <install path>\var\psf
\PrinterName directory, where PrinterName is the name of the InfoPrint actual destination
representing the actual device.

3. Edit the codepage.grd file you just created. Copy this line for the personal computer multilingual
codepage for ASCII data and paste it at the end of the codepage.grd file:

T1000850 850 980 # PC MULTILINGUAL

4. Change the first entry in the copied line (in the code page name column) to the codepage
identifier of the personal computer ASCII codepage for Iceland that you want to map to the
multilingual codepage. You can change the comment at the end of the copied line to identify the
mapping change you are making.

T1000861 850 980 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the codepage.grd file to make sure that it contains no other T1000861
entries. A later entry of the same character set would replace the entry you just made.

6. Save your changes and close the file.

Modifying the FGID and CPGID GRID files

You can add new entries to map your GRID data to the resident fonts in your printer by modifying either
the fgid.grd.sample file or the cpgid.grd.sample file. If you have a printer that does not support the
outline font technology (such as the InfoPrint 3835 Advanced Function Printer), we recommend that you
map all the CZnnnn entries to raster font character-set names. If you do not create this mapping, InfoPrint
issues an error message and does not print the job.

For example, to map the Times New Roman Latin 1 character set to the raster version, follow these
steps.
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1. Open the file <install path>\grd\fgid.grd.sample in a text editor such as Notepad.

2. Click File→ Save as. Rename the file fgid.grd and save it into the <install path>\var\psf
\PrinterName directory, where PrinterName is the name of the InfoPrint actual destination
representing the printer device.

3. Edit the file that you just created and copy this line:

2308 2039 * * CZN200 # Times New Roman Latin1

4. Change the entry in the FCS name column to CON20000.

2308 2039 * * CON20000 # Raster version of TNR Latin 1

5. Save your changes and close the file.

After this substitution, InfoPrint prints jobs that specify the font character-set name CZN200 and that
processed on the physical printer for which you made the change using the raster version of the font.
The CZN200 character set now maps to:

• An FGID of 2308

• A GCSGID of 2039

• A vertical size of 65535

• A width of 0

For more information about the different values available for font character sets and code pages, see
"IBM Font Interchange Information" in InfoPrint Data Stream and Object Architectures Mixed Object Document
Content Architecture Reference.

Because the InfoPrint 3835 Advanced Function Printer does not support any resident outline fonts, the
fgid.grd.sample file maps the FGID and the GCSGID back to the C0N20000 character set. Then,
InfoPrint searches the resource library search path to locate the C0N20000 character set for
downloading with the job.

To modify the cpgid file so that the personal computer ASCII codepage for Iceland maps to the
multilingual codepage for ASCII data as described in Modifying the charset and codepage GRID files,
p. 311, do these steps:

1. Open the file <install path>\grd\fgid.grd.sample in a text editor such as Notepad.

2. Click File→ Save as. Rename the file cpgid.grd and save it into the <install path>\var\psf
\PrinterName directory, where PrinterName is the name of the InfoPrint actual destination
representing the printer device.

3. Edit the cpgid.grd file you just created and copy this line for the personal computer multilingual
codepage for ASCII data:

850 980 T1000850 # PC MULTILINGUAL

4. Change the first entry in the copied line, in the cpgid column, to the codepage identifier of the
personal computer ASCII codepage for Iceland font that you want to map to the multilingual
codepage. You can change the comment at the end of the copied line to identify the mapping
change you are making.

861 980 T1000850 # ICELAND MAPPED TO MULTILINGUAL

Working with global resource identifiers
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5. Search the remainder of the cpgid.grd file to ensure that it contains no other 861 entries. A later
entry of the same character set would replace the entry you just made.

6. Save your changes and close the file.

Verifying the GRID files

During physical printer initialization, InfoPrint examines the contents of the GRID files. If InfoPrint detects
any syntax errors, it reports an error condition and fails to enable the physical printer. To correct these
errors, you must edit the GRID files that fail. For information about what files, lines, or fields are in error,
you must access the GRID error.log file for the physical printer, which is located in <install path>\var
\psf\PrinterName.

Preventing InfoPrint from using GRID files

If you have a 300-pel printer but you print 240-pel jobs, the printer-resident fonts might have different
line spacings and endings in the printed output. For some types of billing statements, these line endings
are inappropriate. You can solve this problem by preventing InfoPrint from using the GRID files, which in
turn keeps InfoPrint from using printer-resident fonts.

1. Rename your customized GRID files. For example, open Windows Explorer and navigate to the
<install path>\var\psf\PrinterName directory, where PrinterName is the InfoPrint actual destination
that you do not want to use GRID files with. Find the charset.grd file and right-click it. From the
pop-up menu, select Rename and change the name to charset.grd.bak.

2. Open the file <install path>\grd\charset.grd.sample in a text editor such as Notepad.

3. Click File→ Save as. Rename the file charset.grd and save it into the same <install path>\var
\psf\PrinterName directory that you were working with in step 1.

4. Edit the charset.grd file and place a dash (–) in the fgid column.

5. Save your changes and close the file.

6. Open the file <install path>\grd\codepage.grd.sample in a text editor such as Notepad.

7. Click File→ Save as. Rename the file codepage.grd and save it into the same <install path>
\var\psf\PrinterName directory that you were working with in step 1.

8. Edit the copied codepage.grd file and place a dash (–) in the cpgid column.

9. Save your changes and close the file.

Using the 'no resident' version of the sample grid files

There can be situations when you do not want InfoPrint Manager to use printer-resident fonts.

If you do not have customized GRID files and want to use the 'no resident' version of the sample grid
files shipped with InfoPrint Manager, complete this procedure:

1. From a DOS prompt:

cd <install path>\var\psf\PrinterName

Where PrinterName is the name of the InfoPrint physical printer that represents the actual printer
device.
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2. Create the charset.grd file from the charset.grd.nores file:

copy <install path>\lpp\psf\grd\charset.grd.nores charset.grd

3. Create the codepage.grd file from the codepage.grd.nores file:

copy <install path>\lpp\psf\grd\codepage.grd.nores codepage.grd

GGeenneerraattiinngg aanndd ssuubbmmiittttiinngg ccoolloorr mmaappppiinngg ttaabbllee ssoouurrccee aanndd
oouuttppuutt ffiilleess
A color mapping table is a printer resource object that defines a translation from certain MO:DCA
structured fields to new color structured fields used by newer printers. Color mapping tables are used to
provide highlight color attachments to black-and-white printers, such as using the InfoPrint 4005
attachment with the InfoPrint 4100 printer. You can also use a color mapping table to map highlight
colors into richer colors on a color printer like the InfoPrint 5000 printer or the InfoPrint 4100 when
printing with highlight colors. To apply color to black and white documents, you must use the following
procedure to create Color Mapping Table Source (.src) and Output Files. See "InfoPrint administrative
utilities" in " InfoPrint Manager Tools" chapter of the RICOH InfoPrint Manager: Reference for information
about the cmt utility. You can define translations from non-color fields to color, old color fields to new
color fields, and from new color fields to different new color fields. Therefore, you can use existing
applications and documents with new color fields without having to change the documents or
applications. Also, you can use various color mappings with a single document to print the document
using color in different ways without changing the original document.

The sample configuration file named cmt.cfg file should be available in the install_path\config
directory and the cmt utility should be available in the install_path\bin directory on your Infoprint
Server. Using the AFP architectural reference, you can apply color to existing black and white
documents.

A MOD:CA sample color mapping table produces from the sample cmt.cfg file is provided in install_
path\config\cmtsampl.

The cmt utility lets you create color mappings in a variety of different color modes that are defined
through the ColorSpace parameter. For example, the Highlight value can be used when printing to an
InfoPrint 4000 printer with an Highlight Color Model HC2 Post-Processor (HCPP).

Parts of a color mapping table

A color mapping table consists of a base part, a set of source groups, and a set of target groups. The
base part identifies the color mapping table with a type of either reset or normal.

The simplest possible color mapping table is a reset color mapping table that tells the printer to do no
transformations on the color information found in the document. A reset color mapping table has no
source or target groups; all other color mapping tables have at least one source and one target group.
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Using source groups

Each source group has an identification (ID) number that is used to match the source group with a
corresponding target group. You can have unique ID numbers; however, if you create the color
mapping table without the cmt utility and want to map several source groups to a single target group,
you can use the same ID number on multiple source groups. Valid ID values are 1–127.

The cmt utility generates pairs of sources and targets, then assigns increasing, sequential IDs to each
pair. For more information about the cmt utility, see the RICOH InfoPrint Manager: Reference.

Each source group must be classified as one of these color spaces:

Highlight color
Highlight color is used when your existing documents describe color in terms of the percent to be
covered and the percent to be shaded for a color number. The colors are device dependent. For
example, you might have a printer that allows the use of three colors for highlighting. You could
specify percent coverage and percent shading for colors 1, 2, or 3. Your printer setup would
determine the actual colors.

Standard Object Content Architecture (OCA)
Standard OCA uses defined combinations of red, green, and blue to create: blue, red, pink,
magenta, green, turquoise/cyan, and yellow. Standard OCA also defines several defaults such as
white on a black medium, black on a white medium, and the same color as the medium. The
medium could be, for example, paper or a display.

GOCA pattern fill
GOCA pattern fill defines patterns for filling areas that you might want to map to colors with a color
mapping table.

For detailed explanations about these color spaces, see Mixed Object Document Content Architecture
Reference.

You can use a color mapping table to pick specific object types to map, such as:

• Object area

• IM image data

• PTOCA data

• Page presentation space

• GOCA data

• Overlay presentation space

• BCOCA data

• IOCA data (bi-level, FS10)

• All PTOCA, GOCA, BCOCA, IOCA, FS10, and IM object data

• All objects, object areas, and presentation spaces

After you pick the color spaces and object types you want to map, you can specify exact values for the
fields you want to map.
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Using target groups

If you create the color mapping table without the cmt utility, you must specify a target group ID number
to match the source groups for a target. Valid ID values are 1–127.

The cmt utility generates pairs of sources and targets, then assigns increasing, sequential IDs to each
pair. For more information about the cmt utility, see the RICOH InfoPrint Manager: Reference.

Each target group must be classified as a color space that is the kind of color you want as output. The
color spaces defined in the matching source groups are transformed to this color space. The color
mapping table allows RGB CMYK, highlight, and CIELAB, but your actual hardware determines your
available choices. For example, if your printer supports only highlight color, your target group must use
highlight color.

You can specify exact values for output colors. For example, if your printer supports three highlight
colors, you can specify colors 1, 2, or 3 with coverage and shading percentages that are supported by
your printer.

Other publications that have helpful references regarding color devices include:

• InfoPrint 4005 Hi-Lite Color Application Design Reference, available from your Ricoh marketing
representative.

• InfoPrint Hi-Lite Color Introduction and Planning Guide for 4005.

Creating a color mapping table

In the procedure described below, we create a color mapping table to print an Advanced Function
Presentation (AFP) file that contains pie charts in the color green.

For our AFP files, this pie chart appears as a series of horizontal lines. By reviewing the chapter on
"Graphic primitives and attributes" in Graphics Objects Content Architecture for Advanced Function
Presentation Reference, we can see that these horizontal lines are created by a Pattern Output Primitive
with a hexadecimal value of '0B'(11).

To turn these horizontal lines into a shade of green when using a ColorSpace source group of GOCA to
map to a target group value of RGB, make sure that you specify a low value for red (12), a high value
for green (252), and a value under 50 for blue (42) to provide a clear contrast.

You must do these tasks from the Windows command line:

1. From the install_path\config directory, specify:

copy cmt.cfg piel.cfg

This copies the Color Mapping Table configuration file into a file you can customize for your own
purposes (in this case, pie1.cfg)

2. Specify

notepad piel.cfg.
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This lets you edit the configuration file and insert the applicable values to create the appropriate
color mapping (whether GOCA to RGB or OCA to CIELAB) table. See the sample cmt.cfg
configuration file below:

# -------------------------------------------------------
# Required, starts a Color Mapping Definition.
# One definition for each Source to Target mapping.
# -------------------------------------------------------
# -------------------------------------------------------
# BeginSourceDef:
# Required, starts the Source Parameters
# -------------------------------------------------------
BeginSourceDef:
# -------------------------------------------------------
# ColorSpace:
# Required, values= OCA | Highlight | GGOOCCAA
# -------------------------------------------------------
ColorSpace: GOCA
# -------------------------------------------------------
# ColorValue:
# Required, values depend on Color Space
# -------------------------------------------------------
ColorValue: 11
# -------------------------------------------------------
# ObjectType:
# Optional, values= ObjArea | ImageData | PTOCData |
#GOCAData | BCOCAData | AllOCA | Page | Overlay |
#ObjsAll
# default= ObjsAll
# -------------------------------------------------------
ObjectType: GOCAData
# -------------------------------------------------------
# PercentShading:
# Optional, only valid for SourceColorSapce: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# -------------------------------------------------------
# PercentShading:
# -------------------------------------------------------
# PercentCoverage:
# Optional, only valid for SourceColorSpace: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# -------------------------------------------------------
# PercentCoverage:
# -------------------------------------------------------
# EndSourceDef:
# Required, ends the Source Parameters
# -------------------------------------------------------
EndSourceDef:
# -------------------------------------------------------
# BeginTargetDef:
# Required, starts the Target Parameters
# -------------------------------------------------------
BeginTargetDef:
# -------------------------------------------------------
# ColorSpace:
# Required, values= RGB | CMYK | Highlight | CIELAB
# -------------------------------------------------------
ColorSpace: RGB
# -------------------------------------------------------
# ColorValue:
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# Required, values depend on Color Space
# -------------------------------------------------------
ColorValue: 12 252 42
# -------------------------------------------------------
# PercentShading:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# -------------------------------------------------------
# PercentShading:
# -------------------------------------------------------
# PercentCoverage:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# -------------------------------------------------------
# PercentCoverage:
# -------------------------------------------------------
# EndTargetDef:
# Required, ends the Target Parameters
# -------------------------------------------------------
EndTargetDef:
# -------------------------------------------------------
# Required, ends a Color Mapping Definition.
# -------------------------------------------------------
# EndMappingDef:

3. Once you have finished editing the pie1.cfg file, save the file.

4. To create the Color Mapping Table object (MOD:CA) file that will be used when you submit the job
for printing, run the cmt utility as the input file (-i flag):

cmt -i pie1.cfg -o pie1.out

This command produces a pie1.out output file.

Submitting jobs using a Color Mapping Table

To submit a job using the color mapping tables for spot color, you must make sure that you also specify
a resource-context attribute so that the server knows the location of the color mapping table. Once you
have configured a Color Mapping Table, you must have defined a logical destination (named prt1 for
this example) to which you can send the job.

Submitting jobs through the Windows command line

Once the logical destination has been defined, you can submit a job to an InfoPrint Manager printer by
specifying this from the command line:

Command Values Meaning

pdpr -d prt1 Print Command with logical destination name.

-x job-name=gocajob Name of the AFP file you submit for printing.

-x resource-context=/usr/lpp/psf/cmt/ Explicit path name for the Color Mapping
Table object files.
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-x color-mapping-table=pie1.out Color Mapping Table that you created in
Creating a color mapping table, p. 317 for
printing this file.

install_path\psf\cmt\goca.afp Explicit pathname where the print file is
located in.

Configuring an actual destination with the InfoPrint Manager Administration GUI

To configure an actual destination to use the appropriate Color Mapping Table:

1. From the InfoPrint Administration Servers main window, enable the appropriate actual
destination (in this case, NewP, as shown below) by right-clicking the actual destination and then
selecting Enable.

InfoPrint Administration Servers main window

2. Make sure that the Color mapping table (pie1.out) has been specified on the AFP Color tab of
the Printer Properties notebook and that the Location of resources (install_path\config) has
been specified on the AFP Resources tab:

3 Administrative Procedures: Customizing for Special Jobs



3

321

Printer Properties notebook

3. Submit your job to InfoPrint Manager, using either the command line or the InfoPrint Select client.

Using the InfoPrint Select client with Color Mapping Tables

In InfoPrint Select, specify the name of the Color Mapping Table as the job or document default as
appropriate.

UUssiinngg tthhee IInnffooPPrriinntt 55000000 aanndd RRIICCOOHH PPrroo VVCC sseerriieess mmooddeellss wwiitthh
hhoott ffoollddeerrss ffrroomm IInnffooPPrriinntt MMaannaaggeerr ttoo pprriinntt PPoossttSSccrriipptt aanndd PPDDFF
You can use hot folders to print PDF and PostScript files on the InfoPrint 5000 printer models (AD1/
AD2, AD3/AD4, AD3/AD4-XR3, AS1, AS3, KM3, KM3/MD4, MD3/MD4) and RICOH Pro VC
series models (RICOH Pro VC40000, RICOH Pro VC60000, RICOH Pro VC70000, and RICOH Pro
VC80000) with InfoPrint Manager for Windows.

• To submit the file MyJob to the logical destination IP5000-ld and request two-sided printing and
the color-toner-saver attribute, type:

pdpr -d IP5000-ld -x "sides=2 color-toner-saver=true" MyJob

Using the InfoPrint 5000 and RICOH Pro VC series models with hot folders from InfoPrint Manager to print PostScript and PDF
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The page size and orientation that is specified in the job and in InfoPrint Manager must match that
specified at the printer. Otherwise, the job prints on the page size and with the orientation specified
at the printer.

• To query all the jobs that you submitted to logical destination IP5000, type:

pdq -d IP5000-ld

LLiimmiittaattiioonnss ooff aaccttuuaall ssccrreeeenn ffrreeqquueenncciieess aanndd aanngglleess oonn IInnffooPPrriinntt
44000000 aanndd 44110000 pprriinntteerrss
If you change the version of toner used with your printer, you should recalibrate all customized
calibration curves to make sure that they print correctly. The screen frequencies shown in this section
presume the use of a 600 dots per inch (DPI) printer. Frequencies at other DPI are proportionally lower.
For example, an 85 lines per inch (LPI) screen used on a 300 DPI printer will be 43 LPI. Screen
frequencies match the requested screen frequency as closely as possible, based on constraints of the
halftone design.

For the actual screen frequencies and angles for both InfoPrint 4000 and InfoPrint 4100 printers, see
Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100 HD3/HD4 and HS2
printers with Version 3 or 7 Toner , p. 322, Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/
ID6 and InfoPrint 4100 HD1/HD2, HD5/HD6, PD1/PD2, HS1, HS3, and PS1 printers with Version 2
(enhanced printing toner) or Standard Toner, p. 322, Screen Frequencies for InfoPrint 4000 IR1/IR2
printers with Version 2, 3, or Standard Toner, p. 323, and Screen Frequencies for InfoPrint 4100 TD1-
2 printer with Version 2 Toner and InfoPrint 4100 TS1, TS2, TS3, TD3-4, TD5-6 printers with Version 7
Toner, p. 323.

SSccrreeeenn FFrreeqquueenncciieess ffoorr IInnffooPPrriinntt 44000000 IIRR33//IIRR44 aanndd IIDD55//IIDD66 aanndd IInnffooPPrriinntt 44110000 HHDD33//
HHDD44 aanndd HHSS22 pprriinntteerrss wwiitthh VVeerrssiioonn 33 oorr 77 TToonneerr

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 74 85 96 117

Actual Screen Angle (Default ° Set) 35.5° 45° 51.3 ° 59°

Actual Screen Angle (90° Set) 54.5° 45° 38.7° 31°

SSccrreeeenn FFrreeqquueenncciieess ffoorr IInnffooPPrriinntt 44000000 IIRR33//IIRR44 aanndd IIDD55//IIDD66 aanndd IInnffooPPrriinntt 44110000 HHDD11//
HHDD22,, HHDD55//HHDD66,, PPDD11//PPDD22,, HHSS11,, HHSS33,, aanndd PPSS11 pprriinntteerrss wwiitthh VVeerrssiioonn 22 ((eennhhaanncceedd
pprriinnttiinngg ttoonneerr)) oorr SSttaannddaarrdd TToonneerr

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 85 103 141

Actual Screen Angle 45° 45° 31° 45°
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SSccrreeeenn FFrreeqquueenncciieess ffoorr IInnffooPPrriinntt 44000000 IIRR11//IIRR22 pprriinntteerrss wwiitthh VVeerrssiioonn 22,, 33,, oorr SSttaannddaarrdd
TToonneerr

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 83 106 141

Actual Screen Angle 45° 34° 45° 45°

SSccrreeeenn FFrreeqquueenncciieess ffoorr IInnffooPPrriinntt 44110000 TTDD11--22 pprriinntteerr wwiitthh VVeerrssiioonn 22 TToonneerr aanndd IInnffooPPrriinntt
44110000 TTSS11,, TTSS22,, TTSS33,, TTDD33--44,, TTDD55--66 pprriinntteerrss wwiitthh VVeerrssiioonn 77 TToonneerr

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 74 85 96 117

Actual Screen Angle 36° 45° 51° 59°

SSppeecciiffyyiinngg aa hhaallffttoonnee ffoorr pprriinnttiinngg oonn tthhee IInnffooPPrriinntt MMaannaaggeerr
sseerrvveerr
You can use a particular halftone for printing a grayscale file through either Printing from InfoPrint
Submit Express, p. 323 interface or the Printing from the command line, p. 323.

Printing from InfoPrint Submit Express

You can print using a particular halftone for printing a grayscale file from a job ticket (name.jtk file) in
InfoPrint Submit Express. Begin by selecting a value in the Halftone field of the Look tab. Note that all
halftones shipped with the product have the term 'ibm' prepended to their identifier. If you are accessing
this interface for the first time, all of your previous default calibrations will have 'ibm' attached to the
name.

InfoPrint Manager lets you determine output appearance on a job-by-job basis by setting a default
halftone in a default document or job object.

InfoPrint Submit Express is part of the InfoPrint Manager Common Client DVD-ROM.

Printing from the command line

You can submit a halftone calibration from the command line with the pdpr command:

pdpr -p sip20-sage -x halftone=ibm106lpi:highlight-midtones grayscale.ps

where the -x value is the customized calibration file and grayscale.ps is the file to be printed.

Specifying a halftone for printing on the InfoPrint Manager server
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When submitting a pdpr command from the command line, you can specify the halftone attribute. The
actual halftone name for this example (ibm106lpi:highlight-midtones) can be found either by
using the InfoPrint Manager Administration Interface to look up the halftones supported for the
actual destination, or you can enter this at the command line:

pdls -cp -r halftones-supported ActualDestinationName

Using single cell halftones, available only for InfoPrint 4100 printer models, can improve the print out
image quality, especially when printing small sized objects (images, line art or text).

You use the single-cell-type actual destination attribute to specify the single cell halftone for the printer.
You specify either elliptical or euclidian as the value for single-cell type. You set the object threshold
size with one of these document attributes: image-small-threshold, line-small-threshold, or text-
small threshold.

You can submit a job requesting a single cell threshold for image, line art, or text from the command
line by using one of these variations of the pdpr command:

pdpr -p sip20-sage -x image-small-threshold=0.5i grayscale.ps

pdpr -p sip20-sage -x line-small-threshold=0.5i grayscale.ps

pdpr -p sip20-sage -x text-small-threshold=72p grayscale.ps

For more details about the supported values for the single-cell-type actual destination attribute and the
image-small-threshold, line-small-threshold and text-small-threshold document attributes, see
RICOH InfoPrint Manager: Reference.

SSuubbmmiittttiinngg ssppeecciiaalliizzeedd pprriinntt jjoobbss
This chapter describes these specialized print job:

• Submitting PSF printer input to a PCL or PPDS printer, p. 324

• Printing PCL or PostScript to PSF destinations: specifying which paper bin to use, p. 327

• Sending print jobs to InfoPrint Manager for Windows from an AIX system, p. 335

• Printing from ERP applications, p. 337

Submitting PSF printer input to a PCL or PPDS printer

In addition to AFP printing, InfoPrint Manager lets you submit PSF printer input data to PCL and PPDS
printers as well.

When you use the Create Printer wizard in the InfoPrint Manager Administration GUI to create a printer
object that will send jobs to a PCL or PPDS printer, you must specify the path for the command in the
Printer command field. For example, by default the lpr command is located at c:\winnt40
\system32\lpr.exe. Because InfoPrint Manager does not search the PATH environment variable for
the command, you must either add that directory to the PATH for that system or specify the entire path
of the command, as in this example:

c:\winnt40\system32\lpr -P printername -S servername
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To specify a file name in the command in a location other than at the end of the command, you must
include the text-string -IPMF- in the command string. The temporary file name used to store either the
PCL or PPDS data generated by InfoPrint Manager is substituted into the command wherever the -IPMF-
text-string is located.

The dashes (-) on either side of the -IPMF- text-string are part of the syntax and cannot be omitted.

You can only specify one -IPMF- text-string in a print command, as in the example below:

e:\usrapp\copyit -IPMF- /b e:\tmp

where copyit represents a user-written application for moving either the PCL or PPDS file that InfoPrint
Manager generated to the specified directory (in this case, \tmp on the e drive), and giving it a unique
name.

Setting up PCL tray mappings

To map the input trays requested in the AFP data stream to the input trays on your PCL printer, follow this
procedure:

1. Determine the AFP bin number and PCL bin number for each input tray. Default bin mappings, p.
325 shows the default bin numbers associated with some standard names for input trays.

You can use any tray names you wish, but these names are defined by the PCL data stream and are
the most common names. For more information about the limitations of trays and paper with a PSF
other-driver or PSF command DSS see the psf-tray-characteristics attribute in the RICOH InfoPrint
Manager: Reference.

DDeeffaauulltt bbiinn mmaappppiinnggss

Input tray name AFP bin number PCL bin number

alternate 3 5

bottom 2 4

envelope 65 6

manual 100 2

top 1 1

If these mappings are not appropriate for your printer, reverse the process described in Determining
bin mappings, p. 328. In this case, the AFP bin number is the bin number in the data stream and the
PCL tray number is the bin number used by the printer. Note that AFP bin numbers must be unique,
but different AFP bin numbers can map to the same PCL tray number.

2. Open the InfoPrint Manager Administration GUI.

3. Select the printer that you want to set up trays on.

4. From theMedia/Bins/Trays tab of the Actual Destination Properties notebook, in theMedia
ready table, select Add to define a new tray orModify to change an existing one. You can define
up to 15 trays.
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5. Complete these fields:

Input bin number
This field specifies the AFP bin number.

Media ready
This field shows the medium loaded in the input tray. The drop-down list lets you select from all
media supported by the printer.

Input tray name
This field shows the name associated with the input tray. Standard names for PCL input trays are:

alternate

envelope

lower

manual

upper

Formerly, these were the only names allowed. You can now use any name you like, subject to
these restrictions:

• Manual trays must have the string manual somewhere in the name, in any combination of
upper and lowercase, for example, transparentMANUALa4. You can define multiple
manual trays.

• Envelope trays must have the string envelope somewhere in the name, in any combination
of upper and lowercase, for example, Number10Envelope. You can define multiple
envelope trays.

Tray number
This field specifies the PCL bin number.

Duplex
This field specifies whether two-sided printing is possible from this input tray.

6. Click OK.

To make your changes take effect, you must now stop and restart PSF, the printer, or both. Follow the
steps corresponding to your job submission method.

• If you use DPF to submit jobs:

1. On your host system, stop PSF.

2. In the InfoPrint Manager GUI, left-click the printer, then select Printer→ Stop.

If you do not see Stop on the Printer menu, use Add/Remove Menu Items to add it.

3. Open the Management Console and click the DPF Host Receivers item in the left pane.

4. Click the DPF Host Receiver that feeds this printer to select it.

5. Click Actions→ Obtain Printer Characteristics.
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6. Go back to the InfoPrint Manager GUI and start the printer again.

7. Restart the host PSF.

• If you use any other method to submit jobs:

1. In the InfoPrint Manager GUI, left-click the printer, then select Printer→ Stop.

If you do not see Stop on the Printer menu, use Add/Remove Menu Items to add it.

2. In the Stop command dialog, select Shut down and click OK.

3. Select Printer→ Enable to restart the printer.

Printing PCL or PostScript to PSF destinations: specifying which paper bin to use

In general, when you submit a print job through a PCL or PostScript driver, you can use the printer
options to specify which input paper bin you want the printer to use. For example, if you know that white
8.5 x 11 inch paper is always loaded in bin one and letterhead is always in bin two, you can select bin
one when you want to print a draft and bin two when you're ready to print a real letter.

When you send PCL or PostScript print jobs to a PSF Destination in InfoPrint Manager, the data stream is
transformed into Advanced Function Presentation (AFP) before it is printed. By default, most PCL jobs
that are transformed use paper bin one, regardless of the bin you specify. Transformed PostScript jobs
default to letter-sized paper if no other options are specified, and look for a bin that contains that size
paper; they either print on paper from the first bin that contains the right size or fail because they do not
find the right paper.

If you want the transform program to check for your bin selection and include it in the AFP data that is
sent to the printer, you must specify mappings between the PCL and PostScript bins and the AFP bins.
The transform will use your mappings to convert the bin number it finds in the PCL or PostScript to an
AFP bin number. You can configure InfoPrint Manager so that you can specify up to 20 different input
paper bins. For information about how to figure out which PCL and PostScript bins map to which AFP
bins, see Determining bin mappings, p. 328.

After you have figured out the bin mappings, select the option below that most resembles your situation
and follow the related procedure.

• If you only have one printer with multiple paper bins OR if you can use the same mappings for all of
your printers, see Editing configuration files, p. 333.

• If you have more than one printer with multiple paper bins AND you want to use different mappings
for all of them, see Creating a transform with bin mappings, p. 334.

You cannot specify bin mappings if you are printing booklets (with or without integrated covers) or side-
by-side copies (multiple copies of the same page on one sheet of paper).
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Determining bin mappings

PCL printing

When you submit a print job through a PCL print driver and select a paper bin to print from, the driver
generates a bin number and puts it into the data stream. Unfortunately, different drivers generate
different bin numbers for the same bin. For example, one driver might make "Tray 1" equal to bin 4 and
"Auxiliary tray" equal to bin 2, while another driver makes "Tray 1" equal to bin 1 and "Auxiliary tray"
equal to bin 8. To add more difficulty, the generated PCL bin numbers can range from 0 to 59. While
most drivers use low numbers (0 through 10), keep in mind the other possibilities.

During the transformation from PCL to AFP, InfoPrint Manager takes the bin number that the driver
generated and compares it to the bin mappings you set. The pcl2afp transform inserts the AFP bin
number that you assigned and sends the job to the destination you requested. The printer prints the job
on paper from the bin you chose. As a result, it is essential that all of the users who submit jobs to a
given InfoPrint Manager printer use the same driver. If they do not, the mappings you set up will not
work correctly for them.

The first challenge for you in setting up the mappings is determining what bin number the PCL driver
places in the data stream. For various InfoPrint printers, the drivers actually generate the same bin
numbers. If you are using the PCL5e driver for an IBM Network Printer 12, Network Printer 17,
Network Printer 24, InfoPrint 20, InfoPrint 21, InfoPrint 32, or InfoPrint 40, the numbers listed in IBM
PCL5e Bin numbers, p. 328 are placed in the data stream.

IIBBMM PPCCLL55ee BBiinn nnuummbbeerrss

Tray (what you select in Device Settings) PCL bin number (what the driver puts in data
stream)

Automatically Select 0

Tray 1 1

Manual feed paper 2

Manual feed envelope 3

Auxiliary tray 4

Tray 2 5

Envelope feeder or Envelope tray 6

Tray 3 7

Tray 4 8

Tray 5 or 2000 sheet input tray 9

If you are using a different driver, the documentation that came with your printer might provide these
numbers; look for a section on the PCL driver. Alternatively, if you are able to capture the PCL data that
is sent to a specific bin in your printer, you can look for the bin number in the data stream. In some
cases, however, it might be just as easy to use trial and error to determine the correct mappings. Again,
keep in mind that PCL bin numbers can range from 0 to 59.
The second challenge is in determining the AFP bin numbers that correspond to your printer. AFP bin
numbers range from 1 to 255, and are not standard from printer to printer. Some printers have hard-
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coded bin numbers; each bin on the printer actually has a number written on it. In other cases, the AFP
bin numbers are more difficult to discover. In fact, the numbering scheme for some printers changes
completely when you add one of the optional paper bins. Still other printers allow you to change the
bin numbers yourself. As a result, it is difficult to predict exactly what the AFP bin numbers for your
printers are. However, there are some guidelines that you can use.

• Most AFP paper bins use numbers 1 through 10, with 1 being the biggest, topmost, or bottommost
bin.

• Envelope feeders/bins start at number 65 and can go up to 69.

• The manual feed tray is usually number 100.

If you are printing to InfoPrint printers, the best place to find the default numbering schemes for each
printer is in the IPDS and SCS Technical Reference and the IPDS Handbook for printers that use the AFCCU.

If you find the AFP bin numbers for your printer in this documentation, be aware that the number is
written in hexadecimal notation. You must convert the number to decimal before you put it in the
mapping file. In addition, the numbers that are listed are the machine numbers, not the numbers the
software requires (they are the IPDS bin numbers, not the AFP bin numbers). After you convert the
number to decimal, add 1 to it to get the number that you should put in the mapping file.

For example, if you have a printer with three paper bins and a manual feed bin, you could do this:

1. On the system that your InfoPrint Manager server runs on, install the PCL driver that you plan to use.
The easiest way to install the driver is by using the Windows Add printer wizard to create a printer
that uses that driver.

2. Using the Management Console, create a Windows gateway printer that uses the driver you just
installed and has a PSF printer as its target destination.

3. Click the Windows Start button and select Settings→ Printers to open the Printers window.

4. Right-click the Windows gateway printer you just created and select Properties from the pop-up
menu.

5. Click Device Settings to show the printer options that are available for this driver. For example,
some drivers show a list of "paper trays" and allow you to select a paper size for each one.

6. Make sure that all of the paper trays you plan to use are activated and have the correct size paper
selected.

7. Click OK to close the dialog and make the settings take effect.

8. Determine which method you will be using to map bins:

• If you only have one printer with multiple paper bins OR if you can use the same mappings for
all of your printers, see Editing configuration files, p. 333.

• If you have more than one printer with multiple paper bins AND you want to use different
mappings for all of them, see Creating a transform with bin mappings, p. 334.

9. Follow the appropriate procedure.
When you have to enter PCL and AFP bin numbers, start with the guidelines above and create some
logical mappings, such as the ones shown in table Sample mapping table for an InfoPrint 20, p.
330 for an InfoPrint 20.
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SSaammppllee mmaappppiinngg ttaabbllee ffoorr aann IInnffooPPrriinntt 2200

Tray selection PCL bin number AFP bin number

Tray 1 1 1

Tray 2 5 2

Tray 3 7 3

Manual feed tray 2 100

Envelope tray 1 6 60

Envelope tray 2 4 61

Complete the procedure.

10. Load each paper bin (including the manual feed bin) with a different kind, color, or specially
marked paper.

11. Submit a test job to each bin and see which paper it prints on. Keep track of your results and use
them to change the mappings to meet your configuration.

12.Once you have the mappings worked out correctly, tell your users this information:

• How to create a connection to this Windows gateway printer from their workstations.

• What options to set in the device settings.

• What kind of paper is in each bin.

• How to print to each bin.

PostScript printing

PostScript drivers use different methods to determine what paper bin to print a job on. Some drivers
allow you to select which paper tray you want the paper to come from. When you submit a job, the
driver sends a number to the printer to ask for the corresponding tray. Other drivers allow you to select
different paper options (such as size, color, or weight). When you submit a print job, these options are
sent with the print job and are used to determine which paper bin to use (set the paper size option for
this function to work).

When you configure InfoPrint Manager correctly, it will work with either type of driver. There are three
steps involved in performing this configuration:

1. Gathering paper tray information, p. 330

2. Identifying paper trays to InfoPrint Manager, p. 331

3. Testing tray mappings, p. 332

Gathering paper tray information

The first step in configuring InfoPrint Manager is to figure out:

• How many paper trays does your printer have?

• What is the AFP bin number for each tray?
Guidelines for figuring out the bin numbers are provided below.

• What kind of paper will you be loading into each tray?
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At a minimum, you should know what size paper will go in each tray. You can also specify a color
or weight of the paper.

Use this chart to record your data.

PPaappeerr bbiinn iinnffoorrmmaattiioonn

AFP bin number (in decimal
notation)

Paper tray on printer Paper loaded

100 Manual feed tray

There is trial and error work involved in figuring out the correct bin numbers. AFP bin numbers range
from 1 to 255, and are not standard from printer to printer. Some printers have hard-coded bin
numbers; each bin on the printer actually has a number written on it. In other cases, the AFP bin
numbers are more difficult to discover. In fact, the numbering scheme for some printers changes
completely when you add one of the optional paper bins. Still other printers allow you to change the
bin numbers yourself. As a result, it is nearly impossible to predict exactly what the AFP bin numbers for
your printers are. However, there are some guidelines that you can use.

• Most AFP paper bins use numbers 1 through 10, with 1 being the biggest, topmost, or bottommost
bin.

• Envelope feeders/bins start at number 65 and can go up to 69.

• The manual feed tray is usually number 100.

If you are printing to InfoPrint printers, the best place to find the default numbering schemes for each
printer is in the IPDS and SCS Technical Reference and the IPDS Handbook for printers that use the AFCCU.

If you find the AFP bin numbers for your printer in this documentation, be aware that the number is
written in hexadecimal notation. You must convert the number to decimal before you put it in the
mapping file. In addition, the numbers that are listed are the machine numbers, not the numbers the
software requires (they are the IPDS bin numbers, not the AFP bin numbers). After you convert the
number to decimal, add 1 to it to get the number that you should put in the mapping file.

Identifying paper trays to InfoPrint Manager

Once you have the chart filled in with your first try at mappings, you can move to the second step:
identifying all of the bins to InfoPrint Manager.

By default, InfoPrint Manager assumes that all PostScript printers have only one paper tray. When you
identify the trays, you let InfoPrint Manager know how many there really are. Then, when you submit a
job, you can choose any one of them.
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You identify the paper bins to InfoPrint Manager either in the configuration file or in the transform you
create. In this step, you will determine the syntax that you will be able to use in either place. The general
syntax of the identification statement is:

inputX=(size,type=xxx,weight=xxx,color=xxx),inputX=(size,
type=xxx,weight=xxx,color=xxx)

Where these conditions apply:

• Each inputX corresponds to a different paper tray. You should have as many inputX entries as
you have paper trays. Separate them with commas, no spaces.

• The X in each inputX is replaced with the AFP bin number from Paper bin information, p. 331 for
each tray.

• Size is the only required paper attribute. Replace the word size with the size of the paper that will
be in the tray, such as letter, legal, 8.5ix11i, or A4.

• Other paper attributes can be specified or left out entirely.

All of these are valid identification statements:

input1=(letter),input2=(legal),input100=(letter)

input1=(8.5ix11i,color=blue),input2=(8.5ix11i,color=yellow),
input3=(11ix17i),input100=(8.5ix11i)

input1=(A4,color=white),input2=(A4,color=blue),input3=(A4,color=yellow),
input65=(C5),input100=(A4,type=letterhead)

Write out your identification statement before moving on to the next step.

Testing tray mappings

Once you have your identification statement created, you can test your mappings to make sure they are
correct. This procedure explains one way to verify the mappings.

1. On the system that your InfoPrint Manager server runs on, install the PostScript driver that
corresponds to your printer. The easiest way to install the driver is by using the Windows Add
printer wizard to create a printer that uses that driver. After you create the printer, you can
delete it; the driver will still be installed.

2. Using the Management Console, create a Windows gateway printer that uses the driver you just
installed and has a PSF printer as its target destination.

3. Click the Windows Start button and select Settings→ Printers to open the Printers window.

4. Right-click the Windows gateway printer you just created and select Properties from the pop-up
menu.

5. Click Device Settings to show the trays and options that are available.

6. If your driver lists the paper trays that are available, activate them and select paper sizes for each
one. Set the options to match your identification statement.

7. Click OK to close the dialog and make the settings take effect.

8. Determine which method you will be using to map bins:

• If you only have one printer with multiple paper bins OR if you can use the same mappings
for all of your printers, see Editing configuration files, p. 333.
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• If you have more than one printer with multiple paper bins AND you want to use different
mappings for all of them, see Creating a transform with bin mappings, p. 334.

9. Follow the appropriate procedure.

When you have to change the configuration file or enter the command that your transform will
use, replace the inputX=... statement with your identification statement from Identifying paper
trays to InfoPrint Manager, p. 331, and complete the procedure.
When you have to enter PostScript options and AFP bin numbers, select an input bin number and
enter the options that you want to assign to that bin. For example, if you want AFP bin 1 (on the
printer) to hold letter-sized paper, AFP bin 2 to hold legal paper, and the manual feed tray to
hold 11x17 inch paper, the mapping portion of your command would read:

input1=(letter),input2=(legal),input100=(11ix17i)

10. Load each paper bin (including the manual feed bin) with a different kind, color, or specially
marked paper.

11. Test your settings by submitting print jobs to each bin of the Windows gateway printer and
making sure that it prints on the correct paper. If a job does not print on the correct paper, adjust
your AFP bin numbers and input numbers as necessary.

12. Tell your users this information.

• How to create a connection to this Windows gateway printer from their workstations.

• What options to set in the device settings.

• What kind of paper is in each bin.

• How to print to each bin.

Editing configuration files

There are five configuration files that come with the InfoPrint Manager PCL to AFP and PostScript to AFP
transforms. For the PCL transform, they are: pcl2afp.cfg and pcl2afpd.cfg. For the PostScript
transform they are: ps2afp.cfg, ps2afpd.cfg (used with InfoPrint 3000 and InfoPrint 4000 printers),
and 3160d.cfg (used with all other IPDS printers). You only need to edit one of these files per data
stream, depending on the printer you send your jobs to and these considerations.

• Edit pcl2afpd.cfg, ps2afpd.cfg, or 3160d.cfg if you want everyone to use the same mappings.
This method is recommended.

• Edit pcl2afp.cfg or ps2afp.cfg if different people have to use different mappings.

To edit the appropriate file:

1. On the system that your InfoPrint Manager server is installed on, locate the file. It should be in the
<install path>\pcl2afp or the <install path>\ps2afp directory.

2. Open the file in a text editor such as Notepad.
At the bottom of the file, you will see blocks of instructions and sample commands.

3. Modify the file according to the instructions in the file.
Choose one of the options and uncomment that line, then enter your mapping numbers. If you are
using the ps2afp transform, replace the inputX=... portion of the device_controls line with
your identification statement from Identifying paper trays to InfoPrint Manager, p. 331.

4. Save the file.
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It is recommended that you save a copy of your changes in a directory outside of the InfoPrint
Manager install path so that you have a copy in case you ever have to re-install or apply service to
InfoPrint Manager.

5. Close the file.

6. Restart the computer to have the new settings take effect.

7. Tell your users what kind of paper is in each bin and how to print to each of them.

Creating a transform with bin mappings

You can use the InfoPrint Manager transforms to process print jobs with different options, including
which paper bins to use. First, you create a transform using the InfoPrint Manager Administration GUI,
specifying an input data stream and an output data stream. Then, you associate it with one or more
printers. When you send a print job to that printer, your transform checks to see if the file is the data
stream that needs to be transformed. If it does, the transform converts the file as you specified; if it is not,
the transform passes the file to the logical destination. As a result, if you do not want to use the same bin
mappings for all of your printers, you can create several different transforms, all with different
mappings. Then, associate each transform with whichever printer or printers you want.

If you will be sending both PCL and PostScript jobs to the same printer, you can create two transform
objects (one that accepts PCL and one that accepts PostScript) and associate them both with that printer.

To create a transform that maps PCL/PostScript bins to AFP bins:

1. In the InfoPrint Manager Administration GUI, click Server and select Transform→ Create.

2. In the Create transform dialog, fill in the fields:

• Name: Type a name for the transform.

• Server: Choose the correct InfoPrint Manager server.

• Format of output file: SelectMODCA-P.

• Description: Type a description that will help you remember which printer uses this transform.

• Transform options: The command line that will execute when the transform runs.
If this transform accepts PCL, type:

pcl2afp -o "%o" "%i" –device 'plex,inputX=(pcl_bin=Z),
inputX=(pcl_bin=Z)'

Replacing the Xs with the number of the AFP bin (on the printer) and Zs with the number of the
PCL bin. You can specify up to 20 mappings.

If this transform accepts PostScript, type:

ps2afp -o "%o" "%i" –device 'plex,inputX=(size,type=xxx,color=xxx,
weight=nnn), inputX=(size,type=xxx,color=xxx,weight=nnn)'

Replace the inputX=... portion of the command with your identification statement from
Identifying paper trays to InfoPrint Manager, p. 331.
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Replace size with a paper size such as: letter, legal, A4, or the dimensions of the paper in
inches (8.5ix11i), millimeters (216mx279m), or points (612px792p) and the Xs with the
number of the AFP bin (on the printer). Size is the only required value; the others you can either
fill in or delete.

• Select Transform and print.

• Document formats allowed: The data stream that your transform accepts. Select PCL or
PostScript and add it to the allowed values.

• Click OK.

3. Select the printer that you want to associate this transform with and open its properties notebook.

4. Click Configuration.

5. Find the Transforms to use field.

6. Select the transform you just created in the Possible values box and add it to the Values box.

7. Click Apply.

8. Click Document.

9. Find the Formats allowed section.and look in the Values box. Make sure that modca-p and
either pcl or PostScript are listed.

10.Click OK.

11. Tell your users what kind of paper is in each bin and how to print to each of them.

Sending print jobs to InfoPrint Manager for Windows from an AIX system

To send print jobs from an AIX system to InfoPrint Manager for Windows, you need to set up an
appropriate Line Printer client (LPR) on the AIX system and an appropriate Line Printer Daemon (LPD) on
the Windows system. To use the advanced printing options (such as formdef and pagedefs) that
InfoPrint Manager provides, you must use lprafp on your AIX system and the InfoPrint Manager LPD on
your Windows system.

lprafp is a version of LPR that lets you use –o options to specify advanced print options when you
submit jobs to InfoPrint Manager. You can download an lprafp sample code package (including a
compiled version of the code that can be used on AIX version 4.3.3 and later) from the Ricoh website at
https://dl.ricohsoftware.com/downloads/375bc3fe-3080-401f-91c4-2b8adb607f89. Ricoh does
not provide support for the package.

The InfoPrint Manager LPD is installed and activated with your InfoPrint Manager for Windows server. It
is the only LPD that properly processes the –o options that lprafp submits. If you use a different LPD
(such as TCP/IP Print Services, the LPD that is shipped with the Windows operating system), the –o
options that you send will be lost.

The LPD supplied with the Windows operating system (TCP/IP Print Services) does support a –o option,
but it is not the same. This –o option specifies the binary option.

If you use the InfoPrint Manager LPD, you will only be able to LPR print jobs to InfoPrint Manager
destinations, not to Windows printers. If you use a different LPD, you will only be able to LPR to
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Windows printers. To submit a job to InfoPrint Manager, you will have to set up a Windows gateway
printer.

For additional information about the InfoPrint Manager LPD, see Using the InfoPrint Manager line
printer daemon (LPD), p. 168.

If you cannot use lprafp and/or the InfoPrint Manager LPD, you can use the standard LPR and a
different LPD to submit jobs from an AIX system to your InfoPrint Manager for Windows system.
However, you will not be able to use advanced print options.

1. Do not use this procedure if you have InfoPrint Manager for AIX installed on your AIX system. If you
have InfoPrint Manager for AIX installed, you should use the InfoPrint Manager AIX Client to submit
print jobs from AIX systems to your InfoPrint Manager servers. In addition, you should consider
setting up an interoperating environment so your InfoPrint Manager servers can work together.
For additional information about interoperability, see Configuring a primary AIX server with a
secondary Windows server, p. 156.

2. When you enter the lpr command, you must specify the option that designates binary or already-
formatted data. For example, on AIX you must use the -l (lowercase "L") option on the lpr.

To submit jobs from an AIX system to your InfoPrint Manager for Windows system, you must complete
these tasks:

• Verify that the InfoPrint Manager LPD is running, p. 336

• Install and configure lprafp, p. 337

Verify that the InfoPrint Manager LPD is running

To verify that the InfoPrint Manager LPD is running, follow these instructions:

1. On the system that your InfoPrint Manager server runs on, open the InfoPrint Manager
Management Console.

2. Click Edit→ Service Configuration.

3. In the Service Configuration dialog, find Run InfoPrint Manager LPD service check box.

• If the box is checked, the InfoPrint Manager LPD is already running. Click Cancel to dismiss the
dialog.

• If the box is not checked, click Cancel and continue with step 4.

4. In the InfoPrint Manager Management Console, click File→ Stop Server.

5. After the InfoPrint Manager server has stopped, click Edit→ Service Configuration again.

6. Click Run InfoPrint Manager LPD service to select it.

7. Click OK.

8. Click File→ Start Server to restart the InfoPrint Manager server.
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Install and configure lprafp

The lprafp sample code package is available for free download at https://dl.ricohsoftware.com/
downloads/375bc3fe-3080-401f-91c4-2b8adb607f89.

The compiled version of lprafp for AIX will only run on AIX 4.3.3 and later. If you have an earlier
version, you must use a different LPR client and will not be able to use advanced printing options.

Printing from ERP applications

For information about the use of SAP R/3 with InfoPrint Manager, see the RICOH InfoPrint Manager: SAP
R/3 Planning and Configuring Guide publication, which you can find at https://help.ricohsoftware.com/
swinfocenter.

You can send PostScript or PCL output from your ERP software to InfoPrint Manager to be printed. If
your ERP software is installed on a Windows system, you should submit the jobs through a Windows
gateway printer. If your ERP software is installed on an AIX system and you do not have InfoPrint
Manager for AIX installed, you should use the lprafp Line Printer Client (LPR) and the InfoPrint Manager
Line Printer Daemon (LPD).

Submitting ERP print jobs from a Windows system

Defining the Windows gateway printer

Your ERP print jobs will be submitted to a Windows gateway printer that is associated with the
appropriate PostScript or PCL driver for your printer. To define your Windows gateway printer:

1. Create or select an InfoPrint actual destination that will accept the data stream that you will be
sending to the printer (PostScript, PCL, or AFP).
This actual destination can be almost any type of InfoPrint printer (Passthrough, BSD, IPP, PSF) that
you can create using the InfoPrint Manager Administration GUI. If you do not want to use the
default queue and logical destination, create them and associate the actual destination with them.

2. Install the appropriate PostScript or PCL printer driver on the system that your InfoPrint Manager
server is located on.

• If you will be sending PostScript data to an AFP printer, you can use the IBM Network Printer 17
driver, which you can download from the Ricoh Web site.

• Otherwise, you can install and use the driver that came with your printer.

To install the driver on your system:

1) Insert the DVD or disk containing the driver into the correct drive.

2) Start the Windows Add Printer wizard and create a local printer. When you have to select a
port, select FILE:.

3) When the wizard gives you a list of manufacturers and printers, select either the IBM Network
Printer 17 or the driver that came with your printer.
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4) Finish the wizard without printing a test page or making this printer the default.

Once you finish the wizard, you can delete this printer; the driver will still be installed.

3. Open the Management Console and create a Windows gateway printer.
In the Target destination field, select the destination that you created or chose in step 1. In the
Windows driver name field, select the driver that you installed in step 2. Remember the Share
name that you choose; you will need it later. See Management Console online help for additional
information.

Adding the Windows gateway printer to the system you want to print from

Once the Windows gateway printer is created, you can add it to the desktop of the system that you
want to print from. Then you will be able to submit your print jobs directly to it. Follow this procedure to
add the Windows gateway printer to the desktop.

1. Use the Add Printer wizard to add the Windows gateway printer to your desktop as a network
printer. When you are prompted for the name of the printer to connect to, find or enter the Share
name of the Windows gateway printer you created. Finish the wizard.

2. Once the connection to the Windows gateway printer is created, you can print to it just as you
would to any other printer.

Install and configure lprafp

The lprafp sample code package is available for free download at https://dl.ricohsoftware.com/
downloads/375bc3fe-3080-401f-91c4-2b8adb607f89.

The compiled version of lprafp for AIX will only run on AIX 4.3.3 and later. If you have an earlier
version, you must use a different LPR client and will not be able to use advanced printing options.

Verify that the InfoPrint Manager LPD is running

To verify that the InfoPrint Manager LPD is running, follow these instructions:

1. On the system that your InfoPrint Manager server runs on, open the InfoPrint Manager
Management Console.

2. Click Edit→ Service Configuration.

3. In the Service Configuration dialog, find Run InfoPrint Manager LPD service check box.

• If the box is checked, the InfoPrint Manager LPD is already running. Click Cancel to dismiss the
dialog.

• If the box is not checked, click Cancel and continue with step 4.

4. In the InfoPrint Manager Management Console, click File→ Stop Server.

5. After the InfoPrint Manager server has stopped, click Edit→ Service Configuration again.

6. Click Run InfoPrint Manager LPD service to select it.

7. Click OK.
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8. Click File→ Start Server to restart the InfoPrint Manager server.
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44.. Operator and User Procedures

•Setting up finishing options for specific printers
•Setting up high speed printers for spacing
•General Operator and User Procedures

SSeettttiinngg uupp ffiinniisshhiinngg ooppttiioonnss ffoorr ssppeecciiffiicc pprriinntteerrss

Setting up finishing options for IPDS-only printers

Depending on the printer model, you can set up several finishing options. InfoPrint Manager can be set
up to support many of these possibilities, including edge stitching (stapling one edge of the print job to
create a booklet), saddle stitch (stapling in the middle of the page to create a folded booklet), and
corner stapling. These sections describe how to set up finishing options for IPDS printers, including the
InfoPrint 45 and the InfoPrint 60.

Telling InfoPrint Manager what options the finisher supports

The first step in enabling the finishing options is to let InfoPrint Manager know what options the finisher
supports. To set the appropriate values:

If you will only be submitting print jobs that specify a form definition to this printer, you do not have to
complete this procedure. You can proceed to Setting up InfoPrint Manager and clients to use finishing
options, p. 349.

1. Start the InfoPrint Manager Administration GUI.

2. Find or create the PSF printer (actual destination) that sends jobs to the printer you are setting up.

3. Right-click the printer and select Properties from the pop-up menu.

4. In the Printer Properties notebook, click Job.

5. Find the Finishing options allowed field.

If you do not see the Finishing options allowed field, click Show More.

6. Select all of the finishing options that your finisher supports in the Possible values list and add them
to the Values list.

7. Click OK.

Setting up InfoPrint Manager and clients to use finishing options

How you set up to use finishing options varies depending upon what kind of print jobs you create and
how you submit them. There are several categories; find the one that most resembles your situation.

• You cannot set up InfoPrint Manager and clients to use finishing options with the AGSPDL
processing engine.
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Using the pdpr command

When you submit print jobs from the command line with the pdpr command, you can use the job-
finishing attribute on the –x flag to specify finishing options. For example:

pdpr -d printername -x"job-finishing=staple-top-left" printfilename

You can also use the form-definition attribute on the –x flag to specify finishing options. For example:

pdpr -d printername -x"form-definition=F1name" printfilename

For a list of allowed values, proper syntax, and usage guidelines for the job-finishing and form-
definition attributes, see RICOH InfoPrint Manager: Reference.

Using a form definition

If you submit your print jobs using a form definition (either by specifying a certain one or by using a
default form definition), you can identify the finishing options that you want to apply in the form
definition. When you specify printing and finishing options this way, no InfoPrint finishing attributes are
necessary to request the finishing options. The print job is sent to the printer and the options are read out
of the formdef. If the finisher supports the options chosen, the job should print correctly without any more
configuration on your part.

InfoPrint Manager does not check the finishing options you specify in the formdef against the options
you set in Telling InfoPrint Manager what options the finisher supports, p. 349. As a result, if the finisher
does not support the options, the job will fail.

Using InfoPrint Submit Express

When you submit a job using InfoPrint Submit Express, you can select a variety of options, including
finishing. Build your job ticket as you usually would, and specify the finishing options that you want to
use in the Finishing field on the appropriate tab.

Using InfoPrint Select

The enhanced InfoPrint Select client lets you specify job-finishing attribute values or a form definition
when submitting a job to the server. For more information about using the job-finishing attribute, see
RICOH InfoPrint Manager: Reference. For instructions on setting attribute values in Select, see the help
system.

Using the InfoPrint AFP driver

If you are interested in using the powerful features of AFP in a wide range of environments, you might
want to install and use the InfoPrint AFP driver with InfoPrint Select. To install and set up the InfoPrint AFP
driver, see "Setting up the AFP driver" in RICOH InfoPrint Manager for Windows: Getting Started. To specify
the AFP driver for your printer, follow the directions in "Creating InfoPrint Select printers" in RICOH
InfoPrint Manager for Windows: Getting Started, and specify one of these drivers depending on your printer
model:

1. For the InfoPrint 45 printer, specify the InfoPrint AFP 4345 driver.

2. For the InfoPrint 60 printer, specify the InfoPrint AFP 3160 driver.

Once installed, click Printing Preferences on Windows systems from the Print window, and then use
the AFP driver to specify inline form definitions with finishing options, or make use of other AFP features.
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PSF printer

To use InfoPrint Select to submit print jobs with finishing options to a PSF printer, you must create a
Select printer that uses the specific printer driver for your printer shown here. The driver is installed on
your system when you install InfoPrint Select. Use the procedure that is described in RICOH InfoPrint
Manager for Windows: Getting Started for creating a Select printer, modifying it as described here.

1. Follow the procedure through creating a port and selecting an InfoPrint destination.

2. When the Add Printer wizard asks you to choose a manufacturer and a printer model, do not
select anything, just click Have Disk.

3. In the Install from Disk dialog, click Browse and navigate to the directory that you installed
InfoPrint Select in. The default directory is c:\Infoprint.

Because this dialog assumes the the driver is actually on a floppy disk or DVD-ROM, you might
receive an error that the drive is not ready. In the error box, click Cancel. A Windows Open dialog
should then open. Use that dialog to navigate to the correct directory.

4. Select the Ibmprint.inf file and click Open.

5. Select the appropriate driver based on your printer model and click OK.

• For the InfoPrint 45 printer, specify the InfoPrint AFP 4345 driver.

• For the InfoPrint 60 printer, specify the InfoPrint AFP 3160 driver.

6. In the Install from Disk dialog, click Next.

7. Complete the wizard as usual.

When you submit jobs to this printer, you can choose the finishing option you want to use.

The InfoPrint 60 with Finisher driver only supports four finishing options: top corner, bottom corner,
2 edge stitch (two staples in one side of the paper), and 3 edge stitch (three staples on one side of the
paper). To use other finishing options, you have to use a different submission method.

Using a Windows gateway printer or the IPP gateway

You cannot select finishing options when you submit a print job using any of these methods, therefore it
is recommended that you choose a different submission method to specify finishing options.

If you cannot use a different submission method, the only way to submit print jobs through one of these
methods and request finishing options is to use default jobs. A default job is a list of attributes that is
applied to every job that a particular logical destination receives. You can use the InfoPrint Manager
Administration GUI to modify the default job for the logical destination that InfoPrint Select sends jobs to
so that it requests the appropriate finishing options.

If you use default jobs, you will need a different logical destination for each finishing option. Every job
that you send to a particular logical destination will be finished the same way. For example, if you set
the Finishing options attribute of the default job to staple-top-left, every job that is submitted to that
printer will have a staple in the top left corner, even if the job is only one page long. In addition, a
logical destination can only have one default job, and a default job can only have one finishing option
set.

Setting up finishing options for specific printers
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Using MVS Download

MVS Download is an optional feature of PSF for OS/390 that uses TCP/IP to automatically send data
sets from the JES spool, without formatting them, directly to InfoPrint Manager for AIX or InfoPrint
Manager for Windows. InfoPrint Manager receives the data sets into files, formats them, and sends
them to the printer. When you submit a print job with MVS Download, do one of these:

• Specify a mapping from a JCL keyword to a finishing attribute in the Windows destination control
file. The selected JCL parameter you specify in OS/390 maps to the InfoPrint Manager pdpr
finishing attribute.

• Use the existing form definition JCL keyword to form definition attribute mapping. The JCL FORMDEF
parameter you specify in OS/390 maps to the InfoPrint Manager pdpr form definition attribute.

• Specify a default form definition or finishing attribute so all jobs have the same finishing option.

Using InfoPrint Manager hot folders

An InfoPrint Manager hot folder is a directory that is associated with a logical destination. When you
copy or move a file to the hot folder, InfoPrint Manager automatically submits the file to that logical
destination. The default job and document finishing attributes that are set for the logical destination are
applied to jobs submitted through the hot folder. You can also specify other finishing attributes or use
different values for existing attributes. For instructions on using hot folders, see Submitting jobs through
InfoPrint Manager hot folders, p. 363.

Using InfoPrint Manager LPD and an LPR client

The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit print jobs from other
operating systems using a Line Printer (LPR) client. To submit print jobs with finishing to the InfoPrint
Manager LPD, you must use an LPR client, such as lprafp, that lets you use –o options to specify
advanced printing options (for example, form definitions and page definitions) when you submit jobs to
InfoPrint Manager. You can either specify finishing attributes on the submission command or use a
default job.

On a Windows server, the InfoPrint Manager LPD is the only LPD that properly processes the –o options
that lprafp submits. If you use a different LPD (such as TCP/IP Print Services, the LPD supplied with the
Windows operating system), the –o options that you send will be lost. You can download an lprafp
sample code package from the Ricoh website at https://dl.ricohsoftware.com/downloads/375bc3fe-
3080-401f-91c4-2b8adb607f89. The package includes executable forms of the lprafp client for the
Windows and AIX (Version 4.3.3 Build Level 9 and later) platforms. You can also compile this code to
use it on other platforms. Ricoh does not provide support for the package.

Selecting the correct finishing options

In InfoPrint Manager, the finishing options have very descriptive names so that it is easy to select the one
you want for your job. However, the names of those options are based on print jobs that use the
"portrait" orientation, and as a result are misleading for jobs that printed in the "landscape" orientation.
In addition, some of the options are valid if the paper is fed through the printer long edge first (LEF) and
not valid if the paper is fed short edge first (SEF), and vice versa. As a result, choosing the correct
finishing option can be confusing. These tables can help you determine which option to select for the
InfoPrint 45, InfoPrint 60, and InfoPrint 70, based on how you want your job to be finished.
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Paper fed LEF

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd LLEEFF oonn tthhee IInnffooPPrriinntt 4455

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

Not supported staple top left

One staple in the bottom left
corner

staple bottom left Not supported

More than one staple on the left
edge of the paper

edge stitch, OR edge stitch left Not supported

More than one staple on the top
edge of the paper

Not supported edge stitch OR edge stitch left

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd LLEEFF oonn tthhee IInnffooPPrriinntt 6600

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom right
corner

staple bottom right staple top right

More than one staple on the left
edge of the paper (uses the
default number of staples that is
set for the finisher)

edge stitch OR edge stitch left Not supported

Two staples on the left edge of
the paper

edge stitch 2 Not supported

Three staples on the left edge of
the paper

edge stitch 3 Not supported

More than one staple on the top
edge of the paper (uses the
default number of staples that is
set for the finisher)

Not supported edge stitch OR edge stitch left

Two staples on the top edge of
the paper

Not supported edge stitch 2
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Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

Three staples on the top edge of
the paper

Not supported edge stitch 3

More than one staple on the
right edge of the paper

edge stitch right Not supported

More than one staple on the
bottom edge of the paper

Not supported edge stitch right

Paper fed SEF

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd SSEEFF oonn tthhee IInnffooPPrriinntt 4455

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left Not supported

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom right
corner

Not supported staple top right

More than one staple on the
right edge of the paper

Not supported edge stitch OR edge stitch top

More than one staple on the top
edge of the paper

edge stitch OR edge stitch top Not supported

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd SSEEFF oonn tthhee IInnffooPPrriinntt 6600

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom right
corner

staple bottom right staple top right

More than one staple on the top
edge of the paper (uses the
default number of staples that is
set for the finisher)

edge stitch OR edge stitch top Not supported
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Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

Two staples on the top edge of
the paper

edge stitch 2 Not supported

Three staples on the top edge of
the paper

edge stitch 3 Not supported

More than one staple on the
right edge of the paper (uses
the default number of staples
that is set for the finisher)

Not supported edge stitch OR edge stitch top

Two staples on the right edge of
the paper

Not supported edge stitch 2

Three staples on the right edge
of the paper

Not supported edge stitch 3

More than one staple on the left
edge of the paper

Not supported edge stitch bottom

More than one staple on the
bottom edge of the paper

edge stitch bottom Not supported

Default number of staples in the
center of the sheet

saddle stitch saddle stitch

Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, InfoPrint 2090ES,
InfoPrint 2190, InfoPrint 2210, and InfoPrint 2235

SSttaappllee ppoossiittiioonnss ffoorr IInnffooPPrriinntt 22006600EESS,, IInnffooPPrriinntt 22007755EESS,, aanndd IInnffooPPrriinntt 22009900EESS mmaappppeedd
ttoo IInnffooPPrriinntt MMaannaaggeerr vvaalluueess

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported
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edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

The InfoPrint Manager value saddle-stitch means staple down the center. With the InfoPrint 2060ES,
InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch is only supported for sheets in the
landscape orientation, and if this is specified along with bin 3, the sheets are sent to the BookletMaker.

Staple positions for InfoPrint 2105ES

SSttaappllee ppoossiittiioonnss ffoorr IInnffooPPrriinntt 22110055EESS mmaappppeedd ttoo IInnffooPPrriinntt MMaannaaggeerr vvaalluueess

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

Setting up finishing options for PS/PCL printers

Depending on the printer model, you can set up several finishing options. InfoPrint Manager can be set
up to support many of these possibilities, including edge stitching (stapling one edge of the print job to
create a booklet), saddle stitch (stapling in the middle of the page to create a folded booklet), and
corner stapling. These sections describe how to set up finishing options for printers that can be sent
PostScript and PCL, including the InfoPrint 70, InfoPrint 2085, and InfoPrint 2105.
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Telling InfoPrint Manager what options the finisher supports

The first step in enabling the finishing options is to let InfoPrint Manager know what options the finisher
supports.

1. For the InfoPrint 70, InfoPrint 2060ES, InfoPrint 2075ES, InfoPrint 2085, InfoPrint 2090ES, InfoPrint
2105, and InfoPrint 2105ES, the PSF DSS will set default values for the job-finishings-supported
attribute, so you do not need to do this setup process for the actual destination. These are the
default settings:

InfoPrint 70
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch

InfoPrint 2085, InfoPrint 2105
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch, edge-stitch-left

InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left, saddle-stitch

InfoPrint 2105ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left

2. If you will be submitting only print jobs that specify a form definition to this printer or if, you do not
have to complete this procedure. You can proceed to Setting up InfoPrint Manager and clients to
use finishing options, p. 349.

To set the appropriate values:

1. Start the InfoPrint Manager Administration GUI.

2. Find or create the PSF printer (actual destination) that sends jobs to the printer you are setting up.

3. Right-click the printer and select Properties from the pop-up menu.

4. In the Printer Properties notebook, click Job.

5. Find the Finishing options allowed field.

If you don't see the Finishing options allowed field, click Show More.

6. Select all of the finishing options that your finisher supports in the Possible values list and add them
to the Values list.

7. Click OK.

Setting up InfoPrint Manager and clients to use finishing options

How you set up to use finishing options varies depending upon what kind of print jobs you create and
how you submit them. There are several categories; find the one that most resembles your situation.

Setting up finishing options for specific printers
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Using the pdpr command

When you submit print jobs from the command line with the pdpr command, you can use the job-
finishing attribute on the –x flag to specify finishing options. For example:

pdpr -d printername -x"job-finishing=staple-top-left" printfilename

You can also use the form-definition attribute on the –x flag to specify finishing options. For example:

pdpr -d printername -x"form-definition=F1name" printfilename

For a list of allowed values, proper syntax, and usage guidelines for the job-finishing and form-
definition attributes, see RICOH InfoPrint Manager: Reference.

Using a form definition

If you submit your print jobs using a form definition (either by specifying a certain one or by using a
default form definition), you can identify the finishing options that you want to apply in the form
definition. When you specify printing and finishing options this way, no InfoPrint finishing attributes are
necessary to request the finishing options. The print job is sent to the printer and the options are read out
of the formdef. If the finisher supports the options chosen, the job should print correctly without any more
configuration on your part.

InfoPrint Manager does not check the finishing options you specify in the formdef against the options
you set in Telling InfoPrint Manager what options the finisher supports, p. 349. As a result, if the finisher
doesn't support the options, the job will fail.

Using InfoPrint Submit Express

When you submit a job using InfoPrint Submit Express, you can select a variety of options, including
finishing. Build your job ticket as you usually would, and specify the finishing options that you want to
use in the Finishing field on the appropriate tab.

Using InfoPrint Select

The InfoPrint Select client lets you specify job-finishing attribute values or a form definition when
submitting a job to the server. For more information about using the job-finishing attribute, see RICOH
InfoPrint Manager: Reference. For instructions on setting attribute values in Select, see the help system
provided with InfoPrint Select.

The automatic data stream transforms that PSF printers use do not support finishing (stapling), so in
general, to use InfoPrint Select to submit PCL or PostScript jobs to a PSF printer (destination), you cannot
specify finishing options when you submit a job, even if the print driver you use supports those options.
However, there are other submission methods that will let you submit jobs with finishing options using
Select.

Using the InfoPrint AFP driver

If you are interested in using the powerful features of AFP in a wide range of environments, you might
want to install and use the InfoPrint AFP driver with InfoPrint Select. To install and set up the InfoPrint AFP
driver, see "Setting up the AFP driver" in RICOH InfoPrint Manager for Windows: Getting Started. To specify
the AFP driver for your printer, follow the directions in "Creating InfoPrint Select printers" in RICOH
InfoPrint Manager for Windows: Getting Started and specify one of these printer drivers depending on your
printer model:

4 Operator and User Procedures



4

351

1. For the InfoPrint 70 printer, specify the InfoPrint AFP 2770 driver.

2. For the InfoPrint 2085 printer, specify the InfoPrint AFP 2785 driver.

3. For the InfoPrint 2105 printer, specify the InfoPrint AFP 2705 driver.

Once installed, you can click either Printing Preferences on Windows systems and then use the AFP
driver to specify inline form definitions with finishing options, or make use of other AFP features.

Using a PSF other-driver or DFE printer

You can use the document-formats-ripped-at-destination actual destination attribute to prevent the
automatic data stream transform from occurring. See RICOH InfoPrint Manager: Reference for details.

Using a Passthrough printer

A Passthrough printer allows InfoPrint Manager for Windows to bridge to the Windows print-spooling
subsystem, and it does not transform the data stream. This type of destination uses fewer processing
resources but provides less functions.

Any other destination type

To use InfoPrint Select to submit print jobs to a different destination type (such as a BSD or IPP printer),
the only way to request finishing options on PCL and PostScript jobs is to use default jobs. A default job is
a list of attributes that is applied to every job that a particular logical destination receives. You can use
the InfoPrint Manager Administration GUI to modify the default job for the logical destination that
InfoPrint Select sends jobs to so that it requests the appropriate finishing options.

If you use default jobs, you will need a different logical destination for each finishing option. Every job
that you send to a particular logical destination will be finished the same way. For example, if you set
the Finishing options attribute of the default job to staple-top-left, every job that is submitted to that
printer will have a staple in the top left corner. In addition, a logical destination can only have one
default job, and a default job can only have one finishing option set.

Using a Windows gateway printer or the IPP gateway

You cannot select finishing options when you submit a print job using any of these methods, therefore it
is recommended that you choose a different submission method to specify finishing options.

If you cannot use a different submission method, the only way to submit print jobs through one of these
methods and request finishing options is to use default jobs. A default job is a list of attributes that is
applied to every job that a particular logical destination receives. You can use the InfoPrint Manager
Administration GUI to modify the default job for the logical destination so that it requests the
appropriate finishing options.

If you use default jobs, you will need a different logical destination for each finishing option. Every job
that you send to a particular logical destination will be finished the same way. For example, if you set
the Finishing options attribute of the default job to staple-top-left, every job that is submitted to that
printer will have a staple in the top left corner. In addition, a logical destination can only have one
default job, and a default job can only have one finishing option set.

Using MVS Download

MVS Download is an optional feature of PSF for OS/390 that uses TCP/IP to automatically send data
sets from the JES spool, without formatting them, directly to InfoPrint Manager for AIX or InfoPrint
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Manager for Windows. InfoPrint Manager receives the data sets into files, formats them, and sends
them to the printer. When you submit a print job with MVS Download, do one of these:

• Specify a mapping from a JCL keyword to a finishing attribute in the Windows destination control
file. The selected JCL parameter you specify in OS/390 maps to the InfoPrint Manager pdpr
finishing attribute.

• Use the existing form definition JCL keyword to form definition attribute mapping. The JCL FORMDEF
parameter you specify in OS/390 maps to the InfoPrint Manager pdpr form definition attribute.

• Specify a default form definition or finishing attribute so all jobs have the same finishing option.

Using InfoPrint Manager hot folders

An InfoPrint Manager hot folder is a directory that is associated with a logical destination. When you
copy or move a file to the hot folder, InfoPrint Manager automatically submits the file to that logical
destination. The default job and document finishing attributes that are set for the logical destination are
applied to jobs submitted through the hot folder. You can also specify other finishing attributes or use
different values for existing attributes. For instructions on using hot folders see Submitting jobs through
InfoPrint Manager hot folders, p. 363.

Using InfoPrint Manager LPD and an LPR client

The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit print jobs from other
operating systems using a Line Printer (LPR) client. To submit print jobs with finishing to the InfoPrint
Manager LPD, you must use an LPR client, such as lprafp, that lets you use –o options to specify
advanced printing options (for example, form definitions and page definitions) when you submit jobs to
InfoPrint Manager. You can either specify finishing attributes on the submission command or use a
default job.

On a Windows server, the InfoPrint Manager LPD is the only LPD that properly processes the –o options
that lprafp submits. If you use a different LPD (such as TCP/IP Print Services, the LPD supplied with the
Windows operating system), the –o options that you send will be lost. You can download an lprafp
sample code package from the Ricoh website at https://dl.ricohsoftware.com/downloads/375bc3fe-
3080-401f-91c4-2b8adb607f89. The package includes executable forms of the lprafp client for the
Windows and AIX (Version 4.3.3 Build Level 9 and later) platforms. You can also compile this code to
use it on other platforms. Ricoh does not provide support for the package.

Selecting the correct finishing options

In InfoPrint Manager, the finishing options have very descriptive names so that it is easy to choose the
one you want for your job. However, the names of those options are based on print jobs that use the
"portrait" orientation, and as a result are misleading for jobs that printed in the "landscape" orientation.
In addition, some of the options are valid if the paper is fed through the printer long edge first (LEF) and
not valid if the paper is fed short edge first (SEF), and vice versa. As a result, choosing the correct
finishing option can be confusing. These tables can help you determine which option to choose based
on how you want your job to be finished.
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Paper fed LEF

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd LLEEFF ffoorr tthhee IInnffooPPrriinntt 7700

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

Not supported staple top left

One staple in the bottom left
corner

staple bottom left Not supported

More than one staple on the left
edge of the paper

edge stitch, OR edge stitch left Not supported

More than one staple on the top
edge of the paper

Not supported edge stitch OR edge stitch left

Paper fed SEF

OOppttiioonnss ttoo sseett ffoorr ppaappeerr ffeedd SSEEFF ffoorr tthhee IInnffooPPrriinntt 7700

Desired output Select this value for "portrait"
jobs

Select this value for
"landscape" jobs

One staple in the upper left
corner

staple top left Not supported

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom right
corner

Not supported staple top right

More than one staple on the
right edge of the paper

Not supported edge stitch OR edge stitch top

More than one staple on the top
edge of the paper

edge stitch OR edge stitch top Not supported

Staple positions for InfoPrint 2085 and InfoPrint 2105

SSttaappllee ppoossiittiioonnss ffoorr IInnffooPPrriinntt 22008855 aanndd IInnffooPPrriinntt 22110055 mmaappppeedd ttoo IInnffooPPrriinntt MMaannaaggeerr
vvaalluueess

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported
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staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported

Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES

SSttaappllee ppoossiittiioonnss ffoorr IInnffooPPrriinntt 22006600EESS,, IInnffooPPrriinntt 22007755EESS,, aanndd 22009900EESS mmaappppeedd ttoo
MMaannaaggeerr vvaalluueess

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

The InfoPrint Manager value saddle-stitch means staple down the center. With the InfoPrint 2060ES,
InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch is only supported for sheets in the
landscape orientation, and if this is specified along with bin 3, the sheets are sent to the BookletMaker.
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Staple positions for InfoPrint 2105ES

SSttaappllee ppoossiittiioonnss ffoorr IInnffooPPrriinntt 22110055EESS mmaappppeedd ttoo IInnffooPPrriinntt MMaannaaggeerr vvaalluueess

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported

Working with the InfoPrint Pro C900AFP finishing options

Working with punch options

FFaaccee ddoowwnn ppuunncchh ppoossiittiioonnss ffoorr tthhee IInnffooPPrriinntt PPrroo CC990000 AAFFPP pprriinntteerr mmaappppeedd ttoo IInnffooPPrriinntt
MMaannaaggeerr vvaalluueess,, ppaappeerr oorriieennttaattiioonn,, aanndd jjoobb rroottaattiioonn

InfoPrint
Manager value

Paper
Orientation

Job Rotation
(180° )

Punch Position
Portrait Landscape

punch-2 LEF NO left edge top edge

SEF NO top edge right edge

punch-3 LEF NO left edge top edge

SEF NO top edge right edge

punch-4 LEF NO left edge top edge

SEF NO top edge right edge
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punch-2-top SEF NO top edge right edge

punch-2-left LEF NO left edge top edge

punch-2-right LEF YES right edge bottom edge

punch-2-bottom SEF YES bottom edge left edge

punch-3-top SEF NO top edge right edge

punch-3-left LEF NO left edge top edge

punch-3-right LEF YES right edge bottom edge

punch-3-bottom SEF YES bottom edge left edge

punch-4-top SEF NO top edge right edge

punch-4-left LEF NO left edge top edge

punch-4-right LEF YES right edge bottom edge

punch-4-bottom SEF YES bottom edge left edge

FFaaccee uupp ppuunncchh ppoossiittiioonnss ffoorr tthhee IInnffooPPrriinntt PPrroo CC990000 AAFFPP pprriinntteerr mmaappppeedd ttoo IInnffooPPrriinntt
MMaannaaggeerr vvaalluueess,, ppaappeerr oorriieennttaattiioonn,, aanndd jjoobb rroottaattiioonn

InfoPrint
Manager value

Paper
Orientation

Job Rotation
(180° )

Punch Position
Portrait Landscape

punch-2 LEF NO left edge bottom edge

SEF NO top edge left edge

punch-3 LEF NO left edge bottom edge

SEF NO top edge left edge

punch-4 LEF NO left edge bottom edge

SEF NO top edge left edge

punch-2-top SEF YES top edge right edge

punch-2-left LEF YES left edge top edge

punch-2-right LEF NO right edge bottom edge

punch-2-bottom SEF NO bottom edge left edge

punch-3-top SEF YES top edge right edge

punch-3-left LEF YES left edge top edge

punch-3-right LEF NO right edge bottom edge

punch-3-bottom SEF NO bottom edge left edge

punch-4-top SEF YES top edge right edge
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punch-4-left LEF YES left edge top edge

punch-4-right LEF NO right edge bottom edge

punch-4-bottom SEF NO bottom edge left edge

Loading paper trays

PPaappeerr llooaaddiinngg ppoossiittiioonnss

Tray Face Up/Down

Tray 1 Up

Tray 2 Up

Tray 3 Down

Tray 4 Down

Tray 5 Down

Tray 6 Down

Tray 7 Down

Using output bins

For IPDS jobs, the user has to specify the job-finishing attribute. The user does not have to specify an
output bin to have the finishing operation done.

For PostScript jobs, if the output bin is selected, a finishing option for the output bin must be specified. If
the user does not specify a finishing option for the selected output bin then the printer will reject the job.
If the output bin is set to Shift Tray then there is no need to specify a finishing option.

Working with the binding options

Binding:

InfoPrint Pro C900 AFP printer supports Perfect Binding and Ring Binding. Punch is available only for
Ring Binding. Binding positions are: left, right, and top.

This example shows a perfect bind on the left edge with a cover:
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ip
rz
20

10
00

1

This example shows a ring bind on the left edge:

ip
rz
20

10
00

2

Any covers should be preloaded, controlled by the device, and not requested through AFP.

SSeettttiinngg uupp hhiigghh ssppeeeedd pprriinntteerrss ffoorr ssppaacciinngg
In InfoPrint Manager, moving from page to page in a job is called spacing:

• Forward spacing is moving to a point later in the job (such as skipping from page 10 to page 15).

• Backspacing is moving to a point earlier in the job (such as backing up from page 40 to page 20).

For spacing to work effectively on the InfoPrint 3000, InfoPrint 4000, and InfoPrint 4100, you must first
enable the printer to work with the Simple Network Management Protocol (SNMP) and allow SNMP to
configure the printer. These settings allow you to use the InfoPrint Manager GUI to stop a printer very
quickly (in ten seconds or less) when you need to, instead of having to wait for all of the pages of a job
that have been buffered to print.

Enabling SNMP on an InfoPrint 3000 or an InfoPrint 4000 printer that uses the
operator console

The Operator console is the standard console for the InfoPrint 3000 and the InfoPrint 4000.

1. On the display/touch screen on the Operator console, open the Configure pull-down menu.

2. Select Remote Access.

3. Under Select a Remote Access, select SNMP.
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4. Under Enabled, select Yes.

5. Under Allow to Configure, select Yes.

6. Touch OK to close the window.

7. You will be prompted to restart the printer so that these settings can take effect. Restart the printer,
and wait for it to power back up before you continue.

8. Disable the printer and enable it again to refresh the printer configuration information in the
server.

1. Start the InfoPrint Manager Administration GUI.

2. In the GUI, find the InfoPrint Manager printer (actual destination) that corresponds to this
printer and select it.

3. Use the GUI to disable the printer.

4. Use the GUI to enable the printer again.

Enabling SNMP on a printer that uses the Enhanced Operator Console

The Enhanced Operator Console is the standard console for the InfoPrint 4100 and is available as an
upgrade for the InfoPrint 4000.

1. On the Enhanced Operator Console, touch Printer definition at the top of the screen.

2. On the left side of the screen, touch Remote Access.

3. In the Communities list, select the name of the community you will be using to access the printer
and verify the settings. Make sure that the community hasWrite access to the printer.

4. Select the SNMP Agent Enabled and Allow SNMP to Configure Printer checkboxes, so they
both say Yes.

5. Touch OK to save the settings.

6. You might be prompted to restart the printer so that these settings can take effect. Restart the
printer, and wait for it to power back up before you continue.

7. Disable the printer and enable it again to refresh the printer configuration information in the
server.

1. Start the InfoPrint Manager Administration GUI.

2. In the GUI, find the InfoPrint Manager printer (actual destination) that corresponds to this
printer and select it.

3. Use the GUI to disable the printer.

4. Use the GUI to enable the printer again.

GGeenneerraall OOppeerraattoorr aanndd UUsseerr PPrroocceedduurreess
This chapter describes these procedures:

• Turning duplexing on and off for the InfoPrint 45 and InfoPrint 70, p. 360

• Resubmitting or deleting MVS Download Receiver orphaned files, p. 197
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• Using a Windows gateway printer, p. 361

• Adding an Internet Printing Protocol (IPP) gateway printer to your desktop, p. 362

• Submitting jobs through InfoPrint Manager hot folders, p. 363

• Submitting print jobs through the InfoPrint Manager LPD, p. 365

• Checking job status, p. 366

• Interrupting and restarting a job that is currently printing on an InfoPrint 4000/4100, p. 367

• Stopping, restarting, or pausing a job that is currently printing, p. 368

• Pausing a job that's printing, p. 371

• Moving backward or forward in a job that is currently printing, p. 373

• Stopping a printer to perform scheduled maintenance, p. 375

• Fixing a printer problem and starting to print again, p. 376

• Using the correct halftones for the installed toner version, p. 381

Turning duplexing on and off for the InfoPrint 45 and InfoPrint 70

If your printer has the capability to duplex and has an option on the console to turn it on and off, you
should understand the hierarchy of duplex processing options based on your selections.

The InfoPrint 45 and InfoPrint 70 can produce either simplex (single-sided) or duplex (double-sided)
output. You can turn the duplex option ON or OFF at the printer console, depending upon what type of
output you need. However, you can also turn duplexing on and off using the sides attribute in InfoPrint
Manager. If you use InfoPrint Manager to turn duplexing on or off, the InfoPrint Manager setting will
override the setting on the printer.

You can set the sides attribute on a document, default document, or an actual destination. You can also
specify duplex or simplex in a form definition (formdef). If you set the attribute in a document, that
setting overrides the value in the formdef. The formdef overrides the setting on the default document,
which overrides the setting on the actual destination. All of these settings override the setting on the
printer console.

The default value of the sides attribute on all three objects (document, default document, and actual
destination) is Use default. When InfoPrint Manager encounters that value, it considers the attribute
"not set" and looks to the next item in the priority list to see if sides is set there. InfoPrint Manager keeps
going down the list until it finds a value to use.

Some examples of this behavior include:

• You turn duplexing OFF at the console of your InfoPrint 45. Then, you submit a job to your InfoPrint
45 through InfoPrint Manager. The job uses a formdef that requests duplex printing. The sides
attributes on the document, default document, and actual destination are set to Use printer default.
InfoPrint Manager looks at the sides attribute on the document, and considers it "not set," so it looks
at the formdef. The job prints duplex.

4 Operator and User Procedures



4

361

• You turn duplexing OFF at the console of your InfoPrint 70. Then, you use InfoPrint Submit Express
to send a job with Sides set to duplex, and do not use a formdef. The sides attributes on the default
document is set to Use printer default and on the actual destination is set to 1.
InfoPrint Manager looks at the sides attribute on the document, and sees that InfoPrint Submit
Express sets it to 2. InfoPrint Manager ignores all of the other values and the job prints duplex.

For additional information about the sides attribute, see the "Attributes for documents and default
documents" section in the "InfoPrint object attributes" chapter of the RICOH InfoPrint Manager: Reference.

Using a Windows gateway printer

A Windows gateway printer is a Windows shared printer that you create on your InfoPrint Manager
server system. This lets users anywhere in the network to submit print jobs through InfoPrint Manager.
InfoPrint Manager organizes everyone's print jobs by putting them in a print queue in the order that it
receives them, then sends them all to the correct printers. In addition, if you have InfoPrint Manager
notifications running on your workstation, InfoPrint manager sends you messages about the status of
your print job.

Users must follow the instructions in Adding a Windows gateway printer to a workstation, p. 361 to add
the Windows gateway printer to their desktops. Administrator's can use the Management Console to
create and administer a Windows gateway printer. The Management Console help includes
instructions.

When InfoPrint Manager is uninstalled, all Windows Gateway printers are deleted. Therefore, you must
have your users manually delete the Windows Gateway printer from their desktops after the uninstall.

Adding a Windows gateway printer to a workstation

To add a Windows gateway printer to a workstation, follow the steps below. This procedure assumes
that you have already created the Windows gateway printer on the InfoPrint Manager server system.

1. Locate the share name of the Windows gateway printer.

2. Follow the standard procedure for adding a network printer to your desktop. This procedure
depends on the operating system that you use. For example, on Windows systems, use the Add
Printer Wizard to create a printer that will be managed by network print server. When you are
prompted for the name of the printer to connect to, enter the share name of the Windows gateway
printer.

3. Once the connection to the Windows gateway printer is created, you can print to it just as you
would print to any other printer.
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1. When the InfoPrint Manager server is uninstalled, any Windows gateway printer that exists on the
server is deleted. However, connections to those Windows gateway printers that have been added
to workstations are still present; they are still displayed in the Printers window, and you can still try to
print to them from applications. Because the Windows gateway printer on the InfoPrint Manager
server no longer exists, those print jobs will fail. If you try to print to one of these Windows gateway
printer, you will get an application-dependent message that does not identify this problem. To
resolve this problem, delete the Windows gateway printer from your desktop and create a new one
once your print system administrator has created a new one.

2. In certain situations, the system might try to use drivers that you have not intended to be used.
To avoid this situation, load print drivers for each client OS on the InfoPrint Manager server system
so that they can be automatically installed onto client machines over the network (if they are not
already on the client system).

Adding an Internet Printing Protocol (IPP) gateway printer to your desktop

The Internet Printing Protocol (IPP) is a data transport protocol that lets you print your documents to any
IPP-enabled printer whose IP address you know. You can use IPP to send print data over both LANs and
the Internet, so you can send print jobs to a network printer from your desk, your home office, or
anywhere that you find an Internet connection. Not all printers are currently enabled to work with IPP.
However, InfoPrint Manager provides an IPP gateway (a mechanism that lets you use IPP) even if your
printers are not IPP-enabled.

You must work with your InfoPrint Manager Administrator to have the IPP gateway enabled through the
Management Console.

An Internet Printing Protocol (IPP) gateway printer is a printer that you create on a client
workstation using IPP client software. Users submit print jobs to that printer, and they are sent to InfoPrint
Manager through the InfoPrint IPP gateway. The IPP gateway can then send the job on to any InfoPrint
printer, even those that are not IPP-enabled.

To be able to print through an IPP gateway, you must first have IPP client software installed on your
workstation or laptop. IPP client software is available from various printer vendors; check with your
printing system administrator to see which IPP client your company is using. Once you have the IPP client
software installed, to set up to print through the IPP gateway:

1. Ask your printing system administrator for the address of the printer that you want to print to.

2. Follow the instructions provided with your IPP client software for adding a printer to your desktop.
When you are asked for the address of the printer, enter the address that you got in step 1.

3. Once the printer is added, you can print to it just as you would any other printer.
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Submitting jobs through InfoPrint Manager hot folders

Mapping a network drive

On the end user system, use the standard Windows method to map a network drive (available in
Windows Explorer) to the InfoPrint Manager hot folder. If there are multiple hot folders in the same
directory, you only have to map one network drive to the parent directory; you will be able to access
all of the subdirectories through it.

Submitting jobs through a hot folder

To submit a job through a hot folder, simply copy or move the print file to the hot folder.

If you experience problems with hot folders submitting incomplete jobs to the InfoPrint Manager server,
use the method described in Staging jobs, p. 364.

To save the file, copy it. Files are deleted from the hot folder after submission.

Specifying job attributes

By default, jobs submitted through a hot folder use the attribute values in the default document and
default job associated with the logical destination; and also by default, hot folder jobs are submitted to
InfoPrint Manager with job notifications turned off. To receive notifications about jobs that you submit
through hot folders, you must specify a notification-profile with an explicit delivery-address in the .
att file. To specify other attributes or use different values for existing attributes, complete these steps.

1. Either on your system or in the hot folder itself, create a text file to use as your attributes file. Name
the attributes file filename.att or filename.att.utf8, where filename is the same as the file
name of the print file. For example, if the print file is report.pdf, the attributes file is report.pdf.
att or report.pdf.att.utf8.

2. In the attributes file, specify the InfoPrint Manager attributes and values that you want to use for this
job. For example, to print three single-sided copies of report.pdf, report.pdf.att looks like
this:

copy-count = 3
sides = 1

Use filename.att if the file is saved using ISO88591 or SHIFT-JIS code pages. Use filename.
att.utf8 if the file is encoded using the UTF-8 code page.

The attributes file is in the same format as a –X file passed to a pdpr command.

For information about job and document attributes, see RICOH InfoPrint Manager: Reference.
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3. If you created the attributes file on your system, copy or move the file to the hot folder. The InfoPrint
Manager logical destination recognizes the .att file extension as an attributes file and knows not
to try to print it.

4. Copy or move the print file to the hot folder. The InfoPrint Manager logical destination sees the print
file and looks for an attributes file with the same file name. Both of the files are taken and your
attributes are used.

Staging jobs

You can stage jobs to InfoPrint Manager with this procedure:

1. Make a copy of the print file on your local system.
You will end up with 2 files: report.pdf and copy of report.pdf.

2. Rename the copy of the print file so that it has the same name as the original print file and the
extension .stg.
Rename copy of report.pdf to report.pdf.stg.

3. Copy the new file to the hot folder.
Copy report.pdf.stg and paste it in the hot folder.

The InfoPrint Manager logical destination ignores files with the .stg extension.

4. Change the extension back to the original extension when you want the job to print.
Rename report.pdf.stg back to report.pdf. InfoPrint Manager will pick up the renamed file and
send it to print.

Submitting multiple-document jobs

You can use staging to print jobs that contain multiple documents. In this case, you stage an entire
directory. The InfoPrint Manager logical destination prints the documents as one job, in the order that
you copied the files into the directory.

1. Navigate to the hot folder (using Windows Explorer, for example).

2. In the hot folder directory, create a new folder named jobname.stg, where jobname is any
name you choose.

The InfoPrint Manager logical destination ignores directories with the .stg extension.

3. Copy the documents you want to print into the subdirectory in the same order that you want to print
them.

If you copy multiple files in a single operation, they might not be copied in the same order that you
selected them. If the print order matters, copy the files one at a time.

4. To override the default attributes, create an attributes file called jobname.att, where jobname is
the same as the subdirectory name, and copy it into the subdirectory.

5. Rename the subdirectory from jobname.stg to jobname. The InfoPrint Manager logical destination
then accepts all of the files in the subdirectory as a single job.
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Submitting print jobs through the InfoPrint Manager LPD

The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit print jobs from other
operating systems using a Line Printer (LPR) client. The InfoPrint Manager LPD replaces the LPD that is
supplied with the Windows operating system (TCP/IP Print Services), however, it submits the files it
receives directly to an InfoPrint destination, not to a Windows printer. It also supports the -o options that
are available with some LPR clients (-o options let you specify advanced InfoPrint print options such as
formdefs and pagedefs).

Only one LPD can run on your InfoPrint Manager server system at a time. If you have TCP/IP Print
Services installed, InfoPrint Manager disables it and enables the InfoPrint Manager LPD. If you would
prefer to use TCP/IP Print Services, use the Management Console to change the service configuration.
See the Management Console help for further instructions.

If you have a different LPD installed, InfoPrint Manager does not disable it, but installs and starts the
InfoPrint Manager LPD. You must stop one of the LPDs before you try to submit a print job using an LPR
client.

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client. However, to be able to
specify advanced InfoPrint options on the –o flag, you should use the lprafp sample code package.
lprafp is an LPR client that is available as a free download from the Ricoh Web site. The package
includes executable forms of the lprafp client for the Windows and AIX (version 5.1 and later)
platforms. You can compile this code to use it on other platforms as well. Ricoh does not provide support
for the package.

The Microsoft LPR client supports a –o flag, but it is not the same as the InfoPrint –o. Any values you
pass to InfoPrint Manager using the Microsoft –o flag will be lost. In addition, some LPR clients provide
print control functions, such as landscape print. The InfoPrint Manager LPD does not support these
options.

Install and configure lprafp for Windows from the Web

For Windows operating system clients, the lprafp sample code package is available for free download
from the Ricoh website at https://dl.ricohsoftware.com/. Use this procedure to locate and install the
package:

1. Go to https://dl.ricohsoftware.com/downloads/375bc3fe-3080-401f-91c4-2b8adb607f89.

2. Click lprafp Program Sample (zip format) and agree to the Terms and Conditions for the
download to start.

3. Save the zip archive to your computer.

4. Use a zip utility to unzip the package.

5. Open the readme.txt file and follow the instructions for installing the package on a Windows
system.
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Preparing to submit print jobs

When you submit jobs to the InfoPrint Manager LPD, it uses a mapping file to match the keywords you
specify on the -o option with InfoPrint attributes. A sample mapping file comes with InfoPrint Manager
for Windows; before you submit any print jobs to the InfoPrint Manager LPD, you should modify this file
to meet your needs.

To modify the mapping file do this:

1. Open the file <<iinnssttaallll ppaatthh>>\\vvaarr\\ppdd\\llppdd\\llppddmmaapp..ttxxtt (where <<iinnssttaallll ppaatthh>> is the
directory where InfoPrint Manager is installed) in a text editor such as Notepad.

2. Read all of the instructions in the mapping file before you make any changes.

3. Edit the mappings as necessary and save the file using the same name.

Because all LPR clients use different keywords, it is impossible to list them all. The mappings listed are
"best guess" mappings and might not generate the results you need. The best way to see what values
you need to add or change is to un-comment the line that reads: * DEBUG and save the file. (To un-
comment the line, delete the *.) Submit a print job through the LPD and check the output. If the job fails
or if it prints incorrectly, check the error messages in the server log in the Management Console. Use
them to help determine which keywords are missing or mapped incorrectly. When you are finished, be
sure to open the mapping file and comment the DEBUG line out again.

Submitting print jobs

When you submit print jobs using the LPR client, all you need to specify is the InfoPrint Manager server
and the name of an InfoPrint destination (logical or actual). The InfoPrint Manager LPD submits the job
to the InfoPrint print spool.

Checking job status

This section describes some ways you can find out the status of print jobs that you submit through
InfoPrint Manager.

Checking status using notifications

The easiest way to find out the status of print jobs that you submit is to have InfoPrint Manager send you
messages about them. You can use the InfoPrint Manager Notifications client, or if you submitted the job
using InfoPrint Select, you can use InfoPrint Select Notification. Installing and setting up the Notifications
client is described in the RICOH InfoPrint Manager for Windows: Planning Guide. In addition, see Using
InfoPrint Manager notifications, p. 68 and the “Working with InfoPrint Select Notifications” section in
RICOH InfoPrint Manager for Windows: Getting Started for more detailed instructions about using the
Notifications client and InfoPrint Select Notification.
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Checking status from the Printers window

If you cannot or choose not to use InfoPrint Manager notifications, you might be able to check the status
of your jobs manually. If you submit jobs to a Windows gateway printer or to a Select printer, follow
these steps:

1. Click the Windows Start button, and select Settings→ Printers to open the Printers window.

2. In the Printers window, double-click the printer that you sent your job to. The job window for that
printer will open.

3. Find your job in the list of documents. If the job isn't in the list, it might be finished printing.

For Windows gateway printers, print jobs will appear in this list only if the gateway was configured
to report accurate job status back to workstations.

Interrupting and restarting a job that is currently printing on an InfoPrint 4000/
4100

Use this procedure:

• To interrupt the job that is currently printing and start printing it again

• To interrupt the job that is currently printing, print another job, and then start the job that you
interrupted.

• To interrupt the job that is currently printing, move the job to a different printer, and start printing the
job again.

This procedure does NOT stop the printer; it only stops the job that is currently printing. Other
jobs continue to print on this printer.

Once the job is stopped, the next job in the queue will start to print. To stop the printer (for example, to
replace toner), use the procedure Stopping a printer to perform scheduled maintenance, p. 375.

• Refer to the online help in the InfoPrint Manager GUI if you need instructions on completing any of
these steps.

When you use the Interrupting a job that is currently printing, p. 367 procedure, the job fills a physical
sheet, stops, and prints a message after the last page indicating the number of the last (AFP) page
printed. The job shows on the GUI as Paused. When the job restarts, it starts on the next page of the
job in the next logical partition. InfoPrint Manager prints a message at the end of the restarted section of
the job indicating the page on which the printing started. You might want to use this procedure if you
are printing a very long job, and you need to print another, more urgent job immediately.

Interrupting a job that is currently printing

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.

General Operator and User Procedures



4

368

2. In the GUI, find the printer where the currently printing job is, and select it.

3. Right-click on the printer, and select Interrupt Printing Job or left-click on the printer and then

left-click on the icon on the toolbar.

If the Interrupt Printing Job action does not appear on the Printer menu or toolbar, use the
Customize dialog to add the action.

4. Select from these options:

• Click Now to interrupt the job as soon as possible

• Click After current copy to interrupt the job after the current copy has finished printing.

5. Click OK.

The job that is currently printing stops printing, its icon changes to black, and the job is listed in
the job window of the main InfoPrint Manager GUI window. Other jobs continue to print on this
printer.

Restarting the interrupted job

To restart the interrupted print job:

• In the GUI, right-click on the interrupted job and select Resume.

• Select the job and left-click on the

icon on the toolbar.

Stopping, restarting, or pausing a job that is currently printing

Use this procedure to stop printing a job and start printing it again or to stop printing a job, move it to a
different printer, and start printing again. If you are printing an AFP print job, you can also use this
procedure to stop printing a job and start it again from any page in the job, not just from the beginning.

This procedure does NOT stop the printer; it only stops the job you select.

Once the job is stopped, the next job in the queue will start to print. To stop the printer (for example, to
replace toner), use the procedure Stopping a printer to perform scheduled maintenance, p. 375.

If you need instructions on completing any of these steps, see the online help in the InfoPrint Manager
GUI.

When you use the Stopping the job, p. 369 procedure, InfoPrint Manager considers the job cancelled
and does not collect any checkpoint information about the job. Unless the operator changes the page
range before releasing the job to print again, the job restarts printing at page 1. Be sure to remember
any n-upping associated with the job when selecting the page range so that the pages are placed into
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the correct partition in relation to each other. You might want to use this procedure when you realize
that a job has started to print on the wrong form.

Stopping the job

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.

2. In the GUI, find the job that you want to stop and select it.

3. Click Job→ Hold.

If the Hold item does not appear in the Job menu, use Add/Remove Menu Items to add it.

4. Click OK.

The job stops printing, the icon changes to black, and the job is listed in the job window of the
main InfoPrint Manager GUI window.

Restarting the job

Use this procedure to do one of these:

• Print the entire job on the same printer it was printing on before.

• Print the entire job on a different printer.

• Print part of the job (such as page one to page fifty, or page twelve to the end).

– When you use Job→ Hold, the job information resets to the beginning of the job. Checkpoint
information is not stored.

– You can only start printing in the middle of the job if the job is transformed to AFP before it gets
printed. You cannot print part of an ASCII, KGL, metacode, or LCDS job; you have to print the
whole job.

– You can only start printing in the middle of the job if the job has only one printable document. If
it has more than one printable document, you either have to print the whole job or use spacing
to skip a section of the job. See the Moving backward or forward in a job that is currently
printing, p. 373 for instructions on spacing.
If you submitted this job using DPF from a host system, you can start printing from any page in
the job, but InfoPrint Manager ignores any value you enter for the end page. You will always
print to the end of the job.

Spacing will only work if you send the job to a PSF DSS printer.

To restart the print job:

1. To print the entire job on the same printer it was printing on before, select the job in the job window
and click Job→ Release. The job will start printing from the first page.
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2. To print the entire job on a different printer, skip to Before you Continue between steps 8 and 9
below.

3. To print part of the job, figure out what page you want to start printing from.

If you do not want to start printing from the first page of the job, be careful when you choose which
page to start with. Duplex and n-up jobs can be confusing because you have to start printing with
the first page on the front side of the sheet of paper. If you do not choose the correct start page,
the job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper actually has four pages
printed on it, like this:

22––uupp dduupplleexx pprriinntt jjoobb:: ffrroonntt aanndd bbaacckk vviieewwss

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you can choose page one
or page five (or any other page that would fall in that position). If you choose a different page, the
sequence of pages will be wrong, and the job won't print correctly.

4. Figure out what page you want to stop printing on (if you do not want to print all the way to the end
of the job).
You do not have to be as precise on the last page to print; the last page can be in any location on
the sheet of paper.

5. Select the job you want to print.
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6. With the job selected, click Job→ Change Page Range to Process.
If you do not see the Change Page Range to Process item in the Job menu, use Add/Remove
Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type the start page
and end page you decided.

If you submitted this job using Distributed Print Facility (DPF), InfoPrint Manager ignores the end
page that you specify. DPF jobs always print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same destination support system
(DSS) as the one the job was originally submitted to. If you move the job to a printer that uses a
different DSS and the new printer does not support all of the attributes of the job, the job will fail to
print. To check which DSS your InfoPrint printer uses:

1) Select the printer in the tree view of the Main window of the InfoPrint Manager GUI.

2) See if the Type column appears in the details view. The Type column displays the DSS that the
InfoPrint printer uses.

3) If you do not see the Type column, use Add/Remove menu items to add it.

Continue with step 9.

9. Select the job again and click Job→Move job.

10. In theMove Jobs dialog, select the printer to print the job on. You can choose the same printer it
was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go back into the queue and
wait to be printed. Depending on how many jobs are ahead of it in the queue, it might take a while
for the job to print. To print the job right away, you can either move it to the top of the queue (so it
prints next) or you can change its priority (so it prints sooner, but not necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint Manager GUI and use the
Make Job First task. To change the priority of the job, use the Change Priority task.

12. Select the job in the job window and click Job→ Release.

If the task you want to use does not appear in the menu, use Add/Remove menu items to add it.

Pausing a job that's printing

When you use the use this procedure, InfoPrint Manager stops the job, checks to see if the paused job is
indeed the job currently printing, and collects checkpoint information about the job if it is. The job shows
on the GUI as Paused. Assuming that the operator does not take actions that invalidate the checkpoint
information when the job is resumed, it should restart at the checkpoint boundary. If the checkpoint
information is invalidated, the job restarts at page 1 unless the operator changes the page range before
resuming the job. Changing the job attributes so that the job would have to be re-ripped before printed
is an example of an action that would invalidate the checkpoint information.

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.
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2. Find the job that you want to pause and select it.

3. Click either Job→ Pause→ Now or Job→ Pause→ After current copy.

If the Pause item does not appear in the Job menu, use Add/Remove Menu Items to add it.

4. Click OK.
The job will stop printing, the icon will change to black, and the job will be listed in the job
window of the main InfoPrint Manager GUI window.

5. To resume the printing of this job, click Job→ Resume.

Resubmitting a retained job for reprint

Use this procedure to resubmit retained jobs for reprinting.

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.

2. In the Retained Jobs area, select the job you want to resubmit for reprinting.

To prevent the job from printing immediately after it gets in the queue, see Stopping the job, p.
369.

3. Click Job→Move Job to open theMove Job dialog.

If theMove Job item does not appear in the Job menu, go to Add/Remove Menu Items to
add it.

4. In theMove Job dialog, select a destination from the list. You can select the same printer the job
was printing on before or a different printer.

5. Click OK to resubmit the job to the selected destination. If the job is accepted, it gets in the queue
and waits to be printed.

If the job was previously stopped, see Restarting the job, p. 369.

Pausing and restarting an actual destination

Use these procedures to pause and restart an actual destination. You might want to pause an actual
destination when you are printing a long job, so that you can perform maintenance on the printer.

Pausing an actual destination

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.
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2. In the GUI, find the actual destination you want to pause.

3. Right-click on the actual destination, and select Stop or left-click on the actual destination and then

left-click on the icon on the toolbar.

If the Stop action does not appear on the menu or toolbar, use the Customize dialog to add the
action.

4. Select from these options:

• Click Now to pause the actual destination

• Click After current copy to pause the actual destination after the current copy has finished
printing.

• Click After current job to pause the actual destination after the current job has finished printing.

5. Click OK.
The actual destination stops printing, and the jobs processing on the actual destination stay in the
same state until the actual destination starts again.

Resuming the actual destination

To resume the actual destination:

• In the GUI, right-click on the actual destination and select Resume.

• Select the actual destination and left-click on the icon on the toolbar.

Moving backward or forward in a job that is currently printing

In InfoPrint Manager, moving from page to page in a job is called spacing the printer:

• Forward spacing is moving to a point later in the job (such as skipping from page 10 to page 15).

• Backspacing is moving to a point earlier in the job (such as backing up from page 40 to page 20).

Spacing a printer

Things to remember:

• You can only space a printer that uses the PSF Destination Support System (DSS) and one
of these attachment types:

– PSF TCP/IP

– PSF BSD

– PSF Other

To see what DSS your printer uses, do this:
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1. Select the printer in the tree view of the Main window of the InfoPrint Manager GUI.

2. See if the Type column appears in the details view. The Type column displays the DSS that the
InfoPrint printer uses.

3. If you do not see the Type column, use Add/Remove menu items to add it.

• You can only space a printer after a job has already started to print.
If you only want to print a section of a job (such as page 11 to page 20) or to start printing from a
page other than the first page of the job, use the Change Page Range to Process task in the
InfoPrint Manager GUI.

• Spacing works better on high-speed printers than on low speed printers.
While spacing is supported on all printers that you print to using the PSF DSS, it is very difficult to
space printers that print 40 pages per minute (ppm) or less. Spacing works adequately on printers
that print between 60 and 100 ppm, and works very well with high-speed InfoPrint printers that are
configured correctly.

• The InfoPrint 3000, InfoPrint 4000, and InfoPrint 4100 printers require additional
configuration for spacing to work efficiently.
See the Setting up high speed printers for spacing topic for instructions on configuring your
printer.

• Page numbers refer to pages of the print job, not necessarily to any page numbers in your
document.
For example, in a book, the first page of chapter one is usually "page 1." However, it might be
page 15 of the print job, because of the title page, credits, and table of contents.

• You cannot space to the back side of a sheet of paper.
If you are printing a duplex job, you will always print both the front and back sides of the sheet of
paper that you space to.

To space a printer, do this:

1. Start the InfoPrint Manager GUI.

2. In the GUI, find the InfoPrint printer that you need to space.

3. Select the InfoPrint printer by clicking on it, then click Printer→ Stop.

If you do not see Stop in the menu, useAdd/Remove menu items to add it.

4. In the Stop printer_name dialog, select Pause and Now, and click OK.
Even though you selected Now, the printer will keep printing for a while because it has to get to
a point in the job where it can stop. For InfoPrint 3000, and InfoPrint 4000 printers that are
configured correctly, you shouldn't have to wait more than 10 seconds. For other printers, you
might have to wait longer.

5. Once the printer has stopped printing, look at the last sheet that printed. Write down the number
of that sheet of the job.

6. Figure out what sheet of paper in the job you want to space to. Write down the number of that
sheet of the job.

7. Figure out the number of sheets of paper you need to space.

• To forward space the printer:
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Subtract the number of the sheet that printed last (from step 5) from the number of the sheet
that you want to skip to (from step 6), and then subtract one. Like this:

(number from step 6) – (number from step 5) – 1 = number of sheets to skip

• To backspace the printer:
Subtract the number of the sheet that you want to go back to (from step 6) from the page that
printed last (from step 5), and add one (for the current page). Like this:

(number from step 5) – (number from step 6) + 1 = number of sheets to back up

8. Determine the number of "sides" to space the printer.

• If you are printing a simplex job, the number of sides is the same as the number of sheet from
step 7.

• If you are printing a duplex job, multiply the number from step 7 by two to get the number of
sides. (number from step x 2 = number of sides)

9. In the InfoPrint Manager GUI, find the printer you want to space and select it.

10. With the printer selected, click Printer→ Space.

11. In the Space printer_name dialog, select Backspace or Forward space and type the number of
sides you found in step 8.

12. Click OK.

13. Make sure the printer is still selected and click Printer→ Resume to start the printer again.

Stopping a printer to perform scheduled maintenance

Use this procedure to stop a printer so you can perform routine maintenance, such as updating the
microcode, changing paper, or cleaning the printer. While you have the printer stopped, InfoPrint
Manager will not be able to send or schedule jobs to it. This procedure will work for printers that use
any DSS.

1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager Administration GUI.

2. In the GUI, find the printer that you want to stop and select it.

3. Use Printer—>Disable to disable the printer.

The InfoPrint printer will stop accepting jobs, but the printer will not stop printing immediately. All
of the jobs that were in the processing state before you disabled the printer will print before it
stops.

4. After the printer stops printing, you can perform whatever maintenance you need to.

5. When you are finished and the printer is ready to receive jobs again, go back to the InfoPrint
Manager GUI.

6. Find the printer in the GUI and select it.

7. Use the GUI to enable the printer again.

The printer will be available to accept and print jobs again.
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Fixing a printer problem and starting to print again

Use this procedure when the printer stops printing because of a paper jam, "out of paper" error, or for
some other reason.

• Refer to the online help in the InfoPrint Manager GUI if you need instructions on completing any of
these steps.

Try this first

"Out of paper" errors and some paper jams are easy to recover from. Most of the time, you do not have
to do anything to InfoPrint Manager to fix them; InfoPrint Manager just waits until the printer is ready to
print again. While it is waiting, InfoPrint Manager continues to accept jobs and schedule them to the
printer.

If the printer stops printing because of a problem, first try this.

1. Check the printer.

• If a lot of pages of the job are ruined and need to be reprinted, stop here. Do not finish this
procedure. Use the Fixing more complicated problems, p. 376 procedure below instead.

• Otherwise, load paper if the bins are empty or clear paper jams as the printer console
indicates. Once everything is clear, the printer should reset itself and continue sending jobs.
InfoPrint Manager should pick up where it left off.

2. Find the printer in the InfoPrint Manager GUI. Make sure that its status is ready. If it is not, select
the printer and use the GUI to enable it.

3. If just a few pages of the print job need to be printed again, the easiest thing to do is to resubmit
the job and print only those pages through page-select attribute. You can only print part of the
job if you are using the PSF DSS and if the job will be transformed to AFP before it is printed.

4. If just a few sheets of the print job need to be printed again, this can be done by resubmitting the
job and reprinting only certain sheet ranges. You can only print sheet ranges of the job if you are
using the PSF DSS. The sheet range option does not apply to the ASCII or DPF IPDS datastreams.

Fixing more complicated problems

Use this procedure when the problem is more difficult to fix or if you have to reprint numerous pages of
a job.

1. Open the InfoPrint Manager GUI.

2. Find the InfoPrint Manager printer (also called an actual destination) that sends jobs to that printer
and select it.

3. Use the GUI to disable the printer.
The printer won't be able to accept any print jobs until you enable it again.

4. If the printer stopped printing in the middle of a job, find that job in the GUI and select it.
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5. With the job selected, click Job→ Hold.

If the Hold item does not appear in the Job menu, use Add/Remove Menu Items to add it.

6. Click OK.
The job will stop printing, the icon will change to black, and the job will be listed in the job window
of the main InfoPrint Manager GUI window.

7. Decide what you want to do with any other jobs that are in the queue waiting for this printer. Some
of the options are:

• Leave them in the queue, so they print when you enable the printer again. If you can fix the
problem quickly, this option is the easiest one. In addition, if your printers are pooled, the other
printers will take care of all of the jobs until this one is ready.

• Move them to a different printer so they can be scheduled to print while you are working on this
one.

• Delete them. You should only consider this option if it is easier to resubmit the jobs than to use
other methods to recover them.

8. Fix the problem at the printer.
Once the problem is fixed, the printer might start to print again, just to clear the pages that were in
the buffer before you disabled it and deleted the job. If any other jobs were in processing state
when you disabled the printer, they will print as well.

9. Go back to the InfoPrint Manager GUI, find the InfoPrint Manager printer again, and select it.

10.Use the GUI to enable the printer.
The printer will be available to accept jobs again. If you left jobs in the queue, the printer should
start accepting and printing them.

Restarting the job that was printing when the problem occurred

You can either:

• Start the job from the beginning.

• Start the job from a point before the problem occurred (so the ruined pages get printed).

– You can only start printing in the middle of the job if the job is transformed to AFP before it gets
printed. You cannot print part of an ASCII, KGL, metacode, or LCDS job; you have to print the
whole job.

– You can start printing in the middle of the job, even if the job has more than one printable
documents. You can do this by specifying a sheet range (or multiple sheet ranges) to be
reprinted.

1. To print the entire job on the same printer it was printing on before, select the job in the job window
and click Job→ Release. The job will start printing from the first page.

2. To print the entire job on a different printer, skip to Before you Continue between steps 8 and 9
below.
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3. To print only part of the job, figure out what page you want to start printing from.
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If you do not want to start printing from the first page of the job, be careful when you choose which
page to start with. Duplex and n-up jobs can be confusing because you have to start printing with
the first page on the front side of the sheet of paper. If you do not choose the correct start page,
the job will print, but the sequence will probably be wrong. The easiest way to avoid this is to
choose a sheet range specifying the start and the end of the sheet that you want to print.

For example, if you are printing a 2–up duplex job, each sheet of paper actually has four pages
printed on it, like this:

22––uupp dduupplleexx pprriinntt jjoobb:: ffrroonntt aanndd bbaacckk vviieewwss

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you can choose page one
or page five (or any other page that would fall in that position). If you choose a different page, the
sequence of pages will be wrong, and the job won't print correctly.

However, there is a way to avoid this situation. You can choose a sheet range specifying the first
and the last sheet that you want to print.

To define the sheet range:

1) Go to Job -> Properties -> Show more.

2) Click on the Job Other tab.

3) Enter a number range in the fields provided under the Sheet range section.
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4) Click on the Add button to insert new ranges in the values list field on the right.

You can specify up to 10 sheet-ranges to be printed. If you specify more than 10 sheet-ranges, no
sheets print and InfoPrint issues an error.

4. Decide what page you want to stop printing on (if you do not want to print all the way to the end of
the job).
You do not have to be as precise on the last page to print; the last page can be in any location on
the sheet of paper.

5. Select the job you want to print.

6. With the job selected, click Job→ Change Page Range to Process.
If you do not see the Change Page Range to Process item in the Job menu, use Add/Remove
Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type the start page
and end page you decided above.

If you submitted this job using Distributed Print Facility (DPF), InfoPrint Manager ignores the end
page that you specify. DPF jobs always print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same destination support system
(DSS) as the one the job was originally submitted to. If you move the job to a printer that uses a
different DSS and the new printer does not support all of the attributes of the job, the job will fail to
print. To check which DSS your InfoPrint printer uses:

1) Select the printer in the tree view of the Main window of the InfoPrint Manager GUI.

2) See if the Type column appears in the details view. The Type column displays the DSS that the
InfoPrint printer uses.

3) If you do not see the Type column, use Add/Remove menu items to add it.

Continue with step 9.

9. Select the job again and click Job→Move job.

10. In theMove Jobs dialog, select the printer that you want to print the job on. You can select the
same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go back into the queue and
wait to be printed. Depending on how many jobs are ahead of it in the queue, it might take a while
for the job to print. If you want the job to print right away, you can either move it to the top of the
queue (so it prints next) or you can change its priority (so it prints sooner, but not necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint Manager GUI and use the
Make Job First task. To change the priority of the job, use the Change Priority task.

12. Select the job in the job window and click Job→ Release.

If the task you want to use does not appear in the menu, use Add/Remove menu items to add it.
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Using the correct halftones for the installed toner version

Multiple versions of toner are available for the InfoPrint 4000 and InfoPrint 4100 printers. For some
printer models, InfoPrint Manager ships different halftone curves for different toners, and provides scripts
to replace or install the correct ones. Make sure you have the correct halftone installed for your toner to
achieve the best print quality.

The toner characteristics can require changes in the halftone resources. When the toner in the printer is
replaced with a different version of toner, you must change the version of the printer toner that you want
to use and set the toner-version actual destination attribute.
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55.. Reference Information

•IPDS print operator commands
•IPDS error recovery
•Supported formatting objects

IIPPDDSS pprriinntt ooppeerraattoorr ccoommmmaannddss
InfoPrint Manager offers a comprehensive set of operator commands that can be used to manage
printing on IPDS printers. These commands can be used to help manage printing priorities and also help
by providing the operator with functions that are useful when dealing with problems that might occur in
the printing system. This table describes several of the most commonly used operator tasks, and their
corresponding commands. For more information, see the RICOH InfoPrint Manager: Reference.

Task Description InfoPrint Manager Command
Syntax

1 Disable
Stop a printer from receiving
new jobs.

pddisable -cd dest where dest specifies
either a logical or an actual destination
(printer) object.

2 Enable
Allow a printer to receive new
jobs.

pdenable -cd dest where dest specifies
either a logical or an actual destination
(printer) object.

3 Query active job

Query which job is actively
printing on a printer

The query response is based on
the last set of station counters
obtained from the printer, which
is printing pages continuously.
To get an absolutely accurate
query you must:
• Pause the printer (7)
• Enter the query
• Resume the printer (11).

pdls -f "destination-name-
requested==ldest && current-job-
state==printing" server: where server
specifies the InfoPrint AIX server to
which the job was submitted, and dest
specifies the actual destination
(physical printer).

4 Query page
number

Query the page number of the
currently printing page. See
Note after (3).

pdls -cj -r current-page-printing jobid
where jobid specifies the job-identifier
attribute. InfoPrint Manager
recommends using the global ID,
which follows the convention
server:0123456789 where server
specifies the name of the InfoPrint AIX
server to which this job was submitted
and 0123456789 indicates a 10-digit
numeric value assigned by the InfoPrint
spooler. You can determine the job-
identifier attribute value by specifying:
pdls -cj server:
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Task Description InfoPrint Manager Command
Syntax

5 Query job details
Query the number of copies,
sheets and pages stacked for a
job. See Note after (3).

pdls -cj -r "job-copies-completed
media-sheets-completed pages-
completed" jobid where jobid specifies
the job-identifier attribute.

6 Clean Remove all jobs from a printer. pdclean ldest where ldest specifies the
logical destination (logical printer).

7 Pause printer Pause a printer immediately. pdpause -cd dest where dest specifies
the actual destination (physical printer).

8 Pause printer Pause a printer after the current
copy completes.

pdpause -cd -w after-current-copy dest
where dest specifies the actual
destination (physical printer).

9 Pause printer Pause a printer after the current
job completes.

pdpause -cd -w after-current-job dest
where dest specifies the actual
destination (physical printer).

10 Resume printer Resume a printer that had been
paused.

pdresume -cd dest where dest specifies
the actual destination (physical printer).

11 Cancel job Cancel a specific job. pdrm jobid where jobid specifies the
job-identifier attribute.

12 Pause job Pause a specific job after the
current copy completes.

pdpause -cj -w after-current-copy jobid
where jobid specifies the job-identifier
attribute.

13 Pause job Pause a specific job
immediately.

pdpause -cj jobid where jobid specifies
the job-identifier attribute.

14 Pause job Pause the job that is currently
printing immediately.

pdpause -cd -j dest where dest specifies
the actual destination (physical printer).

15 Pause job Pause the job that is currently
printing after the current copy.

pdpause -cd -j -w after-current-copy
dest where dest specifies the actual
destination (physical printer).

16 Resume job Resume a job that was paused. pdresume -cj jobid where jobid
specifies the job-identifier attribute.

17 Back space
Back space (reprint a specific
number of sides) the job that is
printing.

pdspace -cd -b sidecount dest where
dest specifies the actual destination
(physical printer).

18 Reprint Reprint the job that is printing
from the beginning.

pdspace -cd -b -1 dest where dest
specifies the actual destination
(physical printer).

19 Forward space
Forward space (skip a specific
number of sides) the job that is
printing.

pdspace -cd -f sidecount dest where
dest specifies the actual destination
(physical printer).
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If one of these commands is received and it affects a job that has been sent or is in the process of being
sent to the printer, InfoPrint Manager immediately stops sending data to the printer and sends the printer
a command to stop printing (this applies to commands 7, 9, 10, 12-15).

For printers that support the SNMP Remote Operator interface, like the InfoPrint 4000, the printer will
stop in a few seconds. For printers without this support, some pages will likely print before the printer
stops.

The number of pages that print before the printer stops will vary depending on the number, size, and
complexity of jobs that are in process as well as the speed and type of printer involved. Once the printer
has stopped, InfoPrint Manager performs the steps necessary to execute the requested operator
command.

IIPPDDSS eerrrroorr rreeccoovveerryy
When driving an IPDS printer, InfoPrint Manager sends page and resource data to the printer. The
printer reports status and errors back to InfoPrint Manager. The printer status information is in the form of
station counters representing progress of pages sent to the device through the printer microcode and the
physical printing mechanism. Station counters report the number of pages and the number of copies of
pages proceeding through each point in the printer.

InfoPrint Manager requests printer status information (an acknowledgement request) after sending each
job. The acknowledgement response contains the latest values of all the printer station counters. Once
all pending jobs have been processed, InfoPrint Manager polls the printer periodically until all the
pages of each job have been stacked.

The actual destination object ack-interval attribute is configurable and defines how often InfoPrint
Manager requests updated station counters from the printer while processing a particular job. The value
for this attribute is specified in terms of pages and can be from 1 to 9999; the default value is 100
pages. For a 360 page job, an ack-interval setting of 100 pages means that InfoPrint Manager will
send an acknowledgement request to the printer after sending pages 100, 200, 300, and 360.

The printer responds to an acknowledgement request and returns station counters when all of the pages
up to that point have been processed. This does not necessarily mean that all of those pages have
printed or are stacked. The acknowledgement response from the printer after the 100th page will show
that 100 pages have been processed (received). The printer might report, however, that only 10 pages
have stacked.

The ack-interval value affects printing performance and the currency of job status information. A small
ack-interval value causes increased communication and processing and can cause a reduction in
printer throughput. A small ack-interval value will, however, increase the frequency that job attributes
such as current-page-printing, job-copies-completed, media-sheets-completed, and pages-
completed are updated. A small ack-interval value will also enable the InfoPrint Manager software to
have more recent station counters than it would with a large ack-interval value.

Errors reported from the printer can be grouped into these categories:

• IPDS error recovery: Data stream errors, p. 386

• IPDS error recovery: Insufficient memory in the printer, p. 388

• IPDS error recovery: Intervention required conditions, p. 388

• IPDS error recovery: Unrecoverable problems, p. 389
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IPDS error recovery: Data stream errors

For data stream errors, the job might continue printing or the job might be terminated, depending on the
severity of the error. There are hundreds of specific data stream errors. If one data stream error is
defined for the error, InfoPrint Manager directs the printer to continue processing the page and take an
alternate exception action.

When a data stream error occurs, messages are produced describing the problem and the recovery
actions performed. The messages report details about the error and include the page number where the
error occurred. After InfoPrint Manager receives a data stream error from the printer and produces a
message, it uses station counters returned from the printer to continue printing without skipping or
reprinting any pages.

Reporting of some data stream errors (using undefined code points in a font or printing outside of the
valid printable area) can be controlled with job attributes. This allows the job submitter to decide
whether error messages or printer error marks should be generated when the these type of errors are
encountered:

• Data stream error example 1 (job continues printing):, p. 386

• Data stream error example 2 (job is terminated, no pages print):, p. 387

• Data stream error example 3 (job is terminated; some pages print): , p. 387

Data stream error example 1 (job continues printing):

If page 3 of a 10–page document attempts to print outside the valid printable area (an error) and the
submitter specified (data-fidelity-problem-reported=all), this occurs:

1. Pages 1-2 and 4-10 in the document print normally.

2. For page 3, the printer prints only the data that is inside the valid printable area. In addition, a
printer error marker (PEM) is printed on the page where the print data extends outside the valid
printable area.

3. After all 10 pages have printed, a set of messages is printed:

0420-094: The following messages were generated for file /info/afp/baddata with Job ID
123. This file printed on the InfoPrint destination ip60, which is a 3160
destination.

0420-484: The destination reported that an attempt was made to print outside of the valid
printable area.

0420-249: InfoPrint received IPDS exception X'08C1..00', action code X'01' from the
destination.

0420-098: The error occurred while printing page 3 of copy 1 of this print job.

0420-254: The destination reported an error that caused InfoPrint to stop processing the
page.
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Data stream error example 2 (job is terminated, no pages print):

If a document is submitted and it requests a specific form definition which does not exist, this occurs:

1. The document does not print. However, auxiliary sheets such as the start sheet (header) and end
sheet (trailer) page, if requested, do print.

2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/testfdef with Job ID
456. This file printed on the InfoPrint destination ip60, which is a 3160
destination.

0420-128: ERROR: InfoPrint cannot find or cannot access the FORMDEF resource named
F1BAD.

0420-060: The error occurred with the object type page with token name PAGE0001.

0420-060: The error occurred with the object type document with token name ASCII.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.

Data stream error example 3 (job is terminated; some pages print):

If page 5 of a 10–page document requests a font (C0D0GT15) which cannot be located, this occurs:

1. Pages one through four print; page five does not print. Printing of the document ends; pages 6
through 10 also do not print.

2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/long.list3820 with
Job ID 167. This file printed on the InfoPrint destination psf4317, which is a
4317 destination.

0423-284: InfoPrint mapped the FGID, GCSGID, width, vertical size combination: 230, 0,
96, 160 to the FCS name C0D0GT15. The FGID.GRD mapping file specified
that this mapping be performed.

0423-291: Map Coded Font (MCF) structured field could not be processed because
InfoPrint could not locate the font character set C0D0GT15. Attempted
resolution/type(s): 300-pel Font Fidelity for this job was CONTINUE. Destination
supported resolution/type(s): 300-pel.

0420-060: The error occurred with the object type Active Environment Group with token
name 1.

0420-060: The error occurred with the object type page with token name 1.

0420-060: The error occurred with the object type document with token name LONG.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.
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0423-302: The font reference in the MCF1 structured field, repeating group number 1, with
sequence number 1, at file offset 118, could not be processed successfully.
Additional error and diagnostic messages follow.

0420-729: The error occurred in file /info/afp/long.list3820. The structured field in error
was structured field EAG with code X'D3A9C9' and sequence number 1 located
at file offset 250.

IPDS error recovery: Insufficient memory in the printer

In some cases, a printer might not have sufficient storage to process the data or resources required for a
page. When this occurs, InfoPrint Manager responds by deleting resources in the printer which are not
required for the page and then tries to print the page again. Frequently, this recovery will allow the
page to print successfully. If the printer still reports that there is insufficient storage to process the page,
the job is terminated and a message is produced indicating that the page and its associated resources
are too complex.

Insufficient memory in the printer exmple:

A 30 page document is submitted. Each page of the document references several complex page
segments.

1. InfoPrint Manager sends pages for the document to the printer.
Before each page is sent, InfoPrint Manager downloads page segments that are required by the
page.

2. The printer reports an insufficient memory error to InfoPrint Manager (for page 23).
InfoPrint Manager deletes all the page segments (and any other resources) previously downloaded
to the printer. All of the printer memory available for resources should now be free. InfoPrint
Manager then attempts to load only the page segments required for page 23. Because unnecessary
page segments have been removed from printer memory, all of the page segments for page 23 can
be successfully downloaded into the printer. No messages are reported to the server and no
message pages are printed.

3. All 30 pages of the job print successfully.

IPDS error recovery: Intervention required conditions

A printer might experience intervention required conditions that are not related to the data stream or
complexity of the data. These conditions cause printing to stop. Some intervention required conditions
are handled directly by some printers and are not reported back to InfoPrint Manager. In these cases,
InfoPrint Manager continues to send data to the printer.

Example:

1. As soon as the paper jam occurs, printing stops and the destination (printer) object changes to red.
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A message is sent to the operator:

0420-466: The destination reported a paper jam; clear the jam.

2. The actual destination (printer) object's destination-state changes to "needs key operator."
InfoPrint Manager waits until the paper jam has been cleared.

3. The operator then clears the paper jam, according to the printer jam recovery procedure. Some
damaged pages are usually discarded as part of this procedure.

4. Once the printer jam is cleared, the destination (printer) object is no longer red. Using station
counters from the printer, InfoPrint Manager repositions to the correct page and continues printing
the document.

5. At the end of the document, a message page is printed which contains these:
0420-094: The following messages were generated for file /info/paperjam with Job ID 787. This
file printed on the InfoPrint destination ip32, which is a 4332 destination.

0420-467: A paper jam occurred in the destination while printing this job. Inspect the output to
determine if it is complete and that all printed pages are acceptable.

IPDS error recovery: Unrecoverable problems

Unrecoverable problems cause the InfoPrint Manager software or printer software to stop functioning or
prevent them from communicating with each other. Examples of unrecoverable errors include: server
system crash, software core dump, printer abort, power failure, or severe network problems.

These errors prevent the InfoPrint Manager software from obtaining current station counter status
information from the printer. In these cases, InfoPrint Manager cannot determine how many pages and
which jobs printed since the last set of valid station counters were received. InfoPrint Manager considers
a job complete only when all pages are reported by the printer as stacked. In most cases, some pages
for one or more jobs will print between the time InfoPrint Manager last received a printer
acknowledgment and the time the unrecoverable error occurs.

Those jobs, because they are considered incomplete, will normally start printing from the beginning
when the problem is resolved and both the InfoPrint Manager software and the printer are operating
and communicating again.

However, if the submitter or operator does not want the job to start printing from the beginning, there is
a way to modify where printing starts for the documents in these jobs. The document object page-select
attribute can be modified before the job is processed again. This attribute allows the submitter to specify
a page range (first to last) for each document in a job. This way, the submitter or operator can control
which pages are printed after the problem is resolved.

Another way to modify where the printing starts is to set the sheet-range job attribute before the job is
processed again. This attribute allows the submitter to specify a sheet range (first to last) for the whole
job. This way, the submitter or operator can control which sheets are printed after the problem is
resolved.

Depending on the type of error and the network configuration, some errors might not be reported to
InfoPrint Manager immediately. In these cases, an operator can issue a pdshutdown command to the
actual destination object. This command works without any attempts to communicate with the printer.
InfoPrint Manager will checkpoint the job that was partially stacked at the printer and use the station
counters from the last valid acknowledgment to determine which page of which job to checkpoint. A
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small ack-interval value will make it possible to checkpoint using a more recent set of station counters
than would be available with a large ack-interval value. The job can be resumed later from that
checkpoint.

Some unrecoverable errors are reported immediately to the InfoPrint Manager software and the actual
destination object (printer) is disabled. When this occurs, the pdshutdown command cannot be issued
and therefore no checkpoint can be taken. InfoPrint Manager does not perform automatic
checkpointing.

Unrecoverable problem example:

1. The destination (printer) object becomes disabled, the state goes to needs-key-operator and the
icon changes to red.

2. The job object changes to the pending state.

3. Later, the printer power is restored.

4. The operator must enable the destination (printer) object.

5. Jobs start printing on the printer in the order they have been scheduled.

All 300 pages of the job that were printing during the power failure print again.

SSuuppppoorrtteedd ffoorrmmaattttiinngg oobbjjeeccttss
Supported XSL formatting objects, p. 390 lists the XSL formatting objects (XSL-FO) and properties that
XML Extender supports. For more information about XSL formatting objects and XSL style sheets, see
http://www.w3.org/TR/XSL/ and http://www.w3.org/Style/XSL/.

• The XML transforms do not support XSL shorthand properties and XSL functions.

• For the common properties listed in the table, most of their properties are supported.

SSuuppppoorrtteedd XXSSLL ffoorrmmaattttiinngg oobbjjeeccttss

The order of the formatting objects is based on the order listed in the XSL Standard on W3C.

Formatting object Category Property

root declaration-pagination-
layout

page-sequence declaration-pagination-
layout

initial-page-number

master-reference
page-sequence-master declaration-pagination-

layout
master-name

single-page-master-reference declaration-pagination-
layout

master-reference

repeatable-page-master-
reference

declaration-pagination-
layout

master-reference
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Formatting object Category Property

maximum-repeats

repeatable-page-master-
alternatives

declaration-pagination-
layout

maximum-repeats

layout-master-set declaration-pagination-
layout

simple-page-master declaration-pagination-
layout

Common Margin Properties–Block

master-name

page-height

page-width

reference-orientation

region-body declaration-pagination-
layout

Common Border, Padding, and
Background Properties

Common Margin Properties–Block

clip

region-name

reference-orientation

region-before declaration-pagination-
layout

Common Border, Padding, and
Background Properties

extent

precedence

region-name

reference-orientation

region-after declaration-pagination-
layout

Common Border, Padding, and
Background Properties

extent

precedence

region-name

reference-orientation

region-start declaration-pagination-
layout

Common Border, Padding, and
Background Properties

extent
region-name

reference-orientation

region-end declaration-pagination-
layout

Common Border, Padding, and
Background Properties
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Formatting object Category Property

extent
region-name

reference-orientation

flow declaration-pagination-
layout

flow-name

static-content declaration-pagination-
layout

flow-name

block block Common Border, Padding, and
Background Properties

Common Font Properties

Common Margin Properties–Block

absolute-position

color

linefeed-treatment

line-stacking-strategy

text-align

visibility

text-indent

white-space-collapse

white-space-treatment

wrap-option

block-container block Common Border, Padding, and
Background Properties

Common Margin Properties–Block

block-progression-dimension

height

inline-progression-dimension

reference-orientation

width

character inline Common Border, Padding, and
Background Properties

Common Font Properties

Common Margin Properties–Inline
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Formatting object Category Property

character

color

initial-property-set inline Common Border, Padding, and
Background Properties

Common Font Properties

color

external-graphic inline Common Border, Padding, and
Background Properties

Common Margin Properties–Inline

block-progression-dimension

content-height

content-width

inline-progression-dimension

src

text-align

inline inline Common Border, Padding, and
Background Properties

Common Font Properties

Common Margin Properties–Inline

block-progression-dimension

color

height

inline-progression-dimension

width

wrap-option

inline-container inline Common Border, Padding, and
Background Properties

Common Margin Properties–Inline

block-progression-dimension

height

inline-progression-dimension

reference-orientation

width

Supported formatting objects



5

394

Formatting object Category Property

page-number inline Common Border, Padding, and
Background Properties

Common Font Properties

Common Margin Properties–Inline

wrap-option

table-and-caption table Common Border, Padding, and
Background Properties

Common Margin Properties–Block

caption-side

text-align

table table Common Border, Padding, and
Background Properties

Common Margin Properties–Block

block-progression-dimension

inline-progression-dimension

height

table-layout

width

table-column table column-width

number-columns-spanned

table-caption table Common Border, Padding, and
Background Properties

block-progression-dimension

height

inline-progression-dimension

width

table-header table Common Border, Padding, and
Background Properties

table-footer table Common Border, Padding, and
Background Properties

table-body table Common Border, Padding, and
Background Properties

table-row table Common Border, Padding, and
Background Properties
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Formatting object Category Property

height

table-cell table Common Border, Padding, and
Background Properties

block-progression-dimension

empty-cells

ends-row

height

inline-progression-dimension

number-columns-spanned

number-rows-spanned

starts-row

width

list-block list Common Border, Padding, and
Background Properties

list-item list Common Border, Padding, and
Background Properties

list-item-body list

list-item-label list
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AAcccceessssiibbiilliittyy
Ricoh strives to provide products with usable access for everyone, regardless of age or ability. For more
information about the commitment that we have made to accessibility, see: https://www.ricoh-usa.
com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility.

Accessibility features

Accessibility features help users who have disabilities, such as restricted mobility or limited vision, use
information technology products successfully.

The major accessibility features in this product let you:

• Use screen readers, screen magnifiers, and other assistive technologies.

• Use a keyboard instead of a mouse.

• Change attributes such as volume, color, contrast, and font size.

In addition, the information center and the publications for the product are in an accessible format.

Keyboard navigation

This product uses standard Microsoft Windows navigation keys.

GGlloossssaarryy
This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home directory of a person using the InfoPrint GUI. InfoPrint uses
this file to save and reference information about the servers you are monitoring and the windows
you are working in.

A

Access Control List (ACL)
In computer security, a collection of all access rights for one object.

ACL
Access Control List.

acl editor
A command line interface that lets you view, add, update, and delete access authorization records
in an ACL.

action
In the InfoPrint GUI, an icon that represents an operation that you can perform on an InfoPrint
object. You drag and drop the action onto an object to initiate the operation for that object. For
example, using the Enable action to enable a disabled actual destination.

actual destination

https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility
https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility


In InfoPrint, an object that represents the output device that performs the printing or transmission
function. See email destination; see also physical printer, printer device; contrast with logical destination.

additive color system
A system that reproduces an image by mixing (adding) appropriate quantities of red, green, and
blue light (the additive primary colors) to create all other colors of light, either direct or transmitted.
When the additive primaries are superimposed on one another, they create white light. Contrast
with subtractive color system.

administrator
In InfoPrint, the person who creates and manages one or more components of a printing system,
such as servers and actual destinations. By default, InfoPrint gives administrators authorization to
perform some InfoPrint operations and to access certain information that is not available to the
operators or job submitters.

Adobe Acrobat
An Adobe software program that provides instant access to documents in their original format,
independent of computer platform. With the Adobe Reader, you can view, navigate, print, and
present any Portable Document Format (.pdf) file.

Adobe PageMaker
A desktop publishing program that produces PostScript documents.

Adobe PostScript Raster to Image Transform (RIP)
See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager (ADSM/6000)
A program that provides storage management for archived files.

Advanced Function Common Control Unit (AFCCU)
A RISC-based control unit with code common to all printers that use the AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with user applications, that use the all-points-addressable
concept to print data on a wide variety of printers or to display data on a wide variety of display
devices. AFP includes creating, formatting, archiving, retrieving, viewing, distributing, and printing
information.

Advanced Function Presentation data stream (AFP data stream)
The printer data stream used for printing AFP data. The AFP data stream includes composed text,
page segments, electronic overlays, form definitions, and fonts downloaded from the operating
system to the printer.

A presentation data stream that is processed in AFP environments. The AFP data stream includes
MO:DCA-P-based data streams.

Advanced Interactive Executive (AIX)
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An operating system used with pSeries computers. The AIX operating system is IBM's implementation
of the UNIX operating system.

AFCCU
Advanced Function Common Control Unit.

AFP
Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data stream.

ainbe
The printer input/output backend program used by the PSF DSS to send jobs to printer devices.
Depending on the incoming data stream of the job, the PSF DSS might have transformed the data
stream of the job before the backend program sending it to the printer device.

AIX
Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port that receives jobs from an AIX print queue.

In InfoPrint, a PSF physical printer that represents an AIX-attached printer device. See also direct-
attached printer, TCP/IP-attached printer, upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support system that communicates with the standard AIX print backend
(piobe), or with certain variations of the rembak print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a printer device that uses the AIX destination support system.

aliasing
In a digitized image, the creation of diagonal lines by combining short horizontal and vertical line
segments that approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and position text, overlays, and images at any defined point of
the printable area of the paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing letters, digits, and other symbols such as punctuation marks.
Synonymous with alphameric.

AMPV
Average monthly print volume.
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analog
Pertaining to a continuous variable sampling of information between two points that achieves an
even, smooth transition of photographic material.

analog color proof
An off-press color proof made from separation films.

anti-aliasing
The rendering of hard-edged objects so that they blend smoothly into the background. PhotoShop
offers anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality in diagonal lines produced on a computer screen by
aliasing. This removal is effected by creating less densely shaded fields parallel to the diagonal line.

APA
All-points-addressability.

API
Application Program Interface.

Application Program Interface (API)
The call interface between a client program and the procedures that implement the printing system,
as defined by the specification. Clients use the API to access servers. (P)

architecture
The set of rules and conventions that govern the creation and control of data types such as text,
image, graphics, font, color, audio, bar code, and multimedia.

archiving
The transfer of digital information from an online system onto floppy disk, compact disc, or other
media for offline storage. The original copy is deleted from the online system. See also retrieval.

array inkjet
An ordered collection of multiple print heads used in an inkjet printer.

ASCII
American National Standard Code for Information Exchange. The standard code, using a coded
character set consisting of 7–bit coded characters (8 bits including a parity check). The ASCII code
is used for information exchange among data processing systems, data communications systems,
and associated equipment. The ASCII character set includes control characters and graphic
characters.

asynchronous
Pertaining to two or more processes that do not depend upon the occurrence of specific events,
such as common timing signals. (T)

In InfoPrint, occurring without a regular or predictable time relationship to a specified action.
Contrast with synchronous.

attachment type
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Defines the method by which a printer device is attached to the AIX system from which it receives
data. See AIX-attached printer, direct-attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached
printer.

attribute
A defined characteristic of an object, such as the number of copies required of a job, or the
document formats accepted by an actual destination.

attribute name
A string that identifies an attribute. Typically, in InfoPrint attribute names consist of two or more
words separated by hyphens.

attribute value
The element of an attribute that specifies the characteristics relating to the attribute.

authorization
In computer security, verification of the eligibility of a user to access an object.

authorized user
A person with the appropriate permissions to access an object or to issue a command.

automatic recovery
A function of printer logic that permits the printer to reprint a job if the job is misprinted or damaged
or if a component has failed.

auxiliary sheet
In InfoPrint, an object that represents a particular sheet of paper, blank or otherwise, that can
precede a job, separate documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start, separator, and end sheets that print with jobs on a particular
printer device.

B

backend
In AIX or Linux, the program that is invoked by the qdaemon process (AIX) or CUPS printing system
( Linux) to run a print or batch job. Synonymous with backend program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time calculated by InfoPrint that is required to print all of the jobs currently
in a queue.

backspace
In InfoPrint, the action used to back up and reprint pages in a job.

bar code
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A code representing characters by sets of parallel bars of varying thickness and separation that are
read optically by transverse scanning.

An array of parallel rectangular bars and spaces that together represent data elements or
characters in a particular symbology. The bars and spaces are arranged in a predetermined pattern
following unambiguous rules defined by the symbology.

BCOCA
Bar Code Object Content Architecture.

Bezier curves
A method of defining curves using anchor points, control handles, and tangent lines. The PostScript
path passes through anchor points. Its approach direction is along the tangent lines that are
controlled by the control handles. Many personal computer programs use this drawing method.
Type 1 PostScript fonts are defined using Bezier curves.

binding
The cover and materials that hold a book together. See edition binding, perfect binding, spiral binding,
wire-o binding.

The process of applying the binding to a book.

In InfoPrint, assigning a job to an actual destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a rectangular grid of pixels. Each pixel is assigned a value to
denote its color. One-bit images are black and white; 8–bit images have 256 colors (or grays);
24–bit images have full color. CMYK images have 32–bits per pixel to encode 256 levels in each
of four channels. Bitmapped images are also called raster images.

bleed
An extra amount of printed image that extends beyond the trim edge of the sheet. Bleed ensures that
no white gap appears at the edge of the sheet.

boot
To prepare a computer for operating by loading an operating system.

BSD
Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support system that generates a print command string that the shell runs
to print jobs.

BSD physical printer
In InfoPrint, the object representing a printer device that uses the BSD destination support system.

burn
In platemaking, an exposure. Burn is named because of the extremely bright ultraviolet lamps used
to transfer images from film to plate.

In photography, to lengthen the final exposure time to increase the final density of print.
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CDE
Common Desktop Environment.

child
See parent/child relationship.

choke
In color printing, an area whose dimensions have been reduced to avoid overlapping another
color. Contrast with spread.

class
Synonym for object class.

clean
In InfoPrint, an action used to remove all the jobs from specified servers, actual destinations, or
queues, or to remove all the jobs submitted to specified logical destinations.

CLI
Command Line Interface.

client
In InfoPrint, the component of the print system that assembles a print request and submits the request
to a server. The client generates the local ID numbers for each job, submits the jobs to the servers,
and keeps track of where each user's jobs have been submitted.

CMR
Color Management Resource.

CMY
Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard drive disk array used to store RIPped files and later transfer
them to the LED print heads for imaging.

color balance
The relative levels of cyan, magenta, and yellow channels in an image to produce accurate color
rendition of an original image.

color correction
The adjustment of the color balance in an image to produce accurate color rendition of an original
image. Color correction is used for two- or three-spot-color jobs.

color key
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A color proof similar to Cromalin, but typically not laminated and not necessarily accurate in color.
Color keys are used to verify that breaks or color assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an architected resource that is used to carry all of the color
management information required to render a print file, document, group of pages or sheets, page,
or data object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands are specified on the command line. Contrast with
Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have multiple values with each value containing multiple
components.

constant data
Data that does not change between copies of a document and that is merged with variable data to
produce personalized documents. For example, a form letter (constant data) can be merged with a
customer's name and address (variable data).

contextual help
A type of online help that provides specific information about each selectable object, menu choice,
notebook tab, field, control, and pushbutton in a window.

control strip
A strip of information that can be attached to a print job and used to measure registration and
density.

Cromalin
The Dupont color proofing system. Four layers (CMYK) of light-sensitive material are exposed
through final halftone negative films, then laminated together on an opaque backing to produce a
color- and trap-accurate final proof showing actual halftone dot structure. Cromalin is sometimes
called an analog proof.

crop
To remove unwanted areas of an image, usually indicated by crop marks on the original.

CTS
Cutter-trimmer-stacker.

CUPS
Common Unix Printing System is a modular printing system for Unix-like computer operating systems
which allows a computer to act as a print server. A computer running CUPS is a host that can accept
print jobs from client computers, process them, and send them to the appropriate printer.

CUPS destination support system
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In InfoPrint, the destination support system that communicates with the standard LINUX print system
(CUPS) and that uses InfoPrint Manager pioinfo backend, InfoPrint Manager piorpdm backend
for Ricoh printers or other print backends to print jobs.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a printer device and used for paper handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset printing, as opposed to the three basic colors of light: red, green,
and blue. Magenta, yellow, and cyan are the subtractive primaries. Black is added to provide
better density and to produce a true black.

D

daemon
A program that runs unattended to perform a standard service. Some daemons are triggered
automatically to perform their tasks; others operate periodically. Daemon processes generally
provide a service that must be available at all times to more than one task or user, such as sending
data to a printer.

data stream
All information (data and control commands) sent over a data link.

A continuous stream of data that has a defined format.

In InfoPrint, pertaining to the incoming format of the job and the output format required by the
printer device. InfoPrint transforms the incoming format into the output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one whose deadline is closest. Contrast with FIFO (first-in-first-out), job-priority, longest-job-first, and
shortest-job-first.

default document
In InfoPrint, an object that represents default attribute values for a document in a job. Synonymous
with initial value document.

default job
In InfoPrint, an object that represents default attribute values for a job. Synonymous with initial value
job.

default object
In InfoPrint, a general term that refers either to a default document or a default job. Synonymous with
initial value object.

default value
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A value stored in the system that is used when no other value is specified.

delete
In InfoPrint, an action used to delete default objects, jobs, logical destinations, actual destinations,
or queues from the server.

desktop publishing
Performing print-related activities on a personal computer, including but not limited to layout,
design, photo manipulation, creating fonts, editing text, color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual destination uses to communicate with the output device.
Synonymous with device support system. See AIX destination support system, BSD destination support
system, email destination support system, and PSF destination support system.

device
An individual piece of equipment (hardware) that attaches to a computer, such as a printer device.

device address
The identification of an input or output device by its channel and unit number.

device driver
A file that communicates with a specific device such as a printer, disk drive, or display. An
application that sends output to a device controls the actions of the device through the device driver.
See printer driver.

device support system (DSS)
Synonym for destination support system.

DFE
Digital Front End

DFE destination support system
In InfoPrint Manager, the destination support system that communicates with a DFE print server
driving a Ricoh printer.

DFE printer
In InfoPrint Manager, the object representing a DFE print server driving a Ricoh printer.

DFS
Distributed File Service.

digital
Pertaining to data represented by digits, sometimes with special characters and the space character.

digital color proof
An off-press color proof made from a color printer attached to a computer.
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digital printing
A filmless and plateless printing process in which digital data for each page is transferred directly to
a light-sensitive drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port.

In InfoPrint, a PSF physical printer that represents a direct-attached printer device. See also AIX-
attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the acceptance of jobs on destinations, queues, or servers, or to
stop writing information to logs.

distributed print system
A computer system with the ability to interchange print data and controls among different computing
environments with the intent of printing the data on a different system from the one where the print
request was generated. For example, in host-to-LAN distributed printing, data that is located on the
host is printed on printers attached to a local area network.

dithering
A technique of filling the gap between two pixels with another pixel having an average value of the
two to minimize the difference or to add detail to smooth the result.

document
In InfoPrint, an object representing a grouping of data in a job. A job can contain one or more
documents. The documents in a job can differ from each other in some ways. For example, they can
contain different data and can have different document formats. A document in a job can contain
printable data or a resource that is not printable by itself. See file-reference document, printable
document, and resource document.

document element
A portion of a document at least a single page in size.

document format
In InfoPrint, a document format describes the type of the data and control characters in the
document, such as line data or PostScript. The format of the data determines which printer devices
are capable of printing the document and whether InfoPrint must transform the format.

document identifier
A string that identifies a document in a job. It consists of a job ID followed by a period (.) and a
document sequence number. For example, 12.2. Document sequence numbers are integers starting
at 1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that addresses those aspects of document processing that enable
users in a distributed open systems environment to send electronic documents to shared, possibly
geographically-dispersed printers. InfoPrint supports the DPA standard.

document transfer method
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In InfoPrint, the transfer method describes how documents are transferred to, or acquired by,
servers. See pipe-pull and with-request.

document type
In InfoPrint, the document type describes the kind of data in the document. A printable document can
only contain printable data. A resource document can only contain data such as fonts or form
definitions that are not printable. A file reference document can only contain names of files entered on
separate lines.

dot
The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot during printing, caused by ink spreading. Generally, this
value is known precisely, and the scanning and filming production process is calibrated to
compensate for it. The Cromalin proofing system simulates this effect.

dots per inch (dpi)
A measure of data density per unit distance. Typical values for desktop publishing range from 200
to 300 dpi.

DPA
Document Printing Application.

DPF
Distributed Print Facility.

dpi
Dots per inch.

drag and drop
In graphical user interfaces, a procedure by which you perform actions and tasks. Using the mouse,
you drag (move) an action or object icon to a new position where you want the action or task to
occur.

DSS
Destination support system.

dummy
A rough paste-up or hand-drawn representation of the anticipated finished product. A dummy is
used for basic design and pagination.

duplex printing
Printing on both sides of the paper. Contrast with simplex printing (1).

Printing on both sides of the paper, placing output images on the media in a head-to-head format,
so that the top of one image is at the same edge as the top of the next image. Contrast with tumble
duplex printing; see also simplex printing (2).

E

early binding
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In InfoPrint, assigning a job to an actual destination as soon as it is accepted. Early binding permits
InfoPrint to estimate the time when the job will be completed. Contrast with late binding.

edition binding
A type of book binding in which printed sheets are folded into 16- or 32-page signatures. Four-
page endleaves are pasted on the outside of the first and last signature. The signatures are then
collated by machine and sewn together using special sewing machines. Contrast with perfect
binding, spiral binding, and wire-o binding.

electronic document
A document stored in a computer instead of printed on paper.

electronic mail
Correspondence in the form of messages sent between workstations over a network. Synonymous
with email.

electrophotographic
Pertaining to a type of printer technology that creates an image on paper by uniformly charging the
photoconductor, creating an electrostatic image on the photoconductor, attracting negatively
charged toner to the discharged areas of the photoconductor, and transferring and fusing the toner
to paper.

em
In composition, a unit of measurement exactly as wide and as high as the point size of the font
being set. The name is derived from the fact that the letter M in early typefaces was usually cast on
a square body.

email
Electronic mail.

email destination
In InfoPrint, an actual destination representing an electronic mailing system.

email destination support system
In InfoPrint, the destination support system that supports email destinations.

embellishments
Variable data added to all copies of assembled pages to make the unit appear like a whole; for
example, headers, footers, a table of contents, and chapter separations.

en
In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a destination, queue, or server able to accept jobs, or a log able
to accept information.

end sheet
The sheet of paper, blank or otherwise, that can follow a job. See also auxiliary sheet.

Enhanced X-Windows
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A tool designed to permit multiple application processes to operate in multiple windows displayed
on a virtual terminal. See X-Windows.

environment variable
Any one of a number of variables that describe the way an operating system runs and the devices it
recognizes.

error log
A data set or file in a product or system where error information is stored for later access.

estimate
The professional cost analysis made by a print shop in response to a customer's request for a price
quotation on a print job.

event
In InfoPrint, an occurrence in the printing system during an operation; for example, the completion
of a command.

event log
In InfoPrint, a collection of messages about events that have occurred.

event notification
The notification that is sent by InfoPrint for an event.

F

Federated Authentication
A technology that grants users secure access to InfoPrint Manager relying on external identity
providers (IdPs). Instead of managing separate user credentials within the InfoPrint Manager system,
federated authentication allows users to log in using their existing accounts from trusted third-party
services.

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
job that has been in the queue for the longest time. InfoPrint processes jobs in the order in which
they are received. Contrast with deadline, job-priority, longest-job-first, and shortest-job-first.

file-reference document
In InfoPrint, a file containing the names of other files, each entered on a separate line. Job submitters
can specify this file for printing when they specify a document type of file-reference;
InfoPrint prints each file listed in the reference document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that makes it possible to transfer data to and from host
computers and to use foreign hosts indirectly.

finisher
A hardware device attached to a printer that performs such operations as folding or stapling the
printed pages.

finishing
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In a print shop, the final operations on a printed product, such as stapling, trimming, drilling,
folding, embossing, varnishing, gluing, shrink wrapping, perforating, laminating, collating, and so
on.

flag
A modifier of a command that specifies the action of the command. A dash usually precedes a flag.
Synonymous with option. See also keyword.

FOCA
Font object content architecture.

folder
In the InfoPrint GUI, an object that represents a container for a collection of similar objects. For
example, the Retained Jobs folder contains retained jobs.

font
A family of characters of a given size and style; for example, 9-point Helvetica.

One size and one typeface in a particular type family, including letters, numerals, punctuation
marks, special characters, and ligatures.

A paired character set and code page that can be used together for printing a string of text
characters. A double-byte font can consist of multiple pairs of character sets and code pages.

form definition
A resource object used by InfoPrint that defines the characteristics of the form or printed media,
which include: overlays to be used, the paper source (for cut-sheet printers), duplex printing, text
suppression, and the position of composed-text data on the form.

forward space
In InfoPrint, the action used to move ahead and skip the printing of a specified number of pages in a
job.

FPO
Low-quality (sometimes photographic) images placed in a dummy to represent final images.
Desktop publishing software produces images as display-screen resolution FPOs.

front panel
In the CDE, a workspace area containing controls that represent various tasks you can perform and
workspace switches.

FST
Files and Sockets Transport is the local security implementation for InfoPrint Manager. It uses the
local namespace for user credentials, and it is a lightweight security protocol.

FTP
File Transfer Protocol.

G

GCR
Gray component replacement.
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GIF
Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to make changes to one or more attributes of several objects at
once. You can also perform the same action on several objects of the same object class at the same
time; for example, disabling two or more actual destinations at the same time.

global character
A character or set of characters used to specify an unknown number or set of characters in a search
string. In InfoPrint, a global character is represented by an asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In InfoPrint, it is represented as the name of the server managing the
job followed by a colon (:) and a generated integer. This ID uniquely identifies the job in the
InfoPrint server.

glyph
An image, usually of a character, in a font.

GOCA
Graphics object content architecture.

graphic character
A visual representation of a character, other than a control character, that is normally produced by
writing, printing, or displaying.

Graphical User Interface (GUI)
A type of user interface that takes advantage of a high-resolution monitor and includes a
combination of graphics to implement an object-action paradigm, the use of pointing devices, menu
bars, overlapping windows, and icons. Contrast with Command Line Interface.

Graphics Interchange Format (GIF)
A compressed graphics format widely used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging from white to black, placed at the side of the original copy
during photography to measure the tonal range and contrast obtained.

GUI
Graphical User Interface.

gutter
The blank area or inner margin from the printing area to the binding.
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H

halftone
A printing method that simulates continuous-tone shading using dots of varying sizes laid out on a
rectangular grid. Larger dots simulate darker tones and smaller dots simulate lighter tones. Typical
grid spacings are 85 lines per inch (lpi) (newspaper), 133 lpi (low end), 150 lpi (midrange), and
175+ lpi (high quality).

help
In the InfoPrint GUI, an action used to display the online help for a specific template, object, action,
button, control, or area in an application window.

The name of a button used to access the online help.

hold
An indication determined by the job-hold attribute that is used to keep a job in the queue and
prevent InfoPrint from scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy jobs to submit them to print.

hypertext
A way of presenting information online with connections between one piece of information and
another. These connections are called hypertext links. See also hypertext link.

hypertext link
A connection between one piece of information and another. Selecting a link displays the target
piece of information.

I

icon
A graphic symbol displayed on a screen that a user can click to invoke a function or software
application.

image
Toned and untoned pels arranged in a pattern.

image data
Rectangular arrays of raster information that define an image.

imagesetter
A high resolution (1270–3600+ dpi) printer that uses an Argon (green) laser to write to film using
digital input. Imagesetting is the step before Cromalin proofing and platemaking.

imposition
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The process of arranging pages on a press sheet to ensure the correct order during final cutting,
folding, and binding. Electronic imposition builds press sheets automatically during the RIP and
outputs film formatted for immediate use in platemaking.

InfoPrint
A solution of software and hardware products that can supplement or replace the offset presses and
copiers in print shops with high-quality, non-impact, black and white or process color printers.
InfoPrint takes documents from creation to the published, kitted, and shipped product.

In InfoPrint software publications, InfoPrint Manager for AIX or any of its components.

InfoPrint Manager for AIX
The software component of InfoPrint. InfoPrint Manager for AIX handles the scheduling, archiving,
retrieving, and assembly of a print job and its related resource files. It also tracks the finishing and
packaging of the printed product.

InfoPrint Manager for AIX is based on Palladium technology developed at MIT/Project Athena. It
conforms to the ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP protocol that InfoPrint uses to communicate among servers,
clients, and output devices.

InfoPrint Select
The component of InfoPrint Manager for AIX that lets you submit jobs from a Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that lets you submit jobs with a job ticket from a Windows or
Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet, workgroup laser printer with optional duplexing and
600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet printer with 600-dpi resolution.

InfoPrint 62
A non-impact, continuous-forms printer that runs at a maximum of 62 impressions-per-minute
(depending on forms size), and is factory set to run at either 240 or 300 dpi on a maximum paper
size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white, continuous-forms printer with 600-dpi resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
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Synonym for default object.

initially settable attribute
An attribute whose value can be established when an object is created but cannot be subsequently
set or modified. See also resettable attribute; contrast with non-settable attribute.

input focus
The area of a window where user interaction is possible from either the keyboard or the mouse.

input tray
For a printer device, the container that holds the medium upon which the printer prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that enables users to position text, images, and graphics at
any defined point on a printed page.

Information that the host sends to IPDS printers. This information generally contains basic formatting,
error recovery, and character data and enables the printers to make decisions.

An architected host-to-printer data stream that contains both data (text, image, graphics, and bar
codes) and controls defining how the data is to be presented. IPDS provides a device-independent
interface for controlling and managing all-points-addressable (APA) printers.

International Organization for Standardization (ISO)
An organization of national standards bodies from various countries established to promote
development standards to facilitate international exchange of goods and services, and develop
cooperation in intellectual, scientific, technological, and economic activity.

Internet
A wide area network connecting thousands of disparate networks in industry, education,
government, and research. The Internet network uses TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to route data from its source to its destination in an internet
environment.

intervening jobs
In InfoPrint, the number of jobs in a queue that are scheduled to print before the job in question.

IOCA
Image object content architecture.

IP address
The IPv4 or IPv6 address.

IPDS
Intelligent Printer Data Stream.

ISO
International Organization for Standardization.
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J

job
In InfoPrint, an object that represents a request to print or send one or more documents together in a
single session. A job includes the data to be printed or sent and resources such as fonts, images,
and overlays. Depending on how it was submitted, it can also include a job ticket. Synonymous with
job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and embellishments that compose a document in a job, either
directly or by reference.

job ID
A local or a global identifier that identifies a job to a job submitter, administrator, operator, or
InfoPrint. See local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one with the highest priority. Contrast with deadline, FIFO (first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs for printing. Often, this person is an application
programmer who maintains applications that generate data to be printed.

job ticket
The customer's hardcopy or electronic instructions listing all the variables describing a print job,
either directly or by reference. The print shop can add specifications to the job ticket and can print
the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely used on the Internet.

JPEG
Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative spacing of two characters to improve their appearance and
readability. Kerning pairs are specific sets of characters with built-in relative spacing. Some
typefaces have as many as 100 kerning pairs.

keyword
A name or symbol that identifies a parameter.

Part of a command operand that consists of a specific character string, such as DSNAME=.

kitting
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In a print shop, packaging the completed published work with attendant binders, tabs, diskettes,
and other equipment or information, before shipping the finished product.

L

LAN
Local Area Network.

laser (light amplification by stimulated emission of radiation)
In InfoPrint printers, a device that emits a beam of coherent light that forms the image on the
photoconductor that is subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an actual destination until it is about to be processed. Late
binding permits InfoPrint to route a job to the first suitable actual destination that becomes available.
Contrast with early binding.

LDAP
Lightweight Directory Access Protocol is the network security implementation for InfoPrint Manager.
It uses an LDAP or Active Directory server for user credentials, and it offers a unified security
implementation in a customer environment.

LED
Light-emitting diode.

light-emitting diode (LED)
The imaging device element for electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used to space halftone dots. Typical grid spacings are 85 lpi
(newspaper), 133 lpi (low end), 150 lpi (midrange), and 175+ lpi (high quality).

Linux
Linux is an open-source operating system modeled on UNIX. There are multiple distributions
available, InfoPrint Manager is only supported on Red Hat Enterprise Linux (RHEL) and SUSE Linux
Enterprise Server (SLES).

Local Area Network (LAN)
A computer network at one location that consisting of devices connected to one another and
communicating. This network can also be connected to a larger network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically generated by the server, identifying the job to the person
who submitted it. InfoPrint maps a local job ID to a global job ID.

locale
The human language and character set of information presented to a user.
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In InfoPrint, the language InfoPrint uses when sending notification and error messages or displaying
the InfoPrint graphical user interfaces.

log
A collection of messages or message segments added to a file for accounting or data collection
purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users submit their jobs. The logical destination routes jobs to one or
more actual destinations representing output devices such as printers, or electronic mail systems. See
also logical printer; contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination. The logical printer routes jobs to one or more physical
printers representing printing devices.

logical unit (LU)
A type of network accessible unit that enables end users to gain access to network resources and
communicate with each other.

logical unit (LU) 6.2
A type of logical unit that supports general communication between programs in a distributed
processing environment. LU 6.2 is characterized by (a) a peer relationship between session
partners, (b) efficient utilization of a session for multiple transactions, (c) comprehensive end-to-end
error processing, and (d) a generic application program interface (API) consisting of structured
verbs that are mapped into a product implementation.

longest-job-first
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
longest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and shortest-job-first.

lpi
Lines per inch.

LU
Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with ink that contains particles of magnetic material.

mainframe processor
A functional unit that interprets and executes instructions in a large computer to which other
computers are connected so that they can share the facilities the mainframe provides.

makeready
All the setup work involved in preparing a press for a print run.
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manage
In the InfoPrint GUI, the action used to put an object into a mode where its icon reflects changes of
status.

mechanical
A camera-ready layout. The mechanical can consist of multiple sheets or overlays for each spot or
process color used. Final images, if not stripped in later, should be at final size, cropped and
screened to the correct line frequency.

medium
In InfoPrint, an object representing the physical material upon which a job is printed.

merge data
Data that is unique to each copy of a document and that customizes the document; for example,
serial numbers or mailing information. Merge data is typically a small percentage of the total data
in the document.

message catalog
A file of all the possible messages than can display during the processing of an application.

MICR
Magnetic ink character recognition.

Mixed Object Document Content Architecture (MO:DCA)
An architected, device-independent data stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content Architecture Presentation.

modify
In InfoPrint, an action used to modify the values of attributes in the object attributes notebook.

moire
Undesirable interference patterns caused by two overprinting halftone screens with incorrect
halftone dot angles.

monospaced
In typesetting, pertaining to a typeface in which all the characters have equal widths. Monospaced
typefaces are useful for tabulating figures.

Multiple Virtual Storage (MVS)
An operating system developed by IBM. The design of MVS incorporates an addressing
architecture that provides a unique address space to each job in the system.

MVS
Multiple Virtual Storage.

N

N_UP
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Pertaining to the number of forms placed together in a layout. Typical layouts are 2_UP, 4_UP, 8_
UP, 16_UP, and so on. N_UP printing is done to use the maximum area of the print sheet.

namespace
A global name repository available to all utilities and API procedures. The namespace contains
mappings of object names to other related objects. For example, the namespace provides the
mapping of a logical destination to the server in which it is located.

Network File System (NFS)
A protocol developed by Sun Microsystems that uses Internet Protocol to allow a set of cooperating
computers to access each other's file systems as if they were local.

newline options
The different ways in which the printer determines how lines are delimited in a document data
stream.

NFS
Network File System.

non-process-runout (NPRO)
A printer function that moves the last printed sheet to the stacker of the printer device.

non-settable attribute
An attribute that is neither initially settable nor resettable. The values for these attributes are
controlled by InfoPrint. Contrast with initially settable attribute and resettable attribute.

notification
The act of reporting the occurrence of events.

In InfoPrint, notification of events appears as messages in event logs or messages sent to
administrators, operators, and job submitters. In the InfoPrint GUI, notification of events also
appears as changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with an object that contains information designating the people
to whom InfoPrint sends notification about events for that object, which event information it sends,
and how it sends the information.

NPRO
Non-process-runout.

O

object
A collection of attributes that represent a physical or logical entity in the print system. For example, a
specific printer device is represented by an actual destination (physical printer) object. An object is
identified by its object name. Objects are grouped into classes. See also object class.

object class
A group of objects that share a common definition and therefore share common properties,
operations, and behavior as defined by their attributes. For example, all InfoPrint queue objects are
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in the same object class and each queue has the same set of queue attributes. However, the values
for those attributes can differ for each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a globally unambiguous identifier to an object or a document
component. The notation is defined in international standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an object.

object state
The state of an object indicates its availability and readiness for performing its functions. An object
can be in one of a number of states such as ready, busy, or unknown.

OCR
Optical character recognition.

octet
A byte that consists of eight binary digits (bits).

offset stacking
In certain printer devices, a function that allows the printer to offset the printed output pages for easy
separation of the jobs.

OID
Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to open a new application window displaying the logical and
actual destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing low-resolution images in review documents with high-resolution
images needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development organization created by a consortium of companies that
work together to develop software in the open systems market.

OpenType font (OTF)
An extension of the TrueType font format that adds:

• Support for PostScript outlines
• Better support for international character sets
• Broader support for advanced typographic control

open window
In the InfoPrint GUI, the action used to open a new application window representing one or more
objects displayed in the currently open application window.

operation
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An action performed on one or more data items.

operator
In InfoPrint, the person responsible for printer devices. Also, this person performs a subset of tasks
for InfoPrint queues and actual destinations and performs some job-related tasks.

OPI
Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable ASCII characters.

option
A modifier of a command that specifies the action of the command. A dash usually precedes an
option. Synonymous with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that represents a logical destination that is not associated with an
existing queue.

orphan logical printer
In the InfoPrint GUI, an object that represents a logical printer that is not associated with an existing
queue.

OSF
Open Software Foundation.

overlay
A collection of constant data, such as lines, shading, text, boxes, or logos, that is electronically
composed in the host processor and stored in a library, and that can be merged with variable data
during printing.

OTF
OpenType font.

P

PAC
Privilege Attribute Certificate.

page definition
A resource that contains the formatting controls for line data.

In InfoPrint, a resource that defines the rules of transforming line data into composed pages and text
controls.

page segment
A resource that contains composed text and images, which are prepared before formatting and
included during printing.

Palladium
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A distributed print system developed at MIT/Project Athena with participation from Digital
Equipment Corporation (DEC), International Business Machines (IBM), and Hewlett-Packard (HP). It
is a reference implementation for the OSI Document Printing Architecture (DPA) standard, ISO/IEC
10175.

pane
In the Work Area of the InfoPrint Manager Administration GUI, an area containing a group of
objects of a specific type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and destinations are related to one another in a parent/child
relationship. For example, a server is the parent of all the queues that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options submitted with a job that are used by the device driver, but not
InfoPrint. InfoPrint does not process or validate this information; it passes it along to the device
driver. See printer driver.

path
The route used to locate files; the storage location of a file. A fully qualified path lists the drive
identifier (if any), directory name, subdirectory name (if any), and file name with the associated
extension.

pause
In InfoPrint, the action used to temporarily halt the printing or transmission of jobs on actual
destinations or the distribution of jobs from servers or queues.

pdcreate
In InfoPrint, the command used to create a new object and set its attributes to specified values.

PDF
Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display information about a message.

pdpr
In InfoPrint, the command used to create and submit a job, consisting of one or more documents, to
a server for printing or transmission.

perfect binding
A type of book binding in which the pages are held together with flexible adhesive. Contrast with
edition binding, spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can access a file and what operations they can perform on the
file.

physical printer
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In InfoPrint, a type of actual destination that represents a printer device. See also printer device.

piobe
The standard printer input/output backend program used by AIX for printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method where InfoPrint saves the documents in a file and transfers
the address of the file to the server. InfoPrint transfers the file to the server upon the request from the
server. This is an efficient transfer method for large jobs and is the default transfer method at job
submission. Contrast with with-request.

plex
A document or actual destination attribute used to define the placement of output images on the
page. See the plex values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can be viewed or printed.

Portable Operating System Interface for Computer Environments (POSIX)
An Institute of Electrical and Electronics Engineers (IEEE) standard for computer operating systems.

POSIX
Portable Operating System Interface for Computer Environments.

PostScript
Adobe's page description language. PostScript has become a standard for graphic design and
layout software. PostScript files can contain both vector and raster data. Fonts are described using
PostScript coding. Many desktop publishing systems produce PostScript data as their output data
stream.

PostScript printer description (PPD)
A file that contains options for printing PostScript data on various printer devices.

PPD
PostScript printer description.

Prefix lengths
Identify a range of IPv6 addresses that are on the same network.

preflight
To assess all resources for a job before the actual print run.

prepress
Work done in the print shop before printing a job, such as preparing data and art, page imposition,
color retouching, electronic editing, and page layout.

print database
The set of files on disk that provide a permanent repository for the attributes of all print objects, such
as logical destinations, queues, and actual destinations.

print job
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Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge smoothing along diagonal lines, fine fidelity protection, and
independent boldness control.

Print Services Facility (PSF)
Any of several programs, including PSF for AIX, PSF/MVS, PSF/VM, and PSF/VSE, that produce
printer commands from the data sent to them.

print system
A group of one or more print servers and one or more printing devices, which might or might not be
located in the same geographical area. The components of a print system are assumed to be
interconnected in some manner, providing at least one network interface to print clients, and acting
synergistically to supply the defined document print service. (D)

printable document
In InfoPrint, an object that represents text or data to be printed by a job. Contrast with resource
document.

printer description file (PDF)
A file that contains options for printing PostScript data on a specific printer device.

printer device
The physical output device that performs the printing function. See also physical printer.

printer driver
A file that describes the physical characteristics of a printer or other peripheral device. This file is
used to convert graphics and text into device-specific data at the time of printing or plotting.
Synonymous with device driver.

priority
In InfoPrint, a number assigned to a job that determines its precedence in being printed. Jobs with
higher priority numbers are handled before jobs with lower priority numbers.

process color
Color made up of CMYK links simulating a specified color. This is the traditional method of
reproducing continuous tone color images (color separations). Because of the nature of color inks,
certain inks do not reproduce well.

processor
In a computer, a functional unit that interprets and executes instructions. A processor consists of at
least an instruction control unit and an arithmetic and logic unit. (T)

promote
In InfoPrint, the action used to move a job to the beginning of the queue so that it will print on the
next available printer that can handle that job.

protocol
A set of semantic and syntactic rules that determines the behavior of functional units in achieving
communication.
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pSeries
A family of workstations and servers based on IBM's POWER architecture. They are primarily
designed for running multi-user numerical computing applications that use the AIX operating system.

PSF
Print Services Facility.

PSF destination support system
In InfoPrint, the destination support system that communicates with PSF for AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a printer device that uses the PSF destination support system.

Q

QuarkXpress
A desktop publishing system produced by Quark, Incorporated.

queue
In InfoPrint, an object that manages a collection of jobs that are waiting to print. A queue receives
jobs from one or more logical destinations and sends jobs to one or more actual destinations.

A line or list formed by items waiting for processing.

R

raster
A pattern of dots defined at varying data depths. Black and white images are one-bit (on/off);
grayscale images are 8-bit (256 levels); RGB images are 24-bit; CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data stream is converted into dot patterns that are transferred to
the final print medium. InfoPrint uses an Adobe RIP to convert PostScript to IPDS for such printers as
the InfoPrint 4000 and InfoPrint 60.

rc.pd
In InfoPrint, a utility used to start the InfoPrint servers listed in the /etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value that cannot be set by the user but can change based on
other activity.

ready
A state in which an object is ready and able to perform tasks.

An available resource, such as a value of the media-ready attribute. Contrast with supported.

red, green, blue (RGB)
The colors of CRT display phosphors. RGB images are for screen display only. They must be
converted to CMYK images before printing.

registration
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The accuracy of printing on paper relative to the edges of the paper.

The accuracy of printing a single color (cyan, magenta, or yellow) relative to black.

The accuracy of printing on one side of a page relative to printing on the reverse side of the page.

reprographics
The process of copying or duplicating documents or information.

requested
In InfoPrint, pertaining to the specific values of attributes requested by a job when it is submitted. The
requested attribute values of a job are validated against supported attribute values for an actual
destination to determine if the printer can handle that job. Contrast with supported.

resettable attribute
An attribute whose value can be set or modified after an object has been created, assuming the
object is in an appropriate state to be modified. See also initially settable attribute; contrast with non-
settable attribute.

resource
In AFP, a file containing a collection of printing instructions used when printing a job. Resources
include fonts, overlays, form definitions, page definitions, and page segments.

resource context
In InfoPrint, an object that contains directory path information that helps the print system locate
resources needed for printing a job. The resources include fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a resource, such as graphics or fonts, used by a job to print a
printable document. Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute pending or retained jobs to a different logical destination than
the one through which the job was originally submitted.

resume
In InfoPrint, the action used to resume the printing of paused jobs or resume the distribution of jobs
from paused servers or queues.

retained job
In InfoPrint, an object that represents a job that is being stored in the print system for a specified
amount of time, normally after the completion of printing the job. A retained job does not reside in a
queue.

retention
The process of storing data after completion of a process for a certain length of time.

retrieval
The process of bringing digital archived data out of storage and into online memory for reuse. See
also archiving.
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RGB
Red, green, blue.

RIP
Raster image processor.

To convert data to dot patterns using a raster image processor.

root user
In the AIX environment, the system user with the most authority who can log in and execute restricted
commands, shut down the system, and edit or delete protected files. Synonymous with superuser.

RPC
Remote Procedure Call.

RPM
Red Hat Package Management is the baseline package format of the Linux Standard Base
distribution.

S

scanner
A device that converts hardcopy source data into digital format (halftone dots) to avoid retyping the
data.

scheduler
In InfoPrint, the scheduling method that the queue uses when assigning a job to an actual
destination.

separator sheet
The sheet of paper, blank or otherwise, that separates documents in a job. See also auxiliary sheet.

server
In InfoPrint, the object that accepts configuration, management, and printing requests, performs the
requested operations, and sends responses back as a result of the operation.

settable attribute
See initially settable attribute, resettable attribute.

severity
An indication of how serious an error condition is.

shell
In the AIX operating system, a command interpreter that acts as an interface between the user and
the operating system. In InfoPrint documentation, all shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the beginning and end of a string of double-byte, ideographic
characters.

shortest-job-first
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In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
shortest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and longest-job-first.

shut down
In InfoPrint, the action used to halt all server or actual destination processes without deleting the
server or actual destination.

signature
A group of pages that are printed, folded, cut, and bound together. Manual placement of pages in
the signature is determined using a folding dummy.

simplex
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-head format, so that the top of one image is at the
same edge as the top of the next image. Depending on the value of the document or actual
destination sides attribute, the document can be printed on one or both sides of the paper.
Contrast with tumble; see also simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper. Contrast with duplex printing (1).

Printing on one or both sides of the paper, placing output images on the media in a head-to-head
format, so that the top of one image is at the same edge as the top of the next image. Contrast with
tumble duplex printing; see also duplex printing (2).

SMIT
System Management Interface Tool.

SNA
Systems Network Architecture.

spiral binding
A type of book binding in which wire or plastic coils are threaded through a series of holes or slots
in the binding edge. Contrast with edition binding, perfect binding, and wire-o binding.

spot color
Individual colored inks formulated to exactly match a specified color. Spot color is used when
CMYK process color cannot produce a reasonable facsimile of the color or when vivid color is
needed. Spot color is also used when fluorescent or metallic colors are needed.

spread
In color printing, an area whose dimensions have been enlarged to eliminate white space between
it and another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise, that can precede a job. See also auxiliary sheet.

state
Synonym for object state.

stripping
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The process of mechanically assembling film into plate layouts. Page imposition takes place during
stripping.

subnet mask
Identify a range of IPv4 addresses that are on the same network.

subnetwork
Any group of nodes that have a set of common characteristics, such as the same network ID.

In the AIX operating system, one of a group of multiple logical divisions of another network, such as
can be created by TCP/IP.

subtractive color system
A system that reproduces an image by mixing (adding) appropriate quantities of cyan, magenta,
and yellow paints on white paper. These paints reflect certain colors and absorb—or subtract—
others. Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job attribute values that the actual destination can accept
during job validation. InfoPrint validates the requested attribute values of the job against the
supported attribute values of the actual destination to determine whether the actual destination can
handle that job. Contrast with requested.

synchronous
Occurring with a regular or predictable time relationship to a specified action. Contrast with
asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface tool for installation, maintenance, configuration, and
diagnostic tasks. SMIT lets you perform tasks without entering any commands.

Systems Network Architecture (SNA)
The description of IBM's logical structure, formats, protocols, and operational sequences for sending
units through, and controlling the configuration and operation of, networks.

T

table reference character (TRC)
An optional control character in a print data set. The TRC identifies the font used to print the record
and can be used to select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned images. TIFF files are also referred to as raster format files (as
opposed to vector format files). When used in desktop publishing, TIFF files produce only a low-
resolution FPO image; the high-resolution data remains on the hard disk.
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task help
A type of online help that provides a list of tasks that can be completed with a selected object.
When you select a task, the help provides step-by-step information about how to complete the task.

TCP/IP
Transmission Control Protocol/Internet Protocol.

TCP/IP-attached printer
A printer device attached to an pSeries computer through telecommunication lines using the TCP/IP
protocol.

In InfoPrint, a PSF physical printer that represents a TCP/IP-attached printer device. See also AIX-
attached printer, direct-attached printer, and upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration GUI, an object that represents a set of default attribute
values that has been defined for creating a particular type of object, such as an actual destination.

ticket
See job ticket.

TIFF
Tagged Image File Format.

Transmission Control Protocol/Internet Protocol (TCP/IP)
A set of communication rules used in the Internet and in any network that follows the U.S.
Department of Defense standards for inter-network protocol. TCP provides a reliable host-to-host
protocol between hosts in packet-switched communications networks and in interconnected systems
of such networks. It assumes that the Internet Protocol (IP) is the underlying protocol. See also Internet
Protocol.

trapping
In desktop publishing, the amount of overlap in overprinting colors. Trapping prevents white paper
showing through gaps caused by normal errors in registration. On sheet-fed presses, trapping is
usually 0.25 point. See also choke and spread.

TRC
Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline technology with flexible hinting. Glyph shapes are based
on quadratic curves. The font is described with a set of tables contained in a TrueType Font File.

TTF
TrueType font.

tumble
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-toe format, so that the top of one image is at the same
edge as the bottom of the next image. The document must be printed on both sides of the paper.
Contrast with simplex.
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tumble duplex printing
Printing on both sides of the paper, placing output images on the media in a head-to-toe format, so
that the top of one image is at the same edge as the bottom of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR
Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black ink that reduces use of CMY inks, improves trapping, and
reduces setup time. Generally, UCR is performed during image scanning, but some RIPs perform it
during processing. Synonymous with gray component replacement (GCR).

unmanage
In the InfoPrint Manager Administration GUI, the action used to put an object into a mode where its
icon does not reflect the changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that represents a printer device attached through an MVS system
and managed by PSF/MVS. InfoPrint communicates with the MVS system through the TCP/IP
network. See also AIX-attached printer, direct-attached printer, and TCP/IP-attached printer.

V

validate
In InfoPrint, to compare the attribute values requested by a job with the supported attribute values of
the actual destinations in the system and to determine whether there is an actual destination capable
of printing or sending the job.

value
A specific characteristic of an attribute.

variable
A name used to represent a data item whose value can change while the program is running.

variable data
Data that can be changed between copies of a document. For example, a form letter (constant
data) can be merged with variable data, such as a customer's name and address to produce
personalized documents.

varnish
A protective layer applied to a finished sheet, usually for photos, but sometimes used as a design
element because of its reflective qualities. Varnishes can be tinted.

vector
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An absolute coordinate point and line in space. PostScript files can contain vector artwork. Vector
files are converted to rasters during the RIP process.

velox
A black and white photographic print made from a halftone negative, to be used as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages the resources of a single computer so that multiple
computing systems appear to exist.

A virtual data processing system that appears to be at the exclusive disposal of a particular user, but
whose functions are accomplished by sharing the resources of a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full name is the Virtual Storage Extended/Advanced Function. It is
a software operating system controlling the execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface that allows system management through the direct
manipulation of objects.

VM
Virtual Machine.

VSE
Virtual Storage Extended.

VSM
Visual Systems Management.

W

web
A roll of paper used in web or rotary printing.

well
In the InfoPrint Manager Administration GUI, an area in a pane that contains a group of objects
related to the objects in the pane; for example, a queues well in a servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite image displayed on the screen at a computer workstation has
the appearance of the final printed image.

window
A rectangular area of the screen that you can move about, place on top of, or pull under other
windows, or reduce to an icon.

wire-o binding
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A continuous double series of wire loops run through punched slots along the binding side of a
booklet. Contrast with edition binding, perfect binding, and spiral binding.

with-request
In InfoPrint, a document transfer method where the client transfers the documents directly to the
server. Contrast with pipe-pull.

workstation
A terminal or microcomputer, usually one that is connected to a mainframe or to a network, at
which a user can use applications.

write access
A level of authorization that grants the ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system developed by MIT. It is the basis for Enhanced X-
Windows, which runs on the AIX Operating System.

xerography
A dry printing process using corona-charged photoconductive surfaces to hold latent images that
are developed with a dry toner and then transferred to paper and fused with heat.

Xstation
A terminal that is connected through a network to an pSeries computer, from which a user can
perform command-line functions and run X-Windows based applications.
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